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О данном руководстве… 
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усовершенствованием, мы оставляем за собой право на изменение информации в данном 

руководстве без предварительного уведомления пользователей. 

Запрещается копирование и воспроизводство данного руководство или его частей без письменного 

разрешения Delta Electronics Inc.. 

 

Сервис и техническая поддержка 
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Предисловие 

Спасибо за выбор продукции компании Delta Electronics. Сенсорные панели оператора серий DOP-A и 

DOP-AE являются средствами человеко-машинного интерфейса (далее по тексту, HMI), 

предназначенными для осуществления мониторинга и управления промышленными контроллерами 

(PLC), частотно-регулируемыми приводами, и другими приборами промышленной автоматизации с 

представлением оперативной и архивной информации процессов в удобном для оператора виде.  

Настоящее руководство описывает полный порядок установки, монтажа, эксплуатации и 

программирования с помощью программного обеспечения Screen Editor (далее “ScrEdit”). Перед 

началом использования панелей серии DOP и программного обеспечения ScrEdit, обязательно 

прочтите руководство по эксплуатации, которое идет в комплекте с панелями, а так же данное 

руководство, поставляемое по запросу.  

Строго соблюдайте требования техники безопасности. Особое внимание в руководстве уделите 

внимание местам с пометками "ОПАСНОСТЬ", "ВНИМАНИЕ" и "ПРЕДОСТЕРЕЖЕНИЕ". В случае 

непонимания каких-то вопросов связанных с подключением, программированием и эксплуатацией 

панелей серии DOP свяжитесь со специалистами торговых представителей компании Delta в вашем 

регионе. 

 

 Как использовать данное руководство 

 Содержание данного руководства 

 Данное руководство является полным руководством по подключению, эксплуатации 

и программированию  панелей оператора серий DOP-A и DOP-AE с помощью 

программного обеспечения ScrEdit.  

 Для кого предназначено данное руководство 

Данное руководство предназначено для: 

 конструкторов и разработчиков проектов и нового оборудования; 

 персонала осуществляющего механический и электрический монтаж; 

 программистов и эксплуатационщиков. 

 Важные меры предосторожности 

Перед началом использования панелей серии DOP, обязательно полностью прочтите 

данное руководство. Обязательно соблюдайте следующие меры предосторожности:  

 Работы по подключению, пуско-наладке и обслуживанию должны производиться 

только квалифицированным персоналом, изучившим настоящее руководство. 

 Устанавливайте панели только в чистых и сухих местах свободных от  коррозионно-

опасных  и легковоспламеняющихся жидкостей и газов. 
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 Гарантируйте для HMI правильное подключение и заземление. Метод заземления 

должен отвечать всем правилам и стандартам страны, где будет эксплуатироваться 

панель. 

 Не выполняйте подключение/отключение электрических соединений HMI при 

поданном напряжении питания. 

 Не рекомендуется использовать кнопки на панели DOP в качестве кнопок 

аварийного отключения, так как в случае отключения питания с панели кнопка 

аварийного отключения не будет функционировать. 

 Запрещается касаться токоведущих частей панели при поданном на неё напряжении 

питания. 

 Перед включением панели убедитесь, что все соединения выполнены правильно и 

напряжение питания составляет 24В постоянного тока, в противном случае 

возможно серьезное повреждение изделия. Убедитесь, что все провода подключены 

в соответствии с полярностью клемм. 

 Не пытайтесь разбирать панель. Не прилагайте недопустимых внешних воздействий 

к корпусу и лицевой панели. Это может привести к разрушению прибора. 
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Глава 1.  Введение 

1.1 Панели оператора серии DOP-A и DOP-AE 

HMI серии DOP-A и DOP-AE – это современные программируемые графические терминалы, 

предназначенные для визуализации информации, поступающей от микропроцессорных устройств 

(промышленных контроллеров, преобразователей частоты, регуляторов температуры, и т.д.), и 

управления производственными и технологическими процессами. Использование операторских 

панелей в системах управления позволяет создать удобный человеко-машинный интерфейс (Human 

Machine Interface) – централизованное рабочее место человека-оператора, управляющего машиной. 

Программирование и настройка панелей производится с использованием специального программного 

обеспечения – пакета ScrEdit, работающего в среде Widows. Ниже рассмотрены основные свойства и 

возможности панелей серии DOP и программного пакета ScrEdit. 

 

1.2 Функциональные возможности 

 Поддержка PLC многих производителей 

Программа ScrEdit v.1.05.74 включает в себя более 70 драйверов для связи с устройствами всех 

ведущих производителей (включая Omron, Siemens, Mitsubishi и т.д.), а так же протокол Modbus. 

Полный список поддерживаемых протоколов связи можно найти на веб-сайте 

(http://www.delta.com.tw/industrialautomation/). Список постоянно расширяется и обновляется. 

 Поддержка всех шрифтов Windows®  

ScrEdit предоставляет возможность отображения текста на экране DOP с использованием всех 

доступных шрифтов Windows® (в том числе на русском языке). 

 Функции макропрограммирования 

Пользователь может создавать макропрограммы, которые могут выполняться непосредственно в 

панели оператора, привязывать их выполнение к отдельным объектам или событиям. Используя 

данную функцию, пользователь может написать, например, драйвер COM-порта для связи с 

уникальным оборудованием. 

 Загрузка программы по USB  

Все панели серии DOP имеют встроенный порт USB Ver1.1, посредством которого можно удобно и 

быстро загрузить/выгрузить прикладную программу из PC в HMI и обратно. 

 Рецепты 
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Рецепт – это набор технологических параметров, который хранит настройки для определенного 

режима работы. Редактор рецептов позволяет создавать и модифицировать их в удобной 

табличной форме. Память рецептов 64000 регистров. Загружать рецепты в панель можно как 

вместе с прикладной программой, так и индивидуально. 

 Многопортовая коммуникация 

Встроенные порты могут работать одновременно по различным протоколам связи с различными 

типами ПЛК, ПЧ, сервоприводами и т.д. 

 On-line симуляция  

Благодаря этому режиму пользователь может создавать и отлаживать программу с полным 

взаимодействием с внешним PLC, подключенным к PC, без участия панели DOP. 

 Off-line симуляция 

В этом режиме пользователь может создавать и отлаживать программу на экране PC без 

взаимодействия с внешним PLC. 

 Использование SMC-карты для хранения данных 

Помимо копирования программы SMC-карта может использоваться для записи на нее 

хронологических данных (History list) и тревожных сообщений (alarm message), которые могут 

быть через карт-ридер скопированы в PC для архивации, обработки и печати. 

 Многоуровневый пароль  

Используется для разделения прав доступа к отдельным элементам прикладной программы. 

Возможно создание до 10 уровней доступа со своими паролями. 

 Порт USB-хост (только в DOP-AE) 

Панели DOP-AE оснащены ведущим USB-Host портом, к которому можно подключить USB флэш-

накопитель, карт-ридер и принтер. Пользователь может сохранять данные, увеличив тем самым 

память данных панели, копировать программу и печатать содержимое экранов  без проблем 

аппаратной несовместимости. 

 Многоязыковая поддержка 

Пользователи могут использовать до 8 языков отображения информации на экране панели и 

легко переключаться между ними с помощью экранных переключателей или по внешней команде 

от ПЛК. 
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1.3 Маркировка  

Серия DOP-A  

Напряжение питания

DOP A 57 GS T D -          

D: DC
A: AC
Интерфейс пользователя
T: Сенсорная панель
K: Внешняя клавиатура
Тип экрана
GS: STN (16 оттенков серого)

CS: STN цветов
TC: TFT (256 цветов)

B 8
F (256 )

H 65536

S: STN (  оттенков голубого)

T : TFT (  цветов)

Размер экрана
57: 5.7"
75: 7.5"
80: 8
10: 10.4"

"

A: стандартная 

Delta Operator Panel

Серия

Название изделия
A : с расширенными функциямиE

 

 

1.4 Предупреждение  

 Условия эксплуатации (температура и влажность окружающей среды) 

Только при эксплуатации HMI при приведенных ниже условиях может быть гарантировано 

наилучшее качество изображения (яркость, контрастность). При длительной работе вне данного 

диапазона температуры/влажности возможно ухудшение параметров LCD-дисплея. 

Диапазон рабочих температур окружающей среды: 0 ºC ~ 50 ºC (32 ºF ~ 122 ºF) 

Относительная влажность: 10% ~ 90%, без образования конденсата 

 SMC-карта 

SMC-карта может применяться для хранения и передачи данных. Только SMC-карта, 

отформатированная в HMI может быть использована в HMI и Windows® OS. (Карта может 

читаться/записываться в нескольких форматах, но могут возникать ошибки из-за несоответствия 

формата различных версий Win95/98/2000/XP) 
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 Не вставляйте и не вынимайте разъемы COM-портов панели в течение работы  

Обязательно снимайте напряжение питания с панели перед коммутацией кабелей COM-портов 

панели. 

 Рекомендуемые системные требования 

 Pentium III, 500МГц и выше 

 256MB RAM 

 Windows® 2000 или Windows® XP 

 

 



НПО "СТОИК ЛТД" т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

Revision 05/30/2006, EH00   2-1 

Глава 2.  Создание и редактирование экранов 

2.1 Установка программы ScrEdit (Screen Editor) 

 Аппаратные требования 

Минимальные системные требования конфигурации ПК для установки и работы с ScrEdit: 

Пункт Системные требования 

Операционная система Windows® 2000 или Windows® XP 

ЦПУ Pentium III, 500MHz и выше 

ОЗУ 256MB и больше 

Жесткий диск 100MB и больше 

Монитор Разрешение: 800х600. Рекомендуемый режим цветности, 
задаваемый в Windows: 256 цветов или больше. 

Манипулятор "мышь" Совместимая с Windows 

Принтер Совместимый с Windows 

 Установка программы 

Последовательность установки программы ScrEdit на ПК: 

1. Шаг 1: Запустите ПК с установленной на нем операционной системой Win2000 или WinXP. (Рис. 

2.1.1) 

 

Рис. 2.1.1 Рабочий стол Microsoft Windows 

2. Шаг 2: Запустите файл "Setup.exe" из установочного дистрибутива ScrEdit любым из способов, 
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например, выполнив команду Run в меню Start. (Рис. 2.1.2) 

 

Рис. 2.1.2 Запуск файла setup.exe 

3. Шаг 3: Нажмите OK, откроется следующее диалоговое окно. 

 

Рис. 2.1.3 Выбор директории для установки ScrEdit 

Выберите директорию для установки программы (по умолчанию C: \Program File\Delta\Screen 

Editor 1.05.55 (Build 1.061)), нажмите Next> для перехода к следующему шагу.  

4. Шаг 4: В следующем диалоговом окне выберите в качестве языка установки: English (Английский) 

и нажмите Next> для перехода к следующему шагу. 
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Рис. 2.1.4 Выбор языка установки 

5. Шаг 5: В этом окне отображается ход установки программы. (Рис. 2.1.5, Рис. 2.1.6) 

 

Рис. 2.1.5 Ход установки 

 

 

 

6. Шаг 6: В конце установки откроется следующее окно, в котором надо нажать Finish для 

завершения установки программы. (Рис. 2.1.7) 
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Рис. 2.1.6 Конец установки ScrEdit 

7. Шаг 7: После завершения установки будет предложено перезагрузить компьютер, что можно 

сделать сразу, нажав OK или позднее, выбрав “No, I will restart my computer later.” и нажать OK. Вы 

должны перезагрузить компьютер перед первым запуском ScrEdit. 

 

Рис. 2.1.7 Завершение установки 
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2.2 Запуск ScrEdit 

После установки программы и перезагрузке ПК вы можете запустить ScrEdit из меню Start > 

Programs > Delta HMI > Screen Editor. (См. рис. 2.2.1) 

 

Рис. 2.2.1 

 

Рис. 2.2.2 Начальный экран 

Когда вы запустите ScrEdit в первый раз, ScrEdit установит драйвер для USB автоматически. Поэтому 

первый запуск программы может несколько затянуться. Это нормально, надо только немного 

подождать.  

1. При последующих запусках программы будет открываться предыдущая прикладная программа, 

если в меню Environment  установить “auto open last file automatically”. 

2. Если не устанавливать “auto open last file automatically”,  то последний редактируемый файл 

открываться не будет (см. Рис. 2.2.3). 
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3. Без открытого файла прикладной  программы в строке меню будут доступны только меню File (F), 

View(V), Option(O) и Help(H). 

Когда ScrEdit активизирован впервые, экран будет иметь следующий вид. 

 

Рис. 2.2.3 Экран без редактируемого файла прикладной программы 

Нажав  или выбрав File> New, будет создан новый файл прикладной программы пользователя, и 

откроется следующее диалоговое окно. (Рис. 2.2.4) 

 

Рис. 2.2.4 Создание новой прикладной программы 

 

Ведите имя прикладной программы (Application Name), имя первого экрана прикладной программы 

(Screen Name), номер первого экрана прикладной программы (Screen ID), выберите модель вашей 
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панели (HMI), модель контроллера (Base Port Controller) и модель принтера (Printer). Затем нажмите  

OK, откроется первое окно прикладной программы пользователя. (Рис. 2.2.5) 

 

 

Рис. 2.2.5 Новая прикладная программа пользователя 

 

Окно ScrEdit состоит из 5 основных частей.  

 Строка меню 

Строка меню состоит из 9 элементов: File, Edit, View, Element, Screen, Tools, Options, Window, и 

Help. 

 

 Панели инструментов  

Панель инструментов (Рис. 2.2.6) содержит элементы, имеющиеся в большинстве приложений 

WINDOWS.  

1. Стандартная панель инструментов 

 

2. Панель масштабирования 

 

3. Панель инструментов текста 
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4. Панель изображения 

 

5. Панель элементов 

  

6. Панель сборки 

 

7. Панель компоновки 

 

 

 

Рис. 2.2.6 Панели инструментов ScrEdit 
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Рис. 2.2.7 Перемещение панели элементов ScrEdit  

 

 Окно свойств  

Окно свойств позволяет редактировать свойства выбранного элемента (объекта). См. главу 3 для 

детального описания. 

 
Рис. 2.2.8 Окно свойств  

 

Выбор состояния объекта
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Рис. 2.2.9 Предварительный просмотр редактируемого экрана 

 

 Выходное окно 

Здесь отображаются все действия и выходные сообщения при компиляции программы. Все 

обнаруженные при компиляции ошибки, будут отображаться в этом окне. Для перехода к объекту 

с ошибкой можно кликнуть мышкой по соответствующему сообщению в этом окне.  

 

Рис. 2.2.10 Выходное окно 

 

 Рабочая область 

Рабочая область – это та область экрана, на которой должны размещаться все элементы 

редактируемого экрана прикладной программы и которая в последствие будет отображаться на 

дисплее операторской панели. Размер рабочей области будет зависеть от выбранной модели 

панели DOP. Ниже показан пример рабочей области для панели DOP-AE10THTD (Рис. 2.2.11). 
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Рис. 2.2.11 Рабочая область ScrEdit 
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2.3 Меню Файл (File) 

Строка меню программы ScrEdit состоит из 9 выпадающих меню, которые содержат все возможные 

функции и элементы, предоставляемые программой. Некоторые из функций и элементов строки 

меню дублируются на панели инструментов для удобства пользователя.  Строка, содержащая девять 

выпадающих меню, имеет следующий вид: 

 

 Элементы меню File 

Меню “File” предоставляет пользователю следующие общие функции по работе с файлом:  

1. Создание нового файла прикладной программы, открытие старой прикладной программы, 

закрытие файла, сохранение текущего файла и сохранение текущего файла под другим 

именем, и т.д. 

2. Скопировать прикладную программу из/на SMC-карту. 

3. Скопировать прикладную программу из DOP в PC и сохранить её на жестком диске.  

4. Обновить программно-аппаратное обеспечение (firmware) панели DOP. 

5. Функция защитного пароля. 

6. Функции вывода экранов прикладной программы на печать. 

7. По умолчанию, внизу выпадающего меню File предоставлен лист из четырех последних 

открываемых файлов для быстрого доступа к ним. 

8. Закрытие программы ScrEdit с предложением сохранить все открытые в текущий момент 

файлы. 

 

Рис. 2.3.1 Элементы меню File 
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 Создание новой прикладной программы 

Выберите File > New (Рис. 2.3.2) или значок  на 
стандартной панели инструментов (Рис. 2.3.3), или 
используйте горячие клавиши Ctrl + N.  

 

Рис. 2.3.2 Создание новой прикладной программы с помощью команды New в меню файл 

 

Рис. 2.3.3 Создание новой прикладной программы с помощью значка New на стандартной 

панели инструментов 
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1. После выполнения предыдущего действия откроется диалоговое окно (Рис. 2.3.4), в 

котором будет предложено ввести имя прикладной программы (Application Name), имя 

первого экрана прикладной программы (Screen Name), номер первого экрана прикладной 

программы (Screen ID), выбрать модель вашей панели (HMI), модель контроллера (Base 

Port Controller) и модель принтера (Printer). 

 

Рис. 2.3.4 Диалоговое окно создания новой прикладной программы 

2. Если в момент создания новой прикладной программы в ScrEdit открыт какой-либо файл, то 

будет предложено его сохранить (Рис. 2.3.5). Нажмите кнопку Yes для сохранения и 

закрытия текущего файла. Нажав кнопку No, текущий файл будет закрыт без сохранения. 

Кнопка Cancel отменит действие по созданию новой прикладной программы. После 

нажатия кнопок Yes или No откроется диалоговое окно (Рис. 2.3.4).  

 

Рис. 2.3.5 Предложение сохранить текущий файл перед его закрытием 

3. Ведите имя прикладной программы (Application Name), имя первого экрана прикладной 

программы (Screen Name), номер первого экрана прикладной программы (Screen ID), 

выберите модель вашей панели (HMI), модель контроллера (Base Port Controller) (Рис. 2.3.6) 

и модель принтера (Printer). Затем нажмите кнопку OK.  
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Рис. 2.3.6 Выбор модели HMI и модели контроллера 

 

 Открытие старой прикладной программы 

Выберите File > Open (Рис. 2.3.7) или значок  на 
стандартной панели инструментов, или используйте 
горячие клавиши Ctrl + O. 

 

Рис. 2.3.7 Открытие старой прикладной программы с помощью команды Open в меню файл 
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Рис. 2.3.8 Открытие старой прикладной программы с помощью значка на стандартной панели 

инструментов 

 

1. Если в момент открытия файла прикладной программы в ScrEdit открыт какой-либо файл, то 

будет предложено его сохранить (Рис. 2.3.5).  Если в момент открытия файла прикладной 

программы в ScrEdit нет открытых файлов, то сразу откроется диалоговое окно выбора 

открываемого файла (Рис. 2.3.9). 

2. Далее в открывшемся диалоговом окне выберите имя файла нужной прикладной 

программы.  

 
Рис. 2.3.9 Открытие старой прикладной программы 
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 Закрытие текущей прикладной программы 

Выберите File > Close (Рис. 2.3.10). 

 

Рис. 2.3.10 Закрытие текущей прикладной программы 

1. Если до выполнения данной команды текущая прикладная команда не была сохранена, то 

будет предложено её сохранить (Рис. 2.3.11). 

  

Рис. 2.3.11 Предложение сохранить текущий файл перед его закрытием 

 Сохранение текущей прикладной программы на жесткий диск ПК 

 Выберите File > Save (Рис. 2.3.12) или значок  на 
стандартной панели инструментов (Рис. 2.3.13), или 
используйте горячие клавиши Ctrl + S. Если данная 
программа сохраняется в первые, то откроется 
диалоговое окно (Рис. 2.3.15) с предложением выбрать 
имя и место сохраняемого файла. Если сохранение 
текущей программы ранее выполнялось, то по данной 
команде она будет немедленно сохранена под старым 
именем в том же месте жесткого диска ПК. 
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Рис. 2.3.Сохранение текущей прикладной программы с помощью команды Save в меню файл 

 

Рис. 2.3.13 Сохранение текущей прикладной программы с помощью значка Save на стандартной 

панели инструментов 

 Сохранение текущей прикладной программы на жесткий диск ПК под другим именем 

 Выберите File > Save As (Рис. 2.3.14). Откроется 
диалоговое окно (Рис. 2.3.15) с предложением выбрать 
имя и место сохраняемого файла. Оно также появиться, 
если прикладная программа сохраняется впервые 
командой Save. 
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Рис. 2.3.14 Сохранение текущей прикладной программы с помощью команды Save As 

 

Рис. 2.3.15 Диалоговое окно выбора имени и места сохраняемого файла 

 Запись прикладной программы на SMC-карту 

 Перед использованием данной команды прикладная 
программа должна быть откомпилирована. Иначе 
команда не выполнится, а на экране ПК появиться 
сообщение об ошибке (Рис. 2.3.16). Выполните 
компиляцию и выберите File > Make SMC Screen Data 
для копирования текущей прикладной программы на 
SMC-карту (Рис. 2.3.17). Если SMC-карта с записанной 
на неё прикладной программой будет вставлена в HMI, 
то при подаче питания на панель все данные будут 
читаться напрямую с SMC-карты.  

 



Глава 2.  Создание и редактирование экранов 

2-20    НПО "СТОИК ЛТД" т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

Рис. 2.3.16 Сообщение об ошибке при 

попытке записать на SMC-карту 

нескопилированную прикладную программу 

 

 
Рис. 2.3.17 Диалоговое окно выбора съемного 

диска (SMC-карты) 

 Открытие прикладной программы с SMC-карты 

 В системном меню HMI пользователь может сохранить 
рабочую прикладную программу на SMC-карту. Затем, 
вставив её в ПК, с помощью команды Open SMC Screen 
Data напрямую открыть её в ScrEdit с возможностью 
редактирования. 

 Загрузка в ПК прикладной программы и рецептов из HMI 

 После выбора File > Upload (Рис. 2.3.18), откроется 
диалоговое окно с запросом пароля, который необходимо
будет ввести (пароль, сохраненный в HMI, имеет более 
высокий приоритет), а затем, если пароль введен 
правильно, откроется диалоговое окно выбора места и 
имени для сохранения  загруженной прикладной 
программы (Рис. 2.3.15). После выбора имени и места 
сохранения начнется копирование программы из HMI в 
ПК (Рис. 2.3.20). Пользователь сможет видеть ход 
загрузки, а также при необходимости прервать её кнопкой
Stop. Когда прогресс будет равен 100%, загрузка 
завершена. Закрыть данное диалоговое окно можно 
кнопкой Stop. Загруженный файл может быть открыт в 
ScrEdit и отредактирован. Эта функция позволяет 
предотвратить потерю прикладной программы при 
потере оригинального файла. 
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Рис. 2.3.18 Команда загрузки прикладной программы из HMI в ПК  

 

Рис. 2.3.19 Диалоговое окно ввода пароля 
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Рис. 2.3.20 Ход копирования программы 

 Загрузка рецептов из HMI в ПК 

Эта функция аналогична предыдущей (Рис. 2.3.20), но 

загружаться будут только рецепты(Рис. 2.3.21). Для 
выполнения этой команды также необходимо ввести 
пароль (пароль, сохраненный в HMI, имеет более 
высокий приоритет).  

 

Рис. 2.3.21 Команда загрузки рецептов из HMI в ПК 

 

 Обновление Firmware (программно-аппаратного обеспечения HMI)  

Эта функция позволяет обновить системную прошивку 
HMI с целью добавления в неё новых возможностей (Рис. 
2.3.22). 
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Рис. 2.3.22 Обновление прошивки HMI с помощью команды Update Firmware 

 Защита прикладной программы паролем 

Пользователь может разрешить или запретить функцию 
защиты паролем прикладной программы выбрав File > 
Password protect (Рис. 2.3.23). Появится диалоговое 
окно, в котором надо будет подтвердить разрешение 
функции пароля Рис. 2.3.24 и рядом с командой “Password
Protect” будет установлен символ , означающий что 
данный файл защищен паролем, без которого его в 
дальнейшем невозможно будет открыть. Сам пароль 
должен быть задан в меню Option > Workstation Setup 
(Рис. 2.3.26). При запрещении функции защиты паролем, 
появится диалоговое окно, показанное на Рис. 2.3.25.  
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Рис. 2.3.23 Команда разрешения/запрещения функции защиты паролем 

  
Рис. 2.3.24 Подтверждение разрешения функции защиты паролем 

 
Рис. 2.3.25 Подтверждение запрещения функции защиты паролем 
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Рис. 2.3.26 Задание пароля  

 Вывод текущего экрана на печать 

 Для печати текущего экрана выберите File > Print 

(Рис.2.3.27), или значок  на стандартной панели 
инструментов (Рис. 2.3.28), или используйте горячие 
клавиши Ctrl + P.  

 

Рис. 2.3.27 Выбор команды Print в меню File 



Глава 2.  Создание и редактирование экранов 

2-26    НПО "СТОИК ЛТД" т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

 

Рис. 2.3.28 Печать текущего экрана с помощью значка на стандартной панели инструментов  

 Предварительный просмотр печатаемых изображений 

 Выберите File > Print Preview (Рис. 2.3.29). Используйте 
эту функцию для предварительного просмотра страниц 
печати (Рис. 2.3.30).  

 

Рис. 2.3.29 Выбор команды Print Preview в меню File 
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Рис. 2.3.30 Предварительный просмотр страниц печати 

 Выбор принтера и установка параметров печати 

 Выберите File > Print Setup (Рис. 2.3.31). Используйте 
эту функцию для выбора принтера и установки его 
свойств, а также для выбора параметров листа, его 
ориентации, и др. параметров печати (Рис. 2.3.32).  

 

Рис. 2.3.31 Выбор команды Print Setup в меню File 
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Рис. 2.3.32 Диалоговое окно настройки печати 

 Быстрый доступ к файлам 

По умолчанию, внизу выпадающего меню File предоставлен лист из четырех последних 

открываемых файлов для быстрого доступа к ним (Рис. 2.3.33). Кликнув мышкой на 

названии данного файла, можно быстро его открыть. Эта функция аналогична команде 

Open, описание которой находится на странице 2-15. Если путь сохранения файла очень 

длинный, то будет отображаться многоточие “….”.  

 

Рис. 2.3.33 Последние открываемые файлы 
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 Закрытие программы ScrEdit 

Эта команда закрывает все открытые в данный момент 
прикладные программы, предварительно предложив их 
сохранить, и  полностью закрывает программу ScrEdit. 
Выберите File > Exit (Рис. 2.3.34). Если текущий файл не 
был предварительно сохранен, откроется диалоговое 
окно (Рис. 2.3.11) с предложением сохранить его на 
жесткий диск ПК. Нажав кнопку Cancel команда Exit 
будет отменена. При нажатии на кнопку Yes текущий 
файл будет сохранен и программа ScrEdit закрыта. 
Нажав кнопку No, текущий файл будет закрыт без 
сохранения. После нажатия кнопки Yes откроется 
диалоговое окно (Рис. 2.3.15) для выбора пути 
сохранения файла. 

 

Рис. 2.3.34 Выбор команды Exit в меню File 
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2.4 Меню Правка (Edit) 

 Элементы меню Edit 

Выпадающее меню выполнено в стиле Microsoft Office и имеет 17 основных элементов (Рис. 2.4.1). 

 
Рис. 2.4.1 Меню Edit 

 Undo - отменить последнее действие 

 Для отмены последнего действия выберите Edit > Undo (Рис.2.4.2) 

или значок  на стандартной панели инструментов (Рис.2.4.3), 
или используйте горячие клавиши Ctrl + Z. Все действия 
регистрируются в выходном окне.  

 

Рис. 2.4.2 Выбор команды Undo в строке меню 
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Рис. 2.4.3 Выбор команды Undo на стандартной панели инструментов 

 Redo – отмена действия команды "Undo" 

 Для отмены действия команды undo выберите  Edit > Redo 

(Рис.2.4.4) или значок  на стандартной панели инструментов 
(Рис.2.4.5), или используйте горячие клавиши Ctrl + Y. Все 
действия регистрируются в выходном окне.  

 

Рис. 2.4.4 Выбор команды Redo в строке меню 
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Рис. 2.4.5 Выбор команды Redo на стандартной панели инструментов 

 Cut – вырезать 

 Позволяет удалить выбранный компонент на редактируемом 
экране и сохранить его в буфере обмена для вставки в другое 

место. Выберите Edit > Cut (Рис. 2.4.6) или значок  на 
стандартной панели инструментов (Рис.2.4.7), или используйте 
горячие клавиши Ctrl + X.  

 

Рис. 2.4.6 Выбор команды Cut в строке меню 
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Рис. 2.4.7 Выбор команды Cut на стандартной панели инструментов 

 Copy - копировать 

 Позволяет скопировать выбранный компонент на редактируемом 
экране в буфер обмена для вставки в другое место.  

Выберите Edit > Copy (Рис. 2.4.8) или значок  на стандартной 
панели инструментов (Рис.2.4.9), или используйте горячие клавиши
Ctrl + C. 

 

Рис. 2.4.8 Выбор команды Copy в строке меню 
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Рис. 2.4.9 Выбор команды Copy на стандартной панели инструментов 

 Paste - вставить 

 Позволяет вставить компонент на редактируемой странице из 
буфера обмена. Выберите Edit > Paste (Рис. 2.4.10) или значок 

 на стандартной панели инструментов (Рис.2.4.11), или 
используйте горячие клавиши Ctrl + V.  

 

Рис. 2.4.10 Выбор команды Paste в строке меню 
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Рис. 2.4.11 Выбор команды Paste на стандартной панели инструментов 

 Delete - удалить 

 Позволяет удалить выбранный компонент. Выберите Edit > Delete 
(Рис. 2.4.12) или используйте клавишу Del на клавиатуре ПК. 

 

Рис. 2.4.12 Выбор команды Delete в строке меню 
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 Select All – выбрать все 

 Используется для выбора всех объектов на редактируемом экране. 
Выберите Edit > Select All (Рис. 2.4.13) или используйте горячие 
клавиши Ctrl + A. Когда выбраны все объекты, объект, 
расположенный в левом верхнем углу, будет выделен синей 
рамкой, как базовый элемент, Остальные объекты будут выделены 
белой рамкой. Базовый элемент используется для выравнивания и 
изменения размеров.  

 

Рис. 2.4.13 Выбор команды Select All в строке меню 

 Find content – найти содержимое 

 Используется для поиска различных компонентов прикладной 
программы по заданным критериям. Выберите Edit > Find content 
(Рис. 2.4.14) или используйте горячие клавиши Ctrl + F. Критериями 
поиска могут быть текст, адрес чтения, адрес записи или адрес 
памяти на текущем экране, или на всех экранах (Рис. 2-4-15). 
Результаты поиска будут отображены в выходном окне, "кликнув" по 
которым мышкой будет совершен переход к данному объекту на 
экране в ScrEdit.  
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Рис. 2.4.14 Выбор команды Find content в строке меню 

 

Элементы диалогового окна "Find" 

 
Find What В этом поле надо ввести текс или адреса, которые необходимо будет искать 
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Элементы диалогового окна "Find" 

 
Current Screen Поиск выполняется только на текущем экране. Результаты поиска 

с координатами расположения найденного объекта будут 
отображены в выходном окне (output window), дважды "кликнув" 
по которым мышкой будет совершен переход к данному объекту 
на экране в ScrEdit. (См. Рис. 2.4.15) 

Рис. 2.4.15 

Options 

All Screen Поиск выполняется на всех экранах ScrEdit. Результаты поиска с 
координатами расположения найденного объекта будут 
отображены в выходном окне (output window), дважды "кликнув" 
по которым мышкой будет совершен переход к соответствующему 
экрану и данному объекту на нем.  

Text Поиск объектов в прикладной программе по тексту (только 
введенному пользователем) 

Read Address Поиск объектов в прикладной программе по адресу чтения (read 
address) 

Write Address Поиск объектов в прикладной программе по адресу записи (write
address) 

Type 

All Address Поиск объектов в прикладной программе по адресу чтения и 
записи. 
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Элементы диалогового окна "Find" 

 
Флаги Если флаг “Match whole word only” поставлен, будет требоваться точное 

соответствие критериям поиска, например 1@M1, при поиске по адресу. Если флаг 
“Match whole word only” не поставлен, не будет требоваться полное соответствие 
критериям поиска, например, введя M1, при поиске по адресу, будут найдены все 
объекты, содержащие в адресе битовое устройство M1. 
Если флаг “Support Multi-Language Finding” поставлен, поиск будет осуществляться 
во всех языках при многоязыковой поддержке. Этот режим поиска может 
использоваться только при поиске текста (Text). 

 Replace - заменить 

 Используется для поиска различных компонентов прикладной 
программы по заданным критериям и замены их на другие. Команда
может применяться для замены текста, адрес чтения, адрес записи 
на текущем экране, или на всех экранах. Эта функция аналогична 
команде Find, только к функции поиска добавлена функция замена 
найденных компонентов на другие. 

Выберите Edit > Replace (Рис. 2.4.16) или используйте горячие 
клавиши Ctrl + R.  

 
Рис. 2.4.16 Выбор команды Replace в строке меню 
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Элементы диалогового окна "Replace" 

 
Find What В этом поле надо ввести текс или адрес, которые необходимо будет найти 

Replace With В этом поле надо ввести текс или адрес, на которые надо будет заменить 
компоненты, заданные в поле поиска (Find What) 

Current Screen Поиск и замена выполняются только на текущем экране.  Options 

All Screen Поиск и замена выполняются на всех экранах ScrEdit. 

Text Поиск объектов в прикладной программе по тексту (только 
введенному пользователем) 

Read Address Поиск объектов в прикладной программе по адресу чтения (read 
address) 

Type 

Write Address Поиск объектов в прикладной программе по адресу записи (write
address) 

Bit 

WORD 

Data Type 

DWORD 

Здесь выбирается тип заменяемых данных (бит, слово или двойное 
слово). Функция активна только при замене адресов. 

Replace 
Replace All 

При нажатии на кнопку "Replace" замену  каждого найденного элемента необходимо 
будет подтверждать или пропускать. Например, для замены адреса $157 на $158, 
введите $157 в поле "Find What", и $158 в поле "Replace With" и нажмите кнопку 
"Replace". После нахождения адреса появится окно ScrEdit в котором надо будет 
нажать кнопку "Yes" для подтверждения замены. 
При нажатии на кнопку "Replace All" будет автоматически произведена замена всех 
найденных элементов.  
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 Group – группировать объекты 

 Используется для группировки выбранных объектов на экране. 

Выберите Edit > Group (Рис. 2.4.17) или значок  на панели 
инструментов (Рис.2.4.18). Когда два или более объектов 
объединены в группу, они будут вести себя как один объект при 
перемещении, изменении размеров и т.д. 

 
Рис. 2.4.17 Выбор команды Group в строке меню 

 

Рис. 2.4.18 Выбор команды Group на панели инструментов 
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 Ungroup – разгруппировать объекты 

 Используется для разгруппировки выбранных объектов на экране. 

Выберите Edit > Ungroup (Рис. 2.4.19) или значок  на панели 
инструментов (Рис.2.4.20).  

 

Рис. 2.4.19 Выбор команды Ungroup в строке меню 

 

Рис. 2.4.20 Выбор команды Ungroup на панели инструментов 
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 Order – порядок размещения объектов 

 Функция используется для определения порядка наложения 
объектов друг на друга. Выберите Edit > Order (Рис. 2.4.21) и 

значки  в меню или на панели инструментов 
(Рис.2.4.22). 

  Bring to Top. Переместить выбранный объект в верхний 
слой, когда два или более объектов перекрыты. 

  Send to Bottom. Переместить выбранный объект в нижний 
слой, когда два или более объектов перекрыты. 

 Bring Forward. Переместить выбранный объект на одну 
позицию вперед. 

 Send Backward. Переместить выбранный объект на одну 
позицию назад. 

 

Рис. 2.4.21 Выбор команды Order в меню 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   2-45 

 
Рис. 2.4.22 Выбор команды Order на панели инструментов 

 Align – выравнивание объектов 

 Применяется для выравнивания расположения выбранных объектов 
на экране. Выберите Edit > Align (Рис. 2.4.23) и соответствующие 
значки в меню или на панели инструментов (Рис.2.4.24): 

 : выравнивание по левому краю объекта;  

 : выравнивание по правому краю объекта;  

 : выравнивание по верхнему краю объекта;  

 : выравнивание по нижнему краю объекта;   

 : вертикальное выравнивание по центру страницы; 

 : горизонтальное выравнивание по центру страницы; 

 : равномерное поперечное пространство; 

 : равномерное продольное пространство.  

Выполнение первых четырех команд возможно, когда выбрано два 
или более объектов, так как левое, правое, верхнее и нижние 
выравнивание производится относительно другого объекта 
(выбранного первым). Выравнивание по центру возможно при 
выборе одного или нескольких объектов, так как объекты 
выравниваются относительно центра страницы. Последние две 
команды выполняются только при выборе трех и более объектов. 
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Рис. 2.4.23 Выбор команды Align в меню 

 

Рис. 2.4.24 Выбор команды Align на панели инструментов 
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 Make Same Size – уровнять размеры объектов 

 Применяется для выравнивания размеров объектов. Выберите 
Edit > Make Same Size (Рис. 2.4.25) и соответствующие значки в 
меню или на панели инструментов (Рис.2.4.26). 

Эта функция возможна при выборе двух и более объектов. По 
объекту, выбранному первым, будут заданы размеры остальным 
выбранным объектам.  

 

 
Рис. 2.4.25 Выбор команды Make Same Size в меню 

 
Рис. 2.4.26 Выбор команды Same Size icons на панели инструментов 
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 Text Process – обработка текста 

 Используется для выравнивания, задания направления и импорта 
текста в ScrEdit. Выберите Edit > Text Process (Рис. 2.4.27) и 
соответствующие значки в меню или на панели инструментов. 

Флаг  разрешает соответствующую команду обработки текста. В 
диалоговом окне "Import Text" пользователь может выбрать текст из 
предварительно созданного текстового банка "Text Bank". Для 
создания и редактирования текстового банка выберите  Option > 
Text Bank. 

 
Рис. 2.4.27 Выбор команды Text Process в меню 

 
Рис. 2.4.28 Диалоговое окно "Import Text" 
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 Duplicate – дублирование объекта 

 Применяется для размножения объекта. Выберите в меню Edit > 
Duplicate, откроется диалоговое окно Рис. 2.4.29, в  котором 
пользователь может выбрать число копий объекта по вертикали и 
по горизонтали. Число копий должно быть не менее 2, так как 
копируемый объект так же входит в задаваемое здесь количество. 
Сняв соответствующий флажок, можно будет располагать копии 
только по вертикали или только по горизонтали.  

Spacing (pixels): Эта опция задает расстояние (в пикселях) между 
копиями объекта. 

Increase / Decrease Address: Эта опция используется для выбора 
последовательного увеличения или уменьшения адресов копий. 
Адрес может быть Word или Bit.  

X-direction / Y-direction: Эта опция задает направление увеличения 
адресов копий: по горизонтали (X-direction) или по вертикали (Y-
direction). 

Для примера см. Рис 2-4-30 и Рис. 2-4-31. 

 
Рис. 2.4.29 Диалоговое окно "Duplicate" 

 
Рис. 2.4.30 Пример 1 дублирования объектов  
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Рис. 2.4.31 Пример 2 дублирования объектов 
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2.5 Меню Вид (View) 

 Элементы меню View 

 
Рис. 2.5.1 Элементы меню View  

В меню View пользователь может решить, какие инструментальные панели и дополнительные окна 

должны отображаться в окне SrfEdit. Для выбора требуемых элементов надо пометить их символом 

. По умолчанию, окно свойств (Property table) и выходного результата (Output window) будут 

отображаться справой стороны экрана. Пользователь может перемещать инструментальные панели 

и дополнительные окна в другие места экрана (Рис. 2.5.2).  

 
Рис. 2.5.2 Дополнительные окна перемещены влево  

Окно свойств и 
выходного результата 

Панели инструментов 
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 Standard Toolbar – стандартная панель инструментов 

 
Рис. 2.5.1 Стандартная панель инструментов 

Значок Функция Описание 

 New Создать новую прикладную программу 

 Open Открыть старую прикладную программу 

 Save Сохранить текущую прикладную программу 

 Export Экспортировать прикладную программу в BMP-формат 

 Undo Отменить последнее действие (на шаг назад) 

 Redo Отменить действие команды Undo (на шаг вперед) 

 Cut Вырезать выделенные элементы 

 Copy Копировать выделенные элементы 

 Paste Вставить элементы, предварительно вырезанные или 
скопированные 

 Find Content Найти в прикладной программе текст, адреса чтения и записи 

 New Screen Создать новый экран в прикладной программе 

 Open Screen Открыть экран в прикладной программе 

 Print Печать прикладной программы 

 Help Показать версию ПО "Screen editor" 

 

 Status Bar – строка состояния 

 

Клавиша “Caps Lock”Статус Выбранный метод загрузки Текущая позиция курсора Модель HMI

Num Lock Scroll Lock  

Рис. 2.5.3 Строка состояния  

 Text Format Toolbar – панель инструментов форматирования текста  

 
Рис. 2.5.2 Текстовая панель 
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Значок Функция Описание 

 Font Size Выбор размера шрифта 

 Font Выбор типа шрифта 

 Aligns Left Выравнивание текста по левому краю 

 Center Horizontal Горизонтальное выравнивание текста по центру 

 Aligns Right Выравнивание текста по правому краю 

 Aligns Top Выравнивание текста по верхнему краю 

 Center Vertical Вертикальное выравнивание текста по центру 

 Aligns Bottom Выравнивание текста по нижнему краю 

 Text Color Выбор цвета шрифта 

 Bold Жирный шрифт 

 Italic Курсив 

 Underline Подчеркивание 

 Панель изображения 

 
Рис. 2.5.3 Панель изображения 

Значок Функция Описание 

 Пипетка Используется для выбора цвета на картинке, который должен 
быть заменен на прозрачный. 

 Функция 
синхронизации 

состояний объекта 

Когда эта функция активна (значок нажат), то команды  
растяжения, выравнивания  и изменения размеров будут 
действовать на картинки, относящиеся ко всем состояниям 
выбранного объекта.  

 
Растягивание во 
все стороны Растягивает (сужает) картинку до границ объекта. 

 
Масштабирование 

1: 1 Масштабирует картинку относительно оригинального размера  

 Фактический размер Изменение размеров картинки на фактические 

 
Левое 

выравнивание Выравнивание картинки по левому краю 

 
Горизонтальное 
выравнивание по 

центру  
Горизонтальное выравнивание картинки по центру 

 
Правое 

выравнивание Выравнивание картинки по правому краю 

 
Верхнее 

выравнивание Выравнивание картинки по верхнему краю 
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Значок Функция Описание 

 
Вертикальное 

выравнивание по 
центру 

Вертикальное выравнивание картинки по центру 

 
Нижнее 

выравнивание Выравнивание картинки по нижнему краю 

 Element Toolbar - Панель элементов (объектов) 

 
Рис. 2.5.4 Панель элементов 

Значок Название Выпадающее меню 

 
Button 

(кнопка) 

 

 
Meter 

(стрелочный 
измерительный 

прибор)  

 
Bar 

(столбчатая 
диаграмма)  

 
Pipe 

(трубопровод) 

 

 
Pie 

(круговая 
диаграмма) 

 

 
Indicator 

(индикатор) 
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Значок Название Выпадающее меню 

 Display 
(дисплей) 

 

 

 Movement 
(движущиеся 
объекты) 

 

 Input 
(объекты 
ввода)  

 
Curve 

(графики) 
  

 
History 

(объекты 
хронологии) 

  

 
Alarm 

(Объекты 
событий, 
аварийной 

сигнализации)  

 
Graphic 

(графические 
объекты) 

 

 
Keypad 

(виртуальная 
клавиатура)  

 Build / Layout Toolbar – панель сборки/компоновки 

Панель сборки 



Глава 2.  Создание и редактирование экранов 

2-56                        НПО "СТОИК ЛТД" т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

 
Рис. 2.5.5 Панель сборки 

Значок Функция Описание 

 
Текущее состояние 

объекта 
Отображается текст на выбранном 
объекте в выбранном состоянии 

 Состояние OFF/0 Переключает объект в состояние  ВЫКЛ/0

 Состояние ON/1 Переключает объект в состояние  ВКЛ/1 

 Индикация адресов 
чтения/записи 

Когда функция активна, будут 
отображаться адреса чтения/записи всех 

объектов на экране 

 Предыдущий экран Переход к предыдущему экрану 
прикладной программы 

 Следующий экран Переход к следующему экрану 
прикладной программы 

 Компиляция Компилирует прикладную программу 

 
Загрузка программы и 

рецептов 
Загружает прикладную программу и 

рецепты в HMI 

 Загрузка программы Загружает прикладную программу в HMI 

 On-line симуляция Режим отладки программы на PC с 
подключением PLC 

 Off-line симуляция Режим отладки программы на PC без 
подключения PLC 

Панель компоновки 

 
Рис. 2.5.6 Панель компоновки 

Значок Функция Описание 

 Группировать Используется для группировки выбранных 
объектов 

 Разгруппировать Используется для разгруппировки 
выбранных объектов 

 Поместить спереди Размещает выбранный объект перед 
остальными объектами 

 Поместить сзади Размещает выбранный объект за 
остальными объектами 

 Переместить вперед Перемещает выбранный объект на одну 
позицию вперед 

 Переместить назад Перемещает выбранный объект на одну 
позицию назад 

 Левое выравнивание Выравнивает объекты по левому краю 
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Значок Функция Описание 

 Правое выравнивание Выравнивает объекты по правому краю 

 Верхнее выравнивание Выравнивает объекты по верхнему краю 

 Нижнее выравнивание Выравнивает объекты по нижнему краю 

 
Вертикальное 

выравнивание по 
центру 

Вертикальное выравнивание по центру 
страницы 

 
Горизонтальное 
выравнивание по 

центру  

Горизонтальное выравнивание по центру 
страницы 

 
Равномерное 
поперечное 
пространство 

Выравнивает горизонтальное расстояние 
между выбранными объектами 

 
Равномерное 
продольное 
пространство 

Выравнивает вертикальное расстояние 
между выбранными объектами 

 Выравнивание ширины
Выравнивает горизонтальные размеры всех 
выбранных объектов относительно объекта, 
выбранного первым 

 Выравнивание высоты
Выравнивает вертикальные размеры всех 
выбранных объектов относительно объекта, 
выбранного первым 

 Выравнивание всех 
размеров 

Выравнивает горизонтальные и 
вертикальные размеры всех выбранных 
объектов относительно первого объекта 

 Zoom Toolbar - панель масштабирования 

 
Рис. 2.5.7 Панель масштабирования 

Значок Функция Описание 

 Масштаб Выбор масштаба рабочего экрана из списка: 25%, 50%, 75%, 100%, 
150%, 200% и 300% 

 Увеличить Увеличение рабочего экрана на один уровень:  150%  200%  
300%. 

 Уменьшить Уменьшение рабочего экрана на один уровень: 25%  50%  75%.

 1:1 Установка актуального масштаба рабочего экрана (100%). 

 Property Table – таблица свойств 

Окно свойств позволяет редактировать свойства выбранного элемента (объекта). См. главу 3 

для детального описания.  
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Рис. 2.5.4 Окно свойств 

 Output Window – окно выходного результата 

Здесь отображаются все действия и выходные сообщения при компиляции программы. Все 

обнаруженные при компиляции ошибки, будут отображаться в этом окне. Для перехода к 

объекту с ошибкой можно кликнуть мышкой по соответствующему сообщению в этом окне (См.  

Рис. 2.5.5, Рис. 2.5.6, Рис. 2.5.7 и Рис. 2.5.8). 

 
Рис. 2.5.5 Выходное окно 

 
Рис. 2.5.6 Вых. окно во время редактирования 

 
Рис. 2.5.7 Вывод результата 

 
Рис. 2.5.8 Вывод ошибок 

 Zoom In – увеличить рабочий экран 
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 Увеличение рабочего экрана в ScrEdit и всех объектов на один 
уровень. (См рис. 2.5.9, Рис. 2.5.10, Рис. 2.5.11 и Рис. 2.5.12) 

 
Рис. 2.5.9 Выбор команды Zoom In в меню 

 
Рис. 2.5.10 Выбор команды Zoom In на панели инструментов 
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Рис. 2.5.11 Уровень масштабирования = 100% (До  выполнения команды Zoom In) 

 
Рис. 2.5.12 Уровень масштабирования = 150% (После  выполнения команды Zoom In) 

 

 Zoom Out - уменьшить рабочий экран 

 Уменьшение рабочего экрана в ScrEdit и всех объектов на один 
уровень. (Refer to Рис. 2.5.13, Рис. 2.5.14 and Рис. 2.5.15) 
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Рис. 2.5.13 Выбор команды Zoom Out в меню 

 
Рис. 2.5.14 Выбор команды Zoom Out на панели инструментов 
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Рис. 2.5.15 Уровень масштабирования = 75% (После выполнения команды Zoom Out) 

 Actual Size – актуальный размер экрана 

 Установка актуального масштаба рабочего экрана (100%).  

Пользователь может выбирать масштаб рабочего экрана из списка: 25%, 50%, 75%, 100%, 150%, 

200% и 300% напрямую (Рис. 2.5.16) или используя значки  и .  

 

Рис. 2.5.16 Выбор масштаба из списка  

 

 Full Screen – полноэкранный режим 

 См. Рис. 2.5.17. Полноэкранный режим предоставляет 
максимальную рабочую область ScrEdit. В полноэкранном режиме 
будут скрыты все панели инструментов и дополнительные окна 
ScrEdit,  но будет показано количество строк макропрограммы.  
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Рис. 2.5.17 Полноэкранный режим (Нажмите клавишу "Esc" или левую кнопку мыши для выхода 

из полноэкранного режима) 

 I/O Screen – полноэкранный режим с индикацией адресов чтения/записи 

 См. Рис. 2.5.18. Функция вызывает полноэкранный режим, но помимо 
рабочей области и количества макрокоманд, будут отображаться 
адреса чтения/записи всех объектов на экране. 

 

Рис. 2.5.18 Режим I/O Screen (Нажмите клавишу "Esc" или левую кнопку мыши для выхода из 
полноэкранного режима) 
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 Grid Setup – установка сетки 

 Координатная сетка помогает пользователю выравнивать и 
размешать объекты проще и точнее. Расстояние между точками 
сетки (spacing) может быть задано в диалоговом окне (Рис. 2.5.19 и 

Рис. 2.5.20). 

Show Grid: Показывать сетку на экране. 

Snap to Grid: Привязывает объекты к координатной сетке. 

 

Рис. 2.5.19 Диалоговое окно "Gird Settings" 

 

Рис. 2.5.20 Координатная сетка на рабочем экране 
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2.6 Меню Объект (Element) 

 Компоненты меню Element 

 

Рис. 2.6.1 Элементы меню  

ПО "Screen editor" предоставляет 14 типов элементов (объектов) и множество стилей для каждого 

типа. Эти 14 типов включают в себя  кнопочные переключатели, стрелочные измерительные приборы, 

столбчатые диаграммы, трубопровод, круговые диаграммы, ламповые индикаторы, индикаторы 

данных, графические индикаторы, объекты ввода, графики, объекты хронологии, событий и 

аварийной индикации, объекты рисования, виртуальная клавиатура, и др. Пользователи могут 

выбрать требуемый элемент из выпадающего меню левой кнопкой мыши, и затем перетащить его на 

рабочую область экрана (см. Рис. 2.6.2 и Рис. 2.6.3).  

 
Рис. 2.6.2 Задание области размещения и размеров объекта  
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Рис. 2.6.3 Объект размещен на экране 

Пользователи могут также открыть контекстное меню объектов с помощью щелчка правой кнопки 

мыши на рабочей области экрана. Для подробного описания каждого объекта меню Element, 

обратитесь к Главе 3. 

 Создание нового объекта 

Пользователи могут выбрать требуемый элемент из выпадающего или контекстного меню левой 

кнопкой мыши, и затем, на рабочей области ScrEdit, задать необходимое место размещения и 

размеры объекта, обозначив верхний левый край объекта щелчком левой кнопки мыши и не 

отпуская её перемещать курсор вправо вниз. Затем необходимо установить свойства объекта (Р

ис. 2.6.4, Рис. 2.6.5, Рис. 2.6.6 и Рис. 2.6.7).  

 
Рис. 2.6.4 Вызов контекстного меню объектов с помощью щелчка правой кнопки мыши на 

рабочей области экрана 
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Рис. 2.6.5 Выбор объекта из выпадающего меню Elevment 

 

Рис. 2.6.6 Задание места размещения и размеров объекта  

Нажать левую кнопку мыши 
и не отпуская её 
перемещать курсор вправо 
вниз
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Рис. 2.6.7 Завершение создания объекта на экране 

 Перемещение объекта 

Пользователи могут перемещать объект в пределах рабочей области экрана с помощью мыши 

(действие производится аналогично другим приложениям Windows®). Когда курсор помещается 

над выбранным объектом, он принимает следующий вид: . Нажав и удерживая левую кнопку 

мыши, объект можно свободно перемещать (Рис. 2.6.8, Рис. 2.6.9 и Рис. 2.6.10).  

 

Рис. 2.6.8 Курсор мыши  над объектом  

Отпустить левую кнопку 
мыши и объект будет 
создан 
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Рис. 2.6.9 Перемещение объекта 

 

Рис. 2.6.10 Завершение перемещения объекта 

 Изменение ширины объекта 

Пользователи могут изменять ширину объекта с помощью мыши. Когда курсор помещается над 

левым или правым краем выбранного объекта, он принимает следующий вид: . Нажав и 

удерживая левую кнопку мыши, объект можно свободно удлинять или укорачивать. (Рис. 2.6.11, 

Рис. 2.6.12 и Рис. 2.6.13). 
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Рис. 2.6.11 Курсор мыши  над левым краем объекта 

 

Рис. 2.6.12 Удлинение объекта влево 
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Рис. 2.6.13 Завершение изменения ширины объекта 

 Изменение высоты объекта 

Пользователи могут изменять высоту объекта с помощью мыши. Когда курсор помещается над 

верхним или нижним краем выбранного объекта, он принимает следующий вид: . Нажав и 

удерживая левую кнопку мыши, объект можно свободно удлинять или укорачивать. (Рис. 2.6.14, 

Рис. 2.6.15 и Рис. 2.6.16). 

 

Рис. 2.6.14 Курсор мыши  над верхним краем объекта  
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Рис. 2.6.15 Удлинение объекта вверх 

 

Рис. 2.6.16 Завершение изменения высоты объекта 

 Одновременное изменение ширины и высоты объекта 

Пользователи могут одновременно изменять ширину и высоту объекта с помощью мыши. Когда 

курсор помещается над одним из углов выбранного объекта, он принимает следующий вид:  

или . Нажав и удерживая левую кнопку мыши, можно свободно изменять размеры объекта по 

горизонтали и вертикали одновременно (Рис. 2.6.17, Рис. 2.6.18 и Рис. 2.6.19). 
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Рис. 2.6.17 Курсор мыши  над верхним правым углом объекта  

 

Рис. 2.6.18 Увеличение размеров объекта вправо и вверх 
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Рис. 2.6.19 Завершение изменения размеров объекта 

 

 Создание текстовой надписи на объекте 

Пользователи могут размещать на выбранном объекте строчные символы из шрифтов 

Windows®, создавая на объекте текстовую надпись. Текст вводится в окне свойств в поле "Text". 

Когда курсор помещается над полем "Text" в окне свойств, он принимает следующий вид: , 

после чего можно вводить требуемый текст, используя клавиатуру ПК (Рис. 2.6.23 и Рис. 2.6.24). 

 

Рис. 2.6.23 Курсор мыши  над полем "Text" в окне свойств 
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Рис. 2.6.24 Введенная текстовая надпись на объекте 

 

 Одиночный клик правой клавишей мыши 

С помощью правой клавиши мыши пользователь может вызывать различные контекстные меню 

в зависимости от места расположения курсора (Рис. 2.6.25, Рис. 2.6.26 и Рис. 2.6.27).  

 

Рис. 2.6.25 Правый клик мыши на панели инструментов – меню выбора отображения панелей 
инструментов 
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Рис. 2.6.26 Правый клик мыши на рабочей области экрана – меню Element (выбор объектов) 

 

Рис. 2.6.27 Правый клик мыши на объекте – меню редактирования объекта 

 Таблица перекрестных ссылок 

 Когда создается и редактируется большое количество различных 
видов объектов, может происходить повторение используемых 
адресов. Чтобы избежать этой ситуации, в ScrEdit есть функция 
"cross reference table", с помощью которой пользователь может 
быстро и удобно отыскать повторяющиеся адреса чтения и записи 
всех объектов. Пользователь сможет увидеть адреса чтения и 
записи выбранного объекта во взаимосвязи с адресами других 
объектов, макрокоманд или системной областью управляющих 
регистров. Функция Cross Reference Table вызывается в меню View 
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(Рис. 2.6.28. Рис. 2.6.29). Первая строка таблицы перекрестных 
ссылок показывает  ссылку к выбранному объекту, а другие строки – 
ссылки к объектам, имеющим такие же адреса. Двойным кликом 
мыши по ссылке пользователь может автоматически перейти к 
объекту, на который указывает ссылка. 

 

Рис. 2.6.28 Выбор функции "Cross Reference Table" в строке меню 

 

Рис. 2.6.29 Диалоговое окно таблицы перекрестных ссылок 
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 Список детализации объектов 

 Когда выбрана функция Element Part List (Рис. 2.6.30), ScrEdit 
будет сортировать и классифицировать все элементы на текущем 
экране. Объекты сортируются по типу и классифицируются по 
следующим свойствам (Name, Describe, Write / Read address, Trigger 
address, Trigger type, Interlock и Level) в каждой таблице (Рис. 
2.6.31). Пользователь может редактировать свойства объектов как 
здесь, так и в таблице свойств объектов. 

 
Рис. 2.6.30 Выбор функции "Element Part List" в строке меню 

 
Рис. 2.6.31 Диалоговое окно списка детализации объектов 
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2.7 Меню Экран (Screen) 

 Элементы меню Screen 

В меню Screen представлены функции, относящиеся к текущему редактируемому экрану (Рис. 2.7.1). 

В этом разделе дано подробное описание элементов меню Screen. 

 
Рис. 2.7.1 Элементы меню Screen  

Если пользователь нажмет на значок Close (закрыть), как показано на Рис. 2.7.2, то текущий рабочий 

экран будет только скрыт, а не удален и не закрыт в отличие от Windows, где значок close закрывает 

текущее приложение и удаляет из памяти его данные, если они не были предварительно сохранены.  

 
Рис. 2.7.2 Закрытие текущего рабочего экрана 
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 New Screen – новый рабочий экран 

 Создание нового рабочего экрана прикладной программы. 
Выберите Screen > New Screen (Рис. 2.7.3) в строке меню 

или значок   на панели инструментов(Рис. 2.7.4), или 
используйте горячие клавиши Shift + N на клавиатуре ПК. 
Новый экран может быть переименован и перенумерован 
пользователем в открывшемся диалоговом окне (Рис. 2.7.5).

 
Рис. 2.7.3 Выбор команды "New Screen" в строке меню 

 
Рис. 2.7.4 Выбор команды "New Screen" на панели инструментов 
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Рис. 2.7.5 Диалоговое окно нового экрана 

 Open Screen – открыть рабочий экран 

 Позволяет открыть созданный ранее рабочий экран, т.е. 
сделать его текущим. Выберите Screen > Open Screen (Рис. 

2.7.6) в строке меню или значок  (Рис. 2.7.7) на панели 
инструментов, или используйте горячие клавиши Shift + O на 
клавиатуре ПК. После выбора команды "open screen", 
откроется диалоговое окно с перечнем всех созданных 
рабочих экранов в данной прикладной программе с 
возможностью их предварительного просмотра (Рис. 2.7.8).  

 
Рис. 2.7.6 Выбор команды "Open Screen" в строке меню 
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Рис. 2.7.7 Выбор команды "Open Screen" на панели инструментов 

 
Рис. 2.7.8 Диалоговое окно выбора рабочего экрана 
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 Screen Management – управление рабочими экранами 

 Когда выбрана функция Screen Management (Рис. 2.7.9, Ри
с. 2.7.10), пользователь может копировать, вставлять и 
вырезать рабочие экраны с помощью мыши, так же просто, 
как в проводнике (Windows Explorer) в Windows®. В 
диалоговом окне управления рабочими экранами 
пользователи могут получать доступ к командам управления 
экранами в контекстном меню, вызываемом правой кнопкой 
мыши (Рис. 2.7.11). Например выбрав в контекстном меню 
команду Edit Save Screen, пользователь может назначить 
любые из рабочих экранов, перетащив их мышкой в нижнюю 
область, в качестве скрин-сэйвера (screen saver) (Рис. 
2.7.12). Для настройки режима "screen saver", выберите 
Options > Configuration > Other.  

 
Рис. 2.7.9 Выбор команды "Screen Management" в строке меню 
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Рис. 2.7.10 Диалоговое окно управления рабочими экранами 

 
Рис. 2.7.11 Вызов контекстного меню правой кнопкой мыши над требуемым экраном  
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Рис. 2.7.12 Назначение рабочего экрана (3) для демонстрации его в режиме "screen saver" 

 Cut Screen – вырезать рабочий экран 

 Позволяет удалить текущий рабочий экран из прикладной 
программы и поместить его в буфер обмена Windows®. 
Выберите Screen > Cut Screen (Рис. 2.7.13), или 
используйте горячие клавиши Shift + T на клавиатуре ПК 
(Рис. 2.7.14). 

Примечание: Пользователи не смогут отменить 
действие команды "cut screen" с помощью команды 
"undo". Вернуть вырезанный экран можно только 
командой "paste" (вставить). 

 
Рис. 2.7.13 Выбор команды "Cut Screen" в строке меню 
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Рис. 2.7.14 Запрос на подтверждение вырезки экрана 

 Copy Screen – скопировать рабочий экран 

 Позволяет скопировать текущий рабочий экран в буфер 
обмена Windows®. Выберите Screen > Copy Screen (Рис. 
2.7.15) или используйте горячие клавиши Shift + C на 
клавиатуре ПК.  

 
Рис. 2.7.15 Выбор команды "Copy Screen" в строке меню 

 Paste Screen – вставить рабочий экран 

 Позволяет вставить, предварительно вырезанный или 
скопированный рабочий экран из буфера обмена в 
прикладную программу. Выберите Screen > Paste Screen 
(Рис. 2.7.16) или используйте горячие клавиши Shift + P на 
клавиатуре ПК. Все свойства и настройки вставленного 
экрана будут идентичны оригинальному экрану за 
исключением номера, который будет назначен 
автоматически.  
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Рис. 2.7.16 Выбор команды "Paste Screen" в строке меню 

 Delete Screen – удалить рабочий экран 

 Позволяет удалить текущий рабочий экран из прикладной 
программы. Выберите Screen > Delete Screen (Рис. 2.7.13) 
или используйте горячие клавиши Shift + D на клавиатуре 
ПК.  

Примечание: Пользователи не смогут отменить 
действие команды "Delete screen" с помощью команды 
"undo". Вернуть удаленный экран будет уже 
невозможно. Внимательно пользуйтесь этой командой! 

 
Рис. 2.7.17 Выбор команды "Delete Screen" в строке меню 
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Рис. 2.7.18 Запрос на подтверждение удаления экрана 

 

 Export – экспорт рабочего экрана 

 Позволяет экспортировать текущий рабочий экран в 
графический BMP-файл. Выберите Screen > Export (Рис. 

2.7.19) в строке меню или значок  (Рис. 2.7.20) на панели 
инструментов, или используйте горячие клавиши Shift + E на 
клавиатуре ПК.  

 
Рис. 2.7.19 Выбор команды "Export" в строке меню 
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Рис. 2.7.20 Выбор команды "Export" на панели инструментов 

 Import – импорт рабочего экрана 

 Позволяет импортировать графический файл в прикладную 
программу и поместить его в виде фонового изображения на 
рабочем экрана. Импортируемое изображение не будет 
являться объектом ScrEdit. Однако, остальные объекты могут 
являться base screen (основанием экрана) для других 
экранов. Возможно импортировать графические файлы 
следующих типов BMP, JPG,  GIF, и др. Выберите Screen > 
Import (Рис. 2.7.21) в строке меню или используйте горячие 
клавиши Shift + I на клавиатуре ПК. 

 
Рис. 2.7.21 Выбор команды "Import" в строке меню 

 Clear Import Data – удалить импортированные данные 
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 Данная команда позволяет удалить импортируемые данные  
с текущего рабочего экрана прикладной программы. 
Выберите Screen > Clear Import Data (Рис. 2.7.22) в строке 
меню. 

 
Рис. 2.7.22 Выбор команды "Clear Import Data" в строке меню 

 Screen Open Macro – макрос выполняемый при открытии рабочего экрана 

 Функция Screen Open Macro позволяет написать макрос, 
который будет однократно выполняться при каждом 
открытии данного рабочего экрана в прикладной программе 
HMI. (См. Главу 4 для подробного описания языка и методов 
макропрограммирования). 

 
Рис. 2.7.23 Выбор функции "Screen Open Marco" в строке меню 
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Рис. 2.7.24 Выбор функции "Screen Open Marco" в окне свойств 

 
Рис. 2.7.25 Окно написания и редактирования макросов 

 Screen Close Macro – макрос выполняемый при закрытии рабочего экрана 

 Функция Screen Close Macro позволяет написать макрос, 
который будет однократно выполняться при каждом закрытии 
данного рабочего экрана в прикладной программе HMI. (См. 
Главу 4 для подробного описания языка и методов 
макропрограммирования). 
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Рис. 2.7.26 Выбор функции "Screen Close Marco"  в строке меню 

 
Рис. 2.7.27 Выбор функции "Screen Close Marco" в окне свойств 

 Screen Cycle Macro – макрос циклически-выполняемый на данном рабочем экране 

 Функция Screen Cycle Macro позволяет написать макрос, 
который будет циклически выполняться, когда данный 
рабочий экран в прикладной программе HMI будет активен. 
Цикличность (периодичность) выполнения макроса 
пользователь может задавать. (См. Главу 4 для подробного 
описания языка и методов макропрограммирования). 
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Рис. 2.7.28 Выбор функции "Screen Cycle Marco" в строке меню 

 
Рис. 2.7.29 Выбор функции "Screen Cycle Marco" в окне свойств 

 Auxiliary Key – вспомогательная клавиатура 

 Каждая операторская панель серии DOP имеет 
вспомогательные кнопки, функции которых, могут быть 
различными для каждого рабочего экрана. Выберите Screen 
> Auxiliary Key (Рис. 2.7.30) в строке меню. После чего 
дополнительная клавиатура HMI (Рис. 2.7.31) будет показана 
на экране ScrEdit (Рис. 2.7.32). 
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Рис. 2.7.30 Выбор команды "Auxiliary Key" в строке меню 

 
Рис. 2.7.31 Вспомогательная клавиатура на панели HMI 
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Рис. 2.7.32 Вспомогательная клавиатура на экране ScrEdit 

В таблице 2.7.1, пользователь может информацию о количестве программируемых 

вспомогательных клавиш в каждой модели панелей DOP. 

Модель DOP  Число праммируемых клавиш 

DOP-A57BSTD 4 
DOP-A57GSTD 4 
DOP-A57CSTD 4 
DOP-A75CSTD 6 
DOP-A10TCTD 7 

DOP-AE57BSTD 4 
DOP-AE57GSTD 4 
DOP-AE57CSTD 4 
DOP-AE80THTD 6 
DOP-AE10THTD 7 

Табл. 2.7.1 Количество программируемых вспомогательных клавиш в моделях DOP 

 Screen Properties – свойства экрана 

 Выберите Screen > Screen Properties (Рис. 2.7.33) в строке 
меню или Screen Properties в окне свойств текущего экрана 
(Рис. 2.7.34). Откроется диалоговое окно "Screen Properties", 
описание элементов которого см. в таблице 2.7.2. 
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Рис. 2.7.33 Выбор команды "Screen Properties" в строке меню 

 
Рис. 2.7.34 Выбор команды "Screen Properties" в окне свойств 

 

Табл. 2.7.2 Настройка свойств рабочего экрана 

Функция Описание 

Screen Number 
(номер экрана) 

Номер рабочего экрана может быть в диапазоне 1~65535  и он не 
может повторяться. 
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Функция Описание 

General View 
Screen 
(Рабочий экран 
общего 
назначения) 
 

Рассматривается как рабочий экран общего назначения. Объекты. 
созданные на нем могут быть загружены в HMI после компиляции и 
будут отображаться на дисплее HMI. Объекты, предназначенные для
ввода данных, такие как Button, Input и Keypad могут нажиматься на 
дисплее HMI и использоваться для выполнения функции печати 
(print).  

Применение 
экрана 

Apply Print Screen 
(экран 
предназначен 
ный для вывода 
на печать) 

1. Рассматривается как экран, предназначенный для вывода его 
содержимого на печать с помощью функции "print screen". 
Объекты, созданные на этом экране, после компиляции могут 
быть распечатаны на принтере. Эта функция доступна только в 
панелях серии DOP-AE и разрешена только после установки 
принтера. Для установки принтера выберите Option > 
Configuration > Print (Рис. 2.7.35). 

2. Когда функция "Apply Print Screen" выбрана, редактируемая 
область должна быть отмасштабирована в соответствие с 
размером страницы печатаемых листов принтера. Распечатаны 
будут только объекты, попадающие в область печати принтера. С
помощью этой функции могут быть распечатаны все 
хронологические данные (history data или sampling records) 
редактируемых объектов. Эта функция обычно применяется для 
печати набранного текста.  

Настроить принтер можно, выбрав Option > Configuration > Print, как 
показано на Рис. 2.7.35. 

 
Рис. 2.7.35 Окно настройки параметров печати 
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Функция Описание 

Опция “This 
screen is a sub-
screen” 

Выбрав опцию “This screen is a sub-screen” данный рабочий экран 
можно сделать вспомогательным. Это возможно только когда 
выбрана опция "General View Screen".  

 
Рис. 2.7.36 Настройка вспомогательного экрана (Sub-screen) 

Screen Width 
(ширина экрана) 

Здесь устанавливается ширина вспомогательного рабочего экрана в 
пикселях. 

Screen Height 
(высота экрана) 

Здесь устанавливается высота вспомогательного рабочего экрана в 
пикселях. 

Sub-screen 
Position  
(местоположение 
экрана) 

Вспомогательные экран может отображаться по центру дисплея HMI 
или в другом месте, координаты которого по оси Х и  Y пользователь 

может указать с помощью мыши, нажав значок  (Рис. 2.7.37). 

 
Рис. 2.7.37 Позиция вспомогательного экрана 

Настройка 
вспомогат. 
экрана 
(Sub-
screen) 

Title Bar 
(заголовок 
экрана) 

Если опция  “Use Title Bar” выбрана, то на вспомогательном экране 
будет отображаться его название.  

Cycle Macro Delay Time 
(Время цикла выполнения 
макроса) 

Используется, когда выполняется макрос  "Screen Cycle Macro", для 
задания периодичности его выполнения  в диапазоне 100мс ~ 5с. 

Fast Refresh Rate 
(частота обновления экрана) 

Доступно три уровня скорости обновления экрана: High (высокая), 
Medium (средняя) и Low (низкая). С помощью этой функции 
некоторые объекты будут обновлять свое состояние немедленно при 
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Функция Описание 
открытии данного экрана. Однако, надо помнить, что только 4 
объекта на каждом экране могут обновлять свое состояние 
мгновенно.  

Setting 
(установочные 
параметры) 

Эта функция есть только в панелях серии DOP-AE и разрешена 
только после установки принтера. Для установки принтера выберите 
Option > Configuration > Print (Рис. 2.7.35). Когда эта функция 
разрешена, и кнопка печати рапорта (report list) создана на экране, и 
в качестве устройства вывода назначен принтер, HMI будет 
выводить на печать текст из заданной здесь области экрана. Помимо
печати на принтере, заданная здесь область экрана может быть 
сохранена на другой твердый носитель с помощью функции функция 
"screen-printing".   

Top-Left (левый 
верх) 

Hard Copy 
Region 
(область для 
твердой 
копии) 

Right-Bottom 
(правый низ) 

Здесь задается область рабочего экрана HMI для печати на 
принтере (а также для сохранения на другом носителе) в пикселях.  

Base Screen 
(основание 
рабочего 
экрана) 

Опция “Need a 
base screen” 

Любой из созданных экранов может быть использован в качестве 
основания для других рабочих экранов. Когда опция “Need a base 
screen” активна, в выпадающем меню можно выбрать рабочий экран, 
который будет использоваться в качестве фонового основания  
(располагаться за всеми объектами) на текущем рабочем экране. 
После компиляции и загрузки в HMI все объекты основания будут 
работать также как на основном рабочем экране, где они были 
созданы.  
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2.8 Меню Инструменты (Tools) 

 Элементы меню Tools 

 

Рис. 2.8.1 Элементы меню Tools 

 Compile – компилировать программу 

 Используется для компиляции редактируемой прикладной 
программы и трансляции её в формат HMI. Если прикладная 
программа является новой, то пользователю будет 
предложено сохранить её перед началом компиляции. Если 
прикладная программа старая или ранее проводилось её 
сохранение, то компиляция будет выполнена сразу. В 
течение выполнения компиляции, все текущие сообщения, 
включая ошибки, будут записываться в окно вывода 
результата (output field). Файл программы для загрузки в HMI 
будет создан, если в процессе компиляции не обнаружено 
ни одной ошибки. Для выполнения компиляции выберите 

Tools > Compile (Рис. 2.8.2) в строке меню или значок  

на панели инструментов (Рис. 2.8.3), или используйте 
горячие клавиши Ctrl + F7 на клавиатуре ПК. 

 
Рис. 2.8.2 Выбор команды "Compile" в строке меню 
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Рис. 2.8.3 Выбор команды "Compile" на панели инструментов 

 

Табл. 2.8.1 Поиск ошибок компилятором  

Пример поиска и устранения ошибок, найденных в процессе компиляции 

1. Создайте новую прикладную программу. 
2. Создайте два рабочих экрана. 
3. Создайте объект button (кнопка) на обоих экранах и не изменяйте никакие свойства объектов 

Рис. 2.8.4. 

Рис. 2.8.4 
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Пример поиска и устранения ошибок, найденных в процессе компиляции 

4. Запустите компиляцию программы значком , будут обнаружены в программе две ошибки, 
и описаны в окне вывода результата (Рис. 2.8.5). 

  
Рис. 2.8.5 В процессе компиляции найдены две ошибки  

 
5. Пользователь может кликнуть левой кнопкой мыши по сообщению об ошибке в окне 

результата, и будет совершен автоматический переход к объекту м котором обнаружена 
данная ошибка. 

 Download Screen & Recipe - загрузка программы и рецептов в HMI 

 Пользователь может  загрузить текущую прикладную 
программу и рецепты в HMI, выбрав Tools > Download 

Screen & Recipe (Рис. 2.8.6) в строке меню или значок  
на панели инструментов (Рис. 2.8.7), или использовав 
горячие клавиши Ctrl + F8. Если при этом PC и HMI не 
соединены между собой, то появиться сообщение об ошибке 
(Рис. 2.8.9 and Рис. 2.8.10). Пользователь может выбрать 
порт загрузки, выбрав Options > Configuration в строке меню. 
Загрузку можно осуществить по интерфейсам USB или RS-
232. 
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Рис. 2.8.6 Выбор команды "Download Screen & Recipe" в строке меню 

 

Рис. 2.8.7 Выбор команды "Download Screen & Recipe" на панели инструментов 
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Рис. 2.8.8 Процесс загрузки (прогресс от 0 до 100%) 

 
Рис. 2.8.9 Сообщение об ошибке открытия порта USB 

 
Рис. 2.8.10 Сообщение об ошибке связи по USB (к порту USB ничего не подключено) 

 Download Screen - загрузка программы в HMI 

 Пользователь может  загрузить текущую прикладную 
программу в HMI, выбрав Tools > Download Screen (Рис. 

2.8.11) в строке меню или значок  на панели 
инструментов (Рис. 2.8.12), или использовав горячие 
клавиши Ctrl + F9. В процессе загрузки будет показан её 
прогресс (Рис. 2.8.8). 
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Рис. 2.8.11 Выбор команды "Download Screen" в строке меню 

 

Рис. 2.8.12 Выбор команды "Download Screen" на панели инструментов 
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 On Line Simulation – симуляция в режиме онлайн 

 Режим используется для полной отладки программы на PC с 
подключением PLC. Контроллер должен быть подключен к 
компьютеру через один из портов (COM1 или COM2). Данная
функция (онлайн симуляция) не может быть выполнена без 
внешнего PLC. Выберите Tools > On Line Simulation (Рис. 

2.8.13) в строке меню или значок  на панели 
инструментов (Рис. 2.8.14), или используйте горячие 
клавиши Ctrl + F4. В режиме "On Line Simulation" на экране 
ПК будет воспроизводиться дисплей аналогичный HMI (Рис. 
2.8.15). 

 

Рис. 2.8.13 Выбор функции "On Line Simulation" в строке меню 
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Рис. 2.8.14 Выбор функции "On Line Simulation" на панели инструментов 

 

Рис. 2.8.15 Экран отладки программы в режиме онлайн 
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 Off Line Simulation - симуляция в режиме офлайн 

 Режим используется для частичной отладки программы 
(дизайн, компоновка, переходы, работа макросов и т.д.) на 
PC без подключения PLC. Данная функция (офлайн 
симуляция) выполняется без внешнего контроллера. 
Выберите Tools > Off Line Simulation (Рис. 2.8.16) в строке 

меню или значок   на панели инструментов (Рис. 2.8.17), 
или используйте горячие клавиши Ctrl + F5.  

 
Рис. 2.8.16 Выбор функции "Off Line Simulation" в строке меню 
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Рис. 2.8.17 Выбор функции "Off Line Simulation" на панели инструментов 

 

 Recipe - рецепт 

 Функция рецептуры – это метод, позволяющий вводить в 
ПЛК набор технологических параметров для определенного 
техпроцесса. Редактор рецептов позволяет создавать и 
модифицировать их в удобной табличной форме, после чего 
они могут быть загружены в ПЛК различных моделей и 
брэндов. Выберите Tools > Recipe (см. Рис. 2.8.18) в строке 
меню. Будет открыто диалоговое окно редактора рецептов 
Recipe Setup (Рис. 2.8.19), в котором можно создавать и 
редактировать рецепты. См. описание в табл. 2.8.2. 

 
Рис. 2.8.18 Выбор команды "Recipe" в строке меню 
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Рис. 2.8.19 Редактор рецептов 

На Рис. 2.8.19 создано 10 рецептов (групп параметров)  каждый из них по 10 слов. Пользователь 

может загрузить эти рецепты в память PLC, начиная с назначенного адреса (выделено красной 

рамкой на Рис. 2.8.19) и выбирать работу параметров каждого рецепта по команде с HMI. 

 Download Recipe - загрузка рецептов в HMI 

 Команда позволяет загрузить рецепты в память HMI без 
загрузки прикладной программы и тем самым уменьшить 
время загрузки. Выберите Tools > Download Recipe в строке 
меню и рецепты начнут копироваться в HMI. Файл рецептов 
имеет расширение .rcp (Рис. 2.8.20). 

 

Рис. 2.8.20 Загрузка рецептов 
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Table 2.8.2 Редактор рецептов 

Редактор рецептов 

 
Enable Recipe  
(активация 
рецептов) 

Когда выбрана опция “Enable Recipe”, функция рецептов будет разрешена. 
Если пользователь не активирует данную функцию, то он не сможет 
работать с рецептами, даже если имеет загруженные рецептурные данные. 

Address 
(адрес) 

Здесь должен быть введен адрес регистра в ПЛК, определив тем самым 
область памяти, куда будут скопированы рецептурные данные, начиная с 

данного адреса. Для ввода адреса можно использовать кнопку  для 
открытия диалогового окна (Рис. 2.8.21)  ввода адреса начального регистра. 

  

Рис. 2.8.21 Диалоговое окно ввода адреса начального регистра памяти 

рецептов 
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Редактор рецептов 

Length 
(длина рецепта) 

Используется для задания размера рецепта в словах (word). Длина рецепта 
должна быть больше 0, иначе появится следующее сообщение об ошибке 
(Рис. 2.8.22). 

 
Рис. 2.8.22 Ошибка: длина рецепта должна быть > 0 

Group 
(группа параметров) 

Используется для задания количества групп параметров или рецептов. 
Количество рецептов (групп параметров) должно быть больше 0, иначе 
появится следующее сообщение об ошибке (Рис. 2.8.23). 

 
Рис. 2.8.23 Ошибка: число рецептов должно быть > 0 

Input 
(ввод значений) 

После задания размера и количества рецептов, нажмите кнопку 

 для ввода и редактирования значений параметров рецептов. 
Размер памяти рецептов ограничен. Если в качестве места хранения данных
(Hold Data Place) выбрана память SRAM, то память рецептов составляет 
64K. Суммарный размер всех рецептов не должен превышать 64К. (длина 
рецепта x число рецептов должна быть меньше  64 X 1024). Если суммарный
размер рецептов превысит лимит, появится следующее сообщение об 
ошибке (Рис. 2.8.24). 

 
Рис. 2.8.24 Ошибка: размер рецептов должен быть < 64K 

Некоторые модели HMI, такие как DOP-AE80THTD и DOP-AE10THTD имеют 
встроенный USB-хост порт, к которому можно подключить USB-диск.  И если 
в качестве места хранения данных (Hold Data Place) выбрать память USB 
disk, то память рецептов может составлять 4Мб (4×1024×1024). Выбрать 
место хранения рецептов можно в меню Options > Configuration > 
Standard. См. Рис. 2.8.25 на следующей странице. 
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Редактор рецептов 

Hold Data Place 
(место хранения 
данных) 

 
Рис. 2.8.25 

Open 
(открыть) 

Пользователь может открыть в редакторе созданный ранее файл рецептов с

помощью кнопки . Файл рецептов не содержит в себе стартовый 
адрес рецептурных данных. Поэтому независимо от используемой модели 
PLC , пользователь может использовать данный рецептурный файл, введя 
соответствующий для подключенного ПЛК стартовый адрес регистров 
памяти рецептов. Файл рецептов так же можно открыть в  Windows® Excel. 

Save 
(сохранить) 

Пользователь может сохранить текущий рецепт в файл. Стартовый адрес 
рецептурных данных в файл сохранен не будет. Рецепты можно так же 
сохранить в файл формата Windows® Excel CSV.  

Reset 
(Сброс) При нажатии на кнопку , все введенные рецептурные данные 

будут удалены. 
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Редактор рецептов 

Clear 
(очистить) 

Все введенные значения параметров рецептов станут равны 0 (ноль), при 
выполнении данной функции. 

 
Рис. 2.8.26 

Print 
(печать) 

Все рецептурные данные на текущем экране будут выведены на печать. 

OK 
После ввода всех рецептурных данных нажмите кнопку  для их 
сохранения и выхода из редактора рецептов. Одновременно, ScrEdit будет 
проверять адекватность всех введенных рецептурных данных. Если введены 
не все рецептурные данные или введены не правильно, функция OK не 
будет выполнена полностью, появиться сообщение об ошибке. Для примера, 
на Рис. 2.8.27, показано сообщение об ошибке: не введен стартовый адрес 
рецептурных данных.  

 
Рис. 2.8.27 

Cancel 
(отмена) Команда  закроет редактор рецептов без сохранения 

введенных рецептурных данных. Внимательно пользуйтесь данной 
командой!  
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2.9 Меню Настройка (Options) 

 Элементы меню Options 

 

Рис. 2.9.1 Элементы меню Options  

 Configuration – конфигурация 

 Выберите Options > Configuration (Рис. 2.9.2). Откроется 
диалоговое окно, включающее пять закладок: Standard, 
Communication, Print, Default и Other, описание которых см. ниже. 

 

Рис. 2.9.2 Выбор команды "Configuration" в строке меню 
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Табл. 2.9.1 Закладка Standard (базовая конфигурация) 

Закладка "Standard (Общие)" в меню "Configuration" 

 
Application Name 
(Название прикладной 
программы) 

Также является именем файла прикладной программы. 

HMI Type (Тип панели 
оператора) 

В выпадающем меню надо выбрать конкретную модель панели DOP, для 
которой предназначена данная прикладная программа.  

 
Base Port Controller 
(Тип контроллера, 
подключенного к 
основному порту HMI) 

В выпадающем меню надо выбрать конкретную модель внешнего 
контроллера, с которым будет связана панель DOP. Контроллеры 
рассортированы по брендам компаний-производителей. 

 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   2-117 

Закладка "Standard (Общие)" в меню "Configuration" 

Hold Data Place (Место 
сохранения данных) 

Данные резервной памяти могут быть сохранены в одном из трех мест: 
SRAM, SMC или USB Disk, выбранном в данном выпадающем меню. 
Однако выбор USB-диска возможен не во всех моделях HMI, а только в 
тех, которые имеют USB host-порт (см. спецификацию). 

Password (Пароль) Здесь можно задать пароль для стартового уровня доступа. Всего можно 
задать пароли для 8 уровней доступа. Кроме этого, заданный здесь 
пароль будет служить для защиты файла данной прикладной программы. 

Starting Level  
(Стартовый уровень 
доступа) 

Здесь можно задать уровень доступа, который будет действовать при 
старте программы. Высший уровень доступа - 7,  а низший - 0. 

Address (Адрес 
начального регистра 
блока управления) 

Здесь можно задать адрес начального регистра системного блока 
управления. 

Size (Размер блока 
управления) 

Здесь можно задать число регистров системного блока управления. 
Максимально блок управления может состоять из 8 регистров (слов). 
(Например, при использовании функции много-языковой поддержки 
необходимо задать размер 8, так как эта функция находится в 8-м 
регистре блока управления). Описание системного блока управления 
находится в Главе 5.  
Примечание: Если размер блока управления задан 0, то работа блока 
управления будет заблокирована. 

Clear flag after done 
(флаг очистки после 
выполнения) 

Когда данный флаг установлен, значение регистра блока управления 
всегда будет устанавливаться в 0, после выполнения операции. 

Address (Адрес 
начального регистра 
блока состояния) 

Здесь можно задать адрес начального регистра системного блока 
состояния. Размер блока постоянный и составляет 6 слов. В каждом слове 
содержится различная информация о текущем состоянии HMI. Описание 
системного блока состояния находится в Главе 5. 

Optimize – 
Dynamic 
(динамическая 
оптимизация) 

Обеспечивается максимальная эффективность 
отображения чтения значений всех объектов при 
переключении между экранами. 
Имейте в виду, что когда выбрана эта функция, все 
объекты с адресами чтения могут кратковременно 
показывать неправильные значения. Отображение 
значений станет нормальным после завершения 
оптимизации. 

Optimize Type (тип 
оптимизации) 

Optimize – Static
(статическая 
оптимизация) 

Обеспечивается максимальная эффективность 
отображения чтения значений всех объектов на экране в 
течение сбора информации. 

Upload / Download 
(Порт загрузки 
программы) 

Здесь можно выбрать один из двух портов ПК: USB или COM-порт (т.е. RS-
232), который будет использоваться для загрузки программы в/из HMI. 

Startup Delay Time
(Время задержки при 
пуске программы) 

Здесь можно задать время задержки при пуске программы HMI для 
ожидания запуска внешнего контроллера (т.е. PLC). Диапазон: 0 ~ 255 сек. 

Clock Macro Delay
(Задержка цикличности 
выполнения макроса) 

Здесь можно задать интервал времени цикличности выполнения макроса 
(clock macro). Диапазон: 100 ~ 65535 мс.  
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Табл. 2.9.2 Закладка Communication (параметры коммуникации) 

Закладка "Communication (Связь)" в меню "Configuration" 

 
Add (добавить) Нажмите кнопку "Add" и в открывшемся окне напишите 

название связи и выберите тип контроллера: 

 
Максимальное количество различных связей определяется 
моделью панели DOP. Например, панели DOP-AE могут 
одновременно поддерживать до трех связей с различными 
моделями контроллеров, т.е. осуществлять связь 
одновременно по трем протоколам. 

Delete (удалить) Используется для удаления, созданной ранее связи с 
внешним контроллером (Одна прикладная программа должна 
иметь хотя бы связь с одним контроллером). 

Add / Delete / 
Modify (добавить, 
удалить, 
модифицировать 
связь с внешним 
контроллером) 

Modify 
(изменить) 

Используется для изменения типа контроллера. 

COM Port Используется для выбора COM-порта панели (COM1 или 
COM2) для связи с внешним контроллером. Порт COM3 есть 
только в моделях DOP-AE и AS. 

Controller Settings 
(параметры связи 
с контроллером) 

Password 
(пароль) 

Входной пароль, запрашиваемый перед началом связи с 
контроллером. 
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Закладка "Communication (Связь)" в меню "Configuration" 

Comm. Delay 
Time 

Используется для задания времени ожидания запуска 
внешнего контроллера (т.е. PLC). Диапазон: 0 ~ 255 мс. 

Timeout Время ожидания ответа от внешнего контроллера. Диапазон: 
100 ~ 65535мс.  

Retry Count 
(число 
повторов) 

Здесь можно задать число повторных попыток передачи 
коммуникационной команды во внешний контроллер при 
отсутствии от него ответа. Диапазон: 0 ~ 255 раз.  

Optimize 
(оптимизация) 

Эта опция используется для разрешения функции 
оптимизации, которая позволяет обеспечить максимальную 
эффективность отображения чтения значений всех объектов. 

Size Limit 
(ограничение 
размера) 

Эта опция доступна, только когда выбрана функция 
“Optimize – Static” в закладке "Standard". И используется, 
чтобы избежать медленного обновления экрана при чтении 
большого количества непрерывных адресов.  

Communication 
Interrupt 
(коммуникаци-
онные 
прерывания) 

Здесь можно задать число коммуникационных прерываний, по
достижению которого связь HMI с внешним контроллером 
будет остановлена. Эта функция используется, чтобы 
избежать вывода окна ошибки коммуникации на экран HMI 
при сбое коммуникации и повторных попытках наладить 
связь. Диапазон: 1 ~ 255 раз. 

HMI Station 
(адрес панели 
оператора) 

Используется для задания коммуникационного адреса данной 
панели оператора в сети. Диапазон: 0 ~ 255. 

PLC Station 
(адрес ПЛК) 

Используется для задания коммуникационного адреса PLC, 
который будет использоваться во всех объектах как адрес по 
умолчанию. Диапазон: 0 ~ 255.  

Interface 
(интерфейс) 

Используется для выбора коммуникационного интерфейса, по 
которому будет осуществляться связь с ПЛК. По умолчанию 
выбран интерфейс RS232. Доступно три интерфейса RS232, 
RS422 и RS485. 

Data Bits (Длина 
передаваемых 
данных) 

Можно выбрать 7-битный или 8-битный формат передачи 
данных. 

Stop Bits Можно выбрать формат с 1 или 2 стоповыми битами. 

Baud Rate 
(скорость 
передачи) 

Можно выбрать одну из следующих скоростей передачи 
данных: 4800, 9600, 19200, 38400, 57600 и 115200 бит/сек. Так 
же пользователь может задать значение скорости передачи 
напрямую, но максимальное значение не должно превышать 
187500.  

Parity  
(Паритет) 

Можно выбрать: None, Odd или Even.  
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Табл. 2.9.3 Закладка Print (параметры печати) 

Закладка "Print (Печать)" в меню "Configuration" 

 
Printer 
(Принтер) 

В выпадающем меню пользователь может выбрать одну из 
поддерживаемых моделей принтера. Для удобства принтеры 
разбиты по формам-производителям 

 
Paper 
(бумага) 

Используется для выбора размера листа бумаги для печати. 
Возможен выбор только листа формата A4 или Letter (8.5x11 
дюймов). 

Standard 
(Общие) 

Quality 
(качество 
печати) 

Предусмотрено только разрешение  72DPI. 

Margin (поля 
печати) 

Пользователь может задать размеры верхнего (top), нижнего (bottom), левого 
(left) и правого (right) полей на печатаемом листе в миллиметрах. 

Interface 
(интерфейс) 

Пользователь может выбрать интерфейс связи с принтером. Связь можно 
осуществить, подключив принтер к параллельному порту или USB.  

Auto Next Page Когда выбрана опция “Auto Next Page” принтер будет печатать следующую 
страницу автоматически. А если опция “Auto Next Page” не выбрана, печать 
будет непрерывной без разбивки на отдельные страницы. 

Direction 
(ориентация) 

Здесь можно выбрать вертикальную (книжную) или горизонтальную 
(альбомную) ориентацию печати. 
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Табл. 2.9.4 Закладка Default (значения по умолчанию) 

Закладка "Default (По умолчанию)" в меню "Configuration" 

 
Start up Screen 
(начальный экран) 

Здесь задается экран прикладной программы, который 
будет отображаться первым при включении HMI.  

Default Format 
(формат значений 
по умолчанию) 

Когда создается новый объект, его значение по 
умолчанию будет отображаться в формате, выбранном 
здесь. 

Default Screen 
Background (Цвет 
фона экранов по 
умолчанию) 

Когда создается новый экран, его цвет по умолчанию 
будет таким, как выбран здесь. 

System Error Display 
Time (время 
появления 
сообщения о 
системной ошибке) 

Используется для задания время появления сообщения о 
системной ошибке. Диапазон: 0 ~ 5 сек.  
Имейте в виду, что при значении 0, сообщение о 
системной ошибке на экране HMI появляться не будет.

System Default 
Value (системные 
значения по 
умолчанию) 

System Key Use 
Mode (Режим 
работы системной 
кнопки "SYS") 

Здесь можно выбрать один из трех режимов работы 
системной кнопки "SYS": Disable (кнопка отключена), 
Check Password (запрос пароля для входа в системное 
меню панели) и Unchecked Password (вход в системное 
меню панели без запроса пароля). 
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Закладка "Default (По умолчанию)" в меню "Configuration" 

Element Font Size 
(размер шрифта) 

Используется для задания размера шрифта, который 
будет использоваться по умолчанию для всех вновь 
создаваемых объектов.  

Element Font Name 
(тип шрифта) 

Используется для задания типа шрифта, который будет 
использоваться по умолчанию для всех вновь 
создаваемых объектов.  

Element Font Color 
(цвет шрифта) 

Используется для задания цвета шрифта, который будет 
использоваться по умолчанию для всех вновь 
создаваемых объектов.  

Element Default 
Value (значения по 
умолчанию 
объектов) 
 

Twinkle Time (время 
мигания текста) 

Используется для задания периода мерцания текста, 
который будет использоваться по умолчанию для всех 
вновь создаваемых объектов. 
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Табл. 2.9.5 Закладка Other (другие настройки) 

Закладка "Other (Прочее)" в меню "Configuration" 

 
В элементе "Screen Management" на стр. 2-66, описано как с помощью 
перетаскивания мышью задать экраны, которые будут использоваться в 
качестве заставки в режиме скрин-сейвера (т.е. хранителя экрана). 

Enable Save Screen 
(разрешить режим 
заставки) 

Эта опция должна быть выбрана, когда пользователь 
хочет использовать функцию Edit Save Screen в 
элементе Screen Management. Если эта опция не 
выбрана, экранная заставка отображаться не будет. 

Save Screen  
(хранитель экрана) 

Read Controller Address 
(читать адрес 
контроллера) 

1. Эта опция доступна, если режим заставки 
разрешен. Когда значение = 0, то, что режим 
заставки запрещен. Если значение не равно 0, то, 
что режим заставки разрешен. Когда пользователь 
нажмет на экран HMI, панель выйдет из режима 
заставки.  
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Закладка "Other (Прочее)" в меню "Configuration" 

Read Controller Address 2. Если эта опция не выбрана, режим заставки будет 
разрешен автоматически по достижении времени 
Screen Saver Time. Когда пользователь нажмет на 
экран HMI, панель выйдет из режима заставки.  

 
Interval Time At Two 
Save Screen 

Используется для задания интервала времени 
переключения между различными заставками . 
Диапазон: 1 ~ 255 сек.  

Ending of Save Screen 
Mode (окончание 
режима заставки) 

1. Return Original: Возврат к экрану, 
предшествующему началу режима заставки. 

2. Indicate Screen: Возврат к назначенному экрану.  

New (новый язык) Нажмите кнопку "New", откроется следующее 
диалоговое окно: 

 
Здесь пользователь может ввести название нового 
языка и соответствующее ему значение в диапазоне 0 
~ 255. Название будет использоваться в текстовом 
редакторе, а значение – для выбора данного языка с 

помощью контрольного регистра. Нажав на кнопку  
можно выбрать цвет флага языковой закладки.  

Enable/Disable 
(разрешить/запретить) 

В прикладной программе экраны могут иметь 
многоязыковый интерфейс, однако с помощью данной 
кнопки пользователь может разрешить или запретить 
поддержку каких-либо языков в HMI при загрузке в неё 
программы.  

Remove (Удалить) Кнопкой "Remove" можно удалить какой-либо язык, 
созданный ранее из прикладной программы. Однако в 
программе должен остаться хотя бы один язык. 

Multi-Language 
(многоязыковая 
поддержка) 

Modify (изменить) Этой кнопкой вызывается диалоговое окно, в котором
пользователь может изменить название языка и
соответствующее ему значение. 
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Закладка "Other (Прочее)" в меню "Configuration" 

Enable Edit Multi-
Language User Interface

Использую эту опцию можно разрешить 
многоязыковый интерфейс, т.е. в окне свойств 
пользователь сможет видеть закладки выбора языков, 
как показано на рис.:  

 
 

Как использовать функцию многоязыковой поддержки  

Пример:  

Создадим экран, все объекты которого должны иметь возможность отображать надписи на одном из 

трех языков: английском, русском и китайском - выбор, которого должен  осуществляться кнопочным 

переключателем типа “Increment”. 

1. Создадим новую прикладную программу.  

Выберем модель HMI: “DOP-A57CSTD 256 Colors”. 

 

2. Создадим на экране две кнопки “Set” и “Increment”. 
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Создадим блок управления  (Options > Configuration > Control Block) с начальным адресом $200 и 

длиной 8 слов. 

 

3. Настроим параметры многоязыковой поддержки 

Добавим три языка:  “English”, “Русский” и “Simplified Chinese” со значениями 0, 1 и 2.  

 

 

4. В окне свойств объекта “Set” будут отображаться три текстовые закладки. 
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 Сделайте активной закладку "English" и введите текст“Alarm” на английском языке. 

 Сделайте активной закладку "Рус" и введите текст “Тревога” на русском языке. 

 Сделайте активной закладку “Simplified Chinese” и введите текст “警示燈” на китайском языке 

5. В свойствах кнопки “Increment” установите адрес записи (write address), как internal memory $207.  
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6. В макросе “Before Execute Macro” введите следующую макрокоманду: $207=$207%3. 

 

7. Выполните компиляцию программы с помощью команды Compile и запустите офф-лайн 

симуляцию (Off Line Simulation). При каждом нажатии на кнопку “Increment” текст кнопки “Set” 

будет отображаться на разных языках. 
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 Alarm Setup – настройка аварийной сигнализации 

 Выберите Options > Alarm Setup (Рис. 2.9.3). Настройка 
аварийной сигнализации должна быть выполнена при 
использовании объектов "Alarm". HMI будет выполнять alarm-
функции автоматически в соответствии с заданными здесь 
установками. Когда определенные условия будут выполнены 
(соответствующие биты в состоянии ON или OFF), на дисплее HMI 
будут отображаться заданные здесь соответствующие им 
сообщения. В диалоговом окне (Рис. 2.9.4) можно создавать 
сообщения, удалять, изменять, импортировать и экспортировать 
их. Подробнее о настройке сигнальных сообщений см. в табл. 2.9.6 
на следующей странице и в главе 3. 

 

Рис. 2.9.3 Выбор команды "Alarm Setup" в строке меню. 
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Рис. 2.9.4 Диалоговое окно настройки аварийной сигнализации 

Таблица 2.9.6 Настройка аварийной сигнализации 

Диалоговое окно "Alarm Setup" 

Address of 
Alarm Block 
(адрес блока 
сигнализации) 

Здесь должен быть задан начальный адрес блока регистров (или 
битовых операндов), являющихся условиями вывода тревожных 
сообщений. Предусмотрено 512 сигнальных сообщений, 32 слова. 

Scan Time 
(second) 

Используется для задания периода сканирования условиями 
вывода тревожных сообщений HMI. Единицы измерения - секунды. 

Number of 
Records in 
History 
(число записей 
в журнале 
аварий) 

Используется для задания числа записей в журнале аварий. Когда 
число записей в журнале превысит заданное здесь число, самые 
ранние записи будут удаляться, а новые записываться на 
освободившееся места. Например, если число записей = 100, то 
при превышении ста записей в журнале, первая запись будет 
удалена и вторая запись станет первой, третья запись станет 
второй…и 100-я станет 99-й. Следовательно, новая запись (101-я) 
станет 100-й. 

Alarm Setting 
(установка 
сигнализации) 

Non-volatile 
(энергонезави 
симая память) 

Использование этой опции разрешает сохранять записи в 
энергонезависимой памяти (SRAM). Объем памяти для хранения 
аварийных сообщений в DOP-A 8Mбайт, а в DOP-AE 16Mбайт. 
(Данные в SRAM хранятся с помощью батарейки.) (В некоторых 
моделях HMI, данные можно сохранять на USB-Disk или SMC-card. 
Объем памяти аварийных событий в этом случае будет 
определяться объемом памяти USB Disk или SMC-card.) 
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Диалоговое окно "Alarm Setup" 

Двойным кликом мыши по строке тревожного сообщения 
вызывается диалоговое окно редактирования свойств аварийной 
сигнализации.  
(Имейте в виду, что для сообщений аварийной сигнализации 
также действительна функция многоязыковой поддержки, и 
сообщения могут быть записаны на нескольких языках.) 

 
Диалоговое окно редактирования свойств аварийной сигнализации:

 
Message  Ввод текстового сообщения, которое будет 

отображаться при возникновении определенного 
события. 

Color  Цвет отображения текстового сообщения. 

Trigger 
Mode 

Определение состояния бита (1 или 0),  при котором 
будет выводиться данное сообщение. 

Alarm Property 
Setup 
(установка 
свойств 
аварийной 
сигнализации) 

Screen Выбор экрана, который будет открыт при возникновении 
определенного события.  

Delete Удаление сообщения аварийной сигнализации. 

Modify Изменение сообщения аварийной сигнализации. Эту функцию так 
же можно вызвать двойным кликом мыши по тексту сообщения. 

Import Импорт файла аварийных сообщений в текущую таблицу. 

Export Экспорт содержимого таблицы аварийных сообщений в файл. 

 

Close Выход из диалогового окна настройки аварийной сигнализации. 

Enable Разрешение отображения аварийных сообщений бегущей строкой в 
определенной части экрана. 

Position Определение позиции на экране для бегущей строки. Можно 
выбрать верх (Top) или низ (Bottom) экрана. 

Alarm Moving 
Sign  
(Бегущая 
строка 
аварийной 
сигнализации) Direction Left Направление перемещения сообщений на бегущей строке:

справа налево. 
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Диалоговое окно "Alarm Setup" 

Right Направление перемещения сообщений на бегущей строке:
слева направо. 

Up Направление перемещения сообщений на бегущей строке:
снизу вверх. 

Down Направление перемещения сообщений на бегущей строке:
сверху вниз. 

Moving points Выбирается число точек (пикселей) на которое будет 
осуществляться перемещение сообщение через каждый интервал 
времени. Диапазон: 1 ~ 50 точек. 

Interval (ms) Задается интервал времени, через который будет происходить 
сдвиг сообщения. Диапазон: 50 ~ 3000 мс. 

Background 
Color 

Цвет фона бегущей строки аварийных сообщений. 

 

 History Setup – настройка архива данных 

 Настройка архива данных необходима для  объектов "Sampling". 
Для подробного описания см. главу 3. 

 

Рис. 2.9.5 Выбор команды "History Setup" в строке меню 
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Таблица 2.9.7 Настройка архива данных 

Диалоговое окно "History Setup" 

 
Нажатием на кнопку "Append" можно создать новый архив данных. Максимально может 
быть создано 12 архивов данных. После нажатия на кнопку "Append", откроется 
диалоговое окно свойств (Buffer Properties): 

 
Read Address Стартовый адрес регистров данных для выборки в архив. 

Data Length 
(Word) 

Количество регистров (слов), данные из которых будут записываться в 
архив. Диапазон: 1 ~ 13 слов, расположенных друг за другом, т.е. в 
один архив могут записываться данные максимально из 13-ти 
последовательных словных регистров. 

Append 
(добавить) 

Cycle (ms) Время цикла выборки данных из регистров (определяется период 
считывания). Если установлен флаг команды записи данных от PLC, 
эта опция будет не активна. Диапазон: 0 ~ 86400000 мс. 
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Диалоговое окно "History Setup" 

Sample Number 
(объем 
выборки) 

Эта опция используется совместно с опцией "Auto Stop". Если флаг 
"Auto Stop" установлен, HMI будет останавливать запись данных в 
архив, когда число выборок достигнет заданного здесь числа. Если 
флаг "Auto Stop" не установлен, запись данных будет продолжаться 
даже при превышении заданного объема выборки, при этом данные, 
записанные первыми будут удаляться, а новые записываться на 
освободившееся места. Например, если объем выборки = 100, то при 
превышении ста выборок в архиве, данные первой выборки будут 
удалены и вторая выборка станет первой, третья выборка станет 
второй…и 100-я станет 99-й. Следовательно, новая выборка (101-я) 
станет 100-й. 

Stamp Time and 
Date 

Эта опция определяет: будет ли фиксироваться в архиве время и дата 
каждой выборки. 

Auto Stop Если флаг "Auto Stop" установлен, HMI будет останавливать запись 
данных в архив, когда число выборок достигнет заданного объема 
выборки 

Non-Volatile Использование этой опции разрешает сохранять архив данных в 
энергонезависимой памяти (SRAM). Объем памяти для хранения 
архива данных в DOP-A 240Mбайт, а в DOP-AE 360Mбайт. (Данные в 
SRAM хранятся с помощью батарейки.) (В некоторых моделях HMI, 
данные можно сохранять на USB-Disk или SMC-card. Объем памяти 
архива данных в этом случае будет определяться объемом памяти 
USB Disk или SMC-card.) 

Trigger Задание режима записи данных в архив: Timer (через заданные 
промежутки времени) или PLC (по команде от ПЛК). 

OK / Cancel Нажмите кнопку "OK" для сохранения настроек и выхода из окна 
свойств. Нажмите кнопку "Cancel" для выхода из окна свойств без 
сохранения текущих настроек.  

Delete Нажатием кнопки "Delete" можно удалить выбранный архив данных.  

Modify Нажатием кнопки "Modify" можно отредактировать выбранный архив данных.  

 

 Tag Table – таблица тегов 

 Используется для замены оригинального адреса на определенное 
пользователем слово или число. Например, если пользователь 
хочет заменить адрес 1@Y0 выхода PLC на слово “OS”, просто 
надо назначить в таблице тегов "Tag Table" данную ассоциацию.  
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Рис. 2.9.6 Выбор команды "Tag Table" в строке меню 

 

Таблица 2.9.8 Установочные параметры таблицы тегов 

Диалоговое окно "Tag Table" 

 
Open Открыть файл с тегами в данном окне. 

Save Сохранить текущие установки таблицы тегов в файл. 
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Диалоговое окно "Tag Table" 

Add Предварительно выберите тип операндов памяти для тегов: Internal Memory (внутренняя 
память HMI) или Base Port (внешняя память – память подключенного ПЛК). Затем 
нажмите кнопку "Add" для создания и назначения нового тега. 

 
Delete нажатием на кнопку " Delete", выбранная строка таблицы тегов будет удалена. 

OK Нажмите кнопку "OK" для сохранения настроек и выхода из окна "Tag Table". 

Cancel Нажмите кнопку "Cancel" для выхода из окна "Tag Table" без сохранения текущих 
настроек.   

 Print Typesetting – набор печати 

 Предоставляет эффективную функцию компоновки печати. См. 
ниже приведенный пример. 

 

Рис. 2.9.7 Выбор команды "Print Typesetting" в строке меню 
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Как использовать функцию "Print Typesetting"? 

Пример:  

Установка принтера и страницы печати 

1. Функция "Print Typesetting" возможна только в панелях серии DOP-AE. 

 

2. Выберите принтер 

В меню File > New в открывшемся диалоговом окне "New Application" в области “Printer” из 

выпадающего меню выберите модель принтера. Или в меню Options > Configuration > Print 

выберите принтер.  

 

3. Сконфигурируйте параметры печати 

Выберите Options > Configuration > Print. Задайте требуемые параметры печати. 
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Создание печатного отчета  

Шаг 1:   

Создайте новый рабочий экран (Выберите Screen > New Screen) и в свойствах экрана (Screen > 

Screen Properties) установите опцию Apply Print Screen. Описание функции "Apply Print Screen" см. в 

табл. 2.7.2 на стр. 2-80. 
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Шаг 2: 

Создайте на рабочем экране объекты, которые надо вывести на печать. Например, если 

пользователь хочет распечатать график архивных данных (Historical Trend Graph) и 

двухкоординатный график (X-Y Chart), необходимо создать соответствующие объекты (выберите 

Element > Sampling > Historical Trend Graph и Element > Curve > X-Y Chart). В таблицах свойств 

созданных элементов установите необходимые параметры. (См. описание объектов в главе 3). 

 

Шаг 3: 

В окне свойств объектов пользователь может выбрать “Yes” или “No” использования функции “Print 

Successive Data” – нужна или нет последовательная печать данных. Если выбрано “Yes”, то все 

записи архива данных будут полностью распечатаны.  

Historical Trend 
Graph (график 
архивных данных) 

X-Y Chart (2-х 
координатный 
график) 
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Компоновка вывода на печать  

Шаг 1:  

Выберите Options > Print Typesetting. Перетащите мышкой экраны, предназначенные для печати в 

правую область окна. Если “General View Screen” (окно общего назначения) переместить в правую 

область, оно станет окном, предназначенным для печати “Apply Print Screen” (в свойствах окна) 

автоматически. 
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Шаг 2: 

Создайте кнопку “Report List” на окне общего назначения “General View Screen”. Используйте эту 

кнопку “Report List” для разрешения функции печати. 

 

Шаг 3: 

В свойствах кнопки “Report List” выберите опцию "Report Device", в которой можно выбрать одно из 

устройств вывода: SMC, USB Disk, или Printer. Имейте в виду, что при выборе SMC или USB Disk, 

данные будут только сохранены на SMC или USB Disk и не будут распечатаны на принтере.  
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Как использовать функцию получения твердой копии? 

Функция получения твердой копии (Hard Copy) возможна только при установке флага “General View 

Screen”. Если HMI обнаружит уже использование функции “Print Typesetting” для редактируемого 

экрана, функция “Hard Copy” будет не доступна.  

Шаг 1: Задайте область твердой копии (Hard Copy Region) в окне свойств экрана. 

 

Шаг 2: Разрешите функцию печати.  

Создайте кнопку “Report List” на окне общего назначения “General View Screen” и используйте её для 

вывода на печать аналогично функции “Print Typesetting”. 
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 Picture Bank – банк изображений 

 Пользователи могут применять данную функцию для импорта 
различных изображений в специальное хранилище для 
последующего использования их в прикладной программе. 
Выберите Options > Picture Bank для создания банка 
изображений. 

 

Рис. 2.9.8 Выбор команды "Picture Bank" в строке меню 

 

Рис. 2.9.9 Банк изображений 
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Таблица 2.9.9 Настройка банка изображений 

Диалоговое окно "Picture Bank Browse" 

 
Выберите опцию "Picture Bank" для просмотра всех картинок сохраненных в банке изображений. 
Когда выбрана одна из картинок, она будет отображаться в окне предварительного просмотра. 
Двойным кликом мыши по выбранной картинке, она будет отображена в полную величину. 

 New Picture Bank  Создание нового банка изображений. После нажатия на значок , 
появится окно для ввода имени нового банка. 

 

 Open Picture Bank Открытие файла с банком изображений (*.pib файл). 

 Uninstall Picture Bank 
Удаление выбранного банка изображений. Банк будет перемещен в 
корзину. 

 Save Сохранение изменений в банке изображений. 
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Диалоговое окно "Picture Bank Browse" 

Import Picture Позволяет импортировать картинки в назначенный банк. 

 
В банк изображений можно помещать картинки форматов BMP, JPG, 
GIF(static) и ICON. Пользователь может преобразовать цветовую 
гамму изображений для ускорения компиляции или выбрать опцию 
“No changed”, что бы оставить оригинальные цвета. 

 Export Экспорт изображений в BMP-формат из банка изображений.  

 Delete Удаление картинок из банка.  

 Inverse Инверсия цветов. Получение 
негатива. 

 

 Grayscale Преобразование полноцветного 
изображение в  256 оттенков 
серого.  

 Horizontal Mirror  Эффект горизонтального 
отражения.  

 

 Vertical Mirror Эффект вертикального отражения.
 

Vertical mirror effect 

Inverse effect 

Horizontal mirror effect 

Grayscale effect 



Глава 2.  Создание и редактирование экранов 

2-146               НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru  

Диалоговое окно "Picture Bank Browse" 

Shortcut Menu 
 

Пользователь может правой кнопкой мыши контекстное меню, в 
котором содержится список команд относящихся к банку 
изображений, что позволяет более быстро и эффективно работать с 
изображениями. 

 

 Text Bank – банк текста 

 Ввод общих или часто-используемых текстовых элементов и 
терминов в текстовый банк. С помощью данной функции 
пользователь сможет более быстро вводить текстовые элементы 
в прикладную программу. 

 

Рис. 2.9.10 Выбор команды "Text Bank" в строке меню 
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Таблица 2.9.10 Настройка текстового банка 

Диалоговое окно "Text Bank" 

 
Append Кнопка "Append" позволяет добавить новый текст в банк. Текстовый банк позволяет 

использовать функцию многоязыковой поддержки, т.е. можно вводить текст и термины 
одновременно на различных языках и сохранять их в текстовом банке. Шрифт для 
различных языков может также быть задан одновременно.  

Delete Кнопка "Delete" удаляет текст или термин из банка.  

Open Кнопка "Open" позволяет открыть и импортировать текст в банк из файла. 

Save Кнопка "Save" позволяет экспортировать и сохранить текст из банка в файл. 

Close Кнопка "Close" закрывает данное диалоговое окно. 
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 Sub macro – подпрограммы 

 С помощью данной опции можно создавать и редактировать 
подпрограммы, которые могут быть вызваны из других макро-
программ. Для подробного описания макрофункций обратитесь к 
главе 4.  

 

Рис. 2.9.11 Выбор команды "Submacro" в строке меню 

 

Рис. 2.9.12 Диалоговое окно "Submacro" 
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 Initial Macro – начальная макро-программа 

 С помощью данной опции можно создать и редактировать 
начальную макропрограмму, которая будет автоматически 
выполнена сразу же после подачи на HMI напряжения питания. 
Для подробного описания макрофункций обратитесь к главе 4. 

 

Рис. 2.9.13 Выбор команды "Initial Macro" в строке меню 

 

 Background Macro - фоновая макропрограмма 

 С помощью данной опции можно создать и редактировать 
фоновую макропрограмму, которая будет постоянно выполняться 
в течение всего времени пока на HMI подано напряжения питания. 
Для подробного описания макрофункций обратитесь к главе 4. 
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Рис. 2.9.14 Выбор команды "Background Macro" в строке меню 

 

 Clock Macro – тактовая макропрограмма 

 С помощью данной опции можно создать и редактировать 
тактовую макропрограмму, которая будет периодически 
выполняться в течение всего времени пока на HMI подано 
напряжения питания через заданные промежутки времени. Для 
подробного описания макрофункций обратитесь к главе 4. 

 

Рис. 2.9.15 Выбор команды "Clock Macro" в строке меню 
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 Environment – окружение 

 Эта опция используется для настроек взаимодействия "Screen 
Editor" с окружающим оборудованием и программами. 

 

Рис. 2.9.16 Выбор команды "Environment" в строке меню 
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Таблица 2.9.11 Настройки окружения 

Диалоговое окно "Environment" 

 
System Path Используется для задания места хранения на ПК системных файлов ScrEdit, 

включая некоторые системные базы данных и  динамически подключаемые 
библиотеки (*.dll). Для избежания системных ошибок и сбоев при нахождении 
файлов, мы не рекомендуем пользователям изменять данный путь без особой 
необходимости. (Эта опция по умолчанию отключена.) 

Output Path Используется для задания места хранения на ПК выходных файлов прикладной 
программы ScrEdit после компиляции. Некоторые функции, такие как онлайн и 
оффлайн симуляция, загрузка и выгрузка прикладной программы, используют 
данные файлы.  

ToolBars/Windows Здесь можно определить какие панели инструментов и 
дополнительные окна будут отображаться в ScrenEdit при её 
запуске. 

Language Используется для выбора языка (English, Traditional Chinese
или Simplified Chinese) интерфейса программы ScrenEdit.  

Upload/Download Используется для определения коммуникационного 
интерфейса ПК для загрузки/выгрузки прикладной программы.
Здесь можно выбрать USB или PC COM-порт. 

Auto Saving… Time 
Interval 

Используется для задания интервала времени, через который 
будет производиться автоматическое сохранение 
редактируемой прикладной программы ScrEdit. Диапазон 0 ~ 
120 минут.  

Options 

Auto Open for Next 
Execute Application 

Эта опция позволяет автоматически открывать данный файл 
прикладной программы при запуске ScrEdit. 
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Диалоговое окно "Environment" 

Center Drawing Area Когда выбрана данная опция, рабочая область экрана будет 
отображаться в центре окна. 

 
Include Picture Data 
For Uploading 

Если выбрана эта опция, все картинки будут так же загружены 
в ScrEdit при выполнении функции "upload".  Все загруженные 
изображения будут сохранены в файл с именем 
“_LOCALTEMP01.PIB”. Название банка “Picture Bank Name” и 
картинок “Picture Name” (заданное в окне свойств) 
редактируемых объектов также будут сохранены в файле. 
Если программа ScrEdit была закрыта аварийно, названия 
файлов будут следующие: “_LOCALTEMP02.PIB, 
_LOCALTEMP03.PIB …”. Номера файлов увеличиваются 
автоматически. 

Auto Convert Input 
Address To Tag 
Name 

Автоматическое преобразование адресов ввода в названия 
тегов. 
Например, если пользователь хочет изменить оригинальное 
название адреса 1@Y0 на “OS”, определите данную 
ассоциацию в таблице тегов. Когда выбрана эта опция, 
ScrEdit будет автоматически конвертировать адрес 1@Y0 в 
слово “OS”. 

Driver Переустановить драйвер HMI USB. Используйте в случае если перестанет 
работать связь по USB. 
Удалить драйвер HMI USB. 

OK Нажмите кнопку "OK" для сохранения настроек и выхода из диалогового окна 
"Environment". 

Cancel Нажмите кнопку "Cancel" выхода из диалогового окна "Environment" без сохранения 
настроек. 
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2.10 Меню Окно (Window) 

 Элементы меню Window 

 
Рис. 2.10.1 Элементы меню Window  

 Close Window – закрыть окно 

 Используется для закрытия (скрытия) текущего окна. Выберите 
Window > Close Window (Рис. 2.10.2). Для открытия скрытого окна 
выберите Screen > Open Screen (Рис. 2.7.6). 

 

Рис. 2.10.2 Выбор команды "Close Window" в строке меню 
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 Close All Windows – закрыть все окна 

 Используется для закрытия всех окон. Выберите Window > Close 
All Windows (Рис. 2.10.3). Для открытия скрытого окна выберите 
Screen > Open Screen (Рис. 2.7.6). 

 

Рис. 2.10.3 Выбор команды "Close All Windows" в строке меню 

 

Рис. 2.10.4 Состояние экрана после закрытия всех окон 
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 Next Window – следующее окно 

 Используется для переключения от текущего к следующему 
окну. Если текущее окно является последним, то переключения 
не произойдет.  

 

Рис. 2.10.5 Выбор команды "Next Window" в строке меню 

 

Рис. 2.10.6 Выбор команды "Next Window" на панели инструментов 
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Рис. 2.10.7 Пример переключения от окна screen1 к следующему окну (до переключения) 

 

Рис. 2.10.8 Пример переключения от окна screen1 к следующему окну (после переключения) 
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 Previous Window – предыдущее окно 

 Используется для переключения от текущего к предыдущему 
окну. Если текущее окно является первым, то переключения не 
произойдет.  

 

Рис. 2.10.9 Выбор команды "Previous Window" в строке меню 

 

Рис. 2.10.10 Выбор команды "Previous Window" на панели инструментов 
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Рис. 2.10.11 Пример переключения от окна screen2 к предыдущему окну (до переключения) 

 

Рис. 2.10.12 Пример переключения от окна screen2 к предыдущему окну (после переключения) 
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 Cascade 

 Используется для расположения всех редактируемых окон 
каскадом. При этом отображаться полностью будет только 
последнее окно, а у других окон будут видны только заголовки. 
Выберите Window > Cascade (Рис. 2.10.13). Все открытые окна 
будут отображаться как на Рис. 2.10.14. 

 

Рис. 2.10.13 Выберите команду "Cascade" в строке меню 

 

Рис. 2.10.14 Состояние экрана при расположении окон каскадом 
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 Title Horizontal – горизонтальное расположение заголовков окон 

 Используется для расположения всех редактируемых окон 
рядом в направлении сверху в низ. Выберите Window > Title 
Horizontal (Рис. 2.10.15). Все открытые окна будут 
располагаться горизонтально как на Рис. 2.10.16. 

 

Рис. 2.10.15 Выбор команды "Title Horizontal" в строке меню 

 

Рис. 2.10.16 Состояние экрана при горизонтальном расположении окон 
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 Title Vertical - вертикальное расположение заголовков окон 

 Используется для расположения всех редактируемых окон 
рядом в направлении слева направо. Выберите Window > Title 
Vertical (Рис. 2.10.17). Все открытые окна будут располагаться 
вертикально как на Рис. 2.10.18.  

 

Рис. 2.10.17 Выбор команды "Title Vertical" в строке меню 

 

Рис. 2.10.18 Состояние экрана при вертикальном расположении окон 
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 Window Summary – список окон 

Здесь отображается список всех открытых окон, который удобно использовать для 
переключения между ними. Просто щелкните левой кнопкой мыши по заголовку требуемого окна, 
и оно станет текущим, т.е. буде расположено по верх остальных. 

 

Рис. 2.10.19 Список окон 

 

Рис. 2.10.20 Выбор окна Screen 2 в строке меню 



Глава 2.  Создание и редактирование экранов 

2-164                НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

 

Рис. 2.10.21 Переключение на окно Screen 2 

2.11 Меню Справка (Help) 

 Элементы меню Help 

 

Рис. 2.11.1 Элемент меню Help 

 About ScrEdit – о программе ScrEdit 

 Отображается информация о версии программы Screen Editor. 

 

Рис. 2.11.2 Версия Screen Editor 
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Глава 3.  Описание объектов 

ScrEdit предоставляет в распоряжению пользователю различные типы объектов для создания 

экранных форм, отвечающие различным требованиям и применениям. До начала создания новых 

объектов, прочитайте данную главу, что бы понять - как выбирать объекты и назначать им 

специальные функции и свойства. 

3.1 Как выбрать объект 

Существует три метода выбора объектов: 

1. Кликом правой кнопки мыши на рабочей области экрана можно вызвать контекстное меню (см. 

Рис. 3.1.1.), из которого можно выбрать любой объект. 

2. В строке меню можно выбрать команду "Element" как на Рис. 3.1.2.  

3. На панели инструментов есть значки всех объектов (см. Рис. 3.1.3). 

 

Рис. 3.1.1 Контекстное меню быстрого доступа 



Глава 3.  Описание объектов 

3-2               НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

 

Рис. 3.1.2 Меню "Element" в строке меню 

 

Рис. 3.1.3 Значки объектов на панели инструментов 

После выбора объекта, поместите курсор на рабочей области экрана, нажмите левую кнопу мыши и, 

не отпуская её, перемещайте курсор вправо и вниз, тем самым, задавая место размещения и 

размеры нового объекта как на Рис. 3.1.4.  
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Рис. 3.1.4 Создание нового объекта с помощью мыши 
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3.2 Кнопочный переключатель (Button) 

 

Рис. 3.2.1 Варианты кнопочных переключателей 

Табл. 3.2.1 Кнопочные переключатели 

Тип кнопки Макро Чтение Запись Описание 

Set 
(включить) 

ON да да После нажатия на эту кнопку в соответствующем 
битовом операнде (Bit) будет установлено состояние ON 
(ВКЛ). Данное состояние будет сохранено после 
отпускания кнопки или при повторном её нажатии. 
Одновременно с этим будет выполнена программа ON 
Macro (макропрограмма, выполняемая при включении).  

Reset 
(выключить) 

OFF да да После нажатия на эту кнопку в соответствующем 
битовом операнде (Bit) будет установлено состояние 
OFF (ВЫКЛ). Данное состояние будет сохранено после 
отпускания кнопки или при повторном её нажатии. 
Одновременно с этим будет выполнена программа OFF 
Macro (макропрограмма, выполняемая при выключении). 

Momentary 
(кнопка без 
фиксации) 

ON 
OFF 

да да После нажатия на эту кнопку в соответствующем 
битовом операнде (Bit) будет установлено состояние ON 
(ВКЛ) и выполнена программа ON Macro. После 
отпускания кнопки в соответствующем битовом операнде 
(Bit) будет установлено состояние OFF (ВЫКЛ) и 
выполнена программа OFF Macro. 

Maintained 
(кнопка с 
фиксацией) 

ON 
OFF 

да да После нажатия на эту кнопку в соответствующем 
битовом операнде (Bit) будет установлено состояние ON 
(ВКЛ). Данное состояние будет сохранено после 
отпускания кнопки, но при повторном её нажатии будет 
установлено состояние OFF (ВЫКЛ), которое так же 
будет сохранено до последующего нажатия. 
Одновременно с изменением состояния битового 
операнда будут выполняться соответствующие 
программы ON / OFF Macro. 

Multistate  
(многопозиц. 
переключатель) 

нет да да Пользователь может задать 1~256 состояний 
переключателя. Состояния можно изменять, как в 
прямом, так и в обратном направлении (прядок задается 
в свойствах "Sequence"). Если выбрать "next state", то 
номер состояния будет  увеличиваться при каждом 
нажатии на кнопку. Если выбрать "previous state", то 
номер состояния будет  уменьшаться при каждом 
нажатии на кнопку. 

Set Value 
(установить 

нет нет да После нажатия на кнопку на экран HMI будет вызвано 
диалоговое окно “Numeric keypad", в котором 
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Тип кнопки Макро Чтение Запись Описание 
значение) пользователь сможет набрать требуемое значение и, 

нажав кнопку ENTER, ввести его в соответствующий 
регистр. 

Set Constant  
(установить 
константу) 

нет нет да После нажатия на кнопку, в соответствующий регистр 
будет записано предварительно установленное 
значение.  

Increment  
(увеличить) 

нет да да После нажатия на кнопку, значение в соответствующем 
регистре будет увеличено на предварительно 
установленную величину.  

Decrement  
(уменьшить) 

нет да да После нажатия на кнопку, значение в соответствующем 
регистре будет уменьшено на предварительно 
установленную величину.  

Goto Screen 
(переход к 
другому экрану) 

нет нет нет После нажатия на кнопку, произойдет переключение на 
предварительно заданный экран. 

Previous Page 
(возврат на 
предыдущую 
страницу) 

нет нет нет После нажатия на кнопку, произойдет возврат на 
предыдущий экран. 

 Основные кнопки 

После нажатия на основные кнопки, HMI будет передавать соответствующий сигнал ON/OFF в PLC. 

Основные кнопки в включают в себя 4 типа: Set, Reset, Momentary и Maintained. См. описание свойств 

данных объектов нижеприведенной таблице 3.2.2.  

Table 3.2.2 Описание свойств основных кнопок 

Свойства основных кнопок 
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Свойства основных кнопок 

Нажмите кнопку  в поле “Write Address” или “Read Address”. Появится
диалоговое окно “Input”, в котором можно выбрать адрес записи или чтения. 

 
В поле link (канал связи) можно выбрать место расположения адреса: Base 
Port (память внешнего ПЛК) или Internal Memory (внутренняя память HMI). 
Если используется многопортовая коммуникация, то в поле “Link” будут 
отображены все созданные соединения. Далее в поле Device Type следует 
выбрать тип операнда, и корректно ввести его адрес, после чего нажать 
кнопку Enter для ввода установленных значений в память. Операнды могут 
быть следующих типов: 

$ Внутренний регистр 
(SDRAM) 

RCP Регистр рецепта 

$M Энергонезависимый 
внутренний регистр 
(SRAM) 

RCPNO Регистр номера рецепта 

Write Address 
Read Address 
(Адрес чтения  
Адрес записи) 

*$ Косвенный адрес 
регистра (SDRAM) 

Другие Другие регистры или битовые 
операнды, принадлежащие внешнему 
PLC. Типы операндов PLC см. в 
руководствах по программированию 
PLC. 

Edit On/Off Macro 
(Редактировать 
макросы вкл/выкл) 

С помощью этой функции можно редактировать макросы, которые будут 
выполнены при включении (On) и выключении (Off) данной кнопки. 
Подробное описание макрофункций см. в главе 4. 
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Свойства основных кнопок 

Text 
Text Size 
Font 
Text Color 
 
(Текст 
Размер шрифта 
Тип шрифта 
Цвет шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 

шрифты Windows®. Нажмите кнопку  в поле “Font”, откроется диалоговое 
окно “Font Detail Setting” выбора шрифта. 

 
Если используется функция многоязыковой поддержки, будут отображаться 
различные языковые закладки, в которых могут быть заданы различные 
параметры шрифтов для разных языков. 

Twinkle (мигание) Если здесь выбрать Yes (да), то объект будет иметь мигающую индикацию.  

В поле “Picture Bank Name” пользователь может выбрать банк изображений. 
(если он создан), из которого в “Picture Name” можно будет выбрать картинку, 
которая будет отображаться на объекте. Окно выбора картинки показано 
ниже:  

 
В этом диалоговом окне двойным кликом мыши по требуемой картинке, она 
будет помещена на объект. Также можно нажать клавишу "Shift" и левую 
кнопу мыши для импорта нескольких картинок одновременно, которые будут 
размещены на разных состояниях объекта. Если число выбранных картинок 
больше чем число состояний объекта, то импортировано будет только число 
картинок равное числу состояний, а остальные будут проигнорированы. 

Picture Bank Name 
Picture Name 
 
(Банк изображений 
Имя изображения) 

Import From File Нажатием на эту кнопку можно напрямую импортировать 
картинку из файла без предварительного использования  
команды “Option” > “Picture Bank”.  
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Свойства основных кнопок 

Используя инструмент пипетка , можно взять образец цвета и определить 
цвет объекта вокруг картинки для достижения эффекта прозрачности. 
Пример данного эффекта до и после действия показан ниже на рисунках. 
Проверьте, состоит ли картинка из 16M бит (65536) цветов или нет. Эта 
функция будет не применима и появится соответствующее сообщение, если 
пользователь применит эту функцию для элемента 16M bits (65536) цветов 
(созданного для экрана DOP-AE) в 256 цветном режиме (на экране DOP-A). 
если элемент преобразован в 256 цветов после команды импорта, мы 
рекомендуем выбрать прозрачный цвет кликом мыши, не используя 
выпадающий список "Transparent Color", в котором возможно только 144 
цвета. Пользователь может достаточно точно выбрать цвет из выпадающего 
списка, но могут быть некоторые хроматические аберрации. 
Например, RGB(0,0,0) это черный цвет, но RGB(1,1,1) это также черный цвет. 
Впрочем, RGB(0,1,0) также может быть воспринят, как черный. 

До акции транспарирования После акции транспарирования 

Transparent Effect 
Transparent Color 
 
(Эффект прозрачности 
Цвет фона) 

  
Standard 

(Стандартный) 
Raised 

(Рельефный) 
Round 

(Круглый) 
Invisible           

(Невидимый) 

    

Foreground Color 
Style 
(Цвет переднего плана 
Стиль) 
 
 

Пользователь может выбрать стиль кнопки и цвет переднего плана, 
используя данные варианты.  

Function 
(Функция) 

Здесь пользователь может переопределить назначение кнопки напрямую без 
создания нового объекта. Доступны следующие варианты кнопок: Set, Reset, 
Momentary и Maintained.  

Push Time  
(Время нажатия) 

Используется для задания времени задержки начала действия кнопки после 
нажатия на неё. Эта функция может применяться для предотвращения 
ошибочных нажатий на кнопку. Диапазон: 0 ~ 10 сек.  

User Security Level 
(Уровень доступа 
пользователя) 

Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Set Low Security 
(Понижение уровня 
доступа) 

С помощью этой опции текущий уровень доступа может быть понижен после 
нажатия на кнопку. Используется для предотвращения возможных ошибок 
(операторами).  

InterLock Address 
InterLock Level 
(Адрес и уровень 
блокировки) 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень 
блокировки)), объект будет разблокирован.   

Before Execute Macro 
(Макрос, выполняемый 
до действия кнопки) 

Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro 
(Макрос, выполняемый 
после действия кнопки) 

Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  
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Пример создания кнопочных переключателей:  

   

Рис. 3.2.2 Пример создания кнопочных переключателей 

 Multistate Buttons – многопозиционные переключатели 

Табл. 3.2.3 Описание свойств многопозиционных переключателей 

Свойства объектов "Multistate Buttons" (многопозиционных переключателей) 

Максимальное число позиций переключателя будет зависеть от выбранного формата данных 
операнда. До 256 состояний – при выборе формата WORD, 16 состояний – при выборе формата LSB 
и 2 состояний – при выборе формата Bit. Типы операндов адресов чтения/записи будут также 
различными при различных форматах данных. Если выбран формат WORD или LSB, то будут 
доступны адреса словных регистров. Если выбран формат Bit, то будут доступны только адреса 
битовых операндов. После получения данных от адреса чтения, переключатель примет 
соответствующее им состояние. А при переключении в следующую позицию, данные 
соответствующие новой позиции будут переданы по адресу записи. Если требуется изменить 
максимальное число состояний, только добавьте или удалите число состояний в таблице свойств 
объекта. 

Write Address 
Read Address 

Используются для установки адреса чтения и записи. Можно использовать 
адреса памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Twinkle  
(мигание) 

Если здесь выбрать Yes (да), то объект будет иметь мигающую индикацию.  

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Push Time (second) Используется для задания времени задержки начала действия кнопки после 
нажатия на неё. Эта функция может применяться для предотвращения 
ошибочных нажатий на кнопку. Диапазон: 0 ~ 10 сек. 

Data Length Bit Битовый формат данных: Переключатель может иметь только два 
состояния. 



Глава 3.  Описание объектов 

3-10               НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

Свойства объектов "Multistate Buttons" (многопозиционных переключателей) 

Word 16-ти битный формат данных: Переключатель может иметь от 1 до 
256 состояния. 

(Размерность данных) 

LSB Переключатель может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed 
Decimal, Unsigned Decimal и Hex), определяемых содержимое читаемой 
памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа состояний многопозиционного 
переключателя. До 256 состояний – при выборе формата WORD, 16 
состояний – при выборе формата LSB и 2 состояний – при выборе формата 
Bit.  

Sequence 
(очередность) 

Используется для задания порядка переключения состояний. Если выбрать 
"next state", то номер состояния будет  увеличиваться при каждом нажатии на 
кнопку. Если выбрать "previous state", то номер состояния будет  уменьшаться 
при каждом нажатии на кнопку. 

User Security Level 
(Уровень доступа 
пользователя) 

Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Set Low Security 
(Понизить уровень 
доступа) 

С помощью этой опции текущий уровень доступа может быть понижен после 
нажатия на кнопку. Используется для предотвращения возможных ошибок 
(операторами).  

InterLock Address 
InterLock Level 
(Адрес и уровень 
блокировки) 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания многопозиционных переключателей:  

Когда формат данных LSB (D100.0-D100.1 … D100.3-D100.4): 

                     

S0=D100.0 ON   S1=D100.1 ON   S2=D100.2 ON   S3=D100.3 ON   S4=D100.4 ON 

 

Y1         Y2        Y3         Y4        Y5        Y6         Y7          MULTI-VALVE 

Рис. 3.2.3 Многопозиционные переключатели 
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 Set Value Button – кнопка установки значений 

Табл. 3.2.4 Описание свойств кнопки установки значений 

Свойства кнопки "Set Value" (установить значение) 

После нажатия на кнопку на экран HMI будет вызвано диалоговое окно “Numeric keypad", в котором 
пользователь сможет набрать требуемое значение и, нажав кнопку ENTER, ввести его в 
соответствующий регистр. Максимальное и минимальное значения ввода могут быть определены 
пользователем. Так же пользователь может в опции "trigger mode" назначить битовый операнд PLC, 
который будет включен при записи значения устанавливаемого данной кнопкой.  

Write Address Используются для установки адреса записи. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения устанавливаемого данной кнопкой и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

 
Data Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word (слово) Double Word (двойное слово) 

Detail Range Setup 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 
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Свойства кнопки "Set Value" (установить значение) 

Minimum 

Maximum 

Здесь можно задать диапазон ввода данных (максимальное и 
минимальное значения). 

Integral Digits 

Fractional 

Здесь можно определить число цифр целой и дробной части 
числа. Это не влияет на само число, а служит только для 
индикации. Реальная десятичная точка будет только, когда 
выбран формат  “Floating”.  

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных параметров (мин. и макс. значения, размерность и 
формат данных, целую и дробную части). 

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Set Low Security С помощью этой опции текущий уровень доступа может быть понижен после 
нажатия на кнопку. Используется для предотвращения возможных ошибок 
(операторами).  

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания кнопки ввода значения:  

Нажмите кнопку "Set Value" и на экране появится диалоговое окно с цифровой клавиатурой 

"Numeric keypad". Пользователь может набрать требуемое значение и ввести его в PLC в 

регистр M100.  

 

 

Рис. 3.2.4 Диалоговое окно "Numeric keypad" 
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 Set Constant Button – кнопка установки константы 

Табл. 3.2.5 Описание свойств кнопки установки константы 

Свойства кнопки "Set Constant" (установить константу) 

После нажатия на кнопку, в соответствующий регистр будет записано предварительно установленное 
значение. Функционально кнопка похожа на кнопку установки значения "Set Value". 

Write Address Используются для установки адреса записи. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения устанавливаемого данной кнопкой и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

 
Data Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word/Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Detail Range Setup 

Value Здесь надо задать число (константу) которое будет 
записываться в адрес записи после нажатия на данную кнопку. 
Когда пользователь нажмет кнопку OK, HMI будет проверять 
правильность и соответствие введенных здесь параметров. 

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 
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Свойства кнопки "Set Constant" (установить константу) 

Set Low Security С помощью этой опции текущий уровень доступа может быть понижен после 
нажатия на кнопку. Используется для предотвращения возможных ошибок 
(операторами).  

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания кнопок ввода константы:  

После нажатия на кнопку, в регистр D1000 будет записана предварительно установленная 

константа. 

 

Рис. 3.2.5 Пример кнопок "Set Constant" 

 

 Increment / Decrement – увеличить/уменьшить 

Табл. 3.2.6 Описание свойств кнопок увеличения / уменьшения 

Свойства кнопок "Increment / Decrement" (увеличить/уменьшить) 

После нажатия на кнопку, значение в соответствующем регистре будет увеличено/уменьшено на 
предварительно установленную величину. Значение регистра не сможет выйти за заданные пределы 
(минимальный и максимальный). 

Write Address 
Read Address 

Используются для установки адреса чтения и записи. Можно использовать 
адреса памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 
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Свойства кнопок "Increment / Decrement" (увеличить/уменьшить) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Function Здесь пользователь может переопределить назначение кнопки напрямую без 
создания нового объекта. Доступны следующие варианты: Increment и 
Decrement. 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения устанавливаемого данной кнопкой и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

 
Data Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word/Double Word 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Jog Step Величина изменения значения регистра при каждом нажатии 
на кнопку. 

Detail Range Setup 

Limit Используется для задания пределов изменения значения 
регистра данной командой. Когда пользователь нажмет кнопку 
OK, HMI будет проверять правильность и соответствие 
введенных здесь параметров. 

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Set Low Security С помощью этой опции текущий уровень доступа может быть понижен после 
нажатия на кнопку. Используется для предотвращения возможных ошибок 
(операторами).  
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Свойства кнопок "Increment / Decrement" (увеличить/уменьшить) 

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания кнопок "Increment / Decrement": 

Регулировка значения D1000 нажатием на кнопки +/-. 

 

Рис. 3.2.6 Пример кнопок "Increment / Decrement" 

 Goto Screen / Previous Page (Previous View) Buttons – кнопки переключения между экранами 

Табл. 3.2.7 Описание свойств кнопок переключения между экранами 

Свойства кнопок "Goto Screen / Previous Page (Previous View)"  

Возможны три вида переключений между экранами: 
1. Goto screen: после нажатия на кнопку, произойдет переключение на предварительно заданный 

экран. 
2. Previous page: после нажатия на кнопку, произойдет переключение на предыдущий экран. 
3. Previous view: после нажатия на кнопку, произойдет переключение на предыдущий вид, 

аналогично команде "Back" (назад) в Windows® Explorer Browse. 

   
Здесь изображена работа кнопки перехода у предыдущему экрану. На экране 1, если нажать кнопку 
“Goto 2” , произойдет переключение на экран 2. если нажать кнопку “Goto 3” на экране 2, произойдет 
переключение на экран 3. Затем, если нажать кнопку перехода к предыдущему экрану на экране 3, 
произойдет переключение на экран 2. Затем, если нажать кнопку перехода к предыдущему экрану на 
экране 2, произойдет переключение на экран 3. (Примечание: однако, если на экране 2 создать 
кнопку “previous view”, а не “previous page”, то произошло бы переключение на экран 1, а не на экран 
3, в чем и состоит отличие кнопок “Previous page” от “Previous view”.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 
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Свойства кнопок "Goto Screen / Previous Page (Previous View)"  

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Function Здесь пользователь может переопределить назначение кнопки напрямую без 
создания нового объекта. Доступны следующие варианты: Goto button, 
Previous page и Previous view buttons. 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения устанавливаемого данной кнопкой и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

Диалоговое окно доступно только когда выбрана функция “Goto screen”. 

 
Close Sub-
Screen 

Когда выбрана эта опция, это показывает, что кнопка "Goto 
screen" действует только на вспомогательном окне (Sub-
Screen). При нажатии на данную кнопку, текущее (активное) 
вспомогательное окно будет закрыто.  

Detail 

User’s security 
level will be set 
to Low Security 
after changing 
screen. 

С помощью этой опции текущий уровень доступа может быть 
понижен после нажатия на кнопку. Используется для 
предотвращения возможных ошибок (операторами). 

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий.  
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Свойства кнопок "Goto Screen / Previous Page (Previous View)"  

Goto Screen При выборе этой опции будет открыто следующее диалоговое окно: 

 
В этом окне “Open Screen”, пользователь может выбрать из списка всех 
созданных экранов требуемый экран к которому будет производится 
переключение по команде данной кнопки. 

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания кнопок "Goto Screen":  

Используя данные кнопки можно переходить на различные экраны 

 

Рис. 3.2.7 Пример кнопок "Goto Screen" 
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 System Function Button – системные функциональные кнопки 

 

Рис. 3.2.5 Типы системных функциональных кнопок 

Табл. 3.2.8 Системные функциональные кнопки 

Тип кнопки Макро Чтение Запись Описание 

System Date 
Time 
(Системное 
время и дата) 

нет нет нет Используется для корректировки часов реального 
времени HMI (год-месяц, часы : минуты : секунды) 

Password Table 
Setup  
(Настройка 
таблицы 
паролей) 

нет нет нет Используется для ввода паролей для всех уровней 
доступа. 

Enter Password 
(Ввод пароля) 

нет нет нет Используется для вызова окна ввода пароля. 

Contrast 
Brightness 
(Контрастность 
Яркость) 

нет нет нет Используется для корректировки яркости и 
контрастности дисплея HMI. 

Low Security 
(Низкий уровень 
доступа) 

нет нет нет После нажатия на эту кнопку, будет установлен 
самый низкий уровень доступа паролем (Уровень 0). 

System Menu 
(Системное 
меню) 

нет нет нет Используется для вызова системного меню HMI.  

Report List 
(Отчет) 

нет нет нет 

После нажатия на эту кнопку, выходные данные 
экрана будут сохранены на внешний носитель 
памяти. Так же эта кнопка может использоваться для 
вывода на печать.  

 

 

Описание свойств системных функциональных кнопок см. в таблице 3.2.9: 
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Табл. 3.2.9 Системные функциональные кнопки 

Свойства системных функциональных кнопок 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
кнопке, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Здесь пользователь может переопределить назначение кнопки напрямую без 
создания нового объекта. Доступны следующие варианты: 

System Date & 
Time 
(Системное 
время и дата) 

Используется для корректировки часов реального времени 
HMI. Требуется нажатие кнопки SYS на панели HMI для 
ввода в HMI системных установок и значений даты и 
времени, как показано ниже: 

 
Password Table 
Setup 
(Настройка 
таблицы 
паролей) 

После нажатия на эту кнопку пользователь получает доступ 
к таблице установки паролей для всех уровней защиты от 
несанкционированного доступа. После загрузки прикладной
программы в HMI, если уровень доступа пользователя 
меньше чем заданный, эта таблица “Password Table” не 
сможет быть открыта, будет отображаться только 
диалоговое окно ввода пароля “Password Keypad”. Таблица 
паролей может быть открыта или нет в зависимости от 
текущего уровня доступа пользователя, который должен 
быть выше установленного. В открытой таблице паролей 
пользователь сможет изменить пароли только тех уровней 
доступа, которые ниже текущего пользовательского.  

         
Полный доступ                       Пароли 5-ти уровней 

Function 

Enter Password 
(Ввод пароля) 

Кнопка используется для вызова таблицы ввода пароля, 
если пользователь хочет изменить пароль для текущего 
уровня доступа. 
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Свойства системных функциональных кнопок 

Contrast 
Brightness 
(Контрастность 
Яркость) 

Кнопка используется для вызова окна, в котором можно 
произвести корректировку яркости и контрастности ЖК-
дисплея HMI. если нажать кнопку “Set for default Contrast”, 
будут восстановлены заводские значения яркости и 
контрастности ЖК-дисплея HMI. 

 
Low Security 
(Низкий уровень 
доступа) 

После нажатия на эту кнопку, будет установлен самый 
низкий текущий уровень доступа (Уровень 0). Эта опция 
может использоваться для повышения защиты от 
несанкционированного доступа и позволяет избежать 
системных ошибок и сбоев из-за ошибочных действий 
персонала. (Эта функция так же может быть привязана к 
кнопке Goto screen.)  

System Menu 
(Системное 
меню) 

Используется для вызова системного меню HMI. Вернуться 
обратно на рабочий экран можно, нажав кнопку “Run” или 
сняв и подав снова напряжение питания на HMI. 

Report List 
(Отчет) 

Эта кнопка имеет несколько назначений. Которые зависят 
от свойств опции “Report List” (См. стр. 2-124 в главе  2 и 
нижеприведенное описание: Report Device). 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения устанавливаемого данной кнопкой и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

Эта опция доступна только для кнопки "Report List". 

 
В диалоговом окне "Report Device" пользователь может выбрать устройство 
(SMC, USB Disk, и Printer), на которое будет сохранен отчет по команде 
"Report List". Имейте в виду, что USB Disk и Printer предоставляются только 
в панелях серии DOP-AE (AS).  
SMC Копирование архива данных и журнала аварий на SMC-карту. 

USB Disk Копирование архива данных и журнала аварий на USB Disk. 

Report Device 

Printer Сначала HMI проверит установку функции "Print Typesetting". 
Если функция "Print Typesetting" уже установлена, данные экрана 
будут выведены непосредственно на печать. Если HMI 
обнаружит, что функция "Print Typesetting" еще не установлена, 
будет разрешена функция "Hard Copy".  

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 
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Свойства системных функциональных кнопок 

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
нажатия на эту кнопку (и отпускания её).  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
нажатия на эту кнопку (и отпускания её).  

Пример создания системных функциональных кнопок: 

 

 
Рис. 3.2.8 Системное меню HMI 
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3.3 Измерительный прибор (Meter) 

 

Рис. 3.3.1 Варианты измерительных приборов 

Табл. 3.3.1 Описание свойств измерительных приборов 

Свойства объекта "Meter" 

Пользователь может настроить внешний вид измерительного прибора в таблице свойств в опциях  
style (стиль), color (цвет, включая цвет рамки, фона, стрелки и шкалы) и scale region number (число 
номеров шкалы), и т.д. Так же здесь могут быть определены максимальное и минимальное значения 
и верхний и нижний пределы измерения. Пользователи могут использовать различные цвета для 
отчетливого показа и удобного распознавания значений измерения. 

Read Address Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). 
(См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
приборе, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color Используется для установки цвета рамки прибора.  

Background Color Используется для установки цвета заднего фона прибора. 

Standard Raised Sunken Style 

   
Data 
Length 

Размерность данных: 16-битное
слово и 32-битное двойное слово. 

Data 
Format 

Доступны различные виды формата 
представления данных: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
 

Minimum Value 

Detail Setup 

Maximum Value 

Используются для задания минимального и максимального 
значений прибора. 
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Свойства объекта "Meter" 

Target 
Value 
Color 

В этой опции пользователь может назначить заданное 
значение измерения, которое будет отображаться на 
приборе линией, установленного здесь цвета. На рис. 
назначено заданное значение 60 и цвет линии – синий. 

 
Ranges 
(Разрешение 
установки области 
измерения)  

См. описание опции "Low и High Region Color". 

Variable 
target/range limits 

Когда заданное значение и верхний и нижний пределы 
измерения должны иметь переменные значения, адрес 
нижнего предела будет Read Address+1, адрес верхнего 
предела будет Read Address+2 и адрес заданного значения 
будет Read Address+3.  

Integral Digits 

Fractional Digits 

Здесь можно определить число цифр целой и дробной 
части числа. Это не влияет на само число, а служит только 
для индикации. 

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных здесь параметров. 

Low Region Color 
High Region Color 

Эта функция доступна, только если опция  “Ranges” в окне "Detail Setup" 
предварительно выбрана. Например, если задан нижний предел 30 и цвет 
нижнего предела зеленый, задан верхний предел 70 и цвет верхнего предела 
красный, прибор будет иметь вид как показан на рисунке:  

 
Stitch Color Используется для установки цвета стрелки прибора. 

Scale Color Используется для установки цвета шкалы прибора. 

Scale Region Number 
используется для установки количества номеров на шкале прибора. используя 
кнопки вверх и вниз можно увеличить или количества номеров на шкале в 
диапазоне 1 ~ 10.  

Пример создания измерительных приборов: 

 

Рис. 3.2.9 Пример объектов "Meter" 
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3.4 Столбчатая диаграмма (Bar) 

 

Рис. 3.4.1 Варианты столбчатых диаграмм 

Табл. 3.4.1 Описание свойств столбчатых диаграмм 

Свойства объекта "Normal Bar" (обычная столбчатая диаграмма) 
HMI читает значение регистра PLC с определенным адресом, преобразует его в графический вид и 
отображает на экране в виде обычной столбчатой диаграммы.  
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). 
(См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
(Цвет рамки) 

Используется для установки цвета рамки объекта.  

Foreground Color 
Background Color 
(Цвет переднего и 
заднего плана) 

Используется для установки цвета переднего и заднего плана объекта. 
Например, передний план на рис. имеет зеленый цвет, а задний – желтый. 

 

Standard (стандартный) Raised (рельефный) Sunken (утопленный) Style 
(Стиль) 

   

Left Движение будет происходить справа налево. 

Right Движение будет происходить слева направо. 

Top Движение будет происходить снизу вверх. 

Display Format 
(формат 
отображения) 

Bottom Движение будет происходить сверху вниз. 

Data 
Length 

Размерность данных: 16-битное
слово и 32-битное двойное слово. 

Data 
Format 

Доступны различные виды формата 
представления данных: 

Word/Double Word 

 

 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Detail 
(детализация) 

Minimum Value Используются для задания минимального и максимального 
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Свойства объекта "Normal Bar" (обычная столбчатая диаграмма) 

Maximum Value отображаемых значений. 

Target 
Value 
Color 

В этой опции пользователь может назначить заданное 
значение измерения, которое будет отображаться на 
диаграмме линией, установленного здесь цвета. На рис. 
назначено заданное значение 50 и цвет линии – красный. 
(Максимальное и минимальное значения: 100 и 0 
соответственно). 

 

Ranges 
(Разрешение 
установки области 
измерения)  

См. описание опции "Low и High Region Color". 

Variable 
target/range limits 

Когда заданное значение и верхний и нижний пределы 
измерения должны иметь переменные значения, адрес 
нижнего предела будет Read Address+1, адрес верхнего 
предела будет Read Address+2 и адрес заданного значения 
будет Read Address+3.  

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных здесь параметров. 

Low Region Color 
High Region Color 
(Цвет нижней и 
верхней областей 
измерений) 

Эта функция доступна, только если опция  “Ranges” в окне "Detail Setup" 
предварительно выбрана. Например, если задан нижний предел 30 и цвет 
нижнего предела зеленый, задан верхний предел 70 и цвет верхнего предела 
красный, диаграмма будет иметь вид, как показан на рисунке (мин. и макс. 
значения 0 и 100 соответственно.):  

           
Значение  = 20              Значение  = 50              Значение  =  80 

 

 

Табл. 3.4.1 Описание свойств столбчатых диаграмм  

Свойства объекта "Deviation Bar" (девиационная столбчатая диаграмма) 
HMI читает значение регистра PLC с определенным адресом, преобразует его в графический вид и 
отображает на экране в виде девиационной столбчатой диаграммы. На экране отображается 
значение отклонения, которое представляет собой разность между заданным стандартным 
значением и значением читаемого регистра. 
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). 
(См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
(Цвет рамки) 

Используется для установки цвета рамки объекта.  
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Свойства объекта "Deviation Bar" (девиационная столбчатая диаграмма) 

Foreground Color 
Background Color 
(Цвет переднего и 
заднего плана) 

Используется для установки цвета переднего и заднего плана объекта. 
Например, передний план на рис. имеет зеленый цвет, а задний – желтый. 

 
Standard (стандартный) Raised (рельефный) Sunken (утопленный) Style 

(стиль) 

   

Horizontal Отклонение будет отображаться в горизонтальном направлении. Display Format 
(формат 
отображения) Vertical Отклонение будет отображаться в вертикальном направлении. 

Data 
Length 

Размерность данных: 16-битное
слово и 32-битное двойное слово. 

Data 
Format 

Доступны различные виды формата 
представления данных: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
 

Standard Value 
(Стандартное 
значение) 

Используется для задания стандартного значения от 
которого отсчитывается отклонение. 

Minimum Value 

Maximum Value 

Используются для задания минимального и максимального 
отображаемых значений. 

Display Deviation 
Limit 
(Отображение 
заданного 
диапазона 
отклонения) 

Значения и цвет предельных отклонений может быть задан 
только тогда, когда выбрана данная опция. При выходе за 
диапазон заданных предельных значений диаграмма 
изменит цвет. Если эта опция не задана, отклонение будет 
отображаться цветом переднего плана во всем диапазоне 
измерений.  

Variable Standard 
Value/Deviation 
Limit 

Когда стандартное значение и верхний предел отклонения 
должны иметь переменные значения, адрес стандартного 
значения будет Read Address+1 и адрес предельного 
отклонения Read Address+2.  

Detail 
(Детали) 

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных здесь параметров. 
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Свойства объекта "Deviation Bar" (девиационная столбчатая диаграмма) 

Пример: если выбран размер данных - Word (16 бит), формат данных - 
Unsigned Decimal (десятичный без знака), standard value (стандартное 
значение) задано 50, минимальное значение задано 0, максимальное значение 
задано 100 и предельное отклонение задано 20, девиационная столбчатая 
диаграмма будет выглядеть следующим образом: 

          
Значение = 10                Значение = 20   

         
Значение = 70                Значение =  90 

Пример создания столбчатых диаграмм: 

 

Рис. 3.4.2 Пример столбчатых диаграмм 
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3.5 Трубопровод (Pipe) 

 
Рис. 3.5.1 Варианты элементов трубопровода 

Табл. 3.5.1 Описание свойств элементов трубопровода 

Свойства элементов трубопровода Pipe (1) и Pipe (2) 
HMI читает значение регистра PLC с определенным адресом, преобразует его в графический вид и 
отображает на экране в виде уровня жидкости в емкостях типа Pipe (1) / Pipe (2).  
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). 
(См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

WaterMark Color 
Inside Tube Color 
(Цвет жидкости 
Цвет внутренней 
поверхности бака) 

Используется для установки цвета переднего и заднего плана объекта, т.е. 
цвета жидкости и задней стенки бака Pipe (1) и Pipe (2). 

       Pipe (1)                                                       Pipe (2) 

                                                  
Цвет жидкости - синий.                                Цвет жидкости - красный. 
Задняя стенка бака - черная.                      Задняя стенка бака - белая. 

Standard (Стандартный) Rotation 180 (Поворот на 1800) Style 
(Стиль) 

     
Data 
Length 

Размерность данных: 16-битное
слово и 32-битное двойное слово. 

Data 
Format 

Доступны различные виды формата 
представления данных: 

Word/Double Word 

Detail Setup 
(Детальная 
установка) 

 

 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
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Свойства элементов трубопровода Pipe (1) и Pipe (2) 

Minimum Value 

Maximum Value 

Используются для задания минимального и максимального 
отображаемых значений (емкость бака). 

Target 
Value 
Color 

В этой опции пользователь может назначить заданное 
значение измерения, которое будет отображаться на 
объекте линией, установленного здесь цвета. 

Ranges 
(Разрешение 
установки области 
измерения)  

См. описание опции "Low и High Region Color". 

Variable 
target/range limits 

Когда заданное значение и верхний и нижний пределы 
измерения должны иметь переменные значения, адрес 
нижнего предела будет Read Address+1, адрес верхнего 
предела будет Read Address+2 и адрес заданного значения 
будет Read Address+3.  

 

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных здесь параметров.  

Low Region Color 
High Region Color 
(Цвет нижней и 
верхней областей 
измерений) 

Эта функция доступна, только если опция  “Ranges” в окне "Detail Setup" 
предварительно выбрана. Например, если задан нижний предел 30 и цвет 
нижнего предела зеленый, задан верхний предел 70 и цвет верхнего предела 
красный, диаграмма будет иметь вид, как показан на рисунке (мин. и макс. 
значения 0 и 100 соответственно.): 

                     
  Значение = 20                  Значение =  50                Значение = 80 

 

Свойства элемента трубопровода Pipe (3)  
Элемент Pipe (3) используется для соединения четырех труб. См. рис.: 
 

 
Pipe Gauge 
(Размер трубы) 

Используется для выбора размера объекта в диапазоне 1 ~ 5. Размер 1 имеет 
в месте стыковки трубы 13 пикселей,  размер 2 имеет 26 пикс. и т.д.  

 

Свойства элемента трубопровода Pipe (4) 
Элемент Pipe (4) используется для соединения трех труб. См. рис.: 
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Свойства элемента трубопровода Pipe (4) 

Standard 
(Стандартный) 

Rotation 90 
(Поворот на 900) 

Rotation 180 
(Поворот на 1800) 

Rotation 270 
(Поворот на 2700) 

Style 
(Стиль) 

 
 

 
 

Pipe Gauge 
(Размер трубы) 

Используется для выбора размера объекта в диапазоне 1 ~ 5. Размер 1 имеет 
в месте стыковки трубы 13 пикселей,  размер 2 имеет 26 пикс. и т.д.  

 

Свойства элемента трубопровода Pipe (5) 
Элемент Pipe (5) используется для соединения двух труб с целью поворота трубопровода. См. рис.: 
 

 
Standard 

(Стандартный) 
Rotation 90 

(Поворот на 900) 
Rotation 180 

(Поворот на 1800) 
Rotation 270 

(Поворот на 2700) 
Style 
(Стиль) 

    
Pipe Gauge 
(Размер трубы) 

Используется для выбора размера объекта в диапазоне 1 ~ 5. Размер 1 имеет 
в месте стыковки трубы 13 пикселей,  размер 2 имеет 26 пикс. и т.д.  

 

Свойства элементов трубопровода Pipe (6) и Pipe (7) 
Горизонтальные и вертикальные трубы. Используются для отображения направления потока 
жидкости.  
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). 
(См. табл. 3.2.2 описания свойств основных кнопок.) 

Mobile Cursor Color 
(Цвет курсора 
движения жидкости) 

Когда в читаемом регистре будет значение 1, курсоры заданного здесь цвета 
будут двигаться вправо (вверх), к в читаемом регистре будет значение 2, 
курсоры заданного здесь цвета будут двигаться влево (вниз).  

Pipe Gauge 
(Размер трубы) 

Используется для выбора диаметра трубы 1 ~ 5. Размер 1 имеет диаметр 
трубы 13 пикселей,  размер 2 имеет 26 пикс. и т.д.  
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3.6 Круговая диаграмма (Pie) 

 
Рис. 3.6.1 Варианты круговых диаграмм 

 

Табл. 3.6.1 Описание свойств круговых диаграмм 

Свойства объекта "Pie" (круговая диаграмма) 
HMI читает значение регистра PLC с определенным адресом, преобразует его в графический вид и 
отображает на экране в виде круговой диаграммы. Пользователю доступны четыре вида круговых 
диаграмм. 
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См. 
табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
Foreground Color 
Background Color 
(Цвет рамки, 
переднего и 
заднего плана) 

Используется для установки цвета рамки, переднего и заднего плана объекта. 
Например, рамка на рис. имеет синий цвет, передний план имеет зеленый цвет, 
а задний – желтый.  

 
Standard 

(стандартный) 
Raised 

(рельефный) 
Sunken 

(утопленный) 
Transparent 

(прозрачный) 
Style 
(Стиль) 

   
 

Data Length Размерность данных: 16-битное
слово и 32-битное двойное слово. 

Data Format Доступны различные виды формата 
представления данных: 

Word/Double Word 

Detail Setup 
(Детальная 
установка) 

 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
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Свойства объекта "Pie" (круговая диаграмма) 

Minimum Value 

Maximum Value 

Используются для задания минимального и 
максимального отображаемых значений. 

Target 
Value 
Color 

В этой опции пользователь может назначить заданное 
значение измерения, которое будет отображаться на 
диаграмме линией, установленного здесь цвета. На рис. 
назначено заданное значение 80 и цвет линии – желтый. 
(Максимальное и минимальное значения: 100 и 0 
соответственно) 

 

Ranges (Разрешение 
установки области 
измерения)  

См. описание опции "Low и High Region Color". 

Variable target/range 
limits 

Когда заданное значение и верхний и нижний пределы 
измерения должны иметь переменные значения, адрес 
нижнего предела будет Read Address+1, адрес верхнего 
предела будет Read Address+2 и адрес заданного 
значения будет Read Address+3.  

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных здесь параметров. 

Low Region Color 
High Region Color 
(Цвет нижней и 
верхней областей 
измерений) 

Эта функция доступна, только если опция  “Ranges” в окне "Detail Setup" 
предварительно выбрана. Например, если задан нижний предел 30 и цвет 
нижнего предела зеленый, задан верхний предел 70 и цвет верхнего предела 
красный, диаграмма будет иметь вид, как показан на рисунке (мин. и макс. 
значения 0 и 100 соответственно.): 

       
     Значение  = 20               Значение  = 50               Значение  =  80 

Пример создания круговых диаграмм: 

 

Рис. 3.6.2 Пример столбчатых диаграмм 
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3.7 Индикатор (Indicator) 

 
Рис. 3.7.1 Варианты индикаторов 

 

Табл. 3.7.1 Описание свойств многопозиционных индикаторов 

Свойства объекта "Multistate Indicator" (многопозиционный индикатор) 

Многопозиционный индикатор предоставляет метод отображения состояния читаемого регистра в 
виде вывода сообщения или изображения, предварительно назначенного для каждого из возможных 
состояний. Для чтения состояния могут быть использованы регистры формата: Bit, LSB или WORD. 

Read Address 
(Адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 
Например, если выбран адрес выходного реле ПЛК, то многопозиционный 
индикатор будет иметь два возможных состояния (ВКЛ или ВЫКЛ). Для 
состояния, когда выходное реле включено, можно задать текс “Старт", а когда
выключено - “Стоп” использовать картинки изображающие каждое состояние. 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны 
все шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Twinkle 
(мигание) 

Если здесь выбрать Yes (да), то объект будет иметь мигающую индикацию. 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Bit Битовый формат данных: индикатор может иметь только два 
состояния. 

Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 
состояния. 

Data Length 
(Размерность данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed 
Decimal, Unsigned Decimal и Hex), определяемых содержимое читаемой 
памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа состояний многопозиционного индикатора. 
До 256 состояний – при выборе формата WORD, 16 состояний – при выборе 
формата LSB и 2 состояний – при выборе формата Bit.  

Пример создания индикаторов: 
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Табл. 3.7.2 Описание свойств диапазонных индикаторов 

Свойства объекта "Range Indicator" (диапазонный индикатор) 

Диапазонный индикатор предоставляет метод отображения состояния читаемого регистра в виде 
вывода сообщения или изображения, предварительно назначенного для каждого из заданных 
диапазонов значений регистра. Для чтения значений могут быть использованы регистры формата: 
Bit, LSB или WORD. 

Read Address 
(Адрес чтения)  

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны 
все шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Twinkle 
(мигание) 

Если здесь выбрать Yes (да), то объект будет иметь мигающую индикацию. 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа состояний многопозиционного индикатора. 
До 256 состояний – при выборе формата WORD, 16 состояний – при выборе 
формата LSB и 2 состояний – при выборе формата Bit.  

Data 
Length 

Размерность данных: 16-битное
слово и 32-битное двойное слово.

Data 
Format 

Доступны различные виды 
формата представления данных: 

Word/Double Word  

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
 

В этой опции можно задать количество пределов (по 
умолчанию 5), которые определят диапазоны значений 
регистра для каждого состояния индикатора. Если число 
состояний = n, то число заданных пределов = n-1. 
Пользователь может назначить цвет переднего плана 
индивидуально для каждого из состояний 0, 1, 2, 3 и 4, 
например, как красный, зеленый, синий, желтый и 
фиолетовый соответственно. 

Предел 0 Предел 1 Предел 2 Предел 3 

100 50 33 1 

Detail 
(Детализация) 

Range 
(Пред
ел) 

Constant
Limits 
(Пост. 
значения 
пределов
) 

Когда значение читаемого регистра больше 100, цвет 
индикатора будет красный. Когда значение читаемого 
регистра больше 50, цвет индикатора будет зеленый, и т.д.  
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Свойства объекта "Range Indicator" (диапазонный индикатор) 

Variable 
Limits 
(Перем. 
значения 
пределов
) 

Когда выбрана данная опция, значения пределов могут быть 
переменными и задаваться в определенных регистрах. 
Например, если адрес чтения $0, и максимальное число 
состояний 5, то Предел 0 будет определяться значением $1, 
Предел 1 будет определяться значением $2, и т.д.  

Табл. 3.7.3 Описание свойств простого индикатора 

Свойства объекта "Simple Indicator" (простой индикатор) 

Простой индикатор удобно использовать для отображения состояния (ON/OFF) битовых операндов в 
виде изменения цвета. Например, для импортированных CAD-чертежей командой Screen > Import, с 
помощью простого индикатора можно изменять цвет фона всего изображения или отдельных его 
частей, тем самым сделав его динамическим. На ниже приведенном рисунке над левой емкостью 
размещен простой индикатор, который позволяет окрашивать его, при определенных условиях, в 
синий цвет. 

   
Read Address  
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса 
памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны 
все шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

XOR Color Используется для задания цвета изменения фона базового изображения. 
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3.8 Объекты отображения данных (Data Display) 

 
Рис. 3.8.1 Варианты объектов отображения данных 

Табл. 3.8.1 Назначение объектов отображения данных 

Название объекта Назначение 

Numeric Display 
(Цифровой дисплей) 

Индикация значения регистра.  

Character Display 
(Символьный дисплей) 

Индикация текста или символов записанных в регистре.  

Date Display 
(Дисплей даты) 

Индикация даты часов реального времени HMI. 

Time Display 
(Дисплей времени) 

Индикация текущего времени часов HMI. 

Day-of-week Display 
(Дисплей дня недели) 

Индикация дня недели часов реального времени HMI. 

Prestored Message 
(Предустановленное 

сообщение) 

Индикация предустановленного сообщения, в соответствии с 
назначенным ему значением регистра. 

Moving Sign 
(Бегущая строка) 

Индикация предустановленного сообщения в виде бегущей строки, в 
соответствии с назначенным ему значением регистра. 

 Numeric Display – цифровой дисплей 

Табл. 3.8.2 Описание свойств цифрового дисплея 

Свойства объекта "Numeric Display" (цифровой дисплей) 
Объект позволяет читать значение регистра по заданному адресу и непосредственно отображать его 
в выбранном формате. 
Read Address 
(Адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.)  

Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и фона) 

Выбор цвета рамки доступен, только когда выбран стиль Raised или Sunken. На 
рис. показан стиль “Sunken”. Цвет фона – зеленый, цвет рамки  - красный. 

  
(Если выбран стиль "Transparent", опции выбора цвета рамки и фона будут 
недоступны.) 
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Свойства объекта "Numeric Display" (цифровой дисплей) 

Standard 
(стандартный) 

Raised     
(рельефный) 

Sunken 
(утопленный) 

Transparent 
(прозрачный) 

Style 
(Стиль) 

    

Leading Zero 
(Ноли в старших 
разрядах) 
 

Если данная опция выбрана, то будут отображаться все заданные разряды 
числа, а если нет – то только значащие. (На рис показано число с 4-мя 
заданными разрядами и 3-мя значащими.) 

    (Если выбрано YES, число будет отображаться как 0888) 

    (Если выбрано NO, число будет отображаться как 888) 

 
Date Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word (слово) Double Word (двойное слово) 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Integral Digits 
(Целая часть 
числа) 

Fractional Digits 
(Дробная часть 
числа) 

Здесь можно определить число цифр целой и дробной части 
числа. Это не влияет на само число, а служит только для 
индикации. Реальная десятичная точка будет только, когда 
выбран формат  “Floating”.  

Gain (a) 
(Усиление) 

Detail 
(Детали) 

Offset (b) 
(Смещение) 

Пользователь может с помощью данных коэффициентов 
преобразовать значение читаемого регистра в какую-либо 
прикладную величину (мм, м/с, л, см3, 0С и др.):  y = (a) x 
(read address value) + (b),  где (y) – число отображаемое на 
дисплее. Например, (a) = 2 , а  (b) = 3, значение читаемого 
регистра = 3, то на дисплее будет отображаться следующее 
число: (2) x 3 + (3) = 9. 
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Свойства объекта "Numeric Display" (цифровой дисплей) 

Round off 
(Округление) 

Если выбрана данная опция, после выполнения уравнения 
показанного выше, все числовые значения могут быть 
округлены и показаны на экране.  

Fast Refresh 
(Частота 
обновления) 

Если выбрана данная опция объект будет обновлять свое состояние 
немедленно при открытии данного экрана.  Однако, надо помнить, что только 4 
объекта на каждом экране могут обновлять свое состояние мгновенно. Выбрать 
скорость обновления экрана можно в меню Screen > Screen Properties. 
Доступно три уровня скорости обновления экрана: High (высокая), Medium 
(средняя) и Low (низкая).  

 Character Display – символьный дисплей 

Табл. 3.8.3 Описание свойств символьного дисплея 

Свойства объекта " Character Display" (символьный дисплей) 
Объект позволяет читать значение регистра по заданному адресу, конвертировать его в текст или 
символы и отображать на экране. Значение регистра должно быть в формате ASCII, иначе правильно 
отобразить текст или символы будет невозможно. (Макс. длина строки 28 слов.) 
Read Address 
(Адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.)  

Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style (Стиль) (См. табл. 3.8.2 описания свойств цифрового дисплея.) 

String Length 
(Длина строки) 

Диапазон: 1 ~ 28 символов. 

 
Если мы в качестве адреса чтения зададим регистр 0 внутренней памяти, т.е. 
$0, длину строки 5 и напишем следующий макрос (Screen Open Macro):  
$0 = 65 
$1 = 66 
$2 = 67 
$3 = 68 
$4 = 69 
Тогда на дисплее будут отображаться символы, как на вышеприведенном 
рисунке.  
Примечание: объект символьный дисплей читает значения из регистров 
байтами, а каждый регистр данных во внутренней памяти $ состоит из слова 
(Word=2 байта), следовательно, при чтении регистра с адресом $0, на дисплее 
будут отображаться: A(65)  (0) B(66)  (0) C(67)  (0)… и т.д.. 
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Fast Refresh 
(Частота 
обновления) 

Если выбрана данная опция объект будет обновлять свое состояние 
немедленно при открытии данного экрана.  Однако, надо помнить, что только 4 
объекта на каждом экране могут обновлять свое состояние мгновенно. Выбрать 
скорость обновления экрана можно в меню Screen > Screen Properties. 
Доступно три уровня скорости обновления экрана: High (высокая), Medium 
(средняя) и Low (низкая).  

 Date Display - дисплей даты 

Табл. 3.8.4 Описание свойств дисплея даты 

Свойства объекта "Date Display" (дисплей даты) 
Объект позволяет читать текущую дату часов реального времени HMI и отображать её на экране. 
Возможны несколько форматов отображения даты (см. табл.) 
Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style 
(Стиль) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на экране: 
MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-день, YY-год. 

 Time Display – дисплей времени 

Табл. 3.8.5 Описание свойств дисплея времени 

Свойства объекта "Time Display" (дисплей времени) 
Объект позволяет читать текущее время часов реального времени HMI и отображать его на экране. 
Возможны несколько форматов отображения времени (см. табл.)  
Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style 
(Стиль) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Time Format 
(Формат времени) 

Доступно для выбора два вида формата отображения времени на экране: 
HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-секунды. 

 Day-of-week Display - дисплей дня недели 

Табл. 3.8.6 Описание свойств дисплея дня недели 

Свойства объекта "Day-of-week Display" (дисплей дня недели) 
Объект позволяет отображать на экране название текущего дня недели с понедельника по 
воскресение (Sunday ~ Monday). По умолчанию названия дней недели написаны на английском языке 
как SUN, MON  … SAT, но пользователь может изменить как названия, так и язык в элементе Text для 
каждого из 7 возможных состояний регистра.  
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Text / Text Size 
Font / Text Color 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style 
(Стиль) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

 Prestored Message - предустановленное сообщение 

Табл. 3.8.7 Описание свойств предустановленного сообщения 

Свойства объекта "Prestored Message" (предустановленное сообщение) 
Объект позволяет читать значение регистра по заданному адресу, и в соответствии с ним отображать 
на экране предварительно установленный текст для каждого из возможных состояний. 
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См. 
табл. 3.2.2 описания свойств основных кнопок.) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style 
(Стиль) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Bit Битовый формат данных: индикатор может иметь только два 
состояния. 

Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 
состояния. 

Data Type 
(Тип данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа возможных состояний объекта, т.е.  
количество сообщений. До 256 состояний – при выборе формата WORD, 16 
состояний – при выборе формата LSB и 2 состояний – при выборе формата Bit.  

 Moving Sign – бегущая строка 

Табл. 3.8.8 Описание свойств бегущей строки 

Свойства объекта "Moving Sign" (бегущая строка) 

Объект позволяет читать значение регистра по заданному адресу, и в соответствии с ним отображать 
на экране предварительно установленный текст, для каждого из возможных состояний, в виде 
бегущей строки. 

Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См. 
табл. 3.2.2 описания свойств основных кнопок.) 
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Свойства объекта "Moving Sign" (бегущая строка) 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
объекте, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 
шрифты Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 

Border Color 
Background Color 
(Цвет рамки и фона) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Style 
(Стиль) 

(См. табл. 3.8.2 описания свойств цифрового дисплея.) 

Bit Битовый формат данных: индикатор может иметь только два 
состояния. 

Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 
состояния. 

Data Type 
(Тип данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа возможных состояний объекта, т.е.  
количество сообщений. До 256 состояний – при выборе формата WORD, 16 
состояний – при выборе формата LSB и 2 состояний – при выборе формата Bit.  

Left Текст на экране будет перемещаться справа налево. 

Right Текст на экране будет перемещаться слева направо. 

Top Текст на экране будет перемещаться снизу вверх. 

Direction 
(Направление 
движения текста) 

Bottom Текст на экране будет перемещаться сверху вниз. 

Moving Points 
(Шаг перемещения) 

Используется для задания величины шага каждого дискретного перемещения. 
Шаг задается в точках (Pixel) экрана в диапазоне 1 ~ 50 Pixels. 

Interval(ms) 
(Интервал времени 
перемещения) 

Используется для задания интервала времени между каждыми дискретными 
перемещениями. Интервал задается в миллисекундах (ms) в диапазоне 50 ~ 
3000 ms. 
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3.9 Объекты отображения графики (Graph Display) 

 
Рис. 3.9.1 Варианты объектов отображения графических элементов 

 

Табл. 3.9.1 Назначения объектов отображения графических элементов 

Название Значок Назначение 

State Graphic 
(Неподвижная 

графика) 
 

Используется для создания и отображения изменяющихся картинок, 
расположенных в точно определенном месте экрана HMI. Для каждого 
состояния может быть назначена своя картинка. 

Animated Graphic 
(Анимированная 

графика) 
 

Используется для создания и отображения изменяющихся картинок, 
местоположение которых на экране HMI, может изменяться  по осям X 
и Y, в зависимости от текущих значений определенных регистров. Для 
различных состояний могут быть назначены различные картинки. 

Dynamic Line 
(Подвижная линия)  

Используется для создания и отображения подвижной линии, размеры 
и местоположение которой на экране HMI, могут свободно изменяться, 
в зависимости от текущих значений определенных регистров.  

Dynamic Rectangle 
(Подвижный 

прямоугольник) 
 

Используется для создания и отображения подвижного 
прямоугольника, размеры и местоположение которого на экране HMI, 
могут свободно изменяться, в зависимости от текущих значений 
определенных регистров. 

Dynamic Ellipse 
(Подвижный 
эллипс) 

 

Используется для создания и отображения подвижного эллипса, 
размеры и местоположение которого на экране HMI, могут свободно 
изменяться, в зависимости от текущих значений определенных 
регистров. 

 Static Graphic – неподвижная графика 

Табл. 3.9.2 Описание свойств объекта Static Graphic 

Свойства объекта "Static Graphic" (неподвижная графика) 
Объект позволяет конвертировать значения читаемых регистров в неподвижные графические 
элементы, которые предварительно заданы для каждого из возможных состояний. Объект не 
изменяет свое местоположение и располагается в точно определенном месте экрана HMI. 
Read Address 
(адрес чтения) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См. 
табл. 3.2.2 описания свойств основных кнопок.) 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color (См. табл. 3.2.2 описания свойств основных кнопок.) 

Data Type Bit Битовый формат данных: индикатор может иметь только два 
состояния. 
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Свойства объекта "Static Graphic" (неподвижная графика) 

Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 
состояния. 

(Тип данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа возможных состояний объекта, т.е.  
количество различных изображений. До 256 состояний – при выборе формата 
WORD, 16 состояний – при выборе формата LSB и 2 состояний – при выборе 
формата Bit.  
No Если выбрана эта опция, значение читаемого регистра будет 

восприниматься как номер состояния объекта. Например, если 
значение регистра $0 = 0, на экране будет отображаться картинка, 
заданная для 0-го состояния; если значение регистра $0 = 5, на 
экране будет отображаться картинка, заданная для 5-го состояния.  

Yes Если выбрана эта опция, то значение читаемого регистра отличное 
от 0-го запустит автоматическое переключение состояний объекта, а 
следовательно и назначенных для них картинок. 

Auto Change 
(Авто изменение) 

Variation Если выбрана эта опция, значение читаемого регистра Read Address 
будет восприниматься как номер состояния объекта,  а значение 
регистра Read Address+1 отличное от 0-го запустит автоматическое 
переключение состояний объекта. 

Transparent 
(Прозрачный) 

Если выбрано Yes (да), то на индицируемом элементе можно убрать 
отображение какого-либо цвета, сделать прозрачным. Выбор удаляемого цвета 
можно задать в "transparent color" или инструментом пипетка . 

 Цвет "transparent color" еще не задан.  

  Цвет "transparent color" задан, как серый. 

 Цвет "transparent color" задан, как черный. 
Примечание: Если выбрано Yes (установка прозрачности), опция "foreground 
color" (цвет переднего плана) будет недоступна. 

Пример объекта неподвижной графики: 

Адрес чтения = D100.  С изменением его значения будет меняться картинка: 

                               

D100=1   D100=2   D100=3    D100=4   D100=5   D100=6   D100=7 
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 Animated Graphic – анимированная графика 

Табл. 3.9.3 Описание свойств объекта анимированной графики 

Свойства объекта "Animated Graphic" (анимированная графика) 
Объект позволяет конвертировать значения читаемых регистров в графические элементы, которые 
могут изменять как содержание, так и свое местоположение на экране HMI. 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.)  

Read Address Значение регистра Read Address используется для 
переключения состояния объекта.  

Read Address+1 Значение регистра Read Address+1 используется для 
задания координаты Х местоположения объекта, т.е. 
перемещения объекта по горизонтали. 

Read Address 
(адрес чтения) 

Read Address+2 Значение регистра Read Address+2 используется для 
задания координаты Y местоположения объекта, т.е. 
перемещения объекта по вертикали. 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Clear Picture 
(очистить картинку) 

Эта опция используется для удаления предыдущего состояния объекта. Если 
она не задана, то картинки всех предыдущих состояний будут оставаться на 
экране. 

Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 
состояния. 

Data Length 
(Тип данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа возможных состояний объекта, т.е.  
количество различных изображений. До 256 состояний – при выборе формата 
WORD, 16 состояний – при выборе формата LSB.  

Пример объекта анимированной графики:  

Адрес чтения = D100.  С изменением значения D100 будет меняться картинка, D101, D102 – её 

местоположение на экране: 

Регистр Dn выбирает картинку  

   Регистр Dn+1 перемещает картинку по координате Х   

                Регистр Dn+2 перемещает картинку по координате Y 
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 Dynamic Line – подвижная линия 

Табл. 3.9.4 Описание свойств объекта подвижная линия 

Свойства объекта "Dynamic Line" (подвижная линия) 
Используется для создания и отображения подвижной линии, размеры, цвет и местоположение 
которой на экране HMI, могут свободно изменяться, в зависимости от текущих значений 
определенных регистров.  

     
Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.) 

Значение регистра Read Address , когда опция Variable 
Position установлена как "Yes", используется для 
перемещения начала линии по горизонтали.  

Read Address 

Когда Variable Position установлена как "No", а опция 
Variable Color установлена как "Yes", значение регистра 
Read Address для изменения цвета линии в диапазоне 0 
~ 255.  

Read Address +1 Значение регистра Read Address+1, когда опция Variable 
Position установлена как "Yes", используется для 
перемещения начала линии по вертикали. 

Read Address +2 Значение регистра Read Address+2, когда опция Variable 
Position установлена как "Yes", используется для 
перемещения конца линии по горизонтали. 

Read Address +3 Значение регистра Read Address+3, когда опция Variable 
Position установлена как "Yes", используется для 
перемещения конца линии по вертикали. 

Read Address 
(адрес чтения) 

Read Address +4 Значение регистра Read Address+4 , когда опция Variable 
Color установлена как "Yes", используется для изменения 
цвета линии в диапазоне 0 ~ 255. 

Line Color 
(цвет линии) 

Используется для установки цвета подвижной линии. 

Twinkle (мигание) Если здесь выбрать Yes (да), то объект будет мигать.  

Line Size 
(Толщина линии) 

Используется для установки толщины подвижной линии в диапазоне 1 ~ 8 пикс. 

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 
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Свойства объекта "Dynamic Line" (подвижная линия) 

Line Style 
(Стиль линии) 
 

Доступны следующие стили подвижной линии: 

 
Variable Position 
(Изменение 
положения) 

(См. описание опции "Read Address" выше) 

Variable Color 
(Изменение цвета) 

(См. описание опции "Read Address" выше) 

 Dynamic Rectangle – подвижный прямоугольник 

Табл. 3.9.5 Описание свойств объекта подвижный прямоугольник 

Свойства объекта "Dynamic Rectangle" (подвижный прямоугольник) 
Используется для создания и отображения подвижного прямоугольника, размеры, цвет и 
местоположение которого на экране HMI, могут свободно изменяться, в зависимости от текущих 
значений определенных регистров.  

     
Используется для установки адреса чтения. Можно использовать адреса памяти
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.) 

Read Address Значение регистра Read Address , когда опция Variable 
Position установлена как "Yes", используется для 
перемещения прямоугольника по горизонтали.  

Read Address +1 Значение регистра Read Address+1 , когда опция Variable 
Position установлена как "Yes", используется для 
перемещения прямоугольника по вертикали.  

Read Address +2 Значение регистра Read Address+2 , когда опция Variable 
Size установлена как "Yes", используется для изменения 
размера прямоугольника по горизонтали.  

Read Address +3 Значение регистра Read Address+3 , когда опция Variable 
Size установлена как "Yes", используется для изменения 
размера прямоугольника по вертикали.  

Read Address 
(адрес чтения) 

Read Address +4 Значение регистра Read Address+4 , когда опция Variable 
Color установлена как "Yes", используется для изменения 
цвета заливки прямоугольника в диапазоне 0 ~ 255.  
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Свойства объекта "Dynamic Rectangle" (подвижный прямоугольник) 

Примечание: когда опция Variable Position установлена как "No", адреса будут 
распределяться следующим образом: Read Address будет использоваться для 
изменения размера прямоугольника по горизонтали; Read Address+1 будет 
использоваться для изменения размера прямоугольника по вертикали; Read 
Address+2 будет использоваться для изменения цвета заливки прямоугольника. 

Twinkle (мигание) Если здесь выбрать Yes (да), то объект будет мигать.  

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

Line Size 
(Толщина линий) 

Используется для установки толщины линий подвижного прямоугольника в 
диапазоне 1 ~ 8 пикс. 

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка прямоугольника. 
При этом опция "Foreground Color" будет недоступна.  

Round Radius 
(Радиус 
закругления) 

Используется для установки радиуса закругления углов прямоугольника в 
диапазоне 0~38 пикс.  

 
Variable Position 
(Изменение 
положения) 

(См. описание опции "Read Address" выше) 

Variable Size 
(Изменение 
размеров) 

(См. описание опции "Read Address" выше) 

Variable Color 
(Изменение цвета) 

(См. описание опции "Read Address" выше) 

 Dynamic Ellipse – подвижный эллипс 

Табл. 3.9.6 Описание свойств объекта подвижный эллипс 

Свойства объекта "Dynamic Ellipse" (подвижный эллипс) 
Используется для создания и отображения подвижного эллипса, размеры, цвет и местоположение 
которого на экране HMI, могут свободно изменяться, в зависимости от текущих значений 
определенных регистров. 
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Свойства объекта "Dynamic Ellipse" (подвижный эллипс) 

Используется для установки адреса чтения. Можно использовать адреса памяти 
внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal Memory). (См.
табл. 3.2.2 описания свойств основных кнопок.) 

Read Address Значение регистра Read Address , когда опция Variable 
Central Point установлена как "Yes", используется для 
перемещения эллипса по горизонтали (координата 
центра эллипса по оси X). 

Read Address +1 Значение регистра Read Address+1 , когда опция Variable 
Central Point установлена как "Yes", используется для 
перемещения эллипса по вертикали (координата центра 
эллипса по оси Y).  

Read Address +2 Значение регистра Read Address+2 , когда опция Variable 
Radius установлена как "Yes", используется для 
изменения размера радиуса эллипса по горизонтали.  

Read Address +3 Значение регистра Read Address+3 , когда опция Variable 
Radius установлена как "Yes", используется для 
изменения размера радиуса эллипса по вертикали. 

Read Address +4 Значение регистра Read Address+4 , когда опция Variable 
Color установлена как "Yes", используется для изменения 
цвета заливки эллипса в диапазоне 0 ~ 255.  

Read Address 
(адрес чтения) 

Примечание: когда опция Variable Central Point установлена как "No", адреса 
будут распределяться следующим образом: Read Address будет определять 
радиус по горизонтали; Read Address+1 будет определять радиус по вертикали; 
Read Address+2 будет определять цвет заливки эллипса. 

Line Color 
(цвет линий) 

Используется для установки цвета линий эллипса. 

Twinkle (мигание) Если здесь выбрать Yes (да), то объект будет мигать.  

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

Line Size 
(Толщина линий) 

Используется для установки толщины линий подвижного эллипса в диапазоне 1 
~ 8 пикс. 

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed Decimal, 
Unsigned Decimal и Hex), определяемых содержимое читаемой памяти. 

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка рамка. При этом 
опция "Foreground Color" будет недоступна.  

Variable Central 
Point 
(Изменение 
положения) 

(См. описание опции "Read Address" выше) 

Variable Radius 
(Изменение 
радиуса) 

(См. описание опции "Read Address" выше) 

Variable Color 
(Изменение цвета) 

(См. описание опции "Read Address" выше) 
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3.10 Объекты ввода данных (Input) 

 
Рис. 3.10.1 Варианты объектов ввода данных 

 

Данные объекты позволяют отображать и вводить данные в регистры. Адреса чтения и записи 

объекта могут быть различными, т.е. читать можно значение одного регистра, а записывать в другой. 

Табл. 3.10.1 Назначение объектов ввода данных 

Название Значок Назначение 

Numeric Entry 
(Ввод чисел)  

Используется для ввода и отображения числовых данных регистра 
PLC или HMI. 

Character Entry 
(Ввод символов)  

Используется для ввода и отображения символьных данных регистра 
PLC или HMI. 

 Numeric Entry – ввод чисел 

Табл. 3.10.2 Описание свойств объекта ввода числовых данных 

Свойства объекта "Numeric Entry" (ввод чисел)  

После нажатия на экране на данный объект, появится системное окно цифрового ввода (десятичная 
клавиатура), с помощью которой пользователь может набрать число и ввести его, нажав ENTER, 
непосредственно в регистр PLC. Максимальное и минимальное значения ввода могут быть 
определены пользователем. 

Write Address 
Read Address 
(Адрес чтения  
Адрес записи) 

Используются для установки адреса чтения и записи. Можно использовать 
адреса памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 
Примечание: если будет задан только адрес записи, то после компиляции 
программы HMI автоматически задаст адрес чтения такой же, как записи.  

Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и 
фона) 

Выбор цвета рамки доступен, только когда выбран стиль Raised или Sunken. На 
рис. показан стиль “ Rasied ”. Цвет фона – синий, цвет рамки  - красный. 

  
(Если выбран стиль "Transparent", опции выбора цвета рамки и фона будут 
недоступны.) 

Standard 
(стандартный) 

Raised     
(рельефный) 

Sunken 
(утопленный) 

Transparent 
(прозрачный) 

Style 
(Стиль) 
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Свойства объекта "Numeric Entry" (ввод чисел)  

Leading Zero 
(Ноли в старших 
разрядах) 
 

Если данная опция выбрана, то будут отображаться все заданные разряды 
числа, а если нет – то только значащие. (На рис показано число с 4-мя 
заданными разрядами и 2-мя значащими.) 

    (Если выбрано YES, число будет отображаться как 0077) 

   (Если выбрано NO, число будет отображаться как 77) 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения в регистр данным объектом и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим сброс
(OFF) операнда и повтор данной функции, это должно быть обеспечено в 
программе PLC. 

 
Date Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word (слово) Double Word (двойное слово) 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 

Minimum 

Maximum 

Здесь можно задать диапазон ввода данных (максимальное и
минимальное значения). 

Integral Digits 

Detail 
(Детали) 

Fractional Digits 

Здесь можно определить число цифр целой и дробной части 
числа. Это не влияет на само число, а служит только для 
индикации. Реальная десятичная точка будет только, когда 
выбран формат  “Floating”.  
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Свойства объекта "Numeric Entry" (ввод чисел)  

Когда выбрана опция Variable Minimum/Maximum Value, минимальное значение 
ввода будет определяться регистром Read Address+1, а максимальное - 
регистром Read Address+2. 

Gain (a) 
(Усиление) 

Offset (b) 
(Смещение) 

Пользователь может с помощью данных коэффициентов 
преобразовать значение читаемого регистра в какую-либо 
прикладную величину (мм, м/с, л, см3, 0С и др.):  y = (a) x 
(read address value) + (b),  где (y) – число отображаемое на 
дисплее. Например, (a) = 2 , а  (b) = 3, значение читаемого 
регистра = 3, то на дисплее будет отображаться следующее 
число: (2) x 3 + (3) = 9. При вводе числа в регистр будет 
производиться обратное преобразование. 

Round off 
(Округление) 

Если выбрана данная опция, после выполнения уравнения 
показанного выше, все числовые значения могут быть 
округлены и показаны на экране.  

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных параметров (мин. и макс. значения, размерность и 
формат данных, целую и дробную части). 

Input Mode 
(Режим ввода) 

Доступны три режима ввода: Touch Popup (ввод в спец. окне), Active Non-Popup 
(ввод с помощью объекта клавиатура, с предварительной разблокировкой 
ввода) и Touch Non-Popup (ввод с помощью объекта клавиатура). По умолчанию 
установлен режим Touch Popup. Для описания режима активного ввода (Active 
input), см. раздел 3.15 Keypad (Клавиатура).  

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Display Asterisk (*) 
(Отображение 
звездочек) 

Если данная опция выбрана (YES), то вводимое значение не будет 
отображаться на экране, а будут показаны только звездочки (*). 

 
Fast Refresh 
(Частота 
обновления) 

Если выбрана данная опция объект будет обновлять свое состояние 
немедленно при открытии данного экрана.  Однако, надо помнить, что только 4 
объекта на каждом экране могут обновлять свое состояние мгновенно. Выбрать 
скорость обновления экрана можно в меню Screen > Screen Properties. 
Доступно три уровня скорости обновления экрана: High (высокая), Medium 
(средняя) и Low (низкая).  

Set Low Security С помощью этой опции текущий уровень доступа может быть понижен после 
ввода. Используется для предотвращения возможных ошибок (операторами).  

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса блокировки 
"InterLock Address " изменит свое состояние с Low на High (или с High на Low, 
это определяется опцией “InterLock Level” (уровень блокировки)), объект будет 
разблокирован.   

Before Execute 
Macro 

Когда эта опция установлена, введенный здесь макрос будет выполнен до ввода 
значения в регистр.  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
ввода значения в регистр.  
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Пример ввода числовых данных:  

После нажатия на объект числового ввода на экране появится диалоговое окно с цифровой 

клавиатурой "Numeric keypad". Пользователь может набрать требуемое значение и ввести его в 

регистр PLC. В данном примере число 99 будет введено в регистр D100. 

 
Рис. 3.10.2 Диалоговое окно "Numeric keypad" 

 Character Entry – ввод символов 

Табл. 3.10.3 Описание свойств объекта ввода символьных данных 

Свойства объекта "Character Entry" (ввод символов)  

Объект позволяет читать и писать символьные (буквенно-цифровые) данные в регистр по заданному 
адресу. Значение регистра должно быть в формате ASCII, иначе правильно отобразить текст или 
символы будет невозможно. (Макс. длина строки 28 слов.)  

Write Address 
Read Address 
(Адрес чтения  
Адрес записи) 

Используются для установки адреса чтения и записи. Можно использовать 
адреса памяти внешнего ПЛК (Base Port) или внутренней памяти HMI (Internal 
Memory). (См. табл. 3.2.2 описания свойств основных кнопок.) 
Примечание: если будет задан только адрес записи, то после компиляции 
программы HMI автоматически задаст адрес чтения такой же, как записи.  

Text Size 
Text Color 

Пользователь может установить размер и цвет шрифта объекта. HMI 
предоставляет выбор размера из диапазона 8~64, тип шрифта используется, 
установленный по умолчанию. 

Border Color 
Background Color 
(Цвет рамки и фона) 

Выбор цвета рамки доступен, только когда выбран стиль Raised или Sunken. 
На рис. показан стиль “ Rasied ”. Цвет фона – синий, цвет рамки  - серый.  

  
(Если выбран стиль "Transparent", опции выбора цвета рамки и фона будут 
недоступны.) 

Style Standard 
(стандартный) 

Raised     
(рельефный) 

Sunken 
(утопленный) 

Transparent 
(прозрачный) 
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Свойства объекта "Character Entry" (ввод символов)  
(Стиль) 

    

Character Length 
(Длина строки) 

Диапазон: 1 ~ 28 символов. По умолчанию 4 символа. 

Trigger 
Trigger Mode 

Здесь пользователь может назначить битовый операнд PLC, который будет 
включен при записи значения в регистр данным объектом и момент его 
включения (до или после записи значения). Примечание: Эта функция может 
установить битовый операнд PLC только в состояние ON. Если необходим 
сброс (OFF) операнда и повтор данной функции, это должно быть обеспечено 
в программе PLC. 

Input Mode 
(Режим ввода) 

Доступны три режима ввода: Touch Popup (ввод в спец. окне), Active Non-
Popup (ввод с помощью объекта клавиатура, с предварительной 
разблокировкой ввода) и Touch Non-Popup (ввод с помощью объекта 
клавиатура). По умолчанию установлен режим Touch Popup. Для описания 
режима активного ввода (Active input), см. раздел 3.15 Keypad (Клавиатура).  

User Security Level Используется для установки уровня доступа к данному объекту. Для объекта 
можно установить только более высокий уровень доступа, чем текущий. 

Display Asterisk (*) 
(Отображение 
звездочек) 

Если данная опция выбрана (YES), то вводимое значение не будет 
отображаться на экране, а будут показаны только звездочки (*). 

 
Fast Refresh 
(Частота обновления) 

Если выбрана данная опция объект будет обновлять свое состояние 
немедленно при открытии данного экрана.  Однако, надо помнить, что только 
4 объекта на каждом экране могут обновлять свое состояние мгновенно. 
Выбрать скорость обновления экрана можно в меню Screen > Screen 
Properties. Доступно три уровня скорости обновления экрана: High (высокая), 
Medium (средняя) и Low (низкая).  

Set Low Security С помощью этой опции текущий уровень доступа может быть понижен после 
ввода. Используется для предотвращения возможных ошибок (операторами). 

InterLock Address 
InterLock Level 

Эта функция позволяет блокировать объект. Когда операнд адреса 
блокировки "InterLock Address " изменит свое состояние с Low на High (или с 
High на Low, это определяется опцией “InterLock Level” (уровень блокировки)), 
объект будет разблокирован.   

Before Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен до 
ввода значения в регистр.  

After Execute Macro Когда эта опция установлена, введенный здесь макрос будет выполнен после 
ввода значения в регистр.  
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Пример ввода символьных данных:  

После нажатия на объект числового ввода на экране появится диалоговое окно с буквенно-

цифровой клавиатурой " ASCII-KEY". Пользователь может набрать требуемый текст и ввести его 

в регистры (D1000~Dn) PLC в формате ASCII, где n – число вводимых символов. 

 

 

 

 
Рис. 3.10.3 Диалоговое окно "ASCII-KEY" 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Глава 3.  Описание объектов 

3-56              НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

3.11 Объекты построения графиков (Curve) 

 
Рис. 3.11.1 Варианты объектов построения графиков 

 

Табл. 3.11.1 Назначения объектов построения графиков 

Название Значок Назначение 

Trend Graph 
(Тренд-график)  

Последовательное чтение значений регистров из PLC, преобразование 
их в однонаправленные кривые (тренды) для отображения на экране HMI. 
Значения читаемых регистров будут определять координаты точек только 
по оси Y.  

X-Y Chart 
(Двухкоорд. 
график)  

Последовательное чтение значений регистров из PLC, преобразование 
их в двухкоординатный XY график для отображения на экране HMI. 
Значения читаемых регистров будут определять координаты точек по 
осям X и Y.  

 Trend Graph - тренд 

Табл. 3.11.2 Описание свойств тренд-графиков 

Свойства объекта "Trend Graph" (тренд)  

Первым шагом установки тренд-графика надо задать количество отображаемых кривых в опции 
“Curve Field Total” (диапазон: 1~4) в таблице свойств. Затем задать адрес чтения, формат чтения, 
толщину и цвет кривой в опции “Detail Setup”. 
HMI будет конвертировать значения регистров, начиная с заданного адреса, в однонаправленные 
кривые (тренды) и отображать их на экране. Например, если выбрано 100 точек и 4 кривых, то всего 
будет 100 X 4 = 400 точек (опрашиваемых регистров). Если HMI связана с Delta PLC, и "read address" 
выбран как D0, будут читаться значения из 400 регистров (D0~D399) после команды запуска. 
Значения регистров D0~D99 будут определять координаты точек по Y кривой 1, D100~D199 - 
координаты точек по Y кривой 2, D200~D299 - координаты точек по Y кривой 3,  D300~D399 - 
координаты точек по Y кривой 4. Если значение регистра превышает заданное максимальное 
значение, на экране будет отображаться максимальное значение. Если значение регистра меньше 
заданного минимального значения, на экране будет отображаться минимальное значение. Для 
активации процесса построения графиков на экране пользователь должен записать бит в 
соответствующий адрес блока управления (control block), запускающий перевод считанных данных в 
тренды и отображение их на экране. См. главу 5 для описания блока управления (control block). 

Border Color 
Background Color 
(Цвет рамки и 
фона) 

Выбор цвета рамки доступен, только когда выбран стиль Raised или Sunken. На 
рис. показан стиль “ Rasied ”. Цвет фона – черный, цвет рамки  - серый.  

  
Standard  

(стандартный) 
Raised      

(рельефный) 
Sunken  

(утопленный) 
Style 
(Стиль) 
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Свойства объекта "Trend Graph" (тренд)  

Curve Field Total 
(Полное число 
кривых) 

На одном объекте можно отображать 1~4 кривых (тренда).  

 
Sample Number 
(число точек 
кривой) 

Max. Sample 
Number 
(макс. число 
точек кривой) 

Когда число точек кривой - константа: макс. число точек кривой 
определяется следующим образом:  
1. Если выбран стиль объекта как “Standard”, то макс. число 

точек кривой определяется шириной объекта в пикселях. 
2. Если выбран стиль объекта как “Raised” или “Sunken”, то 

макс. число точек кривой определяется шириной объекта 
минус ширина рамки (14 пикс.): 

 
Имейте ввиду, что когда число точек кривой константа, то 
опция Max. Sample Number не доступна для изменения.  
Когда число точек кривой - переменная: макс. число точек кривой 
определяется значением регистра Read Address+1. В этом 
случае опция Max. Sample Number будет доступна для 
изменения. Если читаемое значение точек кривой больше, чем 
Max. Sample Number, то число точек кривой будет определяться 
Max. Sample Number.  

Word (слово) Read Format 
(Формат чтения) 
 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Read Address 
(Адрес чтения) 

Используется для установки адреса чтения. Можно использовать 
адреса памяти внешнего ПЛК (Base Port) или внутренней памяти 
HMI (Internal Memory) 

Detail Setup 
(Установка 
деталей) 

Sample Flag 
(Флаг выборки) 

Используется для выбора номера флага выборки в блоке 
управления, которым будет запускать перевод считанных данных 
в тренды и отображение их на экране. См. главу 5 для описания 
блока управления (control block). 
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Свойства объекта "Trend Graph" (тренд)  

Minimum 

Maximum 

Здесь можно задать диапазон отображения данных 
(максимальное и минимальное значения по оси Y). Если 
значение регистра превышает заданное максимальное значение, 
на экране будет отображаться максимальное значение. Если 
значение регистра меньше заданного минимального значения, на 
экране будет отображаться минимальное значение.  

Curve Width 
(Толщина 
кривой) 

Используется для задания толщины кривой в диапазоне 1 ~ 8 
пикс. 

Curve Color 
(Цвет кривой) 

Используется для задания цвета кривой.  

Grid Color 
(Цвет сетки) 

Grid Number in 
Horiz. (Число 
горизонтальных 
линий сетки) 

См. нижеприведенный рис. Здесь выбран красный цвет сетки и 3 горизонтальные 
полосы. 

 

 

 X-Y Chart – двухкоординатный график 

Табл. 3.11.3 Описание свойств двухкоординатного графика 

Свойства объекта "X-Y Chart" (двухкоординатный график)  

HMI будет конвертировать значения регистров, начиная с заданного адреса, в двухкоординатный XY 
графики и отображать их на экране HMI. Значения читаемых регистров будут определять координаты 
точек по осям X и Y.  
Например, если выбрано 100 точек и 4 кривых, то всего будет 100 x 4 x 2 = 800 точек (опрашиваемых 
регистров). Если HMI связана с Delta PLC, и адрес чтения по оси X выбран как D0, а адрес чтения по 
оси Y выбран как D500, будут читаться значения из 800 регистров (D0~D399 и D500~D899) после 
команды запуска. Значения регистров D0~D99 будут определять координаты по оси X кривой 1. 
Значения D500~D599 будут определять координаты по оси Y кривой 1. Значения регистров 
D100~D199 будут определять координаты по оси X кривой 2. Значения D600~D699 будут определять 
координаты по оси Y кривой 2. Значения регистров D200~D299 будут определять координаты по оси 
X кривой 3. Значения D700~D799 будут определять координаты по оси Y кривой 3. Значения 
регистров D300~D399 будут определять координаты по оси X кривой 4. Значения D800~D899 будут 
определять координаты по оси Y кривой 4. Если значение регистра превышает заданное 
максимальное значение, на экране будет отображаться максимальное значение. Если значение 
регистра меньше заданного минимального значения, на экране будет отображаться минимальное 
значение. Для активации процесса построения графиков на экране пользователь должен записать 
бит в соответствующий адрес блока управления (control block), запускающий перевод считанных 
данных в X-Y графики и отображение их на экране. См. главу 5 для описания блока управления 
(control block). 

Border Color 
Background Color 
(Цвет рамки и 
фона) 

Выбор цвета рамки доступен, только когда выбран стиль Raised или Sunken. На 
рис. показан стиль “ Rasied ”. Цвет фона – желтый, цвет рамки  - серый.  
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Свойства объекта "X-Y Chart" (двухкоординатный график)  

Standard  
(стандартный) 

Raised      
(рельефный) 

Sunken  
(утопленный) 

Style 
(Стиль) 

   
Connect Two 
Points 
(Соединять две 
точки) 

Если выбрана данная опция, при построении X-Y графика на экране две соседние 
точки будут соединены линией. 

Curve Field Total 
(Полное число 
кривых) 

На одном объекте можно отображать 1~4 кривых.  

 
Sample Number 
(число точек 
кривой) 

Detail Setup 
(Установка 
деталей) 

Max. Sample 
Number 
(макс. число 
точек кривой) 

Когда число точек кривой - константа: макс. число точек кривой 
определяется следующим образом:  
3. Если выбран стиль объекта как “Standard”, то макс. число 

точек кривой определяется шириной объекта в пикселях. 
1. Если выбран стиль объекта как “Raised” или “Sunken”, то 

макс. число точек кривой определяется шириной объекта 
минус ширина рамки (14 пикс.): 

 
Имейте ввиду, что когда число точек кривой константа, то 
опция Max. Sample Number не доступна для изменения.  
Когда число точек кривой - переменная: макс. число точек кривой
определяется значением регистра Read Address+1. В этом 
случае опция Max. Sample Number будет доступна для 
изменения. Если читаемое значение точек кривой больше, чем
Max. Sample Number, то число точек кривой будет определяться
Max. Sample Number. 
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Свойства объекта "X-Y Chart" (двухкоординатный график)  

Word (слово) Read Format 
(Формат чтения) 
 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 

Horiz. Read 
Address 
(Адрес чтения 
по оси X) 

Используется для установки адреса чтения координат точек по 
оси X. Можно использовать адреса памяти внешнего ПЛК (Base 
Port) или внутренней памяти HMI (Internal Memory) 

Vert. Read 
Address 
(Адрес чтения 
по оси Y) 

Используется для установки адреса чтения координат точек по 
оси Y. Можно использовать адреса памяти внешнего ПЛК (Base 
Port) или внутренней памяти HMI (Internal Memory)  

Sample Flag 
(Флаг выборки) 

Используется для выбора номера флага выборки в блоке 
управления, которым будет запускать перевод считанных данных 
в X-Y графики и отображение их на экране. См. главу 5 для 
описания блока управления (control block). 

Horiz. Minimum 

Horiz. Maximum 

Здесь можно задать диапазон отображения данных 
(максимальное и минимальное значения) по оси Х. Если 
значение регистра превышает заданное максимальное значение, 
на экране будет отображаться максимальное значение. Если 
значение регистра меньше заданного минимального значения, на 
экране будет отображаться минимальное значение.  

Horiz. Minimum 

Horiz. Maximum 

Здесь можно задать диапазон отображения данных 
(максимальное и минимальное значения) по оси Y. Если 
значение регистра превышает заданное максимальное значение, 
на экране будет отображаться максимальное значение. Если 
значение регистра меньше заданного минимального значения, на 
экране будет отображаться минимальное значение.  

Curve Width 
(Толщина 
кривой) 

Используется для задания толщины кривой в диапазоне 1 ~ 8 
пикс. 

Curve Color 
(Цвет кривой) 

Используется для задания цвета кривой.  

Grid Color 
(Цвет сетки) 

Horiz. Line Number 
(Число 
горизонтальных 
линий сетки) 

Vert. Line Number 
(Число 
вертикальных 
линий сетки) 

См. нижеприведенный рис. Здесь выбран красный цвет сетки и по 2 
горизонтальные и вертикальные полосы. 
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3.12 Объекты дискретизации данных (Sampling) 

 
Рис. 3.12.1 Варианты объектов дискретизации 

Объекты данной группы предназначены для отображения на экране информации из архива данных 

(history data) в виде таблиц или графиков. При использовании объектов дискретизации надо 

предварительно настроить функцию "History Setup" (см. так же стр. 2-132). Выберите ”Option” > 

“History Setup” в строке меню и выполните необходимые настройки в открывшемся диалоговом окне.  

 

Табл. 3.12.1 Диалоговое окно настройки архива данных "History Setup" 

Диалоговое окно "History Setup" (настройка архива данных) 

 
Нажатием на кнопку "Append" можно создать новый архив данных. Максимально может 
быть создано 12 архивов данных. После нажатия на кнопку "Append", откроется 
диалоговое окно свойств (Buffer Properties): 

 

Append 
(добавить) 

Read Address Стартовый адрес регистров данных для выборки в архив. 
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Диалоговое окно "History Setup" (настройка архива данных) 

Data Length 
(Word) 

Количество регистров (слов), данные из которых будут записываться в 
архив. Диапазон: 1 ~ 13 слов, расположенных друг за другом, т.е. в 
один архив могут записываться данные максимально из 13-ти 
последовательных словных регистров. 
Например: Если количество данных (Data Length) установлено как 6, 
будет осуществляться выборка из 6 последовательных слов (D100, 
D101, …, D105). Опция Sample Number используется для задания 
максимального числа выборок в архиве. Если Sample Number = 100, 
система будет опрашивать 6 слов x 100 = 600 регистров данных 
одновременно хранящихся в архиве. 

Cycle (ms) 
(Цикл выборки) 

Время цикла выборки данных из регистров (определяется период 
считывания). Если установлен флаг команды записи данных от PLC, 
эта опция будет не активна. Диапазон: 0 ~ 86400000 мс. 

Sample Number 
(объем 
выборки) 

Эта опция используется совместно с опцией "Auto Stop". Если флаг 
"Auto Stop" установлен, HMI будет останавливать запись данных в 
архив, когда число выборок достигнет заданного здесь числа. Если 
флаг "Auto Stop" не установлен, запись данных будет продолжаться 
даже при превышении заданного объема выборки, при этом данные, 
записанные первыми будут удаляться, а новые записываться на 
освободившееся места. Например, если объем выборки = 100, то при 
превышении ста выборок в архиве, данные первой выборки будут 
удалены и вторая выборка станет первой, третья выборка станет 
второй…и 100-я станет 99-й. Следовательно, новая выборка (101-я) 
станет 100-й. 

Stamp Time and 
Date 

Эта опция определяет: будет ли фиксироваться в архиве время и дата 
каждой выборки. 

Auto Stop Если флаг "Auto Stop" установлен, HMI будет останавливать запись 
данных в архив, когда число выборок достигнет заданного объема 
выборки (Sample Number). 

Non-Volatile Использование этой опции разрешает сохранять архив данных в 
энергонезависимой памяти (SRAM). Объем памяти для хранения 
архива данных в DOP-A 240Mбайт, а в DOP-AE 360Mбайт. (Данные в 
SRAM хранятся с помощью батарейки.) (В некоторых моделях HMI, 
данные можно сохранять на USB-Disk или SMC-card. Объем памяти 
архива данных в этом случае будет определяться объемом памяти 
USB Disk или SMC-card.) 

Trigger Задание режима записи данных в архив: Timer (через заданные 
промежутки времени) или PLC (по команде от ПЛК). Когда выбрана 
опция записи данных в архив по команде PLC, каждая выборка будет 
осуществляться активацией определенного бита в блоке управления 
(control block). 

OK / Cancel Нажмите кнопку "OK" для сохранения настроек и выхода из окна 
свойств. Нажмите кнопку "Cancel" для выхода из окна свойств без 
сохранения текущих настроек.  

Delete Нажатием кнопки "Delete" можно удалить выбранный архив данных.  

Modify Нажатием кнопки "Modify" можно отредактировать выбранный архив данных.  
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 Historical Trend Graph – график архивных данных (хронологический тренд) 

Табл. 3.12.2 Описание свойств хронологических трендов 

Описание свойств объекта "Historical Trend Graph" (хронологический тренд)  
Объект используется для конвертирования архива данных (history data) в непрерывные кривые 
трендов и отображения их на экране HMI. 
Border Color 
Background Color 
(Цвет рамки и 
фона) 

На рис. показан цвет фона – черный, цвет рамки  - серый.  

 
Curve Number 
(Число кривых) 

На одном объекте можно отображать 1~8 кривых (трендов).  

 
Logging Buffer 
(Логин-буфер) 

Опция используется для выбора номера(No.1 ~ No.X) 
хронологического буфера для чтения данных от PLC из 
соответствующих адресов. Пользователь может нажать кнопку 
"History Buffer Setup" или выбрать ”Option” > “History Setup” в строке 
меню для настройки буфера. 

Word (слово) 

Detail 
(Детали) 

Data Format 
(Формат 
данных) 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Floating 
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Описание свойств объекта "Historical Trend Graph" (хронологический тренд)  

 Если выбрать формат данных с плавающей запятой 
“Floating”, опция "Data Length" диалогового окна настройки 
архива данных должно быть больше или равно 2 слова, иначе 
появится следующее предупреждение:  

 
Minimum 

Maximum 

Здесь можно задать диапазон отображения данных (максимальное 
и минимальное значения по оси Y). Если значение регистра 
превышает заданное максимальное значение, на экране будет 
отображаться максимальное значение. Если значение регистра 
меньше заданного минимального значения, на экране будет 
отображаться минимальное значение.  

Integral Digits 

Fractional 
Digits 

Здесь можно определить число цифр целой и дробной части 
числа. Это не влияет на само число, а служит только для 
индикации. Реальная десятичная точка будет только, когда выбран 
формат  “Floating”.  

Time/Date (время и дата) 

Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени на 
экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-секунды.

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения даты и времени. 

Curve (No.1 ~ 8) (номера кривых) 

Enable 
(разрешить) 

Эта команда разрешает отображение кривой на экране и делает 
доступными нижеприведенные опции.  

Data No. 
(Номер 
данных) 

Используется для задания номера читаемого слова (Word) данных 
для выбранной кривой. Например, если длина читаемых данных 
(Data Length) в диалоговом окне "History Setup" задана как 3 слова, 
то здесь можно будет выбрать одно из читаемых слов 0 ~ 2. Если 
выбрать 1, то кривая Curve 1 будет строиться из данных регистра с 
адресом Read Address+1 архива данных. 
Если выбран формат данных с плавающей запятой “Floating”, 
в опции Data No. следует устанавливать только нечетные 
номера.   

Curve Width Используется для задания толщины кривой в диапазоне 1 ~ 8 пикс.

Curve Color Используется для задания цвета кривой.  

Grid Color 
(Цвет сетки) 

Grid Number 
(Число линий 
сетки) 

См. нижеприведенный рис. Здесь выбран красный цвет сетки и 3 горизонтальные 
полосы. 
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Пример построения хронологического тренда:  

 
Рис. 3.12.2 График архивных данных 

 Historical Data Table – таблица архивных данных (хронологическая таблица данных) 

Табл. 3.12.3 Описание свойств хронологической таблицы 

Свойства объекта "Historical Data Table" (хронологическая таблица)  
Объект используется для представления архива данных (history data) на экране HMI в виде таблицы. 
Длина читаемых данных (Data Length) может быть в диапазоне 1 ~ 8 слов. Число столбцов данных в 
таблице (Data No.) в диалоговом окне "History Data Detail" будет соответствовать длине 
опрашиваемых данных и заданному числу столбцов. Например, если Data Length = 5, а Data No. 
можно будет выбрать так же 5. 
Border Color 
Background Color 
(Цвет рамки и 
фона) 

На рис. показан цвет фона – зеленый, цвет рамки  - серый.  

 
Data Field Number 
(Число столбцов 
данных) 

На одном объекте можно отображать 1~8 столбцов данных. 
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Свойства объекта "Historical Data Table" (хронологическая таблица)  

 
Logging Buffer 
(Логин-буфер) 

Опция используется для выбора номера(No.1 ~ No.X) 
хронологического буфера, данные из которого будут здесь 
использоваться. Пользователь может нажать кнопку "History Buffer 
Setup" или выбрать ”Option” > “History Setup” в строке меню для 
настройки буфера. 

Time/Date (время и дата) 

Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени на 
экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-секунды.

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения даты и времени. 

Data No. (No. 1~8) (номер столбца данных) 

Date Length 
 

Размерность данных: 16-битное слово и 32-битное двойное слово. 

Доступны различные виды формата представления данных: 

Word (слово) Double Word (двойное слово) 

Detail 
(Детали) 

Data Format 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 

1. BCD 
2. Signed BCD 
3. Signed Decimal 
4. Unsigned Decimal 
5. Hex 
6. Binary 
7. Floating 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   3-67 

Свойства объекта "Historical Data Table" (хронологическая таблица)  

Data No. 
(Номер 
данных) 

Используется для задания номера читаемого слова (Word) данных 
для выбранного столбца таблицы. Например, если длина 
читаемых данных (Data Length) в диалоговом окне "History Setup" 
задана как 3 слова, то здесь можно будет выбрать одно из 
читаемых слов 0 ~ 2. Если выбрать 1, то в столбце 1 будут 
отображаться данные регистра с адресом Read Address+1 архива 
данных. 
Если выбран формат данных с плавающей запятой “Floating”, 
в опции Data No. следует устанавливать только нечетные 
номера.   

Display Color Используется для задания цвета чисел в столбце.  

Integral Digits 

Fractional 
Digits 

Здесь можно определить число цифр целой и дробной части 
числа. Это не влияет на само число, а служит только для 
индикации. Реальная десятичная точка будет только, когда выбран 
формат  “Floating”.  

Пример создания хронологической таблицы:  

 
Рис. 3.12.3 Таблица архивных данных 

 

 Historical Event Table – таблица архива событий 

Табл. 3.12.4 Описание свойств таблицы архива событий 

Свойства объекта "Historical Event Table" (таблица архива событий)  

Объект используется для конвертирования архива данных (history data) в текстовые сообщения и 
отображения их на экране HMI в виде таблицы. 

Text / Text Size 
Font / Text Color 
(Тип/размер/цвет 
шрифта) 

Здесь пользователь может написать текст для каждого из состояний 
опрашиваемого регистра, который будет отображаться на объекте, выбрать 
тип, размер и цвет шрифта текста. Для выбора доступны все шрифты 
Windows®. (См. табл. 3.2.2 описания свойств основных кнопок.) 
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Свойства объекта "Historical Event Table" (таблица архива событий)  

Border Color 
Background Color 
(Цвет рамки и фона) 

На рис. показан цвет фона – желтый, цвет рамки  - серый.  

 
Word 16-ти битный формат данных: индикатор может иметь от 1 до 256 

состояния. 
Data Length 
(Тип данных) 

LSB Индикатор может иметь от 1 до 16 состояния.  

Data Format 
(Формат данных) 

Можно выбрать один из 4-х видов представления данных (BCD, Signed 
Decimal, Unsigned Decimal и Hex), определяемых содержимое читаемой 
памяти. 

Add/Remove State 
(Добавить/удалить 
состояние) 

Используется для установки числа возможных состояний объекта, т.е.  
количество различных сообщений. До 256 состояний – при выборе формата 
WORD, 16 состояний – при выборе формата LSB и 2 состояний – при выборе 
формата Bit.  

 
Logging Buffer 
(Логин-
буфер) 

Опция используется для выбора номера(No.1 ~ No.X) 
хронологического буфера, данные из которого будут здесь 
использоваться. Пользователь может нажать кнопку "History 
Buffer Setup" или выбрать ”Option” > “History Setup” в строке 
меню для настройки буфера. 

Data No. 
(Номер 
данных) 

Используется для задания номера читаемого слова (Word) 
данных для отображения в таблице. Например, если длина 
читаемых данных (Data Length) в диалоговом окне "History 
Setup" задана как 3 слова, то здесь можно будет выбрать одно 
из читаемых слов 0 ~ 2. Если выбрать 1, то в таблице будут 
отображаться события определяемые регистром с адресом 
Read Address+1 архива данных. 

Time/Date (время и дата) 

Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени 
на экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-
секунды. 

Detail 
(Детали) 

Date Format 
(Формат 
даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 
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Свойства объекта "Historical Event Table" (таблица архива событий)  

Color 
(Цвет) 

Здесь можно выбрать цвет отображения даты и времени. 

Пример создания таблицы архива событий:  

1. D1000=0   

2. D1000=1   

3. D1000=2   

4. D1000=3   

5. D1000=4   

6. D1000=5   

7. D1000=6   

 
Рис. 3.12.4 Таблица архива событий 
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3.13 Объекты тревожной сигнализации (Alarm) 

 
Рис. 3.13.1 Варианты объектов тревожной сигнализации 

При использовании объектов тревожной сигнализации надо предварительно настроить функцию " 

Alarm Setup " (см. так же стр. 2-129). Выберите ”Option” > “ Alarm Setup ” в строке меню и выполните 

необходимые настройки в открывшемся диалоговом окне. 

Табл. 3.13.1 Назначение объектов "Alarm" 

Название Значок Назначение 

Alarm History Table 
(Таблица архива 

аварий) 
 

Объект позволяет сканировать через фиксированные промежутки 
времени состояние определенного операнда и при изменении его 
состояния, записывать в таблицу предустановленные сообщения с 
указанием времени возникновения и пропадания данного события.  

Active Alarm List 
(Список активных 

аварий) 
 

Объект позволяет сканировать через фиксированные промежутки 
времени состояние определенного операнда и при изменении его 
состояния, выводить на дисплей только текущие аварийные 
сообщения с указанием их времени возникновения.  

Alarm Frequency Table 
(Таблица частоты 

аварий) 
 

Объект позволяет подсчитывать число возникновения заданных 
аварий и отображать эту информацию на дисплее. 

Alarm Moving Sign 
(Сигнализация 

бегущей строкой) 
 

Объект позволяет сканировать через фиксированные промежутки 
времени состояние определенного операнда и при изменении его 
состояния, выводить на дисплей текущие аварийные сообщения 
бегущей строкой. 

 Alarm History Table – таблица архива аварий 

Табл. 3.13.2 Описание свойств хронологической таблицы аварий 

Описание свойств объекта "Alarm History Table" (таблица архива аварий)  
Объект позволяет сканировать через фиксированные промежутки времени состояние читаемого 
операнда и при изменении его состояния, записывать в таблицу предустановленные сообщения с 
указанием времени возникновения и пропадания данного события.  
Background Color 
(Цвет фона) 

На рис. показан цвет фона – белый и темно-зеленый.  

  Белый цвет фона. 

 Темно-зеленый цвет фона. 
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Описание свойств объекта "Alarm History Table" (таблица архива аварий)  

 
Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени на 
экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-секунды.

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 

Alarm Number 
(Номер 
аварии) 

Если выбрана данная опция, в таблице архива аварий будут 
фиксироваться порядковые номера аварийных сообщений в 
соответствие с диалоговым окном настройки аварий (Alarm Setup) 
как показано на рис.: 

 

 

Detail 
(Детали) 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения порядкового номера, даты 
и времени. 

 Active Alarm List - список активных аварий 

Табл. 3.13.3 Описание свойств списка активных аварий 

Описание свойств объекта "Active Alarm List" (список активных аварий) 
Объект позволяет сканировать через фиксированные промежутки времени состояние читаемого 
операнда и при изменении его состояния, выводить на дисплей текущие аварийные сообщения в 
виде списка.  
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Описание свойств объекта "Active Alarm List" (список активных аварий) 

Background 
(Цвет фона) 

На рис. показан цвет фона – белый и желтый.  

 Белый цвет фона. 

 Желтый цвет фона. 

 
Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени на 
экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-секунды.

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 

Alarm Number 
(Номер 
аварии) 

Если выбрана данная опция, в списке активных аварий будут 
фиксироваться порядковые номера аварийных сообщений в 
соответствие с диалоговым окном настройки аварий (Alarm Setup) 
как показано на рис.: 

 

Detail 
(Детали) 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения порядкового номера, даты 
и времени. 

 Alarm Frequency Table – таблица частоты аварий 

Табл. 3.13.4 Описание свойств таблицы частоты аварий 

Описание свойств объекта "Alarm Frequency Table" (таблица частоты аварий)  
Объект позволяет подсчитывать число возникновения заданных аварий и отображать эту 
информацию на дисплее справа от текста аварийного сообщения. 
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Описание свойств объекта "Alarm Frequency Table" (таблица частоты аварий)  

Background Color 
(Цвет фона) 

На рис. показан цвет фона – белый и желтый. 

  Белый цвет фона. 

 Желтый цвет фона. 

 
Time Format 
(Формат времени) 

Доступно для выбора два вида формата отображения 
времени на экране: HH:MM:SS, HH:MM, где HH-часы, MM-
минуты, SS-секунды. 

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты 
на экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, 
DD-день, YY-год. 

Alarm Number 
(Номер аварии) 

Если выбрана данная опция, в таблице частоты аварий будут 
фиксироваться порядковые номера аварийных сообщений в 
соответствие с диалоговым окном настройки аварий (Alarm 
Setup) как показано на рис.: 

Display for Counting 
Zero 
(Отображение не 
случившихся 
аварий) 

Эта опция позволяет разрешить/запретить отображение 
аварийных сообщений в таблице, число возникновений 
которых равно нолю.  

Detail 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения порядкового номера, 
даты и времени. 

 Alarm Moving Sign - сигнализация бегущей строкой 

Табл. 3.13.5 Описание свойств бегущей строки активных аварий 

Описание свойств объекта "Alarm Moving Sign" (сигнализация бегущей строкой)  

Объект позволяет сканировать через фиксированные промежутки времени состояние читаемого 
операнда и при изменении его состояния, выводить на дисплей текущие аварийные сообщения в 
виде бегущей строки.  
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Описание свойств объекта "Alarm Moving Sign" (сигнализация бегущей строкой)  

Border Color 
Background Color 
(Цвет рамки и 
фона) 

На рис. показан стиль “Sunken”. Цвет фона – зеленый, цвет рамки  - красный. 

 
Standard 

(стандартный) 
Raised     

(рельефный) 
Sunken 

(утопленный) 
Transparent 

(прозрачный) 
Style 
(Стиль) 

  

Moving Points 
(Шаг 
перемещения) 

Используется для задания величины шага каждого дискретного перемещения. Шаг
задается в точках (Pixel) экрана в диапазоне 1 ~ 50 Pixels. 

Interval(ms) 
(Интервал 
времени 
перемещения) 

Используется для задания интервала времени между каждыми дискретными 
перемещениями. Интервал задается в миллисекундах (ms) в диапазоне 50 ~ 3000 
ms. 

 
Time Format 
(Формат 
времени) 

Доступно для выбора два вида формата отображения времени на 
экране: HH:MM:SS, HH:MM, где HH-часы, MM-минуты, SS-
секунды. 

Date Format 
(Формат даты) 

Доступно для выбора три вида формата отображения даты на 
экране: MM/DD/YY, DD/MM/YY, DD.MM.YY, где ММ-месяц, DD-
день, YY-год. 

Alarm Number 
(Номер 
аварии) 

Если выбрана данная опция, в бегущей строке активных аварий 
будут фиксироваться порядковые номера аварийных сообщений в 
соответствие с диалоговым окном настройки аварий (Alarm Setup) 
как показано на рис.: 

 

Detail 
(Детали) 

Color 
(Цвет) 

Здесь можно выбрать цвет отображения порядкового номера, 
даты и времени. 
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3.14 Неподвижные графические элементы (Graphic)  

В этой группе представлены базовые элементы черчения. С помощью них пользователь может 

создавать на экране HMI различные чертежи и рисунки.  

 
Рис. 3.14.1 Варианты графических элементов 

 

 Line - линия 

Табл. 3.14.1 Описание свойств графического элемента "линия" 

Свойства объекта "Line" (линия)  
Выбрав данный объект, левой кнопкой мыши можно рисовать линии в произвольном направлении и 
затем редактировать их. В окне свойств можно устанавливать ширину, цвет и стиль линии. 

                
     Направление линий                 Ширина линий (1 - 8) 
Line Color 
(Цвет линии) 

Используется для задания цвета линии. 

Line Size 
(Размер линии) 

Используется для задания ширины линии в диапазоне 1 ~ 8 пикс. 

Line Style 
(Стиль линии) 

Доступны следующие стили линии:  
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 Rectangle - прямоугольник 

Табл. 3.14.2 Описание свойств графического элемента "прямоугольник" 

Свойства объекта "Rectangle" (прямоугольник)  
Выбрав данный объект, левой кнопкой мыши можно нарисовать прямоугольник произвольного 
размера и затем редактировать его. В окне свойств можно устанавливать ширину и цвет линий 
прямоугольника. Внутри прямоугольника можно поместить картинку из банка изображений. 
Line Color 
(Цвет линий) 

Используется для задания цвета линий прямоугольника. 

Picture Bank Name 
Picture Name 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

Line Size 
(Размер линий) 

Используется для задания ширины линий прямоугольника в диапазоне 1 ~ 8 
пикс. 

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка прямоугольника. 
При этом опция "Foreground Color" будет недоступна.  

Round Radius 
(Радиус 
закругления) 

Используется для установки радиуса закругления углов прямоугольника в 
диапазоне 0~38 пикс. 

 

 Circle - окружность 

Табл. 3.14.3 Описание свойств графического элемента "окружность" 

Свойства объекта "Circle" (окружность)  
Используется для создания и отображения окружности или эллипса на экране HMI. В окне свойств 
можно устанавливать ширину и цвет линий данного элемента. 
 

  У данных эллипсов опция “Transparent” (прозрачный) в таблице свойств 
указана как “No” (нет). 

  



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   3-77 

Свойства объекта "Circle" (окружность)  
 

    У данных окружностей опция “Transparent” (прозрачный) в таблице свойств 
указана как “No” (нет). 

 

  У данных окружностей опция “Transparent” (прозрачный) в таблице свойств 
указана как “Yes” (да).  
 

 У данных эллипсов опция “Transparent” (прозрачный) в таблице свойств 
указана как “Yes” (да). 

  
Line Color 
(Цвет линий) 

Используется для задания цвета линий объекта. 

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

Line Size 
(Размер линий) 

Используется для задания ширины линий объекта в диапазоне 1 ~ 8 пикс. 

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка объекта. При этом 
опция "Foreground Color" будет недоступна.  

 Polygon - многоугольник 

Табл. 3.14.4 Описание свойств графического элемента "многоугольник" 

Свойства объекта "Polygon" (многоугольник)  
Выбрав данный объект, левой кнопкой мыши можно нарисовать многоугольник произвольной формы 
размера и затем редактировать его. В окне свойств можно устанавливать ширину и цвет линий 
многоугольника. 
Line Color 
(Цвет линий) 

Используется для задания цвета линий многоугольника. 
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Свойства объекта "Polygon" (многоугольник)  

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

             
Синий цвет заливки.                                 Бирюзовый цвет заливки. 

Line Size 
(Размер линий) 

Используется для задания ширины линий многоугольника в диапазоне 1 ~ 8 
пикс. 

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка многоугольника. 
При этом опция "Foreground Color" будет недоступна. 

 У данного многоугольника опция “Transparent” (прозрачный) 
в таблице свойств указана как “No” (нет). 

 

 У данного многоугольника опция “Transparent” (прозрачный) 
в таблице свойств указана как “Yes” (да). 

 Arc - дуга 

Табл. 3.14.5 Описание свойств графического элемента "дуга" 

Свойства объекта "Arc" (дуга)  
Используется для создания и отображения дуг и секторов на экране HMI. В окне свойств можно 
устанавливать ширину и цвет линий данного элемента. Когда опция “Transparent” установлена как 
Yes, будет отображаться дуга, а  если - No, то будет отображаться сектор. 

                             
 Опция “Transparent” установлена как “No”           Опция “Transparent” установлена как “Yes”. 
Line Color 
(Цвет линий) 

Используется для задания цвета линий объекта. 

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. 

Line Size 
(Размер линий) 

Используется для задания ширины линий объекта в диапазоне 1 ~ 8 пикс. 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   3-79 

Свойства объекта "Arc" (дуга)  

Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только рамка объекта. При этом 
опция "Foreground Color" будет недоступна.  

 Text  -  текст 

Табл. 3.14.6 Описание свойств графического элемента "текст" 

Свойства объекта "Text" (текст) 
Используется для создания, редактирования и отображения на экране HMI текстовой надписи. В окне 
свойств можно устанавливать тип, размер и цвет шрифта надписи. 
Text 
Text Size 
Font 
Text Color 
 
(Текст 
Размер шрифта 
Тип шрифта 
Цвет шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
надписи, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 

шрифты Windows®. Нажмите кнопку  в поле “Font”, откроется диалоговое 
окно “Font Detail Setting” выбора шрифта. 

 
Если используется функция многоязыковой поддержки, будут отображаться
различные языковые закладки, в которых могут быть заданы различные
параметры шрифтов для разных языков. 

Foreground Color 
(Цвет заливки) 

Используется для задания цвета заливки объекта. На нижеприведенном 
рисунке установлен синий цвет заливки.. 

 
Transparent 
(Прозрачный) 

Когда выбрана эта опция, будет отображаться только текст. При этом опция 
"Foreground Color" будет недоступна.  

 Scale - шкала 

Табл. 3.14.7 Описание свойств графического элемента "шкала" 

Свойства объекта "Scale" (шкала)  

Объект позволяет отобразить на экране HMI мерную шкалу с заданной ценой деления. В окне 
свойств можно устанавливать ориентацию шкалы, направление, цену деления, максимальное и 
минимальное значения, цвет и размер шрифта. 
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Свойства объекта "Scale" (шкала)  

Text Size 
Text Color 
Размер и цвет 
шрифта) 
 

Пользователь может установить размер и цвет шрифта шкалы. Тип шрифта 
используется установленный по умолчанию, а размер можно установить в 
диапазоне 8~70. 

Standard 
(Стандартный) 

Rotation 90 
(Поворот на 900) 

Rotation 180  
(Поворот на 1800) 

Rotation 270 
(Поворот на 2700)

Style 
(Стиль) 

   

Main Scale 
(Основная шкала) 
 

 

           
Число делений основной шкалы = 2         Число делений основной шкалы = 3 

Display Mark 
(Отображение 
маркеров) 

Используется для выбора: отображать или нет цифры на шкале. 

 
Date Length Размерность данных: 16-битное слово и 32-битное двойное 

слово. 

Доступны различные виды формата представления данных: 

Word/Double Word (слово/двойное слово) 

Data Format 

1. BCD 
2. Signed Decimal 
3. Unsigned Decimal 

Minimum 

Maximum 

Здесь можно задать диапазон шкалы (максимальное и 
минимальное значения).  

Integral Digits 

Detail Setup 
(Установка деталей) 

Fractional Digits 

Здесь можно определить число цифр целой и дробной части 
чисел шкалы. 
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Свойства объекта "Scale" (шкала)  

Когда пользователь нажмет кнопку OK, HMI будет проверять правильность и 
соответствие введенных параметров (мин. и макс. значения, формат данных, 
целую и дробную части).  

Grid Color 
(Цвет сетки) 

Используется для задания цвета линий шкалы. 

SubScale Number 
(Число делений 
вспомогательной 
шкалы) 

См. рис: 

           
Число делений вспомог. шкалы = 1         Число делений вспомог. шкалы = 2 

 Table - таблица 

Табл. 3.14.8 Описание свойств графического элемента "таблица" 

Свойства объекта " Table" (таблица)  
Используется для создания и отображения на экране HMI таблицы. В окне свойств можно 
устанавливать число ячеек таблицы, вид, цвет и т.д. 
Background Color 
(Цвет фона) 

Используется для задания цвета фона основных ячеек таблицы.  

 
Row Header 
(заглавная 
строка) 

Используется для выделения цветом заглавной 
(первой) строки таблицы. Пользователь может 
разрешить или запретить данную опцию. 

Header 
(заглавие) 

Col Header 
(заглавный 
столбец) 

Используется для выделения цветом заглавного 
(первого) столбца таблицы. Пользователь может 
разрешить или запретить данную опцию. 

Rows 
(строки) 

Используется для выделения чередующимся цветом 
строк таблицы. Пользователь может разрешить или 
запретить данную опцию. 

Detail Setup 
(Установка деталей) 

Interlacing 
(чередова 
ние)  

Columns 
(столбцы) 

Используется для выделения чередующимся цветом 
столбцов таблицы. Пользователь может разрешить 
или запретить данную опцию. 
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Свойства объекта " Table" (таблица)  

Row Header Используется для распространения выделения 
чередующимся цветом строк таблицы, включая 
заглавный столбец. Пользователь может разрешить 
или запретить данную опцию. 

Columns 
Header 

Используется для распространения выделения 
чередующимся цветом столбцов таблицы, включая 
заглавную строку. Пользователь может разрешить 
или запретить данную опцию. 

Sep. Rows 
Evenly 

Используется для выравнивания высоты строк в 
таблице. 

Cell Setting 
(настройка 
ячеек) Sep. Col 

Evenly 
Используется для выравнивания ширины столбцов в 
таблице. 

Border Color 
(Цвет рамки) 

Используется для задания цвета внешней рамки таблицы 

Grid Color 
(Цвет сетки) 

Используется для задания цвета сетки таблицы  

Number of Rows 
(Число строк) 

Используется для задания числа строк в таблице в диапазоне 1 ~ 99. 

Number of Columns 
(Число столбцов) 

Используется для задания числа столбцов в таблице в диапазоне 1 ~ 99. 
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3.15 Клавиатура (Keypad) 

Табл. 3.15.1 Описание свойств виртуальной клавиатуры 

Свойства объекта "Keypad (1) / (2) / (3)" 
Предоставлены три вида виртуальной клавиатуры. Пользователь может выбрать десятичную, 
шестнадцатеричную или буквенно-цифровую клавиатуру. 

             
                  Keypad (1) – Десятичная клавиатура           Keypad (2) – Шестнадцатеричная клавиатура 

           
                                                          Keypad (3) – Буквенно-цифровая клавиатура 
 
Пользователь может переназначить текст, отображаемый на клавишах. Другие клавиши, такие как  
<ENT> (Enter), <CLR> (Clear), <DEL> (Delete) and <ASCII> (Input Character) могут иметь другой текст. 
См. нижеприведенный рис.: 

 
Клавиши клавиатуры на экране сгруппированы “Group”. Пользователь может их разгруппировать с 
помощью команды “Ungroup” в меню “Edit”. В этом случае можно будет возможно изменение 
размеров отдельных клавиш и перекомпоновка клавиатуры. В тоже время пользователи смогут в 
таблице свойств в опции “Text” переназначить отображаемый текст отдельных клавиш, например 
вместо цифры “1” (см. рис.), можно указать символ “%” и т.д.  
 
Для возможности осуществления ввода с клавиатуры в свойствах объектов ввода  (Numeric Entry 
или Character Entry) установить режим ввода (Input Mode), как Active Non-Popup (ввод с помощью 
объекта клавиатура, с предварительной разблокировкой ввода) и Touch Non-Popup (ввод с помощью 
объекта клавиатура). А в случае выбора режима Active Non-Popup установить адрес устройства 
разблокировки ввода в опции InterLock Address. См. Табл. 3.10.2 и Табл. 3.10.3 для описания 
объектов ввода Numeric / Character Entry.  
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Свойства объекта "Keypad (1) / (2) / (3)" 

Text 
Text Size 
Font 
Text Color 
(Текст 
Размер шрифта 
Тип шрифта 
Цвет шрифта) 

Здесь пользователь может написать текст, который будет отображаться на 
клавишах, выбрать тип, размер и цвет шрифта текста. Для выбора доступны все 

шрифты Windows®. Нажмите кнопку  в поле “Font”, откроется диалоговое окно
“Font Detail Setting” выбора шрифта. 

 
Если используется функция многоязыковой поддержки, будут отображаться 
различные языковые закладки, в которых могут быть заданы различные 
параметры шрифтов для разных языков. 

Picture Bank Name 
Picture Name 
(Банк изображений 
Имя изображения) 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Transparent Effect 
Transparent Color 
(Эффект 
прозрачности 
Цвет фона) 

(См. табл. 3.2.2 описания свойств основных кнопок.) 

Foreground Color 
Style 
 
(Цвет переднего 
плана 
Стиль) 

Доступны два стиля Standard (стандартный) и Raised (рельефный).  

   (Выбран стандартный стиль и зеленый цвет.) 

   (Выбран рельефный стиль и красный цвет.) 

Пользователь может переназначить функции и текст клавиш 

Display Текст, отображаемый на клавише 

Mode 

Detail Setup 
(Установка 
деталей) 

 

Функции клавиш: 
1. <ENT>  Ввод 
2. <CLR>  Очистить 
3. <DEL>  Удалить 
4. <ASCII> Водимый символ 
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Пример создания виртуальной клавиатуры: 

1. Сначала создайте следующие объекты: 

 

Созданные объекты: одна клавиатура Keypad (1), одна кнопка с фиксацией Maintained button, три 

объекта числового ввода Numeric Entry и  три числовых дисплей numeric display. 

2. Задайте свойства объектов 

Объект Свойства 

Keypad (1) Оставьте свойства по умолчанию.  

Maintained button 
(Кнопка с фиксацией) 

Задайте адрес записи (write address) внутренний регистр $10.1. 
Данная кнопка будет предназначена для разрешения ввода значений 
объектов с режимом ввода  Active Non-Popup.  

Numeric Entry (Left) 
(Левый объект ввода) 

Задайте адрес записи (write address) внутренний регистр $0, режим 
ввода (Input Mode) установите Active Non-Popup и адрес 

разблокировки (InterLock Address) установите как $10.1. Когда кнопка 
"Enable" будет нажата, в объект числового ввода начнет мигать и 
можно будет ввести требуемое значение с помощью созданной 
виртуальной клавиатуры. Нажатием клавиши "Enter" на клавиатуре 
введенное значение будет записано в память.  
Если выбрать режим ввода  Touch Non-Popup, то кнопка "Enable"  не 
понадобится, разрешать ввод можно будет касанием объекта ввода. 
 

 
 

Numeric Entry (Middle) 
(средний объект ввода) 

Задайте адрес записи (write address) внутренний регистр $1, режим 
ввода (Input Mode) установите Active Non-Popup и адрес 

разблокировки (InterLock Address) установите как $10.1. 

Numeric Entry (Right) 
(Правый объект ввода) 

Задайте адрес записи (write address) внутренний регистр $2, режим 

ввода (Input Mode) установите Active Non-Popup и адрес 

разблокировки (InterLock Address) установите как $10.1. 

Numeric Display (Left) Задайте адрес чтения (read address) внутренний регистр $0  
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(Левый объект 
отображения) 

Numeric Display (Middle) 
(Средний объект 
отображения) 

Задайте адрес чтения (read address) внутренний регистр $1. 

Numeric Display (Right) 
(Правый объект 
отображения) 

Задайте адрес чтения (read address) внутренний регистр $2. 

 

 



Revision 05/30/2006, EH00   4-1 

Глава 4.  Макрофункции 

Редактор макросов позволяет создавать и редактировать макропрограммы, которые будут 

выполняться в HMI, на языке по синтаксису команд аналогичному языку BASIC. Использование 

макропрограмм позволяет расширить функциональность панели оператора, а так же разгрузить 

внешний ПЛК, взяв на себя часть функций выполняемых его программой. После создания макроса 

пользователь может полностью проверить его работу в режиме онлайн- или офлайн-симуляции на ПК 

до загрузки программы в HMI. Максимальное число строк каждого макроса: 512 и 128 слов (макс.) для 

записи комментариев или символов в строке. Максимальное количество макро-подпрограмм (sub-

macro): 512. См. Рис. 4.1 и Рис. 4.2. 

 

 

Рис. 4.1 

Для удобства работы пользователь может 
переименовать субмакросы. По умолчанию 
субмакросы проименованы, как  Sub-macro (n) (n = 
1 - 512).  

 

Рис. 4.2 

Слева обозначены номера (от 1 до 512) 
субмакросов, по которым можно вызвать 
выполнение соответствующих подпрограмм из 
основных макро-программ командой“CALL n (n = 1 
- 512)”. 
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4.1 Типы макросов 

 

Рис. 4.1.1 Выбор макрокоманды в строке меню 

 

Название макроса Кол-во Комментарий 

Screen open Macro 
(макрос открытия 

экрана) 
1 

Этот макрос однократно выполняется при каждом открытии рабочего 
экрана, к которому он привязан. Следовательно, если в программе 
создано n экранов, то и количество данных макросов может быть n, 
по одному для каждого экрана.  

Screen close Macro 
(макрос закрытия 

экрана) 
1 

Этот макрос однократно выполняется при каждом закрытии рабочего 
экрана, к которому он привязан. Следовательно, если в программе 
создано n экранов, то и количество данных макросов может быть n, 
по одному для каждого экрана. 

Screen Cycle Macro 
(циклический 
макрос экрана) 

1 

Этот макрос циклически выполняется, когда рабочий экран, к 
которому он привязан, в прикладной программе HMI активен. 
Следовательно, если в программе создано n экранов, то и количество 
данных макросов может быть n, по одному для каждого экрана. 

Initial Macro 
(начальный макрос) 

1 Этот макрос однократно выполняется сразу же после подачи на HMI 
напряжения питания.  

Background Macro 
(фоновый макрос) 1 Этот макрос постоянно выполняется в течение всего времени пока на 

HMI подано напряжения питания.  

Clock Macro 
(тактовый макрос) 1 

Этот макрос периодически выполняется в течение всего времени 
пока на HMI подано напряжения питания через заданные промежутки 
времени. 

On Macro 
(макрос включения) 1 Этот макрос однократно выполняется при каждом нажатии на кнопку, 

к которой он привязан. 

Off Macro 
(макрос 

выключения) 
1 Этот макрос однократно выполняется при каждом выключении 

кнопки, к которой он привязан. 

Sub-macro 
(подпрограмма) 512 Эти субмакросы выполняются при вызове их из других макро-

программ. В прикладной программе может быть до 512 субмакросов. 

Табл. 4.1.1 Таблица макрокоманд 
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 Screen Open Macro - макрос открытия экрана 

Этот макрос однократно выполняется при каждом открытии рабочего экрана, к которому он 

привязан. Объекты экрана начнут отображаться только после завершения выполнения данного 

макроса. Поэтому при написания макроса, выполняемого при открытии экрана, надо 

внимательно выбирать его алгоритм и избегать зацикливаний (иначе программа может быть не 

завершена), стараться писать макрос по возможности короче, что бы не затягивать начало 

отображения объектов экрана. Рекомендуется всегда предварительно проверять работу макроса 

на ПК с помощью онлайн/офлайн симулятора до загрузки прикладной программы в HMI, чтобы 

избежать зацикливаний. 

 Screen Close Macro - макрос закрытия экрана 

Этот макрос однократно выполняется при каждом закрытии рабочего экрана, к которому он 

привязан. Переход к новому экрану произойдет только после завершения выполнения данного 

макроса. Поэтому также внимательно проверьте макрос на предмет отсутствия зацикливаний.  

 Screen Cycle Macro - циклический макрос экрана 

Этот макрос запускается сразу после выполнения макроса открытия экрана и постоянно 

выполняется, когда рабочий экран, к которому он привязан в прикладной программе HMI, 

активен. Не рекомендуется писать циклический макрос очень большим, если нет на то особой 

необходимости.  

 Initial Macro - начальный макрос 

Этот макрос однократно выполняется при старте прикладной программы сразу же после подачи 

на HMI напряжения питания. Данный макрос обычно используется для пошаговой 

инициализации программы и назначения переменным начальных значений, что бы избежать 

непредвиденных проблем связанных с неопределенностью состояния системы. 

 Background Macro - фоновый макрос 

Этот макрос запускается сразу после выполнения начального макроса и постоянно выполняется 

в течение всего времени пока на HMI подано напряжения питания. В то время когда 

выполняются другие макросы, такие как циклический макрос экрана, они не будут оказывать 

влияния друг на друга. Они будут выполняться практически одновременно, поскольку время их 

выполнения очень короткое. Для непрерывного выполнения программы в ней не требуется 

создавать дополнительные циклы. Она будет запускаться всякий раз сначала после каждого 

выполнения команды END. 

 Clock Macro - тактовый макрос 

Этот макрос периодически выполняется в течение всего времени пока на HMI подано 

напряжения питания. Он автоматически запускается через заданные промежутки времени. Не 

рекомендуется писать тактовый макрос очень большим, если нет на то особой необходимости.  
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 On Macro - макрос включения 

Этот макрос однократно выполняется при каждом нажатии на экранную кнопку, к которой он 

привязан.  

 Off Macro - макрос выключения 

Этот макрос однократно выполняется при каждом выключении экранной кнопки, к которой он 

привязан.  

 Sub-macro - подпрограмма 

Эти субмакросы выполняют функции подпрограмм и выполняются при вызове их из других 

макропрограмм. В прикладной программе может быть до 512 субмакросов. В подпрограммы 

удобно выносить часто-повторяющиеся фрагменты программы или использовать их для 

создания каких-либо макрокоманд. Пользователь может назначать субмакросам свои имена. 

Каждый субмакрос имеет свой номер, который используется для его вызова. Например, вызвать 

субмакрос с номером 1 (sub-macro 1) из основной программы можно с помощью команды “CALL 

1”. 

 

4.2 Редактор макропрограмм 

После выбора требуемой макро-команды в строке меню, откроется окно редактирования 

макропрограммы "Macro list" как показано на Рис. 4.2.1. Диалоговое окно "Macro command" для ввода 

макрокоманд может быть вызвано кликом мыши по строке макропрограммы.  

 
Рис. 4.2.1 Начало создания макропрограммы 

Так же диалоговое окно "Macro command" для ввода макрокоманд может быть вызвано с помощью 

значка на панели инструментов в окне редактора (Рис. 4.2.2). 

См. Рис. 4.2.3, в макропрограмме можно написать от 1 до 512 строк. Пустые строки программы после 

обновления будут обозначаться значками комментариев Рис. 4-2-4.  

 

 

Окно 
редактора 

макропрограмм

Окно ввода 
макрокоманд 
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Рис. 4.2.2 Панель инструментов 

 

Рис. 4.2.3 Последняя строка макропрограммы 

 

Рис. 4.2.4 Пустые строки макропрограммы (помечены символом #) 

 

 

Открыть 
файл макроса 

Сохранить 
макрос в файл 

Предыдущая 
строка 

Диалоговое окно 
ввода макрокоманд 

Вставка / Замена 

Следующая 
строка 

Вставить 
строку

Удалить строку 
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Пользователь может вводить макрокоманды, используя соответствующее диалоговое окно (Рис. 4.2.5) 

или писать их вручную непосредственно в строках окна редактора макропрограммы. См. так же 

следующие разделы с описанием методов редактирования макропрограммы.  

 

Рис. 4.2.5 Окно ввода макрокоманды 

 File - файл 

 Open Macro – открыть макрос 

ScrEdit позволяет открыть для редактирования файл с созданной ранее макропрограммой. 

Пользователь может применить старый макрос, например, для использования с PLC другого 

брэнда. Окно выбора файла макропрограммы показано на. Рис. 4.2.6. 

 

Рис. 4.2.6 Окно открытия макроса 

 Save As Macro – сохранить макрос 

ScrEdit позволяет с помощью функции “Save As” сохранить редактируемую макропрограмму в 

файл. 
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Рис. 4.2.7 Окно сохранения макроса 

 Меню редактирования макропрограммы 

Пользователь может редактировать макропрограмму, используя элементы меню "Edit" 

диалогового окна ввода макрокоманд "Macro Command".  

 
Рис. 4.2.8 Меню "Edit" 

 Предыдущий 

 

Команда перемещает выделенную строку на одну позицию вверх программы. 

 Следующий 

 

Команда перемещает выделенную строку на одну позицию вниз программы. 

 Обновление 

 

Команда сохраняет выполненные изменения в выделенной строке. Изменения строки не будут 

приняты без команды “update”. Эта дает пользователю второй шанс при принятии решения о 

сохранении изменений или нет.  Следовательно, если пользователь забудет обновить строку, он 
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должен будет вводить её заново.  

 Вставка 

 

Команда позволяет вставить новую строку между двумя старыми. После вставки, имеющиеся 

строки будут смещены вниз. 

 Удаление 

 

Команда позволяет удалить выделенную строку из программы. После удаления, имеющиеся 

строки будут смещены вверх.  

 Комментарий 

 

Комментарии могут использоваться в программе для ввода поясняющего текста и разбивки 

программы на отдельные блоки для удобства её чтения. Строки комментариев обозначаются 

символом # и не выполняются программой. 

 Ввод команд 

В данном меню содержится список всех доступных для использования в программе команд. 

Команды в меню разбиты на 9 групп. См Рис. 4.2.9 - Рис. 4.2.18. 

    

Рис. 4.2.9  

Группы команд 

Рис. 4.2.10 

Арифметические 

Рис. 4.2.11 

Логические 

Рис. 4.2.12 

Передача данных 

    

Рис. 4.2.13  

Преобразование 
данных 

Рис. 4.2.14 

Сравнение 

Рис. 4.2.15 

Управление потоком 

Рис. 4.2.16 

Установка битов 
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Рис. 4.2.17 

Коммуникация 

Рис. 4.2.18 

Прочие   

 Ввод макроса с клавиатуры 

Для удобства редактирования макросов, когда пользователь будет знать синтаксис языка 

макропрограммирования, ScrEdit позволяет вводить макрокоманды вручную непосредственно с 

клавиатуры компьютера. Этот метод позволяет быстрее писать программу. ScrEdit будет 

проверять правильность ввода команд автоматически. Если будет допущена ошибка, появится 

соответствующее предупреждающее сообщение. Пробелы между операндами и знаками 

действия не лимитированы. После завершения ввода и команды обновления или нажатия 

клавиши "Enter" на клавиатуре ПК, ScrEdit преобразует макрос в наилучший формат 

автоматически. Но имейте в виду, что на этом этапе ScrEdit не проверяет правильность 

написания макроса.  

 

4.3 Описание макрокоманд 

 Форматы данных в операциях макропрограммирования 

WORD 

(слово) 

Слово состоит из 16 бит данных (или 2 байта), b15~b0. В шестнадцатеричной 

системе слово представляется в диапазоне 0000~FFFF. 

DWORD, DW 

(двойное 

слово) 

Двойное слово состоит из 32 бит данных (или 2 последовательных слова), 

b31~b0. В шестнадцатеричной системе двойное слово представляется в 

диапазоне 00000000~FFFFFFFF 

BYTE 

(байт) 

Байт состоит из 8 бит данных, b7~b0. В шестнадцатеричной системе слово 

представляется в диапазоне 00~FF 

Signed 

(Число со 

знаком) 

Данный формат позволяет учитывать знаки (+, -) чисел в операциях 

макропрограммирования. Если данная опция не выбрана, обрабатываемые 

числа могут быть только положительными.  

 

 Арифметические операции 

Арифметические действия разделяются на два типа: операции с целыми числами и операции с 

плавающей точкой.  
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Операнды в арифметических операциях могут быть регистрами внутренней памяти HMI или 

константами. Но операнды результата могут быть только регистрами внутренней памяти. См. 

табл. 4.3.1. 

Команда Выражение Описание Комментарий 

ADD (+) V1=V2 + V2 Сложение 

SUB (-) V1=V2 - V3 Вычитание 

MUL (*) V1 = V2 * V3 Умножение 

DIV (/) V1 = V2 / V3 Деление 

MOD (%) V1 = V2 % V3 Остаток от деления 

Ц
ел
оч
ис
ле
нн
ы
е 
оп
ер
ац
ии

 

ADDSUMW V1=ADDSUMW(V2, V3) Итерационное 
сложение 

Результат операции 
может быть записан в 
формате signed (со 
знаком) или unsigned 
(без знака) WORD и 
DWORD. 
Если результирующие 
данные превысят 
заданный размер, то 
значение превышение 
будет отброшено. 

FADD V1=FADD(V2, V3) Сложение 

FSUB V1=FSUB(V2, V3) Вычитание 

FMUL V1=FMUL(V2, V3) Умножение 

FDIV V1=FDIV(V2, V3) Деление О
пе
ра
ци
и 
с 

пл
ав
аю

щ
ей

 т
оч
ко
й 

FMOD V1=FMOD(V2, V3) Остаток от деления 

Операции с плавающей 
точкой всегда 
выполняются в формате 
signed 32 Bit (двойное 
слово со знаком). 

Табл. 4.3.1 Таблица арифметических команд 

 +, FADD 

Операция сложения  

Выражение: V1 = V2 + V3[(Signed | DW)] 

            V1 = FADD(V2, V3) (Signed DW) 

Значения операндов V2 и V3 складываются, и результат сложения записывается в V1. 

Пример: 

Значение регистра внутренней памяти с адресом $2 увеличивается на число 1 

$2 = $2 + 1 

Находится сумма значений регистров внутренней памяти с адресами $1 и $2, и результат 

записывается в регистр с адресом $3. 

$3 = $2 + $1 

Значение регистра внутренней памяти с адресом $4 увеличивается на число 1.9 

$4 = FADD($4, 1.9) 

Находится сумма значений с плавающей запятой регистров внутренней памяти с адресами $5 и 

$3, и результат записывается в регистр с адресом $7. 

$7 = FADD($5, $3) 

 -, FSUB 

Операция вычитания 
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Выражение: V1 = V2 - V3[(Signed | DW)] 

            V1 = FSUB(V2, V3) (Signed DW) 

Вычисление разности значений операндов V2 и V3, и запись результата операции в V1. 

Пример: 

Значение регистра внутренней памяти с адресом $2 уменьшается на число 1 

$2 = $2 - 1 

Находится разность значений регистров внутренней памяти с адресами $2 и $1, и результат 

записывается в регистр с адресом $3. 

$3 = $2 - $1 

Значение регистра внутренней памяти с адресом $4 уменьшается на число 1.9 

$4 = FSUB($4, 1.9) 

Находится разность значений с плавающей запятой регистров внутренней памяти с адресами $5 

и $3, и результат записывается в регистр с адресом $7. 

$7 = FSUB($5, $3) 

 *, FMUL 

Операция умножения 

Выражение: V1 = V2 * V3[(Signed | DW)] 

            V1 = FMUL(V2, V3) (Signed DW) 

Вычисление произведения значений операндов V2 и V3, и запись результата операции в 

V1. 

Пример: 

Значение регистра внутренней памяти с адресом $2 умножается на число 2 

$2 = $2 * 2 

Значение регистра внутренней памяти с адресом $2 умножается на значение регистра с адресом 

$1,  и результат записывается в регистр с адресом $3. 

$3 = $2 * $1 

Значение регистра внутренней памяти с адресом $4 умножается на число 1.5 

$4 = FMUL($4, 1.5) 

Находится произведение значений с плавающей запятой регистров внутренней памяти с 

адресами $5 и $3, и результат записывается в регистр с адресом $7. 

$7 = FMUL($5, $3) 

 /, FDIV 

Операция деления 

Выражение: V1 = V2 / V3[(Signed | DW)] 
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            V1 = FDIV(V2, V3) (Signed DW) 

Вычисление частного значений операндов V2 и V3, и запись результата операции в V1. 

Значение операнда V3 не может быть равно 0 (ноль). 

Пример: 

Значение регистра внутренней памяти с адресом $2 делится на число 2 

$2 = $2 / 2 

Значение регистра внутренней памяти с адресом $2 делится на значение регистра с адресом $1,  

и результат записывается в регистр с адресом $3. 

$3 = $2 / $1 

Значение регистра внутренней памяти с адресом $4 делится на число 1.9  

$4 = FDIV ($4, 1.9) 

Находится частное значений с плавающей запятой регистров внутренней памяти с адресами $5 

и $3, и результат записывается в регистр с адресом $7. 

$7 = FDIV($5, $3) 

 %, FMOD 

Операция вычисления остатка от деления 

Выражение: V1 = V2 % V3[(Signed | DW)] 

            V1 = FMOD(V2, V3) (Signed DW) 

Вычисление остатка от деления значений операндов V2 и V3, и запись результата 

операции в V1. Значение операнда V3 не может быть равно 0 (ноль). 

Пример: 

Значение регистра внутренней памяти с адресом $2 делится на число 5,  и остаток от деления 

записывается в регистр с адресом $3. 

$3 = $2 % 5 

Значение регистра внутренней памяти с адресом $4 в формате с плавающей точкой делится на 

число 4,  и остаток от деления записывается в регистр с адресом $6. 

$6 = FMOD($4, 4) 

 ADDSUMW 

Операция итеративного (многократного) сложения 

Выражение: V1 = ADDSUMW(V2, V3)[(DW)] 

Нахождение суммы операндов V2, V2+1, V2+2, …, V2+V3, и запись результата операции в 

регистр V1. 

Пример: 

$2 = 1 
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$3 = 2 

$4 = 3 

$5 = 3 

$0 = ADDSUMW($2, $5) 

Значения регистров внутренней памяти с адресами $2, $3, $4 складываются (значение регистра 

$5 = 3 определяет количество складываемых регистров начиная с регистра $2), и результат 

операции записывается в регистр $0. Макс. количество складываемых регистров равно 6. 

 

 Логические операции 

В этой группе находится 6 логических команд:  OR (ИЛИ), AND (И), XOR (исключающее ИЛИ), 

NOT (НЕ), Shift-left (смещение влево) и Shift-right (смещение вправо). Каждая операция состоит 

из трех операндов. Операнды в арифметических операциях могут быть регистрами внутренней 

памяти HMI или константами. Но операнды результата могут быть только регистрами внутренней 

памяти. Операнды могут быть формата Word или Double Word. См. табл. 4.3.2.. 

Команда Выражение Описание Комментарий 

OR (|) V1 = V2 | V3 Логическое сложение (ИЛИ) 
AND (&&) V1 = V2 && V3 Логическое умножение (И) 
XOR (^) V1 = V2 ^ V3 Исключающее ИЛИ  

NOT V1 = NOT V2 Логическая операция "НЕ" 
SHL (<<) V1 = V2 << V3 Логическое смещение влево 
SHL (>>) V1 = V2 >> V3 Логическое смещение вправо

Результат операции 
может быть записан в 
формате WORD или 
DWORD. 
 

Table 4.3.2 Таблица логических команд 

 OR (|)  

Операция логического сложения (ИЛИ)  

Выражение: V1 = V2 | V3[(DW)] 

Производится логическое сложение значений операндов V2 и V3, и результат операции 

записывается в V1. 

Пример: 

$2 = F000H 

$4 = 0F00H 

$2 = $2 | $4 

Результат записывается в регистр $2 = FF00H 

 AND (&&) 

Операция логического умножения (И) 

Выражение: V1 = V2 && V3[(DW)] 
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Производится логическое умножение значений операндов V2 и V3, и результат операции 

записывается в V1. 

Пример: 

$2 = F000H 

$4 = 0F00H 

$2 = $2 && $4 

Результат записывается в регистр $2 = 0000H 

 XOR  (^) 

Логическая операция "исключающее ИЛИ" 

Выражение: V1 = V2 ^ V3[(DW)] 

Производится логическая операция " исключающее ИЛИ " со значениями операндов V2 и 

V3, и результат операции записывается в V1. 

Пример: 

$2 = F100H 

$4 = 0F00H 

$2 = $2 ^ $4 

Результат записывается в регистр $2 = FE00H 

 NOT 

Логическая операция "НЕ" 

Выражение: V1 = NOT V2 [(Signed | DW)] 

Производится логическая операция "НЕ" со значением операнда V2, и результат операции 

записывается в V1. 

Пример: 

$2 = F100H 

$4 = NOT $2 

Результат записывается в регистр $4 =  0EFFH 

 SHL (<<)  

Операция побитового смещения влево 

Выражение: V1 = V2 << V3[(DW)] 

Данные в операнде V2 (WORD/DWORD) смещаются влево (число бит смещения 

определяется значением операнда V3). Результат операции записывается в операнд V1. 

Пример: 

$2 = F100H 
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$2 = $2 << 4 

Данные в регистре $2 смещаются влево на 4 бита, и получается значение 1000H 

 SHR (>>) 

Операция побитового смещения вправо 

Выражение: V1 = V2 >> V3[(DW)] 

Данные в операнде V2 (WORD/DWORD) смещаются вправо (число бит смещения 

определяется значением операнда V3). Результат операции записывается в операнд V1. 

Пример: 

$2 = F100H 

$2 = $2 >> 4 

Данные в регистре $2 смещаются вправо на 4 бита, и получается значение 0F10H 

 

 Команды передачи данных 

В этой группе находится 5 команд передачи данных: =, BMOV, FILL, CHR и FMOV. См. табл.  4.3.3. 

Команда Выражение Описание Комментарий 

MOV (=) V1 = V2 Передача данных Тип данных в V1 может 
быть только P, M 

BMOV BMOV(V1, V2, V3) Передача блока данных Тип данных в V1 и V2 
может быть только P, M 

FILL FILL(V1, V2, V3) Размножение данных   

CHR CHR(V1, "V2") Конвертирование текста в 
коды ASCII V2 – строка текста 

FMOV V1 = FMOV(V2) Передача данных с 
плавающей точкой  

P- регистр PLC, M- регистр внутренней памяти HMI, C- константа 

Табл. 4.3.3 Таблица команд передачи данных 

 MOV (=)  

Передача данных 

Выражение: V1 = V2[(Signed DW | DW)] 

Копирование значения операнда V2 в операнд V1. Значение регистра V2 после 

выполнения команды MOV не изменится. 

Пример: 

Запись в регистр внутренней памяти с адресом $0 числа 4. 

$0 = 4 

Копирование данных регистра $2 в регистр с адресом $4. 

$4 = $2 
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 BMOV 

Передача блока данных 

Выражение: BMOV (V1, V2, V3) 

Копирование блока данных из нескольких (количество определяется значением операнда 

V3) последовательных регистров начиная с адреса операнда V2 в регистры начиная с 

адреса операнда V1. Формат данных - слово. Если длина блока выходит за пределы 

внутренней памяти или макс. числа регистров PLC, при компиляции будет выдано 

соответствующее сообщений. 

Пример: 

Копирование данных из регистров $0, $1, $2, $3, $4 в регистры $10, $11, $12, $13. Максимальное 

количество копируемых данных - 4 слова. 

$0 = 1 

$1 = 2 

$2 = 3 

$3 = 4 

BMOV ($10, $1, 4) 

После выполнения команды BMOV: $10=1, $11=2, $12=3, $13=4. 

 FILL 

Размножение данных 

Выражение: FILL(V1, V2, V3) [(Signed)] 

Копирование данных из одного операнда  V2 в несколько (количество определяется 

значением операнда V3) последовательных регистров начиная с адреса операнда V1. 

Если длина блока выходит за пределы внутренней памяти или макс. числа регистров PLC, 

при компиляции будет выдано соответствующее сообщений. 

Пример: 

$5 = 10 

FILL ($0, $5, 4) 

После выполнения команды FILL в регистры $0, $1, $2, $3 будет записано число 10. 

 CHR 

Преобразование текста в коды ASCII  

Выражение: CHR (V1, "V2") 

Конвертирование текста, содержащегося в операнде V2 в коды ASCII, и запись их в 

операнд V1. Максимальное число преобразуемых данных - 128 слов. 

Пример: 
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CHR ($1, "AB12") 

После выполнения команды CHR, значение 4241H будет записано в регистр $1 и значение 

3130H будет записано в регистр $2. 

 FMOV 

Передача данных с плавающей точкой 

Выражение: V1 = FMOV(V2) (Signed DW) 

Копирование значения данных в формате с плавающей точкой операнда V2 в операнд V1. 

Значение регистра V2 после выполнения команды MOV не изменится.  

Пример: 

Запись в регистр внутренней памяти с адресом $0 числа 44.3 

$0 = FMOV(44.3) (Signed DW) 

Копирование в регистр внутренней памяти с адресом $0 данных из регистра PLC 1@D0. 

$0 = FMOV(1@ D0) (Signed DW) 

 

 Команды преобразования данных 

Команда Выражение Описание 

BCD V1 = BCD(V2) Преобразование BIN (двоичных данных) 
в формат BCD 

BIN V1 = BIN(V2) Преобразование BCD в BIN  

W2D V1 = W2D(V2) Преобразование WORD (слово) в 
DWORD (двойное слово) 

B2W V1 = B2W(V2, V3) Преобразование BYTE (байт) в WORD 
(слово) 

W2B V1 = W2B(V2, V3) Преобразование WORD (слово) в BYTE 
(байт) 

SWAP SWAP (V1, V2, V3) Перестановка байтов 

XCHG XCHG (V1, V2, V3) Обмен данными 

MAX V1 = MAX(V2, V3) Поиск максимального значения 

MIN V1 = MIN(V2, V3) Поиск минимального значения 

A2H V1 = A2H(V2) Преобразование кода ASCII в 4-
разрядное целое шестнадцатеричное 
число 

H2A V1= H2A (V2) Преобразование шестнадцатеричного 
целого числа в код ASCII 

FCNV V1= FCNV (V2) Преобразование целого числа в формат 
с плавающей точкой  

ICNV V1= ICNV (V2) Преобразование числа с плавающей 
точкой в целое 

Табл. 4.3.4 Таблица команд преобразования данных 
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 BCD 

Преобразование BIN-данных в формат BCD 

Выражение: V1 = BCD(V2) [(DW)] 

Двоичные данные операнда V2 конвертируются в двоично-десятичный формат (BCD), и  

результат операции сохраняется в V1. 

Пример: 

Значение регистра $4 = 5564. После выполнения BCD-команды, двоичные данные регистра $4 

будут конвертированы в 5564H. 

$4 = 5564 

$4 = BCD($4) 

 BIN 

Преобразование BCD-данных в формат BIN 

Выражение: V1 = BIN(V2) [(DW)] 

Двоично-десятичные (BCD) данные операнда V2 конвертируются в двоичный формат 

(BIN), и результат операции сохраняется в V1. 

Пример: 

Значение регистра $4 = 5564H. После выполнения BIN-команды, BCD-данные регистра $4 

конвертируется 5564. 

$4 = 5564H 

$4 = BIN($4) 

 W2D 

Преобразование WORD в DWORD 

Выражение: V1 = W2D(V2) [Signed] 

16-битные данные операнда V2 конвертируются в 32-битное число, и результат операции 

сохраняется в V1. 

Пример: 

Десятичное 16-битное значение регистра $4 = -7. После выполнения W2D-команды, значение 

регистра $7 преобразуется в -7. 

$4 = -7 

$7 = W2D($4)(Signed) 

 B2W 

Преобразование BYTE в WORD 

Выражение: V1 = B2W(V2, V3) 
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Байты данных (число байтов задается в V3) от операнда V2 преобразуются в слова, и 

результат операции сохраняется в V1. Операнд V2 состоит из двух байтов. Эти два байта 

будут преобразованы в слова и сохранены в V1. Если V3 = 0, будет преобразовываться в 

слово только старший байт. 

Пример: 

Допустим, что значение регистра $65534 = 12. Это означает, что будут конвертироваться 12 

байтов (6 слов) в 12 слов от $785 и результат будет сохранен в регистры от $10 до $21. 

$10=B2W($785, $65534） 

 W2B 

Преобразование WORD в BYTE 

Выражение: V1 = W2B(V2, V3) 

Слова (16 бит) данных (число слов задается в V3), начиная с младшего байта  V2, 

конвертируются в байтовый формат (старшие байты операнда V2 будут отброшены), и 

результат операции сохраняется в V1.  

Допустим, что значение регистра $985 = 12. Это означает, что младшие байты 12-ти словных 

регистров, начиная от $986, будут конвертироваться в 12 байтов (6 слов) и результат будет 

сохранен в регистры от $65 до $70. 

$65= W2B($986, $985) 

 SWAP 

Перестановка байтов в регистре 

Выражение: SWAP (V1, V2, V3) 

Старшие и младшие байты операндов V2, V2+1, V2+2…V2+V3 (WORD) меняются местами,  

и  результат операции сохраняется в операнды V1, V1+1, V1+2…V1+V3. 

Пример: 

Перестановка старших и младших байтов в регистрах $10, $11, …, $14 и сохранение результатов 

операции в регистрах $1, $2, .., $5 соответственно. 

SWAP($1, $10, 5) 

Если $11 = 1234H, то после выполнения команды SWAP, $2 = 3412H. 

 XCHG 

Обмен данными  

Выражение: XCHG (V1, V2, V3)[(DW)] 

Обмен значений операндов V2, V2+1, V2+2…V2+V3 со значениями операндов V1, V1+1, 

V1+2.., V1+V3.  

Пример: 
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Обмен данными регистров $10, $11, …, $14 с регистрами $1, $2, .., $5 соответственно. 

XCHG($1, $10, 5) 

Если $11 = 1234H и $2 = 5678H, то после выполнения команды XCHG будет $2 = 1234H и $1 = 

5678H. 

 MAX 

Поиск максимального значения  

Выражение: V1 = MAX(V2, V3)[ (Signed DW | DW)] 

Поиск максимального значения в операндах V2 и V3,  и сохранение его в V1. 

Пример: 

$0 = 0 

$1 = 2 

$2 =10 

$0 = MAX($1, $2) 

Результат  $0 = 10 

 MIN 

Поиск минимального значения  

Выражение: V1 = MIN(V2, V3)[ (Signed DW | DW)] 

Поиск минимального значения в операндах V2 и V3,  и сохранение его в V1. 

Пример: 

$0 = 0 

$1 = 2 

$2 =10 

$0 = MIN($1, $2) 

Результат  $0 = 2 

 A2H 

Преобразование кода ASCII в 4-разрядное целое шестнадцатеричное число 

Выражение: V1 = A2H(V2) 

Преобразование кода ASCII операнда V2 (4 слова) в целое, и сохранение результата 

операции в V1. 

Пример: 

$10 = 0034H 

$11 = 0033H 

$12 = 0036H 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   4-21 

$13 = 0038H 

$1 = A2H($10) 

После выполнения команды A2H, в регистре $1 будет записано число 4368H. 

 H2A 

Преобразование шестнадцатеричного целого числа в код ASCII 

Выражение: V1= H2A (V2) 

Преобразование V2 (1 слово в шестнадцатеричном формате) в 4 символа ASCII (4 слова), 

и сохранение результата операции в V1. 

Пример: 

$2 = 1234H 

$10 = H2A($2) 

После выполнения команды H2A , в регистрах будет: $10=0031H, $11=0032H, $12=0033H и 

$13=0034H. 

 FCNV 

Преобразование целого числа в формат с плавающей точкой 

Выражение: V1= FCNV (V2)(Signed DW) 

Преобразование целого числа операнда V2 в число в формате плавающей точкой, и 

сохранение результата операции в V1.  

Пример: 

$2 = 100 

$1 = FCNV($2)(Signed DW) 

Результат  $1 = 100.0 

 ICNV 

Преобразование числа с плавающей точкой в целое  

Выражение: V1= ICNV (V2) 

Преобразование числа в формате плавающей точкой операнда V2 в целое число, и 

сохранение результата операции в V1.  

Пример: 

FMOV($2, 100.5) 

$1 = ICNV ($2)(Signed DW) 

Результат  $1 = 100 
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 Команды сравнения 

 IF…THEN GOTO LABEL … 

Условный переход: IF условие THEN GOTO LABEL номер 

Если условие выполняется, то выполнение программы перейдет к заданному номеру метки 

LABEL. 

Доступны следующие условия перехода. 

Условие Описание Комментарий 
V1 == V2 V1 равно V2 
V1 != V2 V1 не равно V2 
V1 > V2 V1 больше, чем V2 

V1 >= V2 V1 больше или равно V2 
V1 < V2 V1 меньше, чем V2 
V1<= V2 V1 меньше или равно V2 

V1 && V2 == 0 
Если результат логической операции 
"И" между операндами V1 и V2 равен  
0 

V1 && V2 != 0 
Если результат логической операции 
"И" между операндами V1 и V2 не 
равен  0 

V1== ON Битовый операнд V1 = ON 
V1== OFF Битовый операнд V1 = OFF 

Операнды V1 и V2 
могут быть внутренними 
регистрами HMI или  
константами. 

Табл. 4.3.5 Таблица команд сравнения 

Пример: 

Когда значение регистра $2 больше или равно 10, то в программе будет совершен переход к 

метке LABEL 1.  

IF $2 >= 10 THEN GOTO LABEL 1 

….. 

LABEL 1 

….. 

Условный переход: IFB V1 == {ON | OFF} THEN GOTO LABEL номер 

Если битовый операнд V1 равен ON или OFF, то выполнение программы перейдет к заданному 

номеру метки LABEL. Операнд V1 – адрес памяти внешнего PLC. 

Пример: 

IFB 1@X0 == ON THEN GOTO LABEL 1 

 IF…THEN CALL … 

Условный переход к подпрограмме: IF V1 == V2 THEN CALL субмакрос 

Если значение операнда V1 равно значению операнда V2, будет выполнен соответствующий 

субмакрос (подпрограмма). Операнды V1 и V2 могут быть внутренними регистрами HMI или  
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константами. 

Пример: 

Если $2 = 10, то будет выполнена подпрограмма sub-macro 1. 

IF 10 = $2 THEN CALL 1 

 IF…ELSE…ENDIF 

Условный переход: 

IF условие1 

Действие1 

ELSEIF условие2 

Действие2 

ELSE 

Действие3 

ENDIF 

Это условный переход с несколькими условиями. Если условие 1 выполняется, то действие1 

будет выполнено. Если условие один1 не выполняется, то будет проверяться условие2. Если 

условие2 выполняется, то действие2 будет выполнено. Иначе если условие 1 и условие 2 не 

выполняются, то будет выполнено действие3. 

Для описания условий см. таблицу 4.3.5 (Таблица команд сравнения). 

Пример: 

Если значение регистра $1 меньше 100, будет выполнено действие $1 = $1 + 1. Иначе будет 

выполнено действие $1 = $1 + 10. 

IF $1 < 100 

$1 = $1 + 1 

ELSE 

$1 = $1 + 10 

ENDIF 

 

 Команды управления потоком 

5 типов команд управления потоком: GOTO, LABEL, CALL..RET, FOR…NEXT и END. 

 GOTO 

Безусловный переход к заданной метке. Команда GOTO будет всегда осуществлять в программе 

прыжок к метке V1. 

Выражение: GOTO LABEL V1 

Безусловный переход в программе к заданной метке Label V1.  
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Main
Macro

Sub-Macro
A1

CALL

RET

Пример: 

Перейти в программе к строке обозначенной меткой Label 2 и далее продолжить выполнение.  

GOTO LABEL 2 

….. 

LABEL 2 

 LABEL 

Метка для команд условного/безусловного перехода 

Выражение: LABEL V1 

Номера меток не должны повторяться в макросе. 

Пример: 

Перейти в программе к строке обозначенной меткой Label 2 и далее продолжить выполнение ally.  

GOTO LABEL 2 

….. 

LABEL 2 

….. 

Повтор метки Label 2 вызовет ошибку программы и предупреждающее сообщение. 

LABEL 2 

….. 

 CALL..RET 

Вызов подпрограммы (Sub-macro) 

Выражение: CALL V1 

V1 означает номер субмакроса. Номер субмакроса может быть в диапазоне 001 ~ 512 и V1 

может быть внутренним регистром HMI или константой. 

 

 

 

Рис. 4.3.1 

После выполнения команды CALL V1 будет вызвана и 

выполнена соответствующая подпрограмма (sub-macro). 

Подпрограмма должна завершаться командой RET, которая 

вернет выполнение к строке следующей за командой CALL. 

Номер субмакроса может быть в диапазоне 001 ~ 512, а имя 

пользователь может придумать самостоятельно. В 

подпрограмме так же может быть использована команда CALL 

перехода к другой подпрограмме, но глубина вложенности не 

должна превышать  6 уровней. 

 FOR…NEXT 

Цикл в программе 
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Выражение: 

FOR V1 

действие 

NEXT 

Вложенные циклы в программе. ”FOR” определяет начало цикла, а ”NEXT” - конец. Допускается 

5 уровней вложенности максимально. V1 может быть внутренним регистром HMI или константой. 

Значение операнда V1 определяет число повторных выполнений действия внутри цикла. 

Действие может состоять из различных макрокоманд и других вложенных циклов. Внутри цикла 

можно изменить количество его повторений, но изменения вступят в силу только при следующем 

выполнении цикла. 

Пример: 

$10 = 10 

$1 = 0 

FOR $10 

$1 = $1 + 1 

$10 = 2 

NEXT 

После выполнения операции, результат будет следующий: $1 = 10, $10 = 2.  

Несмотря на изменение значения регистра $10, цикл все равно выполниться 10 раз. 

 END 

Конец макропрограммы  

Выражение: 

Действие1 

END 

Действие2 

Команда End используется для указания конца макро-программы. Действие2 не будет 

выполняться. Имейте в виду, что команда END обозначает конец выполнения программы. Если 

команда END используется в подпрограмме (sub-macro), это указывает, что программа 

завершается в этом месте. 

Пример: 

$1 = 10 

$1 = $1 + 1 

END 

$1 = $1 + 1 

После выполнения операции, результат будет: $1 = 11. 
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 Установка состояния битов 

4 команды установки битовых операндов: SETB, CLRBL, INVB и GETB.  

Команда Выражение Описание 

SETB SETB V1 Установить битовый операнд V1 = ON 
CLRBL CLRB V1 Установить битовый операнд V1 = OFF 
INVB INVB V1 Инвертировать битовый операнд V1 

GETB V1 = GETB V2 Передать состояние битового операнда 
V2 операнду V1 

Табл. 4.3.6 Таблица команд установки состояния битов 

 SETB 

Установить определенный бит операнда в единичное состояние. 

Выражение: SETB V1 

Установить бит V1 = ON 

Пример: 

Установить бит 0 регистра $0 в единичное состояние. 

$0 = FFFEH 

SETB $0.0 

Результат  $0 = FFFFH 

 CLRB 

Установить определенный бит операнда в нулевое состояние.  

Выражение: CLRB V1 

Установить бит V1 = OFF 

Пример: 

Установить бит 0 регистра $0 в нулевое состояние. 

$0 = FFFFH 

CLRB $0.0 

Результат  $0 = FFFEH 

 INVB 

Инвертировать состояние бита. ON  OFF, OFF  ON 

Выражение: INVB V1 

Инвертировать бит операнда V1. ON  OFF, OFF  ON 

Пример: 

Инвертировать бит 0 регистра $0 

$0 = FFFEH 
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INVB $0.0 

Результат  $0 = FFFFH 

 GETB 

Передать состояние бита 

Выражение: V1 = GETB V2 

Передать значение бита V2 биту V1 

Пример: 

Передать состояние 3го бита регистра $0 пятому биту регистра $10. 

$2 = FFFEH 

$10 = 0 

$10.5 = GETB $0.3 

Результат  $10 = 4 

 

 Команды коммуникации 

Команда Выражение Описание 

INITCOM V1= INITCOM (V2) Инициализация COM-порта 

ADDSUM V1=ADDSUM(V2, V3) Расчет контрольной суммы 
методом сложения 

XORSUM V1 = XORSUM(V2, V3) Расчет контрольной суммы 
методом XOR 

PUTCHARS V1 = PUTCHARS(V2, V3, V4) Передача данных в COM-порт 
GETCHARS V1 = GETCHARS(V2, V3, V4) Прием данных из COM-порта 

SELECTCOM SELECTCOM(V1) Выбор COM-порта 
CLEARCOMBUFFER CLEARCOMBUFFER(V1, V2) Очистка буфера COM-порта 

CHRCHKSUM V1 = CHRCHKSUM(V2, V3, V4) Расчет длины текста и 
контрольной суммы 

Табл. 4.3.7 Таблица коммуникационных команд 

 INITCOM 

INITCOM → Начальная установка COM-порта и задание протокола коммуникации.  
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Рис. 4.3.2 INITCOM 

 

Рис. 4.3.3 Установочные параметры Variable2 в INITCOM (протокол связи) 

 
Рис. 4.3.4 COM-порт 

 
Рис. 4.3.5 Коммуникационный интерфейс 

 
Рис. 4.3.6 Data Bit 

 
Рис. 4.3.7 Parity bit 

 
Рис. 4.3.8 Stop bit 

 
Рис. 4.3.9 Скорость передачи 

Flow Control: Скорость передачи и правильность коммуникации усовершенствуются в течение 

связи по новой технологии передачи, с такими возможностями как непосредственная компрессия, 

отладка,…и т.д. Но новая технология делает скорость обмена данными между HMI и PC более 
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медленной, чем актуальная скорость передачи. Данная функция необходима для надежного и 

безопасного обмена данными между компьютером и HMI. 

No Flow Control: Функция управления потоком отключена. 

CTS/RTS: Это аппаратное управление потоком данных. Используется для установки сигналов 

управления приемом и передачей данных. Контроль необходим для связи HMI через внутренний 

или внешний модем.  

DSR/DTR: Это так же аппаратное управление потоком данных. Используется когда PC и HMI 

связаны кабелем напрямую. 

XON/XOFF: Это программное управление потоком данных. Используется только для модема 

2400bps. Метод управления состоит в генерировании контрольного кода и добавления его к 

передаваемым данным.  

 

Рис. 4.3.10 Управление потоком (Flow control) 

 ADDSUM 

ADDSUM → Используется для вычисления контрольной суммы методом сложения. 

V1=ADDSUM(V2, V3). V1 – вычисленное значение, V2 – начальный адрес вычисления и V3 – 

длина данных. 

 

Рис. 4.3.11 ADDSUM 

 XORSUM 

XORSUM →Используется для вычисления контрольной суммы методом XOR. V1=XORSUM (V2, 

V3). V1 – вычисленное значение, V2 – начальный адрес вычисления и V3 – длина данных. 
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Рис. 4.3.12 XORSUM 

 PUTCHARS 

PUTCHARS → Передача данных в COM-порт. V1= PUTCHARS (V2, V3, V4). V1 – ответное 

сообщение после передачи, V2 – стартовый адрес передаваемых данных, V3 – длина 

передаваемых данных, и V4 – допустимое время передачи (мс). Результат будет сохранен в V1.  

 
Рис. 4.3.13 PUTCHARS 

 GETCHARS 

GETCHARS → Прием данных из COM-порта. V1= GETCHARS (V2, V3, V4). V1- ответное 

сообщение, V2 – стартовый адрес принимаемых данных, V3 – длина принимаемых данных, и 

V4 – допустимое время приема (мс). Результат будет сохранен в V1. 
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Рис. 4.3.14 GETCHARS 

 

Рис. 4.3.15 Пример 1 связи с Delta PLC 

В примере 1 показана начальная инициализация COM-порта для связи с Delta PLC. 

 
Рис. 4.3.16 Пример 2 связи с Delta PLC 

Пример 2 связи с Delta PLC на Рис. 4.3.16 показывает фоновый коммуникационный макрос. От 

строки 1 до строки 3, пользователь может видеть, что состояние Y0 устанавливается в ON и 

записывается во внутреннюю память *10. От строки 4 до строки 6, состояние Y0 устанавливается 

в OFF и записывается во внутреннюю память *30. Затем, команда в строке 12 будет включать 

выход Y0, а  команда в строке 14 - выключать выход Y0. Это пример показывает, как 

пользователь, используя коммуникационный макрос, может управлять внешним PLC. Данный 

метод управления может использоваться, когда панелью Delta DOP надо управлять 

контроллерами PLC специальных драйверов связи, для которых пока нет. 

 SELECTCOM 

SELECTCOM → Используется для выбора COM-порта. Когда внешний PLC не установлен 

(выбран PLC как NULL) в меню Options > Configuration в ScrEdit, пользователи могут 
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использовать два COM-порта панели (0:COM1, 1:COM2) одновременно. (После выполнения 

данной команды все обращения будут выполняться через установленный ей COM-порт.) 

 
Рис. 4.3.17 SELECTCOM 

 

 CLEARCOMBUFFER 

Очистка буфера COM-порта. 

 
Рис. 4.3.18 CLEARCOMBUFFER 

Выражение: CLEARCOMBUFFER(V1, V2) 

V1 – номер коммуникационного порта. Представляется как константа: 0(COM1) или 1(COM2). 

V2 – тип области буфера. Представляется как константа: 0 (область буфера приема) или 

1(область буфера передачи) 

Пример: 

Очистить область буфера приема порта COM2 

CLEARCOMBUFFER(1, 0) 
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 CHRCHKSUM 

Расчет длины текста или символов и контрольной суммы. 

 
Рис. 4.3.19 CHRCHKSUM 

 

Выражение: V1 = CHRCHKSUM(V2, V3, V4) 

V1 – адрес внутренней памяти, в котором сохраняется длина текста V2. 

V2 – текстовая строка. 

V3 – адрес внутренней памяти, в которую сохраняется контрольная сумма V2. 

V4 – длина данных контрольной суммы, что хранятся в V3. 0 представляет байт, а 1 - слово. 

Операция: 

Конвертируются все текстовые символы в коды ASCII и суммируются между собой. Например, 

символ ’2’ конвертируется в код ASCII ‘31H’, ’4’ - в ‘34H’ и контрольная сумма: 31H + 34H = 65H. 

Пример: 

Рассчитать длину данных "24" и контрольной суммы. 

$0 = CHRCHKSUM("24", $10, 2) 

После выполнения операции, 2 сохраняется в $0, что соответствует двум байтам. Контрольная 

сумма сохраняется в $10 как 65H. 

 

 Прочие команды 

Команда Выражение Описание 

TIMETICK V1 = TIMETICK Чтение текущего времени от начала 
запуска системы 

GETLASSERROR V1 = GETLASTERROR Чтение значения прошлой ошибки 
# #V1 Комментарий 

delay delay V1 Задержка 
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GETSYSTEMTIME V1 = GETSYSTEMTIME Чтение системных часов реального 
времени 

SETSYSTEMTIME SETSYSTEMTIME(V1) Установка системных часов реального 
времени 

GETHISTORY V1 = GETHISTORY (V2, V3, 
V4, V5, V6) Чтение архива данных 

 TIMETICK 

TIMETICK → Чтение текущего времени от начала запуска системы, и помещение его в заданный 

адрес. Один шаг счетчика системного времени равен 100мс. 

 
Рис. 4.3.20 TIMETICK 

 GETLASTERROR 

GETLASTERROR →Чтение значения прошлой ошибки. Если ошибок не было, то результат 

команды GETLASTERROR будет равен 0. Информацию о кодах ошибок см. в разделе 4.4. 

 

Рис. 4.3.21 GETLASTERROR 
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 COMMENT 

COMMENT → Комментарии в программе позволяют сделать её удобочитаемой. С помощью этой 

команды можно отключить выполнение любой макрофункции (строки) в программе. Для этого в 

начале строки надо установить символ “#”. 

 

Рис. 4.3.22 COMMENT 

 Delay 

Delay → Задержка выполнения программы использует системное время. Время задержки 

измеряется в миллисекундах. 

 

Рис. 4.3.23 Задержка 
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 GETSYSTEMTIME 

Чтение системных часов реального времени 

Выражение: V1 = GETSYSTEMTIME 

V1 – стартовый адрес последовательных 7 слов внутренней памяти HMI. 

 

V1 Год 

V1 + 1 Месяц 

V1 + 2 День 

V1 + 3 Неделя 

V1 + 4 Часы 

V1 + 5 Минуты 

V1 + 6 Секунды 

Пример: 

Сейчас системные часы реального времени показывают 2006/01/04 Wed 09:26:25. Использую 

данную команду можно сохранить текущую дату и время в регистрах $1~$7. 

$1 = GETSYSTEMTIME 

$1 = 2006, $2 = 01, $3 = 4, $4 = 3, $5 = 9, $6 = 26, $7 = 25 

 SETSYSTEMTIME 

Установка системных часов реального времени 

Выражение: SETSYSTEMTIME(V1) 

V1 – стартовый адрес последовательных 7 слов внутренней памяти HMI. 

V1 Год 

V1 + 1 Месяц 

V1 + 2 День 

V1 + 3 Неделя 

V1 + 4 Часы 

V1 + 5 Минуты 

V1 + 6 Секунды 

Пример: 

Требуется установить дату и время системных часов реального времени как 2006/01/04 Wed 

09:26:25. 

$1 = 2006 

$2 = 1 

$3 = 4 
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$4 = 3 

$5 = 9 

$6 = 26 

$7 = 25 

SETSYSTEMTIME($1) 

 GETHISTORY 

Чтение архива данных 

Выражение: V1 = GETHISTORY (V2, V3, V4, V5, V6) 

V1 – адрес внутренней памяти, где хранится длина данных. 

V2 – адрес внутренней памяти, константа - номер буфера архива данных. 

V3 – адрес внутренней памяти, константа - стартовый адрес опроса. 

V4 – адрес внутренней памяти, константа – количество читаемых точек 

V5 – адрес внутренней памяти, адрес PLC - адрес хранения данных 

V6 – адрес внутренней памяти, константа - тип читаемых данных 

0: Дата, 1: Время, 2: Время и дата 

 

4.4 Сообщения об ошибках 

При компиляции, в окне выходного результата будут отображаться обнаруженные ошибки. Ошибки 

могут появляться из-за невнимательности, неаккуратности пользователя из-за недостатка входных 

команд. Некоторые ошибки в программе могут быть легко и быстро найдены. Но поиск ошибок может 

оказаться трудным в длинных макропрограммах. Для помощи в отладке программы, ScrEdit 

предоставляет систему поиска ошибок и сообщения о них. К сожалению, логические ошибки не могут 

быть обнаружены, и пользователь должен стремиться избегать их и выбирать правильный алгоритм 

программы. 

 Сообщения об ошибках при редактировании программы 

 Code – 100: LABEL cannot be found 

Отсутствует метка LABEL перехода для команды GOTO.  

 Code – 101: Recursion occurs 

Это сообщение обычно появляется в подпрограммах (sub-macro). Способность субмакроса 

вызывать самого себя называется рекурсией. Независимо от того, как происходит вызов: прямо 

или косвенно. В основном, рекурсия неприменима для подпрограмм. Для этих целей 

пользователи могут применять команды GOTO или FOR (много раз). 

 Code – 102: More than 3 nested FOR is used 
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Это сообщение предупреждает пользователя о том, что число вложенных циклов FOR более 

трех, что бы избежать чрезмерного использования памяти. Для этих целей пользователи могут 

применять команды GOTO или IF. 

 Code – 103: Sub-macro does not exist 

Это сообщение предупреждает пользователя об обращении к несуществующей подпрограмме. 

Например, CALL 5 должна вызвать субмакрос 5. Если подпрограмма sub-macro 5 не создана, то 

появится данное сообщение об ошибке. 

 Code – 104: Number of NEXT is less than the number of FOR 

Количество команд NEXT и FOR не совпадает. Это сообщение указывает пользователю, что он 

забыл в программе поставить команду NEXT.  

 Code –105: Number of FOR is less than the number of NEXT 

Количество команд NEXT и FOR не совпадает. Это сообщение указывает пользователю, что он 

забыл в программе поставить команду FOR. 

 Code–106: Repeated LABEL 

Это сообщение указывает пользователю, что в одной макропрограмме повторяется одна и та же 

метка (LABEL). 

 Code–107: There is RET in Macro 

Это сообщение обозначает, что в основной макропрограмме использована команда RET, которая 

должна применяться только в подпрограммах (sub-macro) для возврата в главную программу. В 

главной программе должна применяться команда END, а не RET.  

 Сообщения HMI об ошибках в макросах 

Сообщение об ошибке в одном макросе не будет влиять на выполнение других макропрограмм.  

 Code–10: GOTO Error 

Это сообщение означает, что в макропрограмме имеется ошибка безусловного перехода GOTO.  

 Code–11: Stack Overflow 

Это сообщение означает, что стек в макропрограмме полон. Причиной этого,  может быть 

использование слишком большого количества подпрограмм или одновременное выполнение 

большого количества макросов одновременно. Сообщение служит для того, что бы избежать 

чрезмерного использования памяти. 

 Code–12: CALL Empty Sub-macro 

Это ошибка выполнения подпрограммы. Подпрограмма (sub-macro), которая вызвана, не должна 

быть пустой. Это сообщение позволяет избежать неожиданной ошибки.  
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 Code–13: Data Read Error 

Это - ошибка чтения данных. Иногда это может быть вызвано ошибкой чтения данных 

оперативной памяти, но в большинстве случаев - ошибкой чтения данных из PLC.  

 Code–14: Data Write Error 

Это - ошибка записи данных. Иногда это может быть вызвано ошибкой записи данных в 

оперативную память, но в большинстве случаев - ошибкой записи данных в PLC.  

 Code–15: Divisor is 0 

Ошибка деления на ноль.  

 Сообщения HMI об ошибках коммуникации 

 

Рис. 4.4.1 Пример сообщения об ошибке связи с PLC 

 Com-порт занят 

Сообщение об ошибке: Com? Station ?: Communication Busy... 

 Неизвестный код 

Сообщение об ошибке: Com ? Station ?: Receive Unknow Code ... 

 Контроллер не отвечает 

Сообщение об ошибке: Com ? Station ?: Controller No Response ... 

 Ошибка контрольной суммы HMI 

Сообщение об ошибке: Com ? Station ?: Check Sum Error in HMI Message ... 

 Ошибка контрольной суммы PLC 

Сообщение об ошибке: Com ? Station ?: Check Sum Error in Controller Message ... 

 Неправильная команда 

Сообщение об ошибке: Com %d Station %d: Command Can Not be Executed ... 

 Неправильный адрес 

Сообщение об ошибке: Com ? Station ?: Address Fault ... 

 Неправильное значение 
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Сообщение об ошибке: Com ? Station ?: Value is Incorrect ... 

 Контроллер занят 

Сообщение об ошибке: Com ? Station ?: Controller is Busy ... 

 Сбой сигнала CTS 

Сообщение об ошибке: Com ? Station ?: CTS Signal Fail ... 

 No Such Resource in Controller 

Сообщение об ошибке: Com ? Station ?: No Such Resource ... 

 Такого ресурса в контроллере не найдено 

Сообщение об ошибке: Com ? Station ?: No Such Service ... 

 Требуется повтор 

Сообщение об ошибке: Com ? Station ?: Must Retry ... 

 Ошибка номера станции HMI 

Сообщение об ошибке: Com ? Station ?: HMI Station Number Error ... 

 Ошибка номера станции PLC 

Сообщение об ошибке: Com ? Station ?: Controller Station Number Error ... 

 Ошибка последовательной связи UART 

Сообщение об ошибке: Com ? Station ?: UART Communication Error ... 

 Прочие ошибки коммуникации 

Сообщение об ошибке: Com? Station ?: Other Communication Error ... 
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Глава 5.  Блок управления и блок состояния 

Для реализации двухсторонней связи между панелью DOP и PLC с целью управления различными 

функциями панели с контроллера и получения им информации о текущем её состоянии, можно 

назначить регистры, которые будут выполнять функции блока управления (control block) и блока 

состояния (status block) панели. Для этого выберите в меню Options > Configuration закладку 

"Standard" как показано на Рис. 5.1 и Рис. 5.2. 

 
Рис. 5.1 Выбор команды "Configuration" в строке меню 

 
Рис. 5.2 Закладка "Standard" в меню "Configuration" 
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5.1 Блок управления (Control Block)  

HMI может управляться от PLC с помощью регистров, назначенных в блоке управления. Максимально 

блок управления может состоять из 8-ми последовательных регистров (слов). При задании размера 

блока надо руководствоваться функциями блока, которые вы собираетесь использовать. Например, 

минимальный размер блока управления при использовании функций рецептов должен быть 7 слов. 

Если размер блока управления задан 0, то работа блока управления будет запрещена. Если работа 

функций блока управления разрешена, то HMI может получать информацию о состоянии внешнего 

контроллера и выполнять его команды, непрерывно читая состояние регистров блока управления.  

Функции и краткие пояснения для каждого слова блока управления см. в нижеприведенной таблице. В 

примерах указаны регистры контроллера Delta PLC: Dn ~ Dn+7 (D0 ~ D7). 

Номер слова Название регистра блока управления Пример 

0 Регистр переключения между экранами  (SNIR)  Dn (D0) 

1 Регистр управляющих флагов (CFR)  Dn+1 (D1) 

2 Регистр управления построением графиков (CUCR)  Dn+2 (D2) 

3 Регистр для выборки данных в буфер архива (HBSR) Dn+3 (D3) 

4 Регистр для очистки буфера архива (HBCR)  Dn+4 (D4) 

5 Регистр управления рецептами (RECR)  Dn+5 (D5) 

6 Регистр для указания номера рецепта (RBIR)  Dn+6 (D6) 

7 Регистр системных управляющих флагов (SCFR)   Dn+7 (D7) 

 

 Регистр переключения между экранами (SNIR) 

Слово Функция 

0 Указание номера экрана, который должен стать активным 

Регистр SNIR (Dn) используется для управления переключением между экранами HMI от внешнего 

PLC (D0). Какое значение будет записано в регистре D0, экран HMI с таким номером и будет 

отображаться на дисплее.  

 

 Регистр управляющих флагов (CFR) 

Номер бита Функция 

0 Разрешение / запрещение коммуникации 

1 Разрешение / запрещение лампы подсветки 

2 Разрешение / запрещение звукового сигнала 

3 Очистка буфера аварийных сообщений 

4 Очистка счетчика аварий 

5~7 Зарезервированы 

8 Установка уровня доступа bit0 
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9 Установка уровня доступа bit1 

10 Установка уровня доступа bit2 

11~15 Зарезервированы 

 Разрешение / запрещение коммуникации 

Управление коммуникацией HMI. Когда Bit 0 = ON, связь HMI будет запрещена. Когда Bit 0 = OFF, 

связь HMI будет разрешена. 

 Разрешение / запрещение лампы подсветки 

Управление лампой подсветки HMI. Когда Bit 1 = ON, лампа подсветки HMI будет выключена. 

Когда Bit 1 = OFF, лампа подсветки HMI будет включена.  

 Разрешение / запрещение звукового сигнала 

Управление звуковым сигналом HMI. Когда Bit 2 = ON, звуковой сигнал будет выключен. Когда Bit 

1 = OFF, звуковой сигнал будет включен. 

 Флаг очистки буфера аварийных сообщений 

Используется для очистки буфера аварийных сообщений. При переключении Bit 3 с OFF на ON, 

все сообщения, хранящиеся в буфере аварий, будут удалены. 

 Флаг очистки счетчика аварий 

Используется для очистки счетчика аварий. При переключении Bit 4 с OFF на ON, значение 

счетчика аварий будет обнулено. 

 Установка уровня доступа 

С PLC может быть установлен текущий уровень доступа HMI с помощью Bit 8, Bit 9 и Bit 10. 

Диапазон установки уровней доступа от 0 до 7. MSB: Bit 10 и LSB: Bit 8. 

 

 Регистр управления построением графиков (CUCR) 

Номер бита Функция 

0 Флаг построения кривой 1 

1 Флаг построения кривой 2 

2 Флаг построения кривой 3 

3 Флаг построения кривой 4 

4~7 Зарезервированы 

8 Флаг очистки кривой 1 

9 Флаг очистки кривой 2 

10 Флаг очистки кривой 3 

11 Флаг очистки кривой 4 
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Номер бита Функция 

12~15 Зарезервированы 

 Флаг построения кривых (1-4)  

Используются для активации процесса построения кривых (трендов или двухкоординатных 

графиков) командой от PLC. При переключении этих флагов (Bit 0 ~ Bit 3 = ON) с OFF на ON, HMI 

будет однократно выбирать считанные данные, конвертировать их в кривые и отображать на 

экране HMI. 

 Флаг очистки кривых (1-4)  

Используются для удаления кривых (трендов или двухкоординатных графиков) с экрана HMI 

командой от PLC. Очистка происходит при переключении этих флагов (Bit 8 ~ Bit 11) с OFF на ON. 

 Регистр для выборки данных в буфер архива (HBSR)  

Используется для управления выборкой данных в буфер архива данных. См. так же описание 

настройки архива данных “History Setup” в главе 2. HMI предоставляет возможность записи 12-ти 

треков архива данных. Выборка данных в HMI может осуществляться через заданные интервалы 

времени или командами PLC посредством описываемых здесь флагов.  

Номер бита Функция 

0 Флаг управления выборкой данных в буфер архива 1 

1 Флаг управления выборкой данных в буфер архива 2 

2 Флаг управления выборкой данных в буфер архива 3 

3 Флаг управления выборкой данных в буфер архива 4 

4 Флаг управления выборкой данных в буфер архива 5 

5 Флаг управления выборкой данных в буфер архива 6 

6 Флаг управления выборкой данных в буфер архива 7 

7 Флаг управления выборкой данных в буфер архива 8 

8 Флаг управления выборкой данных в буфер архива 9 

9 Флаг управления выборкой данных в буфер архива 10 

10 Флаг управления выборкой данных в буфер архива 11 

11 Флаг управления выборкой данных в буфер архива 12 

12~15 Зарезервированы 

 Флаги управления выборкой данных в буферы архива  

Используются для управления выборкой данных в буфер архива данных HMI командами от PLC. 

При переключении флагов (Bit 1 ~ Bit 12) с OFF на ON будет происходить однократная выборка 

данных в соответствующий буфер архива HMI. 

 

 Регистр для очистки буфера архива данных (HBCR) 
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Номер бита Функция 

0 Флаг очистки буфера архива 1 

1 Флаг очистки буфера архива 2 

2 Флаг очистки буфера архива 3 

3 Флаг очистки буфера архива 4 

4 Флаг очистки буфера архива 5 

5 Флаг очистки буфера архива 6 

6 Флаг очистки буфера архива 7 

7 Флаг очистки буфера архива 8 

8 Флаг очистки буфера архива 9 

9 Флаг очистки буфера архива 10 

10 Флаг очистки буфера архива 11 

11 Флаг очистки буфера архива 12 

12~15 Зарезервированы 

 Флаг очистки буфера архива  

Используются для удаления всех данных буфера архива данных HMI командами от PLC. При 

переключении флагов (Bit 1 ~ Bit 12) с OFF на ON будет происходить однократная очистка всех 

данных в соответствующем буфере архива HMI. 

 

 Регистр управления рецептами (RECR) 

Номер бита Функция 

0 Изменение номера рецепта  

1 Чтение рецепта (PLC -> HMI) 

2 Запись рецепта (HMI -> PLC) 

3~15 Зарезервированы 

 Флаг управления переключением номера рецепта  

RCPNo – это внутренний системный регистр, используемый для назначения номера рецепта. 

Значение RCPNo может быть изменено записью номера рецепта (N) в регистр (RBIR) Dn+6 с  

переключением этого контрольного флага в состояние ON (Bit 0 = ON). После переключения, 

RCPNo будет изменено к N автоматически. Этот флаг нуждается в установке на OFF и затем 

снова на ON, если пользователь хочет сделать переключение снова. 

 Флаг управления чтением рецепта  

Перед чтением рецепта из PLC, пользователь должен назначить номер рецепта (N), куда будут 

сохранены читаемые данные (См. описание “Флаг управления переключением номера рецепта”). 

Затем надо переключить флаг управления (Bit 1) с OFF на ON. После этого данные будут 

читаться из PLC и сохраняться в назначенное место (номер рецепта) HMI. 
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 Флаг управления записью рецепта  

Перед записью рецепта в PLC, пользователь должен назначить номер записываемого рецепта (N) 

(См. описание “Флаг управления переключением номера рецепта”). Затем надо переключить 

флаг управления (Bit 2) с OFF на ON. После этого рецепт будет записан в PLC. 

 Регистр для указания номера рецепта (RBIR) 

Слово Функция 

0 Назначение номера читаемого/записываемого рецепта 

При записи номера (N) рецепта в регистр (RBIR), значение RCPNo может быть изменено. 

Пользователи могут использовать контрольный флаг изменения номера рецепта (RECR) для записи 

номера рецепта (N) в регистр (RBIR) и изменение значения RCPNo.  

 

 Регистр системных управляющих флагов (SCFR) 

Номер бита Функция 

0 Уставка многоязыковой поддержки Bit 0 

1 Уставка многоязыковой поддержки Bit 1 

2 Уставка многоязыковой поддержки Bit 2 

3 Уставка многоязыковой поддержки Bit 3 

4 Уставка многоязыковой поддержки Bit 4 

5 Уставка многоязыковой поддержки Bit 5 

6 Уставка многоязыковой поддержки Bit 6 

7 Уставка многоязыковой поддержки Bit 7 

8 Флаг печати 

9 Флаг формы подачи принтера 

10~15 Зарезервированы 

 Уставки многоязыковой поддержки 

С помощью данных флагов осуществляется переключение между языковыми интерфейсами 

объектов при использовании функции многоязыковой поддержки. Каждому флагу соответствует 

язык, назначенный в закладке "Other" меню "Configuration".  

 Флаг печати 

При установке этого флага в состояние ON, текущий дисплей или редактируемый экран может 

быть выведен на печать. Когда флаг в состоянии OFF, функция печати запрещена. 

 Printer Form Feed Flag 

When this flag is triggered to ON, the printer will retract the paper and align the paper for the next run 

automatically. When this flag is set to OFF, the printing form feed function is disabled. 
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5.2 Блок состояния 

PLC может получать информацию о текущем состоянии HMI с помощью регистров, назначенных в 

блоке состояния. Максимально блок состояния может состоять из 8-ми последовательных регистров 

(слов), начиная с Dm=D10 (размер 8 слов = D10-D17). Если размер блока управления задан 0, то 

работа блока управления будет запрещена. Если работа блока управления запрещена, работа блока 

состояния будет запрещена так же. Если работа функций блока состояния разрешена, то внешний 

контроллер, т.е. PLC может получать информацию о текущем состоянии HMI, читая регистры блока 

состояния. Функции и краткие пояснения для каждого слова блока состояния см. в нижеприведенной 

таблице. В примерах указаны регистры контроллера Delta PLC: Dm ~ Dm+7 (D10 ~ D17).) 

Номер слова Название регистра блока состояния Пример 

0 Регистр состояния для общего контроля (GCSR) Dm (D10) 

1 Регистр состояния номера экрана (SNSR) Dm+1 (D11) 

2 Регистр состояния построения графиков (CCSR) Dm+2 (D12) 

3 Регистр состояния выборки данных в буфер архива 
(HSSR) 

Dm+3 (D13) 

4 Регистр состояния очистки буфера архива (HCSR) Dm+4 (D14) 

5 Регистр состояния рецептов (RESR) Dm+5 (D15) 

6 Регистр состояния номера рецепта (RBSR) Dm+6 (D16) 

7 Регистр состояния 2 для общего контроля (GCSR2) Dm+7 (D17) 

 

 Регистр состояния для общего контроля (GCSR) 

Номер бита Функция 

0 Состояние переключения между экранами  

1~2 Зарезервированы 

3 Статус очистки буфера аварий  

4 Статус очистки счетчика аварий  

5-7 Зарезервированы 

8 Уровень доступа (Bit0) 

9 Уровень доступа (Bit1) 

10 Уровень доступа (Bit2) 

11 Уровень доступа (Bit3) 

12~15 Зарезервированы 

 Состояние переключения между экранами 

В момент переключения между экранами этот бит будет включен (ON). После завершения 

переключения бит будет выключен (OFF). 
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 Статус очистки буфера аварий 

В момент очистки буфера аварий HMI (функция очистки буфера аварийных сообщений 

разрешена), этот бит будет включен (ON). После выполнения бит будет выключен (OFF). 

 Статус очистки счетчика аварий 

В момент очистки счетчика аварий HMI (функция очистки счетчика аварийных сообщений 

разрешена), этот бит будет включен (ON). После выполнения бит будет выключен (OFF). 

 Состояние уровня доступа  

Bit 8 ~ Bit 11 позволяют прочитать текущий уровень доступа пользователя в HMI.  

                       бит 
 
Уровень  
доступа  

Bit 8 Bit 9 Bit 10 Bit 11 

0 OFF OFF OFF OFF 

1 ON OFF OFF OFF 

2 OFF ON OFF OFF 

3 ON ON OFF OFF 

4 OFF OFF ON OFF 

5 ON OFF ON OFF 

6 OFF ON ON OFF 

7 ON ON ON OFF 

8 OFF OFF OFF ON 

 

 Регистр состояния номера экрана (SNSR) 

Слово Функция 

0 Номер последнего открытого экрана 

 Номер последнего открытого экрана 

Регистр SNSR (Dm+1) для хранения номера текущего открытого экрана. Каждый раз при 

переключении между экранами, последний экран, открытый пользователем (включая sub-screen) 

будет записываться в регистре (D11).  

 

 Регистр состояния построения графиков (CCSR) 

Номер бита Функция 

0 Статус построения кривой 1  

1 Статус построения кривой 2  
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2 Статус построения кривой 3 

3 Статус построения кривой 4 

8 Статус очистки кривой 1 

9 Статус очистки кривой 2 

10 Статус очистки кривой 3 

11 Статус очистки кривой 4 

4~7;12~15 Зарезервированы 

 Статус построения кривых 

Во время опроса регистров координат трендов или двухкоординатных графиков, 

соответствующие биты (Bit 0 ~ Bit 3) будут включены (ON). После выполнения биты будут 

выключены (OFF).  

 Статус очистки кривых 

Во время удаления трендов или двухкоординатных графиков, соответствующие биты (Bit 8 ~ Bit 

11) будут включены (ON). После выполнения биты будут выключены (OFF).  

 

 Регистр состояния выборки данных в буфер архива (HSSR) 

Номер бита Функция 

0 Статус опроса буфера архива данных 1  

1 Статус опроса буфера архива данных 2  

2 Статус опроса буфера архива данных 3 

3 Статус опроса буфера архива данных 4 

4 Статус опроса буфера архива данных 5 

5 Статус опроса буфера архива данных 6 

6 Статус опроса буфера архива данных 7 

7 Статус опроса буфера архива данных 8  

8 Статус опроса буфера архива данных 9 

9 Статус опроса буфера архива данных 10 

10 Статус опроса буфера архива данных 11 

11 Статус опроса буфера архива данных 12 

12-15 Зарезервированы 

 Флаги выборки данных в буферы архива  

Во время опроса регистров буфера архива, соответствующие биты (Bit 0 ~ Bit 11) будут 

включены (ON). После выполнения операции биты будут выключены (OFF).  
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 Регистр состояния очистки буфера архива (HCSR) 

Номер бита Функция 

0 Статус очистки буфера архива данных 1  

1 Статус очистки буфера архива данных 2 

2 Статус очистки буфера архива данных 3 

3 Статус очистки буфера архива данных 4 

4 Статус очистки буфера архива данных 5 

5 Статус очистки буфера архива данных 6 

6 Статус очистки буфера архива данных 7 

7 Статус очистки буфера архива данных 8 

8 Статус очистки буфера архива данных 9 

9 Статус очистки буфера архива данных 10 

10 Статус очистки буфера архива данных 11 

11 Статус очистки буфера архива данных 12 

12~15 Зарезервированы 

 Флаги очистки данных в буферах архива  

Во время удаления данных из буферов архива, соответствующие биты (Bit 0 ~ Bit 11) будут 

включены (ON). После выполнения операции биты будут выключены (OFF).  

 

 Регистр состояния рецептов (RESR) 

Номер бита Функция 

0 Состояние изменения номера рецепта  

1 Состояние чтения рецептов (PLC -> HMI)  

2 Состояние записи рецептов (HMI -> PLC)  

3~15 Зарезервированы 

 Состояние изменения номера рецепта 

Во время изменения номера рецепта управляемого от PLC, Bit 0 будет включен (ON). После 

изменения номера рецепта и обновления значения RCPNo, бит будет выключен (OFF).  

 Флаг состояния чтения рецептов 

Когда HMI читает данные рецепта из PLC, флаг состояния (Bit 1) будет включен (ON). Когда 

данные рецепта полностью прочитаны и сохранены в HMI, флаг будет выключен.  

 Флаг состояния записи рецептов 

Когда HMI записывает данные рецепта в PLC, флаг состояния (Bit 2) будет включен (ON). Когда 

данные рецепта полностью записаны и сохранены в PLC, флаг будет выключен.  
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 Регистр состояния номера рецепта (RBSR) 

Слово Функция 

0 Текущий номер рецепта 

Когда регистр номера регистра RCPNo изменяется (не важно изменяется от PLC или HMI), регистр 

состояния номера рецепта (RBSR) (Dm+6) будет так же обновлен. Может использоваться для 

мониторинга текущего номера рецепта. 

 

 Регистр состояния 2 для общего контроля (GCSR2) 

Номер бита Функция 

0 Статус уставки многоязыковой поддержки Bit 0 

1 Статус уставки многоязыковой поддержки Bit 1 

2 Статус уставки многоязыковой поддержки Bit 2 

3 Статус уставки многоязыковой поддержки Bit 3 

4 Статус уставки многоязыковой поддержки Bit 4 

5 Статус уставки многоязыковой поддержки Bit 5 

6 Статус уставки многоязыковой поддержки Bit 6 

7 Статус уставки многоязыковой поддержки Bit 7 

8 Флаг состояния печати 

9 Флаг состояния формы подачи принтера 

10~15 Зарезервированы 

 Статус уставок многоязыковой поддержки 

С помощью данных флагов можно узнать о текущем языке отображаемом на HMI. 

 Флаг состояния печати 

When this flag is triggered to ON, it indicates that the printer is printing current display or editing screen. 

When this flag is set to OFF, the printer function is disabled. 

 Флаг формы подачи принтера 

When this flag is triggered to ON, it indicates that the printer is retracting the paper and aligning the 

paper for the next run automatically. When this flag is set to OFF, the printing form feed function is 

disabled. 
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Глава 6.  Внутренняя память 

 Внутренние регистры (R/W): $ 

Обращение к словам:  $n (n:  0~65535) 

Обращение к битам:  $n.b (n:  0~65535, b: 0~15) 

HMI серии DOP предоставляет в пользование 65536 16-битных внутренних регистров ($0 ~ 

$65535). 

 Энергонезависимые внутренние регистры (R/W): $M 

Обращение к словам:  $Mn (n:  0~1023) 

Обращение к битам:  $Mn.b (n:  0~1023, b: 0~15) 

HMI серии DOP предоставляет в пользование 1024 16-битных энергонезависимых внутренних 

регистров ($M0 ~ $M1023). 

 Регистры косвенной адресации (R/W): *$ 

Обращение к словам:  *$n (n:  0~65535) 

Регистр косвенной адресации – это регистр, хранящий значение из адреса одноименного 

внутреннего регистра. Пользователю надо извлечь адрес из $n и затем извлечь значение, 

сохраненное в этом адресе. 

*$n =  

 

 

Например, если $n = m; $m = X; то *$n = X. (значение m не может превышать 65535) 

 Регистр номера рецепта (R/W): RCPNO 

Это 16-битный регистр, который используется для назначения номера группе параметров 

(рецепту). Минимальный номер рецепта = 1, а максимальный определяется при редактировании 

рецептов. 

PLC при загрузке будет читать/писать группу параметров рецепта, назначенную в регистре 

номера рецепта. Размер каждого рецепта определяется при редактировании рецептов. 

HMI серии DOP предоставляет в пользование область в 64K Words макс. для хранения рецептов.  

 Регистры рецептов (R/W): RCP 

Размер рецепта L и число рецептов N. 

$n m 

X 
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Обращение к словам:  RCPn (n:  0~NxL+(L-1)) 

Обращение к битам:  RCPn.b (n:  0~NxL+(L-1), b: 0~15) 

Регистры рецептов используются для хранения рецептурных данных, которые загружены из HMI 

после обработки ScrEdit. 

Есть два метода чтения/записи этих регистров: 

Допустим, что пользователь установил размер рецепта как L и номер рецепта как N: 

Групповой адресный доступ: 

Этот метод предоставляет доступ через RCPNO и RCP0~RCP (L-1).  

Например: если RCPNO=3, HMI будет читать RCPNO 3 данные и сохранять их в RCP0~RCP (L-1). 

Затем PLC может читать RCPNO 3 данные из этой области. RCP0~RCP (L-1) могут 

рассматриваться, как общая область. 

Абсолютный адресный доступ: 

Этот метод используется для доступа к данным, адреса которых больше чем RCP (L-1). 

Стартовый адрес 1-го рецепта RCP (1XL), стартовый адрес 2-го рецепта RCP (2XL) и  т.д. 

Следовательно, если пользователь хочет получить доступ к m-му слову n-го рецепта, он может 

использовать уравнение: RCP(nxL+m) для достижения цели. 

RCP0 RCP1 RCP2 RCP (L-1)...

1xL 1xL+1 1xL+2 1xL+(L-1)
2xL 2xL+1 2xL+2

...

...

...

2xL+(L-1)

...

NxL NxL+1 NxL+2 NxL+(L-1)

RCP0=1
RCP0=2

RCP0=N

RCP0=X; (1<=X<=N)
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Приложение A.  Спецификация и установка 

A.1 Спецификация 

Модель A(E)57BSTD A(E)57GSTD A(E)57CSTD A(E)80THTD AE94BSTD A10TCTD / 
AE10THTD 

При
меч.

Тип ЖК-дисплея STN FSTN STN TFT-LCD STN TFT-LCD  

Цветность 8 оттенков 
голубого 

16 оттенков 
серого 256 цветов 65536 цветов 8 оттенков 

голубого 

256 цветов 
(AE: 65536 
цветов) 

 

Разрешение 320 x 240 пикс. 640 x 480 пикс.  

Ресурс лампы 
подсветки Около 50 000 часов при 25°C 

Около 
50000 часов
при 25°C 

Около 
30000 часов 
при 25°C 

Около 
30000 часов
при 25°C 

 

Размер экрана 5.7” (118.2 x 89.4мм) 8.0” (162.2 
x121.7мм) 

9.4” (192.0 
x144.0мм) 

10.4” (215.2 
x 162.4мм)

 

Операционная 
система Windows ОS реального времени  

ЦПУ 32-bit RISC Micro-controller / 202.8MHz  
ROM 3M Bytes 7M Bytes  

 SDRAM 16M Bytes 32M Bytes 16M Bytes 32M Bytes  
Энергонезавис. 
память данных 

(SRAM) 
256K Bytes (AE: 512K Bytes)  

Внешняя карта 
памяти 

Smart Media Card (исключая A: 8” и AE: 9.4") /  
USB Host Ver 1.1 (в серии AE исключая 5.7”) * 

Порт USB для 
загрузки 

программы 
USB CLIENT Ver 1.1 & COM1, COM2  

Последовательн. 
комм. порты 

(UART) 

COM1(RS-232),COM2 и COM3(RS-232C/422/485) 
(AE серия: COM3 (RS-232C/422/485))  

Функциональные 
кнопки 4 программируемые кнопки 6 прогр. 

кнопок 
11 прогр. 
кнопок 

7 прогр. 
кнопок  

RTC Встроенные часы реального времени и календарь   

Батарея Литиевая батарея CR2032X1, 3В (срок службы 5 лет)  
Встроенный 
динамик Громкость 85dB  

Напряжение 
питания +24 В постоянного тока (-10% ... +20%)  

Потребляемая 
мощность 7.2 Вт макс. 15 Вт макс.  

Охлаждение Естественная конвекция  
Степень защиты IP65 / NEMA4 и CE, UL, C-tick (кроме AE серии)  

Рабочая 
температура 
окружающей 

среды 

0°C … 50°C  
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Модель A(E)57BSTD A(E)57GSTD A(E)57CSTD A(E)80THTD AE94BSTD A10TCTD / 
AE10THTD 

При
меч.

Температура 
хранения 

-20°C … +60°C  

Относительная 
влажность 

10% ~ 90% RH (0~40°C), 10%~55% RH (41~50°C) 
 

Допустимая 
вибрация 

В соответствие с IEC61131-2  
Кратковременная вибрация: 10Hz-57Hz 0.0075mm, 57Hz-150Hz 1G 
Продолжительная вибрация: 10Hz-57Hz 0.0035mm, 57Hz-150Hz 0.5G 

по осям X, Y, Z до 10 раз  

 

(W) x (H) x (D) 
Габаритные 
размеры (мм) 

184.1 x 144.1 x 47мм / 172.4 x 132.4мм

243.1 x178.1 
x 52.4мм / 

231.4 x 
166.4мм 

297.1 x 
222.1 x 

50.9мм / 
285.2 x 

210.2мм 

297.1 x 
222.1 x 

51.1мм / 
285.2 x 

210.2мм  

 

Масса 768г. 1140г. 1700г. 1735г.  

* Совместимы со стандартными картами расширения памяти (4M~128M) предлагаемыми на рынке 
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A.2 Габаритные размеры 

 DOPA(E)57G(C)(B)STD 

Вид сверху – Ед.: мм (дюймы) 

169.0(6.65)

 
Вид спереди – Ед.: мм(дюймы) Вид справа – Ед.: мм(дюймы) 

14
4.

1(
5.

67
)

184.1(7.25)

 

6.1(0.24)

12
9.

0(
5.

08
)

47.0(1.85)
8.0(0.31)

 

 DOP-A(E)80THTD 

Вид сверху – Ед.: мм (дюймы) 

228.0(8.98)

 
Вид спереди – Ед.: мм(дюймы) Вид справа – Ед.: мм(дюймы) 
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17
8.

1(
7.

01
)

243.1(9.57)

 
15(0.59)

89
.1

(3
.5

1)

8.0(0.31)
(2.06)52.4 6.1(0.24)

16
3.

0(
6.

42
)

 

 DOPAE94BSTD 

Вид сверху – Ед.: мм (дюймы) 

 

Вид спереди – Ед.: мм(дюймы) Вид справа – Ед.: мм(дюймы) 

  

 

 

281.8 
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 DOP-A10TCTD/DOP-AE10THTD 

Вид сверху – Ед.: мм (дюймы) 

281.7(8.98)

 

Вид спереди – Ед.: мм(дюймы) Вид справа – Ед.: мм(дюймы) 

297.1(9.57)

22
2.

4(
7.

01
)

 

51.1(1.85) 6.1(0.24)
8.0(0.31)

20
6.

7(
6.

42
)

 

A.3 Описание конструкции 

 DOPA(E)57G(C)(B)STD 

A Дисплей 

B Сенсорный экран 

C Светодиод индикации питания  

 Темный: нет питания. 

 Зеленый: питание подано 

D Клеммный разъем питания  

E Слот расширения 

F Порт для карты памяти (SMC) 

G Порт COM 2 

H Порт COM 1 

I Порт USB 

( ) ( )( ) ( )

A,B

C

D

E

F

G H I

F

 

 

Вид спереди 

Вид сзади Вид сбоку 
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 DOP-A(E)80THTD 

A Дисплей 

B Сенсорный экран 

C Светодиод индикации питания 

 Темный: нет питания 

 Зеленый: питание подано 

D Клеммный разъем питания 

E Слот расширения 

F Порт для карты памяти (SMC) 

G Порт COM 2 

H Порт COM 1 

I Порт USB 
H

E

J I

F

G

A,B

C

D

F

 
 

 

 DOP-A10TCTD/DOP-AE10THTD 

A Дисплей 

B Сенсорный экран 

C Светодиод индикации питания 

 Темный: нет питания 

 Зеленый: питание подано 

D Клеммный разъем питания 

E Слот расширения 

F Порт для карты памяти (SMC) 

G Порт COM 2 

H Порт COM 1 

I Порт USB 

J Батарейный отсек 

F

E

H G

D

A,B

F

C

J I  

 

Вид спереди 

Вид сзади Вид сбоку 

Вид спереди 

Вид сзади Вид сбоку 
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A.4 Установочные размеры 

5.7": 172.4мм (6.79") +1мм (0.04") и 132.4мм (5.21")+1мм (0.04")   Ед.: мм (дюймы) 

Толщина монтажной панели: 1.6мм (0.06")~3.0мм (0.12") 

4-R3(0.12)

T

NOTE:

172.4

13
2.

4

14
4.

1(
5.

67
)

184.1(7.25)

6.1(0.24)39.0(1.54)

DOP-A(E)57G(B)(C)STD(-W)

3.0mm(0.12in)
T=1.6mm(0.06in) ~ (5

.2
1 

   
)

+1  0
+0

.0
4

 0

(6.79    ) 0
+1 +0.04

 0

 

 

9.4": 285.2мм (11.22")+1мм (0.04") мм 210.2мм (8.27")+1мм (0.04")      Ед.: мм (дюймы) 

Толщина монтажной панели: 1.6мм (0.06")~3.0мм (0.12") 

  
 

Монтажная панель 

Монтажная панель 
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8.0": 231.4мм (9.11")+1мм (0.04") и 166.4мм (6.55")+1мм (0.04")      Ед.: мм (дюймы) 

Толщина монтажной панели: 1.6мм (0.06")~3.0мм (0.12") 

T=1.6mm(0.06in) ~
3.0mm(0.12in)

(1.75)

DOP-A(E)80TC(H)TD

17
8.

1(
7.

01
)

243.1(9.57)

 0
+1231.4  0(9.11      )+0.04

+0
.0

4
(6

.5
5 

   
   

)
 0+1

16
6.

4
 0

NOTE:

4-R
3.0

(0.
12

)

44.4
T

6.1(0.24)

 

10.4": 285.2мм (11.22")+1мм (0.04") и 210.2мм (8.27")+1мм (0.04")      Ед.: мм (дюймы) 

Толщина монтажной панели:  1.6мм (0.06")~3.0мм (0.12") 

NOTE:

T

21
0.

2

285.2
4-R

3.0
(0.

12
)

DOP-A(E)10TC(H)TD
+0.04

(11.22       )+1
 0  0

T=1.6mm(0.06in) ~

(8
.2

7 
   

   
)

+1  0
+0

.0
4

 0

3.0mm(0.12in)

297.1(11.70)

22
2.

1(
8.

74
)

43.1(1.70) 6.1(0.24)

 

 

Монтажная панель 

Монтажная панель 
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A.5 Установка  

 

 Момент затяжки крепежных винтов не должен превышать 0.5Нм, иначе пластиковый 
корпус может быть разрушен. 

Панели 5.7” (DOP-A(E)57GSTD, DOP-A(E)57CSTD, DOP-A(E)57BSTD) 

DOPA(E)57G(C)(B)STD(-W)

 

Панели 9.4” (DOP-AE94BSTD) 

DOPA75CSTD

 

Панели 8.0” (DOP-AE80THTD) 

DOPA(E)80TC(H)TD

 

Вид сверху 
Крепежные отверстия 

Вид снизу 
Крепежные отверстия 

Фиксатор 
Монтажная панель 

Вид сверху 
Крепежные отверстия 

Вид снизу 
Крепежные отверстия 

Фиксатор Монтажная панель 

  

Фиксатор 
Монтажная панель 

Вид сверху 
Крепежные отверстия 

Вид снизу 
Крепежные отверстия 
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10.4” Panel (DOP-A(E)10TCTD) 

DOPA(E)10TC(H)TD

 

 

 

Фиксатор 
Монтажная панель 

Вид сверху 
Крепежные отверстия 

Вид снизу 
Крепежные отверстия 
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Приложение B. Коммуникация 

B.1 Назначение контактов коммуникационных портов  

 COM1 

Pin Контакт 
1 N.C. 
2 RXD 
3 TXD 
4 N.C. 
5 GND 
6 N.C. 
7 RTS 
8 CTS 

 

9 N.C. 

 

 COM2 

Режим1 Режим 2 Режим 3 
Pin 

RS-232 RS-422 RS-485 
1 N.C. RXD- D- 
2 RXD RXD+ D+ 
3 TXD TXD+ D+ 
4 N.C. TXD- D- 
5 GND GND GND 
6 N.C. RTS- N.C. 
7 RTS RTS+ N.C. 
8 CTS CTS+ N.C. 

 

9 N.C. CTS- N.C. 

Примечание  

1) Режим 3 для RS-485: контакты D+ (pin 2 и 3 надо соединить перемычкой); контакты D- (pin 1 и 4 

надо соединить перемычкой). 

2) Рекомендуется использовать заземление портов, если кабели RS-485 и RS-422 имеют большую 

длину. 

3) Не соединяйте заземляющие клеммы корпуса (FGND) и портов (GND). 

4) Скорость и устойчивость связи будет определяться расстоянием и заданной скоростью передачи. 

Pin1 

Pin1 
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B.2 Кабели для загрузки программы  

Разъем DB-9 (штекер) кабеля со стороны панели.  
 

 
См. в таблице назначение контактов. 

Связь по RS-232 

DOP  
9 pin D-SUB штекер 

(RS-232) 

PC  
9 pin D-SUB гнездо  

(RS-232) 

PC  
9 pin D-SUB гнездо 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

RTS (7) (8) CTS

CTS (8) (7) RTS  

 
 
 
 
 
 
 

 
D-SUB 9pin (штекер) со стороны DOP                           D-SUB 9pin (гнездо) со стороны PC  

 
Заземление + Экранирование 

Рис. Кабель RS-232 для связи с PC 

Связь по USB 

 
USB тип B со стороны DOP                                                                        USB тип A со стороны PC 

 
Рис. Кабель USB для связи с PC 

Pin1 
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B.3 Соединение и настройка связи HMI с контроллерами различных брендов 

Для связи с внешними контроллерами должен использоваться кабель с разъемом типа DB-9 (9-pin D-

SUB штекер (папа)) для подключения к COM-порту панели DOP.  

 

 

Бренд Название / серия контроллера 

Delta Controller 
Для сервоприводов/ПЧ/регуляторов температуры/ПЛК 
(984 RTU mode / ASCII mode) Delta 

Delta DVP PLC 

MicroLogix PLC 
Allen Bradley 

SLC5 PLC 

Danfoss VLT 2800 (FC Protocol) 

Facon Facon PLC 

Festo Festo_PLC 

GE Fanuc 90 Series SNP PLC 

Hust Hust CNC Controller 

Nano Series PLC 
Jetter 

JC Series PLC 

Keyence KV/KZ Series 

SU/DL Series 
Koyo 

K-Sequence 

Lenze LECOM-A/B Protocol 

Master K120S/200S 

Glofa GM6 CNET LG 

Master-K CNET 

LI YAN LYPLC EX 

M2i Master 
M2i 

M2i Slave 

Matsushita FP Series 

Mirle FAMA SC 

Mitsubishi FX / FX2N 
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Бренд Название / серия контроллера 

A Series/J71UC24 

Mitsubish A2A/A2AS/A2USH A1SH/A3N/A2ASH CPU Port 

Q Series CPU Port 

MKS CT150 

Modbus (Master) --- 984 RTU / ASCII mode 

Hexadecimal Address (Master) --- RTU / ASCII mode 

nW (Master) --- RTU / ASCII mode 
Modbus 

Modbus (Slave) --- RTU / ASCII mode 

TSX Micro (Uni-Telway) 
Modicon 

TWIDO 

NIKKI DENSO NCS-FI/FS Series 

C Series 
Omron 

CJ1/CS1 Series 

S7 200 

S7-300 (with PC Adaptor) Siemens 

S7-300 (without PC Adaptor) 

Taian TP02 PLC 

Vigor M Series 

Yokogawa ACE PLC 
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Связь с контроллерами Delta (серво/ПЧ/ПЛК/регуляторы температуры) DELTA 

A. Заводские значения параметров связи HMI 

Протокол: ASCII: 9600, 7, None, 2.  

 RTU: 9600, 8. None, 2 

Адрес контроллера: 1. 

Блок управления/блок состояния: не заданы. 

Примечание  

1) С помощью этого драйвера можно осуществить связь со всеми приборами компании Delta, т.е. с 

преобразователями частоты, программируемыми контроллерами, сервоприводами, регуляторами 

температуры и другими устройствами стандарта Modbus. 

2) При использовании стандартного соединения Modbus доступны следующие режимы: 

Modbus / ASCII (Master), Modbus / 984 RTU (Master), Modbus / ASCII Hex Address (Master) и Modbus 

/ RTU Hex Address (Master). При желании изменить драйвер, пользователю требуется в поле 

“Controller” меню "Option" выбрать другой контроллер, и новый драйвер сразу же начнет работать. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Bit No. 
Размер 
данных 

Коммуникационные 
адреса сервопривода SERVO-n n: 0 ~ 0700h нет Word 

Коммуникационные 
адреса ПЧ INVERTER-n n: 0 ~ 2299h нет Word 

Коммуникационные 
адреса темп. контр. TEMP_CTRL-n n: 0 ~ 6000h нет Word 

WORD_DEVICE_X PLC_Xn n: 0 ~ 360(octal) нет Word 

WORD_DEVICE_Y PLC_Yn n: 0 ~ 360(octal) нет Word 

WORD_DEVICE_M PLC_Mn n: 0 ~ 1520, нет Word 

  1536 ~ 4080 нет Word 

WORD_DEVICE_S PLC_Sn n: 0 ~ 1008 нет Word 

WORD_DEVICE_T PLC_Tn n: 0 ~ 255 нет Word 

WORD_DEVICE_C PLC_Cn n: 0 ~ 199 нет Word 

WORD_DEVICE_D PLC_Dn n: 0 ~ 4095, нет Word 

  4096 ~ 9999 нет Word 

WORD_DEVICE_HC PLC_HCn n: 200 ~ 255 нет Double Word 

Коммуникационные 
адреса модулей PLC PLC_Modulen n: 4000 ~ 4499h нет Word 

Регистры вывода RW-n n: 0 ~ FFFFh нет Word 
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Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Bit No. 
Размер 
данных 

Регистры ввода R-n n: 0 ~ FFFFh нет Word 

Регистры вывода Wn n: 40001 ~  50000 нет Word 

Регистры ввода Wn n: 30001 ~ 40000 нет Word 

Примечание  

1) Показанные выше адреса регистров Servo, AC drive, TCNTRL (температурный контроллер) и 

модулей PLC указаны в шестнадцатеричном формате. Словные операнды PLC: X и Y – в 

восьмеричном формате. Другие словные операнды PLC: M, S, T, C, D и HC - в десятичном 

формате. 

2) Адреса регистров WORD_DEVICE_ X / WORD_DEVICE_Y / WORD_DEVICE_M / WORD_DEVICE_S 

должны быть 0 или кратны 16. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Коммуникационные адреса 
сервопривода SERVO-n.b n: 0 ~ 0700h b: 0 ~ f 

Коммуникационные адреса ПЧ INVERTER-n.b n: 0 ~ 2299h b: 0 ~ f 

Коммуникационные адреса 
температурного контроллера TEMP_CTRL-n.b n: 0 ~ 6000h b: 0 ~ f 

Цифровые входы сервопривода SERVO_DI-n нет n: 1 ~ 8 

Цифровые выходы сервопривода SERVO_DO-n нет n: 1 ~ 5 

WORD_DEVICE_X PLC_Xn нет n: 0 ~ 377(octal) 

WORD_DEVICE_Y PLC_Yn нет n: 0 ~ 377(octal) 

WORD_DEVICE_M PLC_Mn нет n: 0 ~ 1535 

   1536 ~ 4095 

WORD_DEVICE_S PLC_Sn нет n: 0 ~ 1023 

WORD_DEVICE_T PLC_Tn нет n: 0 ~ 255 

WORD_DEVICE_C PLC_Cn нет n: 0 ~ 255 

Битовые коммуникационные 
адреса темп. контроллера 

TEMP_CTRLB-n нет n: 800 ~ 8FFh 

Дискретные выходы RWB-n нет n: 0 ~ FFFFh 

Дискретные входы RB-n нет n: 0 ~ FFFFh 

Дискретные выходы Bn нет n: 1 ~ 10000 

Дискретные входы Bn нет n: 10001 ~ 20000 

Примечание  

1) Показанные выше адреса регистров Servo, AC drive, TCNTRL (температурный контроллер) и 

модулей PLC указаны в шестнадцатеричном формате.  
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2) Словные операнды PLC: X и Y – в восьмеричном формате. Другие словные операнды PLC: M, S, 

T, C, D и HC - в десятичном формате. 

3) Цифровые входы и выходы сервопривода используются только для сервопривода. 

Обратите внимание на следующую важную информацию: 

4) Для преобразователей частоты Delta: 

Коммуникационные адреса внутренних параметров ПЧ задаются в шестнадцатеричном формате. 

Для более подробного описания обратитесь к руководствам по эксплуатации соответствующих 

моделей ПЧ. 

Пример 1: Для обращения к параметру 9-01 ПЧ серии VFD-S требуется в HMI задать адрес 

INVERTER901. (десятичное число 9 конвертируется в шестнадцатеричное 09 и десятичное 01 

конвертируется в шестнадцатеричное 01. Следовательно, при задании INVERTER901 в HMI будет 

отброшен первый 0) 

Десятичное число 

Десятичное число

01 Шестнадцатеричное число

09 Шестнадцатеричное число  
Коммуникационный адрес параметра 9-01 = 0901H. 

Пример 2: Для обращения к параметру 8-17 ПЧ серии VFD-S требуется в HMI задать адрес 

INVERTER811. (8 конвертируется в шестнадцатеричное 08 и 17 конвертируется в 

шестнадцатеричное 11. Следовательно, при задании INVERTER811 в HMI будет отброшен 

первый 0) 

Десятичное число  

Десятичное число

11 Шестнадцатеричное число

08 Шестнадцатеричное число  
Коммуникационный адрес параметра 8-17 = 0811H. 

5) Для сервоприводов Delta: 

 Для более подробного описания коммуникационных адресов сервопривода обратитесь к 

руководствам по эксплуатации соответствующих моделей. 

 Цифровые входы и выходы сервопривода используются только для сервопривода. 

6) Для регуляторов температуры Delta (DTA серия): 

HMI может иметь соединение с несколькими регуляторами температуры Delta A серии по 

стандартному протоколу Modbus, используя режим передачи RTU. Однако, время задержки связи 

может нуждаться в увеличении. Рекомендуемое время 5мс и больше. 
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C. Связь (Цоколевка разъемов) 

Сервоприводы Delta 

Связь по RS-232  

DOP 
9 pin D-SUB штекер (RS-232) 

Сервопривод 
Разъем CN3 (RS-232) 

Сервопривод 
Разъем CN3 (RS-232) 

RXD (2) (2) TX

TXD (3)

GND (5)

(4) RX

(1) GND 

 
1  

2  

3  5  

4  6 
Top View  

Связь по RS-422 

DOP 
9 pin D-SUB штекер (RS-422) 

Сервопривод 
Разъем CN3 (RS-422) 

Сервопривод 
Разъем CN3 (RS-422) 

RXD+ (2) (5) TX+

RXD- (1)

TXD+ (3)

(6) TX-

(3) RX+

TXD- (4) (4) RX-  

 
1  

2  

3  5  

4  6 
Top View  

Связь по RS-485 

DOP 
9 pin D-SUB штекер (RS-485) 

Сервопривод 
Разъем CN3 (RS-485) 

Сервопривод 
Разъем CN3 (RS-485) 

RXD+ (2) (3) 485+

TXD+ (3)

RXD- (1)

(5) 485+

(4) 485-

TXD- (4) (6) 485-  

 
1  

2  

3  5  

4  6 
Top View  
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Преобразователи частоты Delta 

Связь по RS-485 

DOP 
9 pin D-SUB штекер  

(RS-485) 

ПЧ  
Разъем RJ-11 

(RS-485) 

ПЧ  
Разъем RJ-11 

(RS-485) 

RXD+ (2) (4 ) SG+

TXD+ (3)

RXD- (1 )

TXD- (4) (3 ) SG-

GND (5) (2 ) GND 

Top View

DO NOT use Pin 1, 5 and 6 while
using RS-485 communication.

61

2: GND
3: SG-
4: SG+

 

 При связи с преобразователем серии VFD-M, пожалуйста, соедините Pin 5 (GND) разъема Delta 

HMI и Pin 2 (GND) разъема Delta VFD-M. 

Температурные контроллеры 

Связь по RS-485 

DOP 
9 pin D-SUB штекер (RS-485) 

Контроллер 
Порт RS-485 

RXD+ (2) D+

TXD+ (3)

RXD- (1)

TXD- (4) D-  
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Delta DVP PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, Even, 2. 

Адрес контроллера: 1. 

Блок управления/блок состояния: D0 / D10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

X_данные Xn n: 0 ~ 360(octal) НЕТ 

Y_ данные Yn n: 0 ~ 360(octal) НЕТ 

M_ данные Mn n: 0 ~ 1520, 1536 ~ 4080 НЕТ 

S_ данные Sn n: 0 ~ 1008 НЕТ 

T_регистры Tn n: 0 ~ 255 НЕТ 

C_регистры Cn n: 0 ~ 199 НЕТ 

D_регистры Dn n: 0 ~ 4095, 4096 ~ 9999 НЕТ 

HC_регистры Cn n: 200 ~ 255 НЕТ 

Примечание  

1) (W) - это “Word” (слово). 

2) (DW) - это “Double Word” (двойное слово). 

3) X_Data / Y_Data / M_Data / S_Data: адреса должны быть 0 или кратны 16.  

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

X_данные Xn НЕТ n: 0 ~ 377(octal) 

Y_данные Yn НЕТ n: 0 ~ 377(octal) 

M_данные Mn НЕТ n: 0 ~ 1520, 

   1536 ~ 4080 

S_данные Sn НЕТ n: 0 ~ 1023 

T_катушка Tn НЕТ n: 0 ~ 255 

C_катушка Cn НЕТ n: 0 ~ 255 
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C. Связь (Цоколевка разъемов) 

Связь по RS-232 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер  

(RS-232) 

RXD (2) (5) TXD

TXD (3)

GND (5)

(4) RXD

(8) GND 

 1 
4 5 

8 

Top View  

Связь по RS-485 

DOP 
9 pin D-SUB штекер (RS-485) 

Контроллер 
порт RS-485 

RXD+ (2) D+

TXD+ (3)

RXD- (1 )

TXD- (4) D-  
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AllenBradley MicroLogix PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 19200, 8, None, 1. 

Адрес контроллера: 1. 

Блок управления/блок состояния: B3:0/B3:10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 

Номер бита 
Тип регистров Формат 

Номер слова Младший 
байт 

Старший байт 
Номер файла 

Выходной файл O:n n: 0 ~ 3 НЕТ 0 

Входной файл I:n n: 0 ~ 3 НЕТ 1 

Файл статуса S2:n n: 0 ~ 65 НЕТ 2 

Битовый файл B3:n n: 0 ~ 255 НЕТ 3 

Флаг таймера T4:n n: 0 ~ 255 НЕТ 4 

Заданное значение таймера T4:n.PRE n: 0 ~ 255 НЕТ 4 

Текущее значение таймера T4:n.ACC n: 0 ~ 255 НЕТ 4 

Флаг счетчика C5:n n: 0 ~ 255 НЕТ 5 

Заданное значение 
счетчика 

C5:n.PRE n: 0 ~ 255 НЕТ 5 

Текущее значение счетчика C5:n.ACC n: 0 ~ 255 НЕТ 5 

Управляющий файл R6:n n: 0 ~ 255 НЕТ 6 

Контрольный размер 
массива битов R6:n.LEN n: 0 ~ 255 НЕТ 6 

Файл управляющего 
резерва 

R6:n.POS n: 0 ~ 255 НЕТ 6 

Целочисленный файл N7:n n: 0 ~ 255 НЕТ 7 

 Номер бита : Младший байт не используется, его значение 0. Старший байт хранит номер файла. 

 Размер данных : Word (слово). 

 T4, C5 и R6 только читают 1 слово одновременно. 

 Если читается одновременно несколько слов, скорость связи с PLC будет медленной. 

Примечание   

1) Если последние коммуникационные данные были сохранены в памяти PLC (PLC будет 

передавать 0x10 0x05 постоянно), связь может быть нарушена. Надо выключить и включить 

питание HMI или выключить и включить PLC. 
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Контакты 

Диапазон чтения/записи 

Номер бита 

Мл. байт Стар. байт 
Тип контактов Формат 

Номер слова 

Биты Номер файла 

Выход O:n/b n: 0 ~ 3 b: 0 ~ 15 0 

Вход I:n/b n: 0 ~ 3 b: 0 ~ 15 1 

Статус S2:n/b n: 0 ~ 65 b: 0 ~ 15 2 

Бит B3:n/b n: 0 ~ 255 b: 0 ~ 15 3 

Таймер T4:n/b n: 0 ~ 255 b: 0 ~ 15 

 T4:n/EN n: 0 ~ 255 15 

 T4:n/TT n: 0 ~ 255 14 

 T4:n/DN n: 0 ~ 255 13 

4 

Заданное значение таймера T4:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 4 

Текущее значение таймера T4:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 4 

Флаг счетчика C5:n/b n: 0 ~ 255 b: 0 ~ 15 

 C5:n/CU n: 0 ~ 255 15 

 C5:n/CD n: 0 ~ 255 14 

 C5:n/DN n: 0 ~ 255 13 

 C5:n/OV n: 0 ~ 255 12 

 C5:n/UN n: 0 ~ 255 11 

 C5:n/UA n: 0 ~ 255 10 

5 

Заданное значение 
счетчика C5:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 5 

Текущее значение счетчика C5:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 5 

Управление R6:n/b n: 0 ~ 255 b: 0 ~ 15 

 R6:n/EN n: 0 ~ 255 15 

 R6:n/DN n: 0 ~ 255 13 

 R6:n/ER n: 0 ~ 255 11 

 R6:n/UL n: 0 ~ 255 10 

 R6:n/IN n: 0 ~ 255 9 

 R6:n/FD n: 0 ~ 255 8 

6 

Контрольный размер 
массива битов R6:n.LEN/b n: 0 ~ 255 b: 0 ~ 15 6 

Файл управляющего 
резерва 

R6:n.POS/b n: 0 ~ 255 b: 0 ~ 15 6 

Целые числа N7:n/b n: 0 ~ 255 b: 0 ~ 15 7 

 Номер бита : Младший байт хранит адрес бита. Старший байт хранит номер файла. 
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C. Связь (Цоколевка разъемов) 

Связь по RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
8 pin Mini DIN штекер 

(RS-232) 

Контроллер 
8 pin Mini DIN штекер 

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(2) GND

(3) RTS

(6) CTS  

 1 
4 3 
7 

2 

6 

Top View  
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AllenBradley SLC5 PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 19200, 8, None, 1. 

Адрес контроллера: 1. 

Блок управления/блок состояния: B3:0/B3:10. 

Примечание   

1) Для проверки ошибок используется метод CRC (Cyclical Redundancy Check). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 

Номер слова Номер бита 

Старший байт 
Тип регистров Формат 

Номер 
элемента 

Младший 
байт Номер слота или файла 

Выходной файл O:n 
O:s.n 

n: 0 ~ 30 НЕТ № слота s = 0 
s: 0 ~ 255 
№ файла = 0 

Входной файл I:n 
I:s.n 

n: 0 ~ 30 НЕТ № слота s = 0 
s: 0 ~ 255 
№ файла = 1 

Файл статуса S2:n n: 0 ~ 255 НЕТ № файла = 2 

Битовый файл Bf:n n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 3. 

Флаг таймера Tf:n n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Заданное значение таймера Tf:n.PRE n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Текущее значение таймера Tf:n.ACC n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Флаг счетчика Cf:n n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 
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Диапазон чтения/записи 

Номер слова Номер бита 

Старший байт 
Тип регистров Формат 

Номер 
элемента 

Младший 
байт Номер слота или файла 

Заданное значение 
счетчика 

Cf:n.PRE n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 

Текущее значение счетчика Cf:n.ACC n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 

Управляющий файл Rf:n n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 

Контрольный размер 
массива битов 

Rf:n.LEN n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 

Файл управляющего 
резерва 

Rf:n.POS n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 

Целочисленный файл Nf:n n: 0 ~ 255 НЕТ f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 7. 

 Номер бита : Младший байт не используется, его значение 0. Старший байт хранит номер файла. 

Контакты 

Диапазон чтения/записи 

Номер слова Номер бита 

Мл. байт Старший байт 
Тип контактов Формат 

Номер 
элемента Биты Номер слота или файла 

Выход O:n/b 
O:s.n/b 

n: 0 ~ 30 b: 0 ~ 15 № слота s = 0 
s: 0 ~ 255 
№ файла = 0 

Вход I:n/b 
I:s.n/b 

n: 0 ~ 30 b: 0 ~ 15 № слота 
s = 0 
s: 0 ~ 255 
№ файла = 1 

Статус S2:n/b n: 0 ~ 31 b: 0 ~ 15 2 

Бит Bf:n/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 3. 
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Диапазон чтения/записи 

Номер слова Номер бита 

Мл. байт Старший байт 
Тип контактов Формат 

Номер 
элемента Биты Номер слота или файла 

Таймер Tf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Tf:n/EN n: 0 ~ 255 15 

 Tf:n/TT n: 0 ~ 255 14 

 Tf:n/DN n: 0 ~ 255 13 

f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Заданное значение таймера Tf:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Текущее значение таймера Tf:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 4. 

Флаг счетчика Cf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Cf:n/CU n: 0 ~ 255 15 

 Cf:n/CD n: 0 ~ 255 14 

 Cf:n/DN n: 0 ~ 255 13 

 Cf:n/OV n: 0 ~ 255 12 

 Cf:n/UN n: 0 ~ 255 11 

 Cf:n/UA n: 0 ~ 255 10 

f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 

Заданное значение 
счетчика 

Cf:n.PRE/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 

Текущее значение счетчика Cf:n.ACC/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 5. 

Управление Rf:n/b n: 0 ~ 255 b: 0 ~ 15 

 Rf:n/EN n: 0 ~ 255 15 

 Rf:n/DN n: 0 ~ 255 13 

 Rf:n/ER n: 0 ~ 255 11 

 Rf:n/UL n: 0 ~ 255 10 

 Rf:n/IN n: 0 ~ 255 9 

 Rf:n/FD n: 0 ~ 255 8 

f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 

Контрольный размер 
массива битов 

Rf:n.LEN/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 
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Диапазон чтения/записи 

Номер слова Номер бита 

Мл. байт Старший байт 
Тип контактов Формат 

Номер 
элемента Биты Номер слота или файла 

Файл управляющего 
резерва 

Rf:n.POS/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 6. 

Целые числа Nf:n/b n: 0 ~ 255 b: 0 ~ 15 f: 10 ~ 255 
Если f игнорируется, ном. 
файла по умолчанию 
будет 7. 

 Номер бита: Младший байт хранит адрес бита. Старший байт хранит номер файла. 

Примечание   

1) Операнды O и I нуждаются в назначении номера слота. (s). Если номер слота не назначен, по 

умолчанию будет использоваться значение 0. 

C. Связь (Цоколевка разъемов) 

Связь по RS-232 

DOP series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB гнездо 

(RS-232) 

Контроллер 
9 pin D-SUB гнездо 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG

(7) RTS

(8) CTS 

 
 
 
 
 
 

Top View 

 
 

Pin1 
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Danfoss VLT 2800 (FC Protocol) DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, Even, 1, RS-485. 

Адрес контроллера: 1. 

Блок управления/блок состояния: не заданы. 

Примечание   

1) Delta HMI могут быть связаны с контроллерами VLT-2800, 5000, 6000, 7000. 

2) Размер данных параметров приводов Danfoss AC не фиксированный, следовательно, функция 

многократного дублирования “Multiple Duplicate” не доступна. 

3) Макс. поддерживаемое число аварий - 16. Если число аварий превышает 16, будет ошибка. 

4) Не поддерживается функция “optimum read/write”. 

5) Если выбранный элемент – это строка, минимальный размер данных должен быть 2. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 

Номер бита 

Старший байт 
Тип регистров Формат 

Номер слова Младший 
байт Номер указателя 

Параметр Pn:I n: 0 ~ 999 0 I: 0 ~ 31 

Слово управления CTRWD 0 НЕТ НЕТ 

Слово состояния STAWD 0 НЕТ НЕТ 

 Номер указателя (index No.): Если номер указателя не используется, по умолчанию будет 

значение 0. По умолчанию номер указателя для параметров P606 ~ P617 задан как 1. 

 Пожалуйста, помните, что необходимо вводить номер указателя, когда используются некоторые 

параметры контроллеров Danfoss. В тоже время, внимательно отнеситесь к диапазону номеров 

указателей. Если диапазон установки начинается не с 0, при чтении и записи параметра будет 

происходить сбой. Например, номер указателя заданного диапазона параметра P615 от 1 до 20, 

если пользователь не введет номер указателя, система присвоит ему номер  0 (по умолчанию), и 

при чтении или записи параметра произойдет ошибка. 

 CTRWD: Только запись. (Не должны использоваться на экране объекты ввода или отображения 

данных. Рекомендуется использовать для ввода значений кнопку установки значения/константы, 

или макрофункцию.) 

 STAWD: Только чтение. 
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 Слово управления и состояния: См. описание на стр. B-20. 

Контакты 

Диапазон чтения/записи 

Номер слова Номер бита 

Мл. байт Старший байт 
Тип контактов Формат 

Номер 
элемента Биты Номер указателя 

Параметр Pn:I.b n: 0 ~ 999 b: 0 ~ 31 I: 0 ~ 31 

 Bit No : Младший байт хранит адрес бита. Старший байт хранит номер указателя. 

C. Связь (Цоколевка разъемов) 

Связь по RS-485 

DOP Series 
9 pin D-SUB штекер (RS-485) 

Контроллер 
порт RS-485 

RXD+ (2) 68 TXD/RXD+

TXD+ (3 )

RXD- (1 )

TXD- (4)

Shell Shell

69 TXD/RXD-

 

Описание слова управления и слова состояния 

Слово управления 

Bit Bit = 0 Bit = 1 

15 Нет функции Зарезервирован 

14 Выбор установки 2 (msb) 

13 Выбор установки 1 (lsb) 

12 Нет функции Реле 04 активир. 

11 Нет функции Реле 01 активир. 

10 Данные не верны Верны 

9 Рампа 1 Рампа 2 

8 Jog 1 выкл. вкл. 

7 Нет функции Сброс 

6 Стоп рампы Старт 

5 Фиксация Разрешение рампы 

4 Быстрый останов Рампа 

3 На выбеге Разрешен 

2 Торм. пост. током Рампа 

1 Выбор предустановки msb 

0 Выбор предустановки msb 
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 Когда Bit 10 = 1 (данные верны), слово управления правильное. 

Слово состояния 

Bit Bit = 0 Bit = 1 

15 Timer OK (время в норме) Лимит превышен 

14 Torque OK (момент в 
норме) 

Лимит превышен 

13 Voltage OK (напряжение в 
норме) 

Лимит превышен 

12 Temperature OK 
(температура в норме) 

Лимит превышен, автостарт 
задержан 

11 Не работает Работает 

10 За пределами Frequency OK (частота в норме) 

9 Местное управление Управление по шине 

8 Скорость � базовой Скорость �  базовой 

7 Нет предупреждений Предупреждение 

6 Зарезервирован 

5 Зарезервирован 

4 Зарезервирован 

3 Нет сбоя Отключение 

2 На выбеге Разрешено 

1 VLT не готово Готовность 

0 Управление не готово Готовность 
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Facon FB Series PLC DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 9600, 7, Even, 1. 

Адрес контроллера: 1. 

Блок управления/блок состояния: R0 / R10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

Входные реле WXn n: 0 ~ 9992 НЕТ Byte 

Выходные реле WYn n: 0 ~ 9992 НЕТ Byte 

Внутренние реле WMn n: 0 ~ 9992 НЕТ Byte 

Шаговые реле WSn n: 0 ~ 9992 НЕТ Byte 

Регистры данных Rn n: 0 ~ 65534 НЕТ Word 

Регистры данных Dn n: 0 ~ 65534 НЕТ Word 

Текущее значение 
таймера 

RTn n: 0 ~ 9999 НЕТ Word 

Текущее значение 
счетчика 

RCn n: 0 ~ 9999 НЕТ Word 

Регистры данных DRCn n: 200 ~ 255 НЕТ Double Word 

 Входные реле / Выходные реле / Внутренние реле / Специальные реле: адреса должны быть 

кратны 8. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входные реле Xn НЕТ n: 0 ~ 9999 

Выходные реле Yn НЕТ n: 0 ~ 9999 

Внутренние реле Mn НЕТ n: 0 ~ 9999 

Шаговые реле Sn НЕТ n: 0 ~ 9999 

Флаги таймеров Tn НЕТ n: 0 ~ 9999 

Флаги счетчиков Cn НЕТ n: 0 ~ 9999 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер (RS-232) 

Контроллер 
15-pin штекер (RS-232) 

Контроллер 
15 pin штекер (RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(1) RXD

(6) SG

(3) RTS

(4) CTS 

 
Вид сверху 

RS-232 

Связь с CB (Коммуникационная плата) или CM (Коммуникационный модуль) 

FBs серия порт 1 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-

232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(5) GND

(8) RTS

(7) CTS  

 

 

RS-232 

FBs серия порт 0 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
4 pin Mini DIN штекер 

(RS-232) 

Контроллер 
4 pin Mini DIN штекер 

(RS-232) 

RXD (2) (4) TXD

TXD (3)

GND (5)

(2) RXD

(1) GND

(3) +5V  

 
1 2 

3 4 

Top View  
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Festo PLC DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 9600, 8, None, 1. 

Адрес контроллера: 0. (нет адреса PLC в протоколе) 

Блок управления/блок состояния: R0 / R10. 

Примечание  

1) Соединяемый PLC: модель FEC-FC 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер бита Размер 
данных 

WORD_DEVICE_IW Iwn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_OW Own n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_FW FWn n: 0 ~ 9999 НЕТ Word 

WORD_DEVICE_TW TWn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_CW CWn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_R Rn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_TP TPn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_CP CPn n: 0 ~ 255 НЕТ Word 

Контакты 

Тип контактов Формат Номер слова Номер бита 

BIT_DEVICE_I In.b n: 0 ~ 255 b: 0 ~ 15 

BIT_DEVICE_O On.b n: 0 ~ 255 b: 0 ~ 15 

BIT_DEVICE_F Fn.b n: 0 ~ 9999 b: 0 ~ 15 

BIT_DEVICE_T Tn НЕТ n: 0 ~ 255 

BIT_DEVICE_C Cn НЕТ n: 0 ~ 255 

BIT_DEVICE_TON TONn НЕТ n: 0 ~ 255 

BIT_DEVICE_TOFF TOFFn НЕТ n: 0 ~ 255 

 BIT_DEVICE_T / BIT_DEVICE_C / BIT_DEVICE_TON / BIT_DEVICE_TOFF: только 1 бит может 

передаваться в каждом сообщении. 

 Только 1 бит или 1 слово может передаваться в каждой команде записи.  
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C. Связь 

Примечание  

1) Коммуникационный порт PLC: COM-порт 

2) Нужно использовать специализированный кабель FESTO  кабель для передачи TTL в RS-232 и 

это 6 pin RJ-12 разъем со стороны PLC. 
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GE Fanuc 90 Series SNP PLC DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 19200, 8, ODD, 1. 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: %R1 / %R10. 

Примечание  

1) Обратите внимание, что в протоколе нет адреса PLC, поэтому, возможна связь только 1(HMI) с 1 

(PLC). 

2) Если PLC разрешает функцию “Check Password”, пользователю требуется установить пароль в 

меню Option > Configuration > Communication. Пользователь должен найти настройки контроллера 

и установить пароль "PLC password" в диалоговом окне конфигурации в  "Communication Tab". 

Пожалуйста, введите 4-разрядный пароль (Если ввести пароль больше 4-разрядного, только 

первые 4 разряда числа будут действительны). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова № бита 
Размер данных 

Дискретные входы %In n: 1 ~ 12288 НЕТ Word (кратно 16 + 1) 

Дискретные выходы %Qn n: 1 ~ 12288 НЕТ Word (кратно 16 + 1) 

Промежуточные 
дискретные сигналы %Tn n: 1 ~ 256 НЕТ Word (кратно 16 + 1) 

Внутренние дискретные 
сигналы %Mn n: 1 ~ 12288 НЕТ Word (кратно 16 + 1) 

%SA дискретные 
сигналы %SAn n: 1 ~ 128 НЕТ Word (кратно 16 + 1) 

%SB дискретные 
сигналы %SBn n: 1 ~ 128 НЕТ Word (кратно 16 + 1) 

%SC дискретные 
сигналы %SCn n: 1 ~ 128 НЕТ Word (кратно 16 + 1) 

%S дискретные сигналы %S-n n: 1 ~ 128 НЕТ Word (кратно 16 + 1) 

Глобальные 
переменные 

%Gn n: 1 ~ 7680 НЕТ Word (кратно 16 + 1) 

Регистры %Rn n: 1 ~ 16384 НЕТ Word 

Аналоговые входы %AIn n: 1 ~ 8192 НЕТ Word 

Аналоговые выходы %AQn n: 1 ~ 8192 НЕТ Word 
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Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные входы %In НЕТ n: 1 ~ 12288 

Дискретные выходы %Qn НЕТ n: 1 ~ 12288 

Промежуточные 
дискретные сигналы %Tn НЕТ n: 1 ~ 256 

Внутренние дискретные 
сигналы %Mn НЕТ n: 1 ~ 12288 

%SA дискретные 
сигналы %SAn НЕТ n: 1 ~ 128 

%SB дискретные 
сигналы %SBn НЕТ n: 1 ~ 128 

%SC дискретные 
сигналы %SCn НЕТ n: 1 ~ 128 

%S дискретные сигналы %-Sn НЕТ n: 1 ~ 128 

Глобальные 
переменные %Gn НЕТ n: 1 ~ 7680 

C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
RJ-45 кабельный разъем 

(RS-232) 

Контроллер 
RJ-45 кабельный разъем 

(RS-232) 
 

RXD (2) (5) TXD

TXD (3)

GND (5)

(6) RXD

(4) GND Top View
81
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HUST CNC Controller DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 2. 

Адрес контроллера: 0. 

Блок управления/блок состояния: W0 / W10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер 
бита 

Размер данных 

Словные регистры Wn n: 0 ~ 13500 НЕТ Word 

Двухслов. регистры Dn n: 0 ~ 13500 НЕТ Double Word 

Примечание   

1) Единица измерении для контроллера Hust CNC - D слово и Wn младшее слово Dn. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

BIT_DEVICE_B Bm.n m: 0 ~ 13500 n: 0 ~ 31 

BIT_DEVICE_I In НЕТ n: 0 ~ 255 (8 DW) 

BIT_DEVICE_O On НЕТ n: 0 ~ 255 (8 DW) 

BIT_DEVICE_C Cn НЕТ n: 0 ~ 255 (8 DW) 

BIT_DEVICE_S Sn НЕТ n: 0 ~ 255 (8 DW) 

BIT_DEVICE_A An НЕТ n: 0 ~ 1023 (32 DW) 

C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(5) SG

(8) RTS

(7) CTS 

Top View  
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Jetter Nano Series PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, EVEN, 1 (RS-232). 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: WR0 / WR10. 

Примечание  

1) Обратите внимание, что в протоколе нет адреса PLC, поэтому, возможна связь только 1(HMI) с 1 

(PLC). 

2) Только 1 бит или 1 слово могут быть переданы в каждом сообщении. 

3) В основном, каждый регистр занимает максимально 24 Бита. Однако, некоторые регистры 

занимают только 8 Битов. 

4) Поскольку начальное время запуска этого контроллера очень большое, рекомендуется 

использовать задержку при пуске HMI (рекомендуемое время задержки 10 сек). 

5) Когда регистр R используется для двухсловного операнда, установите формат "signed". (В Screen 

Editor по умолчанию установлен формат "signed"). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

16-бит регистры WRn n: 0 ~ 32767 НЕТ 16 Bits 

32-бит регистры Rn n: 0 ~ 32767 НЕТ 24 Bits 

Только первые 16 бит используются в регистрах WRn. 

Только первые 24 бит используются в регистрах Rn, старшие 8 бит (Bit 24 ~ 31) будут установлены 

как 0 по умолчанию. 

(24-bit целое число: если в десятичном формате, диапазон:  -8388608 ~ +8388607. Если в 

шестнадцатеричном формате, диапазон: 0x000000 ~ 0xFFFFFF.) 

Примечание   

1) Различия между WRn и Rn: 

 Когда используются словные операнды, только Bit 0 ~ 15 являются доступными для обоих 

регистров WRn и Rn. 

 Когда используются двухсловные операнды,  



Приложение B.  Коммуникация 

B-30                  НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

если формат адреса чтения/записи задан как WRn, то в Bit 0 ~ 15 регистра WRn будет 

значение младшего слова чтения/записи, а в Bit 0 ~ 15 регистра WRn+1 будет значение 

старшего слова чтения/записи;  

если формат адреса чтения/записи задан как Rn, то только Bit 0 ~ 23 будут правильными в 

регистре Rn. 

(Предупреждение: поскольку контроллеры Jetter имеют 24-бит формат управления, то 

правильнее использовать диапазон 24 Bits. Если этот диапазон превысить, HMI 

остановит операцию чтения/записи и выдаст сообщение: “…..Value is Incorrect”. Но, 

пожалуйста, не используйте биты Bit24 ~ Bit31 (Bit24 ~ Bit31 не могут быть записаны).  

 При использовании операндов, размер которых m Words,  

если формат адреса чтения/записи задан как WRn, то в Bit 0 ~ 15 регистра WRn будет 

значение младшего слова чтения/записи, а в Bit 0 ~ 15 регистра WRn+m-1 будет значение 

старшего слова чтения/записи. 

если формат адреса чтения/записи задан как Rn, то Bit 0 ~ 23 регистра Rn будет значение 

младшего слова чтения/записи, а в Bit 0 ~ 23 of Rn+1 будет значение старшего слова 

чтения/записи. 

Каждый регистр рассматривается как “Double Word”. Значения Bit24 ~ Bit31 = 0.  

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входные реле Inbb n: 1 ~ 32 bb: 01 ~ 08 

Выходные реле Onbb n: 1 ~ 32 bb: 01 ~ 08 

Флаги Fn НЕТ n: 0 ~ 32767 

C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(7) GND 
Top View  

 Назначение контактов (pin) кабеля Jetter controller отличается от стандартного кабеля. 

Пожалуйста, обратите на это внимание и не делайте ошибок. 
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Jetter JC Series PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, EVEN, 1 (RS-232). 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: WR0 / WR10. 

Примечание  

2) Обратите внимание, что в протоколе нет адреса PLC, поэтому, возможна связь только 1(HMI) с 1 

(PLC). 

1) Только 1 бит или 1 слово / 2 слова могут быть переданы в каждом сообщении. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

16-бит регистры WRn n: 0 ~ 32767 НЕТ 16 Bits 

32-бит регистры Rn n: 0 ~ 32767 НЕТ 24 Bits 

Характеристики WRn и Rn серии JC такие же как у серии Nano. См. стр. B-29 и B-30. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входные реле Inbb n: 1 ~ 32 bb: 01 ~ 16 

Выходные реле Onbb n: 1 ~ 32 bb: 01 ~ 16 

Флаги Fn НЕТ n: 0 ~ 32767 

C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер (RS-

232) 

RXD (2) (8) TXD

TXD (3)

GND (5)

(4) RXD

(2) GND 

 2 
4 

8 

 
Вид сверху 

 



Приложение B.  Коммуникация 

B-32                  НПО "СТОИК ЛТД"    т/ф: (495) 661-24-41,  E-mail: sales@stoikltd.ru, support@stoikltd.ru    www.stoikltd.ru 

Со стороны контроллера 
(Comm. Port) 
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Keyence KV/KZ Series DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, EVEN, 1 (RS-232). 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: DM-0 / DM-10. 

Примечание  

2) Обратите внимание, что в протоколе нет адреса PLC, поэтому, возможна связь только 1(HMI) с 1 

(PLC). 

1) Только 1 бит или 1 слово могут быть переданы в каждом сообщении. (Скорость связи медленная) 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

Таймер T-nnn nnn: 0 ~ 199 НЕТ Word 

Счетчик C-nnn nnn: 0 ~ 199 НЕТ Word 

Высокоскоростной 
счетчик 

CTH-n n: 0 ~ 1 НЕТ Word 

Высокоскоростной 
счетный компаратор CTC-n n: 0 ~ 3 НЕТ Word 

Память данных DM-nnnn nnnn: 0 ~ 1999 НЕТ Word 

Временная память 
данных 

TM-nn nn: 0 ~ 31 НЕТ Word 

Заданное значение 
таймера 

PT-nnn nnn: 0 ~ 199 НЕТ Word 

Заданное значение 
счетчика 

PC-nnn nnn: 0 ~ 199 НЕТ Word 

Заданное значение CTC PCTC-n n: 0 ~ 3 НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Реле R-nnnbb nnn: 0 ~ 69 bb: 00 ~ 15 

Таймер T-nnn НЕТ nnn: 0 ~ 199 

Счетчик C-nnn НЕТ nnn: 0 ~ 199 

Высокоскоростной 
счетный компаратор CTC-n НЕТ n: 0 ~ 3 
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Примечание  

При использовании формата протокола KV серии и соединения с KZ-80T PLC, могут происходить 

некоторые ошибки: 

1) Читаемые адреса таймеров могут прерываться. Например, T-0 ~ T-9 могут быть считаны, T10 не 

может быть считано, T11 ~ T20 могут быть считаны, T21 ~ T50 не могут быть считаны, …и т.д. 

2) Счетчики могут не читаться. Например, регистры: C- (счетчик), CTH- (высокоскоростной счетчик), 

CTC- (высокоскоростной счетный компаратор), PC- (заданное значение счетчика), PCTC- (CTC) – 

могут не читаться. Контакты: C, CTC – могут не читаться так же. 

C. Связь (Цоколевка разъемов) 

RS-232 

KV Series 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
разъем RJ-11 (RS-232) 

Контроллер 
разъем RJ-11 (RS-232) 

RXD (2) (3) SD

TXD (3)

GND (5)

(5) RD

(4) SG 

 

Top View
6 - 1

 

 
Со стороны PLC(Comm. Port)

KZ Series 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
разъем RJ-11 (RS-232) 

Контроллер 
разъем RJ-11 (RS-232) 

RXD (2) (5) SD

TXD (3)

GND (5)

(3) RD

(4) SG 

 

Top View
6 - 1

 

 
Со стороны PLC (Comm. Port)

Примечание  

1) Кабель связи: контакты SD и RD серии KZ-80T и KV являются обратными. 
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Koyo SU/DL Series DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1 (RS-232). 

Адрес контроллера: 1. 

Блок управления/блок состояния: V1400 / V1410. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

Текущее значение 
таймера 

Vn n: 0 ~ 177 (octal) НЕТ Word 

Текущее значение 
счетчика 

Vn n: 1000 ~ 1177 (octal) НЕТ Word 

V память Vn n:  1400 ~ 7777 (octal) НЕТ Word 

Промежуточные реле Vn n: 40000 ~ 40037 (octal) НЕТ Word 

Статус входов Vn n: 40400 ~ 40423 (octal) НЕТ Word 

Статус выходов Vn n: 40500 ~ 40523 (octal) НЕТ Word 

Управляющие реле Vn n: 40600 ~ 40635 (octal) НЕТ Word 

Шаги (Stage) Vn n: 41000 ~ 41027 (octal) НЕТ Word 

Статус таймера Vn n: 41100 ~ 41107 (octal) НЕТ Word 

Статус счетчика Vn n: 41140 ~ 41147 (octal) НЕТ Word 

Спец. реле 1 Vn n: 41200 ~ 41205 (octal) НЕТ Word 

Спец. реле 2 Vn n: 41216 ~ 41230 (octal) НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Промежуточные реле GXn НЕТ n: 0 ~ 777 (octal) 

Статус входов Xn НЕТ n: 0 ~ 477 (octal) 

Статус выходов Yn НЕТ n: 0 ~ 477 (octal) 

Управляющие реле Cn НЕТ n: 0 ~ 737 (octal) 

Шаги (Stage) Sn НЕТ n: 0 ~ 577 (octal) 

Статус таймера Tn НЕТ n: 0 ~ 177 (octal) 

Статус счетчика CTn НЕТ n: 0 ~ 177 (octal) 

Спец. реле 1 SPn НЕТ n: 0 ~ 137 (octal) 

Спец. реле 2 SPn НЕТ n: 320 ~ 617 (octal) 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
разъем RJ-11 

(RS-232) 

Контроллер 
разъем RJ-11 

(RS-232) 

RXD(2)

TXD(3)

GND(5)

(4)TXD

(3)RXD

(1)GND

(6)GND 

 

Top View
1 - 6
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Koyo K-Sequence DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1 (RS-232). 

Адрес контроллера: 1. 

Блок управления/блок состояния: R1400 / R1420. 

Примечание  

1) Если адреса чтения/записи превысят заданный диапазон, HMI остановит опреацию чтения/записи 

и выведет на дисплей сообщение  “….Error 6….. Command Can Not be Executed….”. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер 
бита 

Размер 
данных 

Статус входов Xnnnn nnnn: 0 ~ 1760 (octal) НЕТ Word 

Статус выходов Ynnnn nnnn: 0 ~ 1760 (octal) НЕТ Word 

Промежуточные реле GXnnnn nnnn: 0 ~ 3760 (octal) НЕТ Word 

Реле GQnnnn nnnn: 0 ~ 3760 (octal) НЕТ Word 

Реле Mnnnn nnnn: 0 ~ 3760 (octal) НЕТ Word 

Шаги (Stage) Snnnn nnnn: 0 ~ 1760 (octal) НЕТ Word 

Статус таймера Tnnn nnn: 0 ~ 360 (octal) НЕТ Word 

Управляющие реле Cnnn nnn: 0 ~ 360 (octal) НЕТ Word 

Спец. реле 1 SPnnn nnn: 0 ~ 760 (octal) НЕТ Word 

Регистр Rnnnnn nnnnn: 0 ~ 41237 (octal) НЕТ Word 

Регистр Pnnnnn nnnnn: 0 ~ 37777 (octal) НЕТ Word 

 nnnn: в восьмеричном (octal) формате и должны быть кратны 16, за исключением R и P. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Статус входов Xnnnn НЕТ nnnn: 0 ~ 1777 (octal) 

Статус выходов Ynnnn НЕТ nnnn: 0 ~ 1777 (octal) 

Промежуточные реле GXnnnn НЕТ nnnn: 0 ~ 3777 (octal) 

Реле GQnnnn НЕТ nnnn: 0 ~ 3777 (octal) 

Управляющие реле Mnnnn НЕТ nnnn: 0 ~ 3777 (octal) 

Шаги (Stage) Snnnn НЕТ nnnn: 0 ~ 1777 (octal) 

Статус таймера Tnnn НЕТ nnn: 0 ~ 377 (octal) 
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Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Статус счетчика Cnnn НЕТ nnn: 0 ~ 377 (octal) 

Спец. реле 1 SPnnn НЕТ nnn: 0 ~ 777 (octal) 

C. Связь (Цоколевка разъемов) 

RS-232 

Порт 0. Кабель связи 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
разъем RJ-11 

(RS-232) 

Контроллер 
разъем RJ-11 

(RS-232) 

RXD(2)

TXD(3)

GND(5)

(4 )TXD

(3 )RXD

(1 )GND

(6 )GND  (Note 1) 

 

Top View
1 - 6

 

 Если pin 6 не заземлен, при связи с контроллером CKD SM 24R может происходить 

коммуникационная ошибка. Гарантируйте, что контакт 6 хорош заземлен. При соединение с 

контроллером SN32DRA не имеет значения pin6 заземлен или нет. 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  
Top View  

RS-485 

Порт 1. Кабель связи 

DOP 
9 pin D-SUB штекер (RS-485) 

DOP 
9 pin D-SUB штекер (RS-485) 

D- (1) D-

D+ (2)

D+ (3)

D+

D- (4)
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Соответствие регистров CCM2 и K-Sequence 

Адреса соответствующих регистров: 

CCM2 K sequence SN32DRA 
V R R 
X X I 
Y Y Q 
C M M 
S S S 
T T T 

CT C C 
SP SP SP 
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Lenze LECOM-A/B Protocol DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 1 (Скорость передачи: 1200/2400/4800/9600/19200). 

Адрес контроллера: 1 (1~99). 

Блок управления/блок состояния: не заданы. 

Примечание   

1) Пожалуйста, обратите внимание на правильность кабельного соединения каждого контакта. 

2) Не используйте стандартный RS-232 5-pin кабель. Потому что контакты 2, 3, 5, 7, 8 соеденены с 

приводом, и привод может не распознать коммуникационный сигнал и не идентифицировать его.  

3) Для детальной информации по назначению контактов кабеля обратитесь к разделу  C. Связь 

(Цоколевка разъемов) на стр. B-26 и B-27. 

4) Гарантируйте правильность формата передачи данных HMI, записываемых в привод. Слово “m” в 

нижеприведенной таблице определяет коммуникационный формат данных HMI. 

5) Обеспечьте правильный формат отображения данных на HMI (Таблица свойств/Заданное 

значение...и т.д..). 

6) При использовании широковещательной функции, пожалуйста, проверьте, корректность 

созданных объектов в программе HMI. Широковещательная функция позволяет только 

передавать данные, поэтому в программе HMI должны использоваться объекты, передающие 

данные “write only” (только кнопки задания значения/константы могут использоваться при 

широковещательной передачи). При выборе других устройств, система будет пытаться читать 

данные из приводов, что приведет к ошибке и выводу сообщения “Controller Station Number 

Error…” на экран HMI. 

7) Драйвер поддерживает связь с преобразователями частоты серии 82XX и 93XX. 

B. Адреса чтения/записи операндов контролера 

Регистры (n, m, y are in decimal) 

Диапазон чтения/записи 

Номер слова Номер бита 

Старший 
байт 

Тип регистров Формат  Младший 
байт 

subcode 

Размер 
данных 

CWn n: 1 ~ 10000 НЕТ НЕТ Word Параметр без субкода 

CWn.m n: 1 ~ 10000 m: 0 ~ 23 НЕТ Word 

Параметр с субкодом CWn/y n: 1 ~ 10000 НЕТ y:1 ~ 255 Word 

 CWn/y.m n: 1 ~ 10000 m: 0 ~ 23 y:1 ~ 255 Word 
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Диапазон чтения/записи 

Номер слова Номер бита 

Старший 
байт 

Тип регистров Формат  Младший 
байт 

subcode 

Размер 
данных 

 
 

     

CDn n: 1 ~ 10000 НЕТ НЕТ DoubleWord Параметр без субкода 

CDn.m n: 1 ~ 10000 m: 0 ~ 23 НЕТ DoubleWord 

Параметр с субкодом CDn/y n: 1 ~ 10000 НЕТ y:1 ~ 255 DoubleWord 

 CDn/y.m n: 1 ~ 10000 m: 0 ~ 23 y:1 ~ 255 DoubleWord 

Примечание   

1) m :  коммуникационный формат данных HMI 

2) Значение m определяет различные коммуникационные форматы данных: 

 Если m не определено: ASCII шестнадцатеричный формат (VH). (4 или 8 чисел.) 

 m >= 23 : ASCII шестнадцатеричный формат (VH). (4 или 8 чисел.) 

 m = 0 ~10 : без знака, ASCII десятичный формат (VD). 

m определяет позицию десятичной точки, Например: 

m=0  нет десятичной точки 

m=1  одна цифра после запятой 

m=2  две цифры после запятой 

 m = 11 ~20 : со знаком, ASCII десятичный формат (VD). 

m определяет позицию десятичной точки, Например: 

m=11  одна цифра после запятой 

m=12  две цифры после запятой 

 m = 21 : со знаком, ASCII десятичный формат (VD). 

без десятичной точки 

 m = 22 : ASCII шестнадцатеричный формат (VH). 2 цифры. 

Когда используется этот формат, записываемое значение будет ограничено 
диапазоном 0~0xFF (младший байт). 

Например: При воде числа 0x1234, действительное записываемое значение 
будет 0x34, а не 0x1234. 
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Контакты (n, b, y в десятичном формате) 

Диапазон чтения/записи 

Номер слова Номер бита 

 Младший байт Старший байт 
Тип регистров Формат 

  subcode 

Параметр без субкода CBn.b n: 1 ~ 10000 b: 0 ~ 31 НЕТ 

Параметр с субкодом CBn/y.b n: 1 ~ 10000 b: 0 ~ 31 1 ~ 255 

Только параметры типа VH позволяют читать/писать биты. 

CBn.b, CWn (CWn.m), CDn (CDn.m): обращение к тем же адресам чтения/записи (адрес n). 

Примечание   

1) Так как формат данных этого контроллера усложнен (a. VS (String format), b. VO (Octet string format 

data blocks), c. VH (ASCII hexadecimal format)(1, 2, 4 bytes), d. VD (ASCII decimal format)(positive, 

negative, decimal,..)) и коммуникационный формат не совместим, поэтому, надо гарантировать 

правильность коммуникационного формата данных HMI во избежание ошибки. 

2) Регистры: возможно только чтение/запись данных в шестнадцатеричном ASCII формате (VH), 

десятичном ASCII формате (VD) (т.е. любой формат данных VH или VD может быть задан через 

коммуникацию.) 

Контакты: возможно только чтение/запись данных в шестнадцатеричном ASCII формате (VH) 

Формат отображения данных в HMI (Таблица свойств/Значения уставок и т.д.) так же должен быть 

корректным. 

Пояснение: 

 Регистры: возможно только чтение/запись данных VH, VD. HMI нуждается в установке 

коммуникационного формата (см. 4), 5) и 6)). String формат (VS), и Octet string формат блока 

данных (VO) не может быть использован. Если контроллер отсылает данные в форматах VS 

или VO, HMI выведет на экран сообщение о некорректном значении “……Value Is Incorrect”. 

 Контакты: возможно только чтение/запись данных в шестнадцатеричном ASCII формате 

(VH). Только параметры типа VH предусмотрены для функции чтения/записи битов. Если 

контроллер отсылает двнные в других форматах, HMI выведет на экран сообщение о 

некорректном значении “……Value Is Incorrect”. 

 Не делайте запись в несуществующие биты адреса, иначе HMI выведет на экран сообщение, 

что команда не может быть выполнена: “….Write …. Command Can Not be Executed”.  

Например: CW470/1. Возможные значения CW470/1 находятся в диапазоне 0 ~ 0xFF. 

Поэтому, Bit 8 ~31 не существуют. Хотя HMI может показать значения Bit 8 ~31 как 0, 

пользователь не может записывать туда свои значения. 

 Установки шестнадцатеричного формата кода ASCII (VH) и формата десятичного числа кода 

ASCII (VD) должны быть правильны. Если данные VD установить в формате VH в HMI 

(значение m будет неопределенно, или m=22 или 23), или данные VH установить в формате 
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VD в HMI (m=0 ~ 21), когда HMI будет записывать данные, на экране появится сообщение, 

что команда не может быть выполнена: “….Write …. Command Can Not be Executed”. 

 Число десятичных разрядов в десятичном формате ASCII (VD) должно быть установлено 

правильно, иначе значение будет записываться не корректно. Число десятичных разрядов 

отображаемых в HMI так же должно быть установлено правильно, иначе значение будет 

отображаться не корректно. 

 Шестнадцатеричный формат ASCII (VH), 2-х разрядный (m = 22). Значение ограничено 2-мя 

цифрами. Значения, записываемые в этом формате должны находиться в диапазоне 0 ~ 

0xFF (младший байт). 

3) Адрес станции и широковещательная передача 

 Допустимый диапазон коммуникационных адресов станций: 0 - 99. При выходе за пределы 

диапазона, HMI остановит операцию чтения/записи и выведет на экран сообщение об 

ошибке адреса станции: “Controller Station Number Error …”. 

 Адрес 00 служит для глобальной передачи данных всем станциям в сети (1~99). 

 Адреса 10, 20, 30, 40, 50, 60, 70, 80, 90 служат для локальной широковещательной передачи 

для диапазонов адресов: 11~19, 21~29, 31~39, 41~49, 51~59, 61~69, 71~79, 81~89 и 91~99 

соответственно. Широковещательная функция позволяет только передавать данные, 

поэтому в программе HMI должны использоваться объекты, передающие данные “write only” 

(только кнопки задания значения/константы могут использоваться при широковещательной 

передачи). При выборе других устройств, система будет пытаться читать данные из 

приводов, что приведет к ошибке и выводу сообщения “Controller Station Number Error…” на 

экран HMI. 

 Используйте протокол LECOM-A/B для связи с преобразователями частоты серии 82XX и 

93XX. 

4) Адреса ошибок связи 

 Регистры: отображение CW n,  CWy n,  CD n,  CDy n  по порядку 

 Контакты: отображение CB n,  CByn  по порядку                     (n: адрес значение) 

5) Формат данных HMI 

 Некоторые параметры контроллера находятся в формате Word (слово), а некоторые в 

формате Double Word (двойное слово). Word ( CWn (CWn.m), CWn/y(CWn/y.m) ) и Double 

Word ( CDn (CDn.m), CDn/y(CDn/y.m) ). 

 HMI может писать/читать только значения 32-бит (Bit0 ~ Bit31) параметров в формате VH. 

 CWn(CWn.m), CDn(CDn.m), или CBn.b: адреса чтения/записи такие же (адрес n), но 

когда символ установлен как CW, будет читаться/записываться только значение младшего 

слова параметра (n). 

Когда символ установлен как CD, будет читаться/записываться двойное слово целых 

параметров (n), 
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Когда символ установлен как CB, будет читаться/записываться один бит Bit (b) No. 

параметра (n). 

(m : формат данных связи HMI) 

 (CWn/y(CWn/y.m), CDn/y(CDn/y.m), CBn/y.b: адрес чтения/записи с субкодом такие же (адрес 

n), но 

когда символ установлен как CW, будет читаться/записываться только значение младшего 

слова параметра (n). 

Когда символ установлен как CD, будет читаться/записываться двойное слово целых 

параметров (n), 

Когда символ установлен как CB, будет читаться/записываться один бит Bit (b) No. парметра 

(n). 

(m : формат данных связи HMI) 

 Замечания по использованию HMI. 

a) При использовании словных операндов Word (например, числовые данные (отображение 

значения, ввод значения…)…), читаемое/записываемое значение будет таким же 

независимо от выбранного формата адресов чтения/записи CWn или CDn как 

чтение/запись только младшего слова параметра (n). 

b) При использовании операндов формата Double Word (например, числовые данные 

(отображение значения, ввод значения…)…), если формат адреса чтения/записи 

выбран, как CWn, чтение/запись значения начинается с младшего слова CWn и 

захватывает следующий за ним адрес CWn+1 (2 адреса ). 

c) При использовании операндов CDn, чтение/запись значения производится 

непосредственно из одного двухсловного адреса CDn (1 адрес). 

d) Когда используется символьный объект (например, отображение символов, ввод 

символов…), если выбран операнд CWn, будут последовательно читаться/записываться 

регистры CWn, CWn+1, CWn+2, …. 

e) При использовании операндов CDn, чтение/запись значения производится 

последовательно из двухсловных адресов CDn, CDn+1, CDn+2,…. 

f) Когда используется функция “Multiple Duplicate” (Многократное дублирование), если 

адреса Word и Bit превысят допустимый диапазон, адреса Word и Bit будут установлены 

как 0 автоматически. При компиляции будет обнаружена ошибка. 

g) CBn.b, CBn/y.b позволяют обратится к отдельным битам параметров формата. 

h) В каждой команде связи можно обратиться только к 1 параметру.  
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C. Связь (Цоколевка разъемов) 

Pin 2, 3, 5 для связи по RS-232. Pin 7, 8 для связи по RS-485. 

RS-232 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 

 
Вид сверху 

RS-485 

DOP 
9 pin D-SUB штекер 

(RS-485) 

Контроллер 
9 pin D-SUB штекер 

(RS-485) 

Контроллер 
9 pin D-SUB штекер 

(RS-485) 

D- (1) (7) T/R (A)

D+ (2)

D+ (3)

(8) T/R (B)

D- (4)

 

 

 
Вид сверху 
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LG Master K120S/200S DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 38400, 8, None, 1. (RS-232) 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: DW0 / DW10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер бита Размер 

WORD_DEVICE_PW PWn n: 0 ~ 15 НЕТ Word 

WORD_DEVICE_MW MWn n: 0 ~ 191 НЕТ Word 

WORD_DEVICE_KW KWn n: 0 ~ 31 НЕТ Word 

WORD_DEVICE_LW LWn n: 0 ~ 63 НЕТ Word 

WORD_DEVICE_FW FWn n: 0 ~ 63 НЕТ Word 

WORD_DEVICE_TW TWn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_CW CWn n: 0 ~ 255 НЕТ Word 

WORD_DEVICE_DW DWn n: 0 ~ 9999 НЕТ Word 

Контакты 

Тип контактов Формат Номер слова Номер бита 

BIT_DEVICE_P Pnb n: 0 ~ 15 b: 0 ~ f 

BIT_DEVICE_M Mnb n: 0 ~ 191 b: 0 ~ f 

BIT_DEVICE_K Knb n: 0 ~ 31 b: 0 ~ f 

BIT_DEVICE_L Lnb n: 0 ~ 63 b: 0 ~ f 

BIT_DEVICE_F Fnb n: 0 ~ 63 b: 0 ~ f 

BIT_DEVICE_T Tn НЕТ n: 0 ~ 255 

BIT_DEVICE_C Cn НЕТ n: 0 ~ 255 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 9 pin D-SUB штекер 
(RS-232 для LG K120S/200S) 

Контроллер 9 pin D-SUB 
штекер 

(RS-232 для LG K120S/200S)

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 

 
Top View 

Примечание   

1) Соединение Pin 4 (RXD), Pin 7 (TXD) и Pin5 (SG), показывает, что протокол CNet используется. 

(См. “LG Master-K CNET” на стр. B-50.) 120S/200S протокол и CNet не могут использоваться 

одновременно. Можно выбрать только протокол 120S/200S или протокол CNet. 
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LG Glofa GM6 CNET DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 19200, 8, None, 1. (RS-232) 

Адрес контроллера: 0. 

Блок управления/блок состояния: %MW0 / %MW10. 

Примечание   

1) HMI по умолчанию имеет настройки предназначенные для порта CPU. Если пользователь хочет 

иметь связь через модуль CNET, надо изменить соответствующие настройки связи: 38400, 8, 

None, 1. (RS-422 / RS-485). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер бита Размер 

Отображение входов IWb.s.w 
w(word):0 ~ 3 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 Word 

Отображение входов IDb.s.w 
w(word):0 ~ 1 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 DWord 

Отображение выходов QWb.s.w 
w(word):0 ~ 3 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 Word 

Отображение выходов QDb.s.w 
w(word):0 ~ 1 
s(slot): 0 ~ 7 

b(base): 0 ~ 1 DWord 

Внутренняя память MWn n: 0 ~ 4095 НЕТ Word 

Внутренняя память MDn n: 0 ~ 2047 НЕТ DWord 

Контакты 

Тип контактов Формат Номер слова Номер бита 

Отображение входов IXb.s.n s(slot): 0 ~ 7 
n(bit): 0 ~ 63 
b(base): 0 ~ 1 

Отображение выходов QXb.s.n s(slot): 0 ~ 7 
n(bit): 0 ~ 63 
b(base): 0 ~ 1 

Внутренняя память MXn НЕТ n: 0 ~ 65535 
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C. Связь (Цоколевка разъемов) 

RS-232 

через CPU Port 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер  

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(5) GND 

 

 
Top View 

RS-422 

через коммуникационный модуль G6L-CUEC CNET 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
кабельный разъем (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD- (4)

SDB

RDA

TXD+ (3) RDB

GND (5) SG  
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LG Master-K CNET DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 38400, 8, None, 1. (RS-422) 

Адрес контроллера: 0. 

Блок управления/блок состояния: DW0 / DW10. 

Примечание   

1) HMI по умолчанию имеет настройки предназначенные для коммуникационного модуля G6L-CUEC 

CNET. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова № бита Размер 

Входные/выходные реле PWn n: 0 ~ 31 НЕТ Word 

Дополнительные реле MWn n: 0 ~ 191 НЕТ Word 

Энергонезависимые реле KWn n: 0 ~ 31 НЕТ Word 

Реле связи LWn n: 0 ~ 63 НЕТ Word 

Специальные реле FWn n: 0 ~ 63 НЕТ Word (только 
чтение) 

Текущее значение таймера TWn n: 0 ~ 255 НЕТ Word 

Текущее значение счетчика CWn n: 0 ~ 255 НЕТ Word 

Регистры данных DWn n: 0 ~ 9999 НЕТ Word 

Контакты 

Тип контактов Формат Номер слова Номер бита 

Входные/выходные реле PXnb n: 0 ~ 31 b: 0 ~ F 

Дополнительные реле MXnb n: 0 ~ 191 b: 0 ~ F 

Энергонезависимые реле KXnb n: 0 ~ 31 b: 0 ~ F 

Реле связи LXnb n: 0 ~ 63 b: 0 ~ F 

Специальные реле FXnb n: 0 ~ 63 b: 0 ~ F 

Контакт таймера TXb НЕТ b: 0 ~ 255 

Контакт счетчика CXb НЕТ b: 0 ~ 255 
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C. Связь (Цоколевка разъемов) 

RS-422 

через коммуникационный модуль G6L-CUEC CNET 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
кабельный разъем (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD- (4)

SDB

RDA

TXD+ (3) RDB

GND (5) SG  

RS-232 

через LG-120S PLC (Master K) 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер  

(RS-232) 

RXD (2) (7) TXD

TXD (3)

GND (5)

(4) RXD

(5) GND 

 

 
Top View 
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LIYAN LYPLC EX DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 1. 

Адрес контроллера: 0. 

Блок управления/блок состояния: D0 / D10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер  
данных 

Вспомогательные реле Mn n: 0 ~ 3064 НЕТ Byte 

Специальные 
вспомогательные реле 

Mn n: 8000 ~ 8248 НЕТ Byte 

Реле состояния Sn n: 0 ~ 992 НЕТ Byte 

Входные реле Xn n: 0 ~ 360(octal) НЕТ Byte 

Выходные реле Yn n: 0 ~ 360(octal) НЕТ Byte 

PV таймера Tn n: 0 ~ 255 НЕТ Word 

PV 16-битного счетчика  Cn n: 0 ~ 199 НЕТ Word 

PV 32-битного счетчика Cn n: 200 ~ 255 НЕТ Double Word 

Регистры данных Dn n: 0 ~ 7999 НЕТ Word 

Специальные регистры 
данных 

Dn n: 8000 ~ 8255 НЕТ Word 

Вспомогательные реле / Специальные вспомогательные реле / Реле состояния / Входные реле / 

Выходные реле: адреса должны быть кратны 8. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Вспомогательные реле Mn НЕТ n: 0 ~ 3071 

Специальные 
вспомогательные реле 

Mn НЕТ n: 8000 ~ 8255 

Реле состояния Sn НЕТ n: 0 ~ 999 

Входные реле Xn НЕТ n: 0 ~ 377(octal) 

Выходные реле Yn НЕТ n: 0 ~ 377(octal) 

Флаг таймера Tn НЕТ n: 0 ~ 255 

Флаг счетчика  Cn НЕТ n: 0 ~ 255 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер (RS-232) 

Контроллер 
8 pin Mini DIN штекер (RS-

232) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(7) RXD

(3) GND

(6) GND 

 

 2 
3 
6 7 

 
 

Вид сверху 
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M2i Master DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 38400, 8, None, 1. 

Адрес контроллера: 1. 

Блок управления/блок состояния: SB0 / SB10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

Словные адреса SBn n: 0000 ~ FFFF НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Битовые адреса SBn.b n: 0000 ~ FFFF b: 0 ~ F 
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M2i Slave DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 38400, 8, None, 1. 

Адрес контроллера: 1 (нет функции) 

Блок управления/блок состояния: SB0 / SB10. 

Примечание   

1) Адрес станции HMI – адрес ведомой (Slave) станции (по умолчанию 0). 

2) Соответствие между адресами памяти M2i и внутренними регистрами HMI. 

Modbus адреса  Внутренние регистры HMI 

SB0000 ~ SB7FFF  $0 ~ $32767 

SB8000 ~ SB83FF  $M0 ~ $M1023 

SB8400  RCPNO 

SB8500 ~ SBFFFF  RCP0 ~ RCP31487 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер 
бита Размер 

Словные адреса SBn n: 0000 ~ FFFF НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Битовые адреса SBn.b n:0000 ~ FFFF b: 0 ~ F 

C. Связь (Цоколевка разъемов):  

См. B-1 для описания цоколевки разъемов. 
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Matsushita FP PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1. 

Адрес контроллера: 238. 

Блок управления/блок состояния: DT0 / DT10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

Внутренние реле WRn n: 0 ~ 886, НЕТ Word 

Специальные внутренние реле  900 ~ 910   

Реле связи WLn n: 0 ~ 639 НЕТ Word 

Внешние входные реле WXn n: 0 ~ 511 НЕТ Word 

Внешние выходные реле WYn n: 0 ~ 511 НЕТ Word 

Таймер/счетчик  P.V. EVn n: 0 ~ 3071 НЕТ Word 

Таймер/счетчик  S.V. SVn n: 0 ~ 3071 НЕТ Word 

Регистры данных DTn n: 0 ~ 32764 НЕТ Word 

Регистры данных связи LDn n: 0 ~ 8447 НЕТ Word 

Файловые регистры FLn n: 0 ~ 32764 НЕТ Word 

Специальные регистры данных DT9_n n: 0 ~ 511 НЕТ Word 

 DT9_0 ~ DT9_511 применяются для контроллеров FP0 T32C, FP2, FP2SH, FP10SH. (Специальные 

регистры данных находятся все в диапазоне DT90000 ~ DT9XXXX). 

 Фактический адрес передачи DT9_n - это 90000 + n (для DT). Например, фактический адрес 

DT9_1 - это 90001 (для DT), фактический адрес DT9_2 - это 90002 (для DT) и так далее. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Внутренние реле Rnb n: 0 ~ 886 b: 0 ~ f 

Специальные внутренние реле  n: 900 ~ 910 b: 0 ~ f 

Реле связи Lnb n: 0 ~ 639 b: 0 ~ f 

Внешние входные реле Xnb n: 0 ~ 511 b: 0 ~ f 

Внешние выходные реле Ynb n: 0 ~ 511 b: 0 ~ f 

Флаг таймера Tn НЕТ n: 0 ~ 3071 

Флаг счетчика Cn НЕТ n: 0 ~ 3071 

 Контроллеры FP2SH / FP10SH имеют увеличенный диапазон адресов чтения/записи. 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
5 pin Mini DIN штекер  

(RS-232 для FP0) 

Контроллер 
5 pin Mini DIN штекер 

(RS-232 для FP0) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(1) SG  

Top View  

RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер  
9 pin D-SUB штекер  
(RS-232 для FP1) 

Контроллер  
9 pin D-SUB штекер 
(RS-232 для FP1) 

RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(7) GND

(4) RTS

(5) CTS  

Top View
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Mirle FAMA SC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 1. 

Адрес контроллера: 0. 

Блок управления/блок состояния: 40100 / 40200. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер 
бита 

Размер данных 

Выходные регистры Wn n: 40001 ~ 50000 НЕТ Word 

Входные регистры Wn n: 30001 ~ 40000 НЕТ Word 

 Входные регистры – только для чтения. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные выходы Bn НЕТ n: 1 ~ 10000 

Дискретные входы Bn НЕТ n: 10001 ~ 20000 

 Дискретные входы -  только для чтения. 

C. Связь (Цоколевка разъемов) 

RS-232 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  
Top View  
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Mitsubish FX/FX2N PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 1. 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: D0 / D10. 

Примечание  

1) Для связи с PLC Mitsubishi серии FXxN, можно использовать коммуникационный протокол обоих 

серий FX2N и FX. 

2) Для связи с PLC Mitsubishi серии FX, можно использовать коммуникационный протокол только 

серии FX. 

3) Некоторые регистры PLC Mitsubishi используются только для чтения, однако, если вы попробуете 

в них что-нибудь записать, то PLC не выдаст для HMI никакого сообщения об ошибке. Имейте это 

ввиду при написании программы PLC. 

4) Для связи с PLC Mitsubishi серии FXxN, рекомендуется использовать протокол FX2N. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

Вспомогательные реле Mn n: 0 ~ 3064 НЕТ Byte 

Специальные 
вспомогательные реле 

Mn n: 8000 ~ 8248 НЕТ Byte 

Реле состояния Sn n: 0 ~ 992 НЕТ Byte 

Входные реле Xn n: 0 ~ 360(octal) НЕТ Byte 

Выходные реле Yn n: 0 ~ 360(octal) НЕТ Byte 

PV таймера Tn n: 0 ~ 255 НЕТ Word 

PV 16-битного счетчика  Cn n: 0 ~ 199 НЕТ Word 

PV 32-битного счетчика Cn n: 200 ~ 255 НЕТ Double Word 

Регистры данных Dn n: 0 ~ 7999 НЕТ Word 

Специальные регистры 
данных 

Dn n: 8000 ~ 8255 НЕТ Word 

 Вспомогательные реле / Специальные вспомогательные реле / Реле состояния / Входные реле / 

Выходные реле: адреса должны быть кратны 8. 
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Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Вспомогательные реле Mn НЕТ n: 0 ~ 3071 

Специальные 
вспомогательные реле 

Mn НЕТ n: 8000 ~ 8255 

Реле состояния Sn НЕТ n: 0 ~ 999 

Входные реле Xn НЕТ n: 0 ~ 377(octal) 

Выходные реле Yn НЕТ n: 0 ~ 377(octal) 

Флаг таймера Tn НЕТ n: 0 ~ 255 

Флаг счетчика  Cn НЕТ n: 0 ~ 255 

C. Связь (Цоколевка разъемов) 

RS-422 

DOP Series 
9 pin D-SUB штекер 

(RS-422) 

Контроллер 
8pin Mini DIN штекер 

(RS-422) 

Контроллер 
8pin Mini DIN штекер 

(RS-422) 

RXD+ (2) (7) TXD+

RXD- (1)

TXD+ (3)

(4) TXD-

(2) RXD+

TXD- (4) (1) RXD-

GND (5) (3) SG  

 1 
4 
7 

2 
3 

Top View  

RS-422 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
25 pin D-SUB штекер (RS-422) 

Pin 2 (RXD+) Pin3 (TXD+)

Pin 1 (RXD-)

Pin 4 (TXD-)

Pin16 (TXD-)

Pin 15 (RXD-)

Pin 3 (TXD+) Pin 2 (RXD+)  
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Mitsubishi A Series AJ71UC24 Communication Module DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1. 

Адрес контроллера: 0. 

Блок управления/блок состояния: D0 / D10. 

Примечание  

1) Драйвер использует проверку суммы (CheckSum). 

2) Установите переключатель “PLC Mode” в позицию 5. 

3) Если какие-нибудь выходные реле (Y) и специальные внутренние реле (SM) установить в 1, PLC 

остановит связь, которая не будет восстановлена автоматической. Для восстановления связи PLC 

надо сбросить (перезагрузить). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат Номер слова Номер 

бита 
Размер данных 

Входы Xn n: 0 ~ 7FF НЕТ Word (multiple of 16) 

Выходы Yn n: 0 ~ 7FF НЕТ Word (multiple of 16) 

Реле связи Bn n: 0 ~ FFF НЕТ Word (multiple of 16) 

Внутренние реле Mn n: 0 ~ 8191 НЕТ Word (multiple of 16) 

Специальные 
внутренние реле 

SMn n: 9000 ~ 9255 НЕТ Word (9000 + multiple of 16) 

Энергонезависимые 
реле 

Ln n: 0 ~ 2047 НЕТ Word (multiple of 16) 

Сигнализатор Fn n: 0 ~ 2047 НЕТ Word (multiple of 16) 

Значение таймера TNn n: 0 ~ 999 НЕТ Word 

Значение счетчика CNn n: 0 ~ 999 НЕТ Word 

Регистры данных Dn n: 0 ~ 8191 НЕТ Word 

Специальные регистры 
данных 

SDn n: 9000 ~ 9255 НЕТ Word 

Файловые регистры Rn n: 0 ~ 8191 НЕТ Word 

Регистры связи Wn n: 0 ~ FFF НЕТ Word 
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Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входы Xn НЕТ n: 0 ~ 7FF 

Выходы Yn НЕТ n: 0 ~ 7FF 

Реле связи Bn НЕТ n: 0 ~ FFF 

Внутренние реле Mn НЕТ n: 0 ~ 8191 

Специальные внутренние 
реле 

SMn НЕТ n: 9000 ~ 9255 

Энергонезависимые реле Ln НЕТ n: 0 ~ 2047 

Сигнализатор Fn НЕТ n: 0 ~ 2047 

Контакт таймера TSn НЕТ n: 0 ~ 999 

Катушка таймера TCn НЕТ n: 0 ~ 999 

Контакт счетчика CSn НЕТ n: 0 ~ 999 

Катушка счетчика CCn НЕТ n: 0 ~ 999 

C. Связь (Цоколевка разъемов) 

RS-422 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
кабельный разъем (RS-422) 

RXD+ (2) SDA

RXD- (1)

TXD+ (3)

SDB

RDA

TXD- (4) RDB 
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Mitsubishi A2A/A2AS/A2USH A1SH/A3НЕТ2ASH (CPU-S1) CPU Port DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1. 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: D0 / D10. 

Примечание  

1) Этот драйвер поддерживает все серии CPU Mitsubishi A. Серия Mitsubishi A разделена на 5 

категорий CPU (использование для связи): 

 A0J2… 

 A1N… 

 A1S ( / A2S / A2N …) 

 A3N ( / A1SH / A2SH …) 

 A2A ( / A2AS / A2USH …) 

Delta HMI может поддерживать A2USH CPU порт (такие как A2A, A2AS CPU-порт) и A1SH CPU 

порт (такие как A3N, A2ASH). 

2) L и M: Коммуникационные адреса L такие же как M. 

3) PX и X: 

В PLC Mitsubishi A2A, коммуникационные адреса PX и X одинаковые. 

В PLC Mitsubishi A, X – для нечетных адресов, а PX – для четных. Это единственное место, где PX 

и X различаются. 

4) X, Y, B, M, SM, L, F, PX ----(Word), 

X, Y, B, M, SM, L, F, PX ----(Bit), 

Когда адрес станции PLC установлен как 255, только значения четных адресов могут 

читаться/записываться. 

Когда адрес станции PLC отличен от 255, все значения всех адресов могут читаться/записываться. 

5) R адреса могут быть различными в зависимости от размера файлового регистра PLC. 

Например, A2USH: 1K: 3800 ~ 4000H 

 2K: 3000 ~ 4000H 

 3K: 2800 ~ 4000H 

 4K: 2000 ~ 4000H 

 5K: 4000 ~ 6800H(cy) 

 6K: 4000 ~ 7000H(cy) 
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Файловый регистр: PLC корректно запущен, иначе значения чтения\записи могут быть 

неправильными. 

 

6) Макс. число однократно читаемых/записываемых регистров и реле 

128 слов (256 байт) регистров 

 64 слов (128 байт) реле 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат Номер слова Номер 

бита 
Размер данных 

Входы Xn n: 0 ~ 7FF НЕТ Word (кратно 16) 

Выходы Yn n: 0 ~ 7FF НЕТ Word (кратно 16) 

Реле связи Bn n: 0 ~ FFF НЕТ Word (кратно 16) 

Внутренние реле Mn n: 0 ~ 8191 НЕТ Word (кратно 16) 

Специальные 
внутренние реле SMn n: 9000 ~ 9255 НЕТ Word (9000 + кратно 16) 

Энергонезависимые 
реле Ln n: 0 ~ 8191 НЕТ Word (кратно 16) 

Сигнализатор Fn n: 0 ~ 2047 НЕТ Word (кратно 16) 

Значение таймера TNn n: 0 ~ 2047 НЕТ Word 

Значение счетчика CNn n: 0 ~ 1023 НЕТ Word 

Регистры данных Dn n: 0 ~ 8191 НЕТ Word 

Специальные регистры 
данных SDn n: 9000 ~ 9255 НЕТ Word 

Файловые регистры Rn n: 0 ~ 8191 НЕТ Word 

Регистры связи Wn n: 0 ~ FFF НЕТ Word 

Регистры карты ввода PXn n: 0 ~ 7FF НЕТ Word (кратно 16) 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входы Xn НЕТ n: 0 ~ 7FF 

Выходы Yn НЕТ n: 0 ~ 7FF 

Реле связи Bn НЕТ n: 0 ~ FFF 

Внутренние реле Mn НЕТ n: 0 ~ 8191 

Специальные внутренние 
реле SMn НЕТ n: 9000 ~ 9255 

Энергонезависимые реле Ln НЕТ n: 0 ~ 2047 

Сигнализатор Fn НЕТ n: 0 ~ 2047 



Руководство по программированию в среде ScrEdit 

Revision 05/30/2006, EH00   B-65 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Контакт таймера TSn НЕТ n: 0 ~ 2047 

Катушка таймера TCn НЕТ n: 0 ~ 2047 

Контакт счетчика CSn НЕТ n: 0 ~ 1023 

Катушка счетчика CCn НЕТ n: 0 ~ 1023 

Регистры карты ввода PXn НЕТ n: 0 ~ 7FF 

C. Связь (Цоколевка разъемов) 

RS-422 

DOP Series 
9 pin D-SUB штекер (RS-422) 

Контроллер 
25 pin D-SUB штекер(RS-422) 

Контроллер 
25 pin D-SUB штекер(RS-

422) 

Pin 2 (RXD+) Pin 3 SDB (TXD+)

Pin1 (RXD-)

Pin 4 (TXD-)

Pin 16 SDA (TXD-)

Pin 15 RDA (RXD-)

Pin 3 (TXD+) Pin 2 RDB (RXD+)

Pin 7 (RTS+) Pin 4 CTS+

Pin 8 (CTS+) Pin 5 RTS+

Pin 6 (RTS-) Pin 17 CTS-

Pin 9 (CTS-) Pin 18 RTS-  

 2 3 4 5

15
16

17
18

 

Пояснение 

Как задать файловый регистр (R) для PLC серии Mitsubishi A: 

1. Запустите MELSOFT серии GX. 

2. Откройте окно “Project Data List”. (меню “View”) 

3. Дважды кликните мышью Parameter \ PLC Parameter, и откройте окно “Setting”. 

4. Задайте Memory Capacity \ File Register (0 ~8). 

5. Нажмите кнопку “End” и завершите установку. 

6. Выполните запись в PLC  "OnLine\Write to PLC". 

7. Разрешите опцию “Parameter \ PLC/Network” и “File register \ Main” (поставьте флажок рядом с 

“Parameter \ PLC/Network” и “File register \ Main”). 

8. Нажмите кнопку “Execute”. 

9. Выполнено 
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Mitsubishi Q Series CPU Port DELTA  

A. Заводские значения параметров связи HMI 

Протокол: 19200, 8, ODD, 1. 

Адрес контроллера: 0. (нет адреса PLC в протоколе, следовательно, возможна связь только 

1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: D-0 / D-10. 

Примечание  

1) Обратите внимание, что  PLC в протоколе не имеет адреса,  поэтому, возможна связь только 

1(HMI) с 1 (PLC). 

2) Если скорость передачи будет установлена не корректно, HMI будет устанавливать скорость 

передачи PLC для HMI автоматически.  

3) Этот драйвер поддерживает серию Mitsubishi Q00 и Q00J с функцией защиты паролем. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат Номер слова Номер 

бита 
Размер данных 

Входы X-n n: 0 ~ 1FFF НЕТ Word (кратно 16) 

Выходы Y-n n: 0 ~ 1FFF НЕТ Word (кратно 16) 

Прямые входы DX-n n: 0 ~ 1FFF НЕТ Word (кратно 16) 

Прямые выходы DY-n n: 0 ~ 15 НЕТ Word (кратно 16) 

Энергонезависимые 
реле 

L-n n: 0 ~ 8191 НЕТ Word (кратно 16) 

Сигнализатор F-n n: 0 ~ 2047 НЕТ Word (кратно 16) 

Реле с вкл. по фронту V-n n: 0 ~ 2047 НЕТ Word (кратно 16) 

Шаговое реле S-n n: 0 ~ 8191 НЕТ Word (кратно 16) 

Реле связи B-n n: 0 ~ 1FFF НЕТ Word (кратно 16) 

Специальное реле 
связи 

SB-n n: 0 ~ 7FF НЕТ Word (кратно 16) 

Внутренние реле M-n n: 0 ~ 8191 НЕТ Word (кратно 16) 

Специальные 
внутренние реле 

SM-n n: 0 ~ 2047 НЕТ Word (кратно 16) 

Значение таймера TN-n n: 0 ~ 2047 НЕТ Word 

Энергонезависимое 
значение таймера 

SN-n n: 0 ~ 2047 НЕТ Word 

Значение счетчика CN-n n: 0 ~ 1023 НЕТ Word 

Регистры данных D-n n: 0 ~ 12287 НЕТ Word 
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Диапазон чтения/записи 
Тип регистров Формат Номер слова Номер 

бита 
Размер данных 

Специальные регистры 
данных 

SD-n n: 0 ~ 2047 НЕТ Word 

Индексные регистры Z-n n: 0 ~ 15 НЕТ Word 

Файловые регистры R-n n: 0 ~ 32767 НЕТ Word 

Файловые регистры ZR-n n: 0 ~ 32767 НЕТ Word 

Регистры связи W-n n: 0 ~ 1FFF НЕТ Word 

Специальные регистры 
связи 

SW-n n: 0 ~ 7FF НЕТ Word 

 Xn, Yn, DXn, Bn, SBn, Wn, SWn : n в шестнадцатеричном формате. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входы X-n НЕТ n: 0 ~ 1FFF 

Выходы Y-n НЕТ n: 0 ~ 1FFF 

Прямые входы DX-n НЕТ n: 0 ~ 1FFF 

Прямые выходы DY-n НЕТ n: 0 ~ 15 

Энергонезависимые реле L-n НЕТ n: 0 ~ 8191 

Сигнализатор F-n НЕТ n: 0 ~ 2047 

Реле с вкл. по фронту V-n НЕТ n: 0 ~ 2047 

Шаговое реле S-n НЕТ n: 0 ~ 8191 

Реле связи B-n НЕТ n: 0 ~ 1FFF 

Специальное реле связи SB-n НЕТ n: 0 ~ 7FF 

Внутренние реле M-n НЕТ n: 0 ~ 8191 

Специальные внутренние 
реле 

SM-n НЕТ n: 0 ~ 2047 

Контакт таймера TS-n НЕТ n: 0 ~ 2047 

Катушка таймера TC-n НЕТ n: 0 ~ 2047 

Энергонезависимый контакт 
таймера 

SS-n НЕТ n: 0 ~ 2047 

Энергонезависимая катушка 
таймера 

SC-n НЕТ n: 0 ~ 2047 

Контакт счетчика CS-n НЕТ n: 0 ~ 1023 

Катушка счетчика CC-n НЕТ n: 0 ~ 1023 

 Xn, Yn, DXn, Bn, SBn : n в шестнадцатеричном формате. 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
6 pin Mini DIN штекер 

(RS-232) 

Контроллер 
6 pin Mini DIN штекер 

(RS-232) 

RXD (2) (2) SD (TXD)

TXD (3)

GND (5)

(1) RD (RXD)

(3) GND

(5) DSR (DR)

(6) DTR (ER)  

 
 

2 1
3

56

 
Top View 
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MKS CT150 DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, E, 1. (RS-232) 

Адрес контроллера: 11. 

Блок управления/блок состояния: не заданы. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

Регистры данных Cn n: 0 ~ 25 НЕТ 

Установочные регистры Cn n: 40 ~ 43 НЕТ 

  45 ~ 50  

  90 ~ 97  

Счетчик ошибок Err_CNT 0 НЕТ 

LV значение LV_VAL 0 НЕТ 

Ошибка печати PRTMARK_ERR 0 НЕТ 

Счетчик циклов BAT_CNT 0 НЕТ 

Счетчик остатка WASTE_CNT 0 НЕТ 

Линейная скорость LINE_SPD 0 НЕТ 

Фактическая длина реза ACT_CUT_LEN 0 НЕТ 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

 Cn.b n: 0 ~ 50 B: 0 ~ 15 

Сброс RST НЕТ 0 

Jog Trim+ JOGTRIM_INC НЕТ 0 

Jog Trim- JOGTRIM_DEC НЕТ 0 

Чтение PI READ_PI НЕТ 0 

Инициализация данных ACT_DATA НЕТ 0 

Сохранить в Eeprom STR_EEPROM НЕТ 0 

Старт/Стоп START_STOP НЕТ 0 

Сброс маркера счетчика RSTMARK_CNT НЕТ 0 
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C. Связь (Цоколевка разъемов) 

RS-232 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-

232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) SG  

 

 
Top View 
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Modbus(Master) --- 984 RTU / ASCII mode DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Адрес контроллера: 0. 

Блок управления/блок состояния: W40100 / W40200. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

Выходные регистры Wn n: 40001 ~ 50000 НЕТ Word 

Входные регистры Wn n: 30001 ~ 40000 НЕТ Word 

 Входные регистры – только для чтения. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные выходы Bn НЕТ n: 1 ~ 10000 

Дискретные входы Bn НЕТ n: 10001 ~ 20000 

 Дискретные входы -  только для чтения. 

C. Связь (Цоколевка разъемов) 

См. цоколевку разъемов в B-1. 
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Modbus Hexadecimal Address (Master) --- RTU / ASCII mode DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Адрес контроллера: 0. 

Блок управления/блок состояния: RW-0 / RW-10. 

Примечание  

1) Коммуникационные адреса начинаются с 0 и используют шестнадцатеричную систему адресации. 

Диапазон адресов от 0 до 65535 (т.е. 0 ~ FFFF в шестнадцатеричном формате). 

2) Отличия от стандартного протокола Modbus: 

Другая адресация. 

Другой диапазон адресов. 

В стандартном Modbus используется десятичный формат адресации. Начальные адреса: 40001, 

30001, 1, 10001 и содержат по 10000 адресов соответственно (40001 ~ 50000, 30001 ~ 40000, 1 ~ 

10000, 10001 ~ 20000). 

В Modbus Hexadecimal Address (Master) используется шестнадцатеричный формат адресации. 

Адресация начинается с 0 и содержит 65536 адресов (от 0 до FFFF) в каждом PDU (протокольная 

единица обмена). 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

Выходные регистры RW-n n: 0 ~ FFFF НЕТ Word 

Входные регистры R-n n: 0 ~ FFFF НЕТ Word 

 RW- : можно читать и писать.  

Преобразовав адрес в десятичный формат, и добавив 40001, получим адрес стандартного 

протокола “Modbus”. 

 R- (Входные регистры): только чтение.  

Преобразовав адрес в десятичный формат, и добавив 30001, получим адрес стандартного 

протокола “Modbus”. 
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Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные выходы RWB-n НЕТ n: 0 ~ FFFF 

Дискретные входы RB-n НЕТ n: 0 ~ FFFF 

 RWB- : можно читать и писать.  

Преобразовав адрес в десятичный формат, и добавив 1, получим адрес стандартного протокола 

“Modbus”. 

 RB- (Дискретные входы): только чтение.  

Преобразовав адрес в десятичный формат, и добавив 10001, получим адрес стандартного 

протокола “Modbus”. 

Примечание  

1) Только первые 10000 можно преобразовать в адреса ”Standard Modbus”. 
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Modbus nW (Master) --- RTU / ASCII mode DELTA  

A. Заводские значения параметров связи HMI  

Протокол: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Адрес контроллера: 1. 

Блок управления/блок состояния: W40100 / W40200. 

Примечание  

1) Драйвер позволяет читать несколько последовательных адресов одной командой Modbus. 

Например, если на экране имеется 6 объектов, на них можно выводить данные W40140, W40141, 

W40142, W40145, W40146, W40150. Они будут прочитаны за три раза: W40140, W40141, 

W40142 – за первый раз, W40145, W40146 – за второй раз и W40150 1 – за третий раз. 

2) Рекомендуется поставить флажок “Optimize” (оптимизация чтения) в закладке “Communication” в 

окне “Configuration” меню “Options” (Options  Configuration  Communication). Если “Optimize” не 

выбрано, не выбрать “Data Length Limit”. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

Выходные регистры Wn n: 40001 ~ 50000 НЕТ Word 

Входные регистры Wn n: 30001 ~ 40000 НЕТ Word 

 Входные регистры – только для чтения. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные выходы Bn НЕТ n: 1 ~ 10000 

Дискретные входы Bn НЕТ n: 10001 ~ 20000 

 Дискретные входы -  только для чтения. 

C. Связь (Цоколевка разъемов) 

См. цоколевку разъемов в B-1. 
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Modbus(Slave) --- 984 RTU / ASCII mode DELTA 

A. Заводские значения параметров связи HMI  

Протокол: 9600, 7, EVEN, 1. (ASCII) 

 9600, 8, EVEN, 1. (RTU) 

Адрес контроллера: 0. (нет адреса PLC в протоколе). 

Блок управления/блок состояния: W40100 / 40200. 

Примечание  

1) Адрес HMI – адрес ведомой (Slave) станции. (по умолчанию 0) 

2) Соответствие между адресами Modbus и регистрами внутренней памяти HMI. 

Modbus адрес  Регистры HMI 

W40001 ~ W41024  $0 ~ $1023 Внутренние регистры 

W42001 ~ W43024  $M0 ~ $M1023 Энергонез. внутренние регистры 

W44001  RCPNO Регистр номера рецепта 

W45001 ~ ...  RCP0 ~ RCPn Регистры рецептов 

B00001 ~ B01024  $2000.0 ~ $2063.15 Внутренние регистры (Bit) 

B01025 ~ B02048  $M200.0 ~ $M263.15 Энергонез. внутр. регистры (Bit) 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

Выходные регистры Wn n: 40001 ~ 50000 НЕТ Word 

Контакты 

Read/Write Range 
Тип контактов Формат 

Номер слова Номер бита 

Дискретные выходы Bn НЕТ n: 1 ~ 2048 

C. Связь (Цоколевка разъемов) 

См. цоколевку разъемов в B-1. 
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Таблица соответствия внутренней памяти Delta HMI и Modbus адресов 

Внутренняя память 
Delta HMI Modbus адрес Поддерживаемые 

команды Modbus Адреса функций 

$0 40001 03H, 06H, 10H 0000H 

$1 40002 03H, 06H, 10H 0001H 

. 

. 

. 

   

$1023 41024 03H, 06H, 10H 03FFH 

    

$M0 42001 03H, 06H, 10H 07D0H 

$M1 42002 03H, 06H, 10H 07D1H 

. 

. 

. 

   

$M1023 43024 03H, 06H, 10H 0BCFH 

    

RCPNO 44001 03H, 06H 0FA0H 

    

RCP0 45001 03H, 06H, 10H 1388H 

RCP1 45002 03H, 06H, 10H 1389H 

. 

. 

. 

   

    

$2000.0 00001 01H, 05H, 0FH 0000H 

$2000.1 00002 01H, 05H, 0FH 0001H 

. 

. 

. 

   

$2000.15 00016 01H, 05H, 0FH 000FH 

$2001.0 00017 01H, 05H, 0FH 0010H 

. 

. 

. 

   

$2063.0 01009 01H, 05H, 0FH 03F0H 

. 

. 

. 

   

$2063.15 01024 01H, 05H, 0FH 03FFH 

    

$M200.0 01025 01H, 05H, 0FH 0400H 
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Внутренняя память 
Delta HMI Modbus адрес Поддерживаемые 

команды Modbus Адреса функций 

$M200.1 01026 01H, 05H, 0FH 0401H 

. 

. 

. 

   

$M200.15 01040 01H, 05H, 0FH 040FH 

$M201.0 01041 01H, 05H, 0FH 0410H 

. 

. 

. 

   

$M263.0 02033 01H, 05H, 0FH 07F0H 

. 

. 

. 

   

$M263.15 02048 01H, 05H, 0FH 07FFH 

Например: 

1. Чтение из внутренней памяти Delta HMI значения регистра $100 of (Адрес HMI: 1) 

: 01 03 00 64 00 01 97 CR LF 

Запись значения 1000 в регистр $100 внутренней памяти Delta HMI (Адрес HMI: 1) 

: 01 06 00 64 03 E8 AA CR LF 

2. Чтение из внутренней памяти Delta HMI значения регистра $M100 (HMI station number: 1) 

: 01 03 08 34 00 01 BF CR LF 

Запись значения 888 в регистр $M100 внутренней памяти Delta HMI (Адрес HMI: 1) 

: 01 06 08 34 03 78 42 CR LF 

3. Чтение из внутренней памяти Delta HMI значения регистра $2000.15 (Адрес HMI: 1) 

: 01 01 00 0F 00 01 EE CR LF 

Установить бит $2000.15 в Delta HMI в состояние ON (Адрес HMI: 1) 

: 01 05 00 0F FF 00 EC CR LF 

Установить бит $2000.15 в Delta HMI в состояние OFF (Адрес HMI: 1) 

: 01 05 00 0F 00 00 EB CR LF 

4. Чтение из внутренней памяти Delta HMI значения регистра $M201.0 (Адрес HMI: 1) 

: 01 01 04 10 00 01 E9 CR LF 

Установить бит $M201.0 в Delta HMI в состояние ON (Адрес HMI: 1) 

: 01 05 04 10 FF 00 E7 CR LF 

Установить бит $M201.0 в Delta HMI в состояние OFF (Адрес HMI: 1) 

: 01 05 04 10 00 00 E6 CR LF 
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Modicon TSX Micro (Uni-Telway) DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 1. 

Адрес контроллера: 2. 

Блок управления/блок состояния: %MW0 / %MW10. 

Примечание  

1) Адрес станции HMI должен быть установлен в диапазоне 1 ~ 8. 

2) Адреса станций PLC и HMI могут быть одинаковыми. 

3) Внутренняя память и  относительные параметры в PLC должны быть установлены 

соответствующим образом в начале. Иначе не возможно будет связаться, исключая %S. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер бита Размер 

WORD_DEVICE_ внутренние %MWn n: 0 ~ 65534 НЕТ Word 

WORD_DEVICE_ системные %SWn n: 0 ~ 127 НЕТ Word 

WORD_DEVICE_ входы %KWn n: 0 ~ 65534 НЕТ Word 

 %KWn is “read only”. 

Контакты 

Тип контактов Формат Номер слова Номер бита 

BIT_DEVICE_ внутренние %Mn:b n:0 ~ 65534 b:0 ~ 15 

BIT_DEVICE_ системные %Sn - n:0 ~ 127 

BIT_DEVICE_ внутренние 1 %Mn - n:0 ~ 65534 

 %Mn: b - это это битовый адрес передающий WORD_DEVICE_ внутренние (%MWn). 

 %Mn – это адрес внутреннего реле PLC. 

 диапазон чтения/записи WORD_DEVICE_ Internal / BIT_DEVICE_ Internal зависит от используемой 

памяти PLC. 

C. Связь (Цоколевка разъемов) 

RS-232 

Требуется использование специального кабеля Modicon Uni-Telway. (RS-232) --- TSX PCX 1031 
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RS-485 

DOP 
9 pin D-SUB штекер (RS-485) 

Контроллер 
8 pin Mini DIN штекер (RS-485) 

Контроллер 
8 pin Mini DIN штекер 

(RS-485) 

RXD+ (2) (1) D+

TXD+ (3)

RXD- (1)

TXD- (4)

(2) D-

 

 2 1

 
Вид сверху 
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Modicon TWIDO DELTA 

Его функции такие же, как Modbus (Master) --- 984 RTU на стр. B-71. 
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NIKKI DENSO NCS-FI/FS Series DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, ODD, 2. 

Адрес контроллера: 1. (доступные адреса: 0 ~ 99) 

Блок управления/блок состояния: не заданы. 

Примечание  

1) Допустимый диапазон адресов станций PLC от 0 до 99. При выходе за данный диапазон из 

номера адреса станции будет автоматически вычтено 100, что бы адрес находился в допустимом 

диапазоне. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Номер 
бита Размер 

WORD_DEVICE_ RRegister RW-n n: 0 ~ 3999 НЕТ Word 

WORD_DEVICE_ RRegister RW-n n: 8000 ~ 9999 НЕТ Word 

WORD_DEVICE_ DStatus XW-n n: 0 ~ 8 НЕТ Word 

WORD_DEVICE_ DStatus DW-n n: 0 ~ 129 НЕТ Word 

WORD_DEVICE_ RRegister RD-n n: 0-3999 НЕТ Double Word

WORD_DEVICE_ RRegister RD-n n: 8000-9999 НЕТ Double Word

WORD_DEVICE_ DStatus DD-n n: 0-129 НЕТ Double Word

Примечание  

Для того чтобы HMI серии DOP были полностью совместимы с этим контроллером, панели DOP 

обеспечиваются поддержкой различных типов данных. См. нижеприведенное описание: 

1) RW-n, RD-n, RB-nb имеют аналогичную связь (просто формат данных различный). Они все 

ссылаются на одинаковый адрес n.  

DW-n, DD-n имеют аналогичную связь (просто формат данных различный). Они все ссылаются на 

одинаковый адрес n. 

XW-n, XB-nb имеют аналогичную связь (просто формат данных различный). Они все ссылаются 

на одинаковый адрес n. 

(В вышеприведенных форматах имен второй символ представляет формат данных, W обозначает 

Word (слово), D обозначает Double Word (двойное слово) и B обозначает Bit (бит)) 

2) Размер данных RW-n, DW-n задан как слово в панели DOP, и каждый адрес данных 

рассматривается как индивидуальный словный адрес. Порядок данных использует архетектуру 

"Little Endian", в которой младшее слово числа сохраняется в памяти с младшим адресом, а 
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старшее слово – со старшим адресом. (Например, в процессорах Intel (используемых в PC) 

применяется порядок байтов "Little Endian") 

Например, если установить начальный адрес как RW900 и размер данных Double Word, то 

читаемое/записываемое значение будет содержать двойное машинное слово, расположенное в 

RW900 (младшее слово) и RW901(старшее). 

Если пользователь устанавливает размер данных RW-n, DW-n как Word, не будет проблем 

изменения порядка данных. Однако, если пользователь устанавливает размер данных RW-n, DW-

n как Double Word, этот контроллер использует архетектуру "Big Endian", в которой  старшее 

слово числа сохраняется в памяти с младшим адресом, а младшее слово – со старшим адресом 

(например, в процессорах Motorola (используемых в Macintosh) применяется порядок байтов "Big 

Endian"), и обратный порядок данных может вызвать проблеммы. 

3) Размер данных RD-n, DD-n определяется как Double Word в панелях DOP, и каждые два адреса 

данных рассматриваются как индивидуальный двухсловный адрес. Порядок данных использует 

аритектуру "Big Endian" (см. выше). 

Например, если установить начальный адрес как RD900 и размер данных как Double Word, то 

читаемое/записываемое значение будет содержать двойное машинное слово, расположенное в 

RW900(старшее слово) и RW901(младшее слово). 

Если пользователь устанавливает размер данных RD-n, DD-n как Double Word, не будет проблем 

изменения порядка данных, и данные на дисплее HMI и в контроллере будут одинаковыми. 

Однако, если пользователь устанавливает размер данных RD-n, DD-n как Word, только младшее 

слово будет отображаться на дисплее, а старшее слово будет равно 0 автоматически. Например, 

если установить начальный адрес как RD900 и размер данных как Word, только значение 

RD901(младшее слово) будет отображаться. Если записать значение 100, панель DOP передаст 

значение в RD901(старшее слово) как 0 и запишет значение 100 в RD901(младшее слово). 

4) X-nb и DW-n имеют аналогичную связь -------- Read DW-n, Write X-nb 

DW-0 — X-0b, (b=0~F) 
DW-1 — X-1b, (b=0~F) 
DW-2 — X-2b, (b=0~F) 
DW-4 — X-3b, (b=0~F) 
DW-104 — X-4b, (b=0~F) 
DW-105 — X-5b, (b=0~F) 
DW-106 — X-6b, (b=0~F) 
DW-107 — X-7b, (b=0~F) 
DW-108 — X-8b, (b=0~F) 

5) DW-n, DD-n  - только для чтения. Если пользователь попытается записать в них значение, HMI 

выведет на экран сообщение о том, что команда не может быть выполнена: “Command Can Not be 

Executed…. ”. 
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Контакты 

Тип контактов Формат Номер слова Номер бита 

BIT_DEVICE_ RRegister RB-nb n: 0 ~ 3999 b:0 ~ F  

BIT_DEVICE_ RRegister  RB-nb n: 8000 ~ 9999 b:0 ~ F 

BIT_DEVICE_ BitControl XB-nb n:0 ~ 8 b:0 ~ F 

C. Связь (Цоколевка разъемов) 

RS-422 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
14 pin спец. штекер (RS-422) 

Контроллер 
14 pin спец. штекер (RS-422) 

RXD- (1) (9) TXD (B)

RXD+ (2)

TXD+ (3)

(2) TXD (A)

(4) RXD (A)

TXD- (4) (11) RXD (B)

GND (5) (14) GND  
 

 
Кабель (Со стороны PLC (J1), 

штекер). 

 
Вид сверху 
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Omron C Series PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 2. 

Адрес контроллера: 0. 

Блок управления/блок состояния: DM0 / DM10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

IR область IRn n: 0 ~ 511 НЕТ Word 

HR область HRn n: 0 ~ 99 НЕТ Word 

AR область ARn n: 0 ~ 27 НЕТ Word 

LR область LRn n: 0 ~ 63 НЕТ Word 

TC область TCn n: 0 ~ 511 НЕТ Word 

DM область DMn n: 0 ~ 6655 НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

IR область IRnb n: 0 ~ 511 b: 00 ~ 15 

HR область HRnb n: 0 ~ 99 b: 00 ~ 15 

AR область ARnb n: 0 ~ 27 b: 00 ~ 15 

LR область LRnb n: 0 ~ 63 b: 00 ~ 15 

TC область TCn НЕТ n: 0 ~ 511 

C. Связь (Цоколевка разъемов) 

RS-232 

1:1 Host Link через конвертер RS-232C  

DOP Series 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-

232) 
RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(9) SG

(4) RS

(5) CS  
Top View  
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Omron CJ1/CS1 Series PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 7, EVEN, 2. (RS-232) 

Адрес контроллера: 0. 

Блок управления/блок состояния: D0 / D10. 

Примечание  

1) Словные операнды: 

Имя операнда и Номер адреса. Например, если используется CIO, H, A, D, E, T, C, W, EM, IR, DR, 

TK, то будет показано CIOn, Hn, An, Dn, Em.n, Tn, Cn, Wn, EMn, IRn, DRn, TKn соответственно. 

“n” – это  Номер адреса. 

2) Битовые операнды: 

Имя операнда и Словный адрес номера будет отображаться, но Битового номера адреса не будет. 

Например, если используется CIO, H, A, D, E, T, C, W, EM, IR, DR, TK, то будет показано CIOBn, 

HBn, ABn, DBn, EBm.n, TBn, CBn, WBn, EMBn, IRBn, DRBn, TKBn соответственно. “n” – это 

Словный номер адреса. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер 
данных 

CIO область CIOn n: 0 ~ 9999 НЕТ Word 

Энергонезавис. область Hn n: 0 ~ 999 НЕТ Word 

Вспомогательная область An n: 0 ~ 999 НЕТ Word 

DM область Dn n: 0 ~ 65535 НЕТ Word 

EM область Em.n M: 0 ~ 12 (bank no.) 
n: 0 ~ 65535 

НЕТ Word 

PV таймера Tn n: 0 ~ 9999 НЕТ Word 

PV счетчика Cn n: 0 ~ 9999 НЕТ Word 

Рабочая область Wn n: 0 ~ 999 НЕТ Word 

Область текущ. банка EM  EMn n: 0 ~ 65535 НЕТ Word 

Индексный регистр IRn n: 0 ~ 99 НЕТ Double Word 

DR область DRn n: 0 ~ 99 НЕТ Word 

TK область TKn n: 0 ~ 1022 (Even 
No.) НЕТ Byte 

 В моделях CJ1M: An: A0-A477 – только для чтения. 

Контакты 
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Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

CIO область CIOBnbb n: 0 ~ 9999 bb: 00 ~ 15 

Энергонезавис. область HBnbb n: 0 ~ 999 bb: 00 ~ 15 

Вспомогательная область ABnbb n: 0 ~ 999 bb: 00 ~ 15 

DM область DBnbb n: 0 ~ 65535 bb: 00 ~ 15 

EM область EBm.nbb n: 0 ~ 65535  

  m: 0 ~ 12 (bank no.) bb: 00 ~ 15 

Область таймера TBn НЕТ n: 0 ~ 9999  

Область счетчика CBn НЕТ n: 0 ~ 9999 

Рабочая область WBnbb n: 0 ~ 999 bb: 00 ~ 15 

Область текущ. банка EM EMBnbb n: 0 ~ 65535 bb: 00 ~ 15 

Индексный регистр IRBnbb n: 0 ~ 99 bb: 00 ~ 31 

DR область DRBnbb n: 0 ~ 99 bb: 00 ~ 15 

TK область TKBnbb n: 0 ~ 1022 (Even 
No.) 

bb: 00 ~ 15 

Примечание  

1) Следующие адреса не могут быть записаны: 

 IRn и DRn: не допускают в них записи. HMI выдаст сообщение об ошибке при попытке 

произвести в них запись. 

 An и Abnbb: в некотором диапазоне An и Abnbb (Auxiliary area) – только для чтения. 

 TKn / TKBnbb / TBn / CBn / EMBnbb / IRBnbb / DRBnbb: Запись в эти адреса не допускается. 

Если пользователь попытается записать в них значение, HMI выведет на экран сообщение о 

том, что команда не может быть выполнена: “Command Can Not be Executed…. ”. 

2) Размер значения адреса IR – двойное слово “Double Word”. 

3) Размер значения адреса TK - байт “Byte”, должны иметь только четные номера. 

C. Связь (Цоколевка разъемов) 

RS-232 

CPU модуль CJ1M  

DOP Series 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB штекер (RS-

232) 
RXD (2) (2) TXD

TXD (3)

GND (5)

(3) RXD

(9) SG

(4) RS

(5) CS  
Top View  
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Siemens S7 200 PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, EVEN, 1. 

Адрес контроллера: 2. 

Блок управления/блок состояния: VW0 / VW10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

Таймер Tn n: 0 ~ 255 НЕТ 

Слово аналогового входа AIWn n: 0 ~ 30 НЕТ 

Счетчик Cn n: 0 ~ 255 НЕТ 

Слово аналогового выхода AQWn n: 0 ~ 30 НЕТ 

Input Image IWn n: 0 ~ 14 НЕТ 

Образ входа IDn n: 0 ~ 12 НЕТ 

Образ выхода QWn n: 0 ~ 14 НЕТ 

Образ выхода QDn n: 0 ~ 12 НЕТ 

Специальные биты SMWn n: 0 ~ 199 НЕТ 

Специальные биты SMDn n: 0 ~ 197 НЕТ 

Внутренние биты MWn n: 0 ~ 98 НЕТ 

Внутренние биты MDn n: 0 ~ 96 НЕТ 

Область данных VWn n: 0 ~ 9998 НЕТ 

 (DBWn) (n: 0 ~ 9998)  

Область данных VDn n: 0 ~ 9996 НЕТ 

Специальные S SWn n: 0 ~ 99 НЕТ 

Специальные S SDn n: 0 ~ 97 НЕТ 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Бит таймера Tn НЕТ n: 0 ~ 255 

Бит счетчика Cn НЕТ n: 0 ~ 255 

Образ выхода In.b n: 0 ~ 15 b: 0 ~ 7 

Образ выхода Qn.b n: 0 ~ 15 b: 0 ~ 7 

Специальные биты SMn.b n: 0 ~ 200 b: 0 ~ 7 

Внутренние биты Mn.b n: 0 ~ 99 b: 0 ~ 7 

Область битовых данных Vn.b n: 0 ~ 9999 b: 0 ~ 7 
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Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Специальные биты S Sn.b n: 0 ~ 100 b: 0 ~ 7 

C. Связь (Цоколевка разъемов) 

RS-232 

через RS-232 / PPI Multi-Master кабель (Связь DOP через PPI кабель) 

DOP Series 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер 

(RS-232) 

Контроллер 
9 pin D-SUB штекер  

(RS-232) 

RXD (2) (2) RD

TXD (3)

GND (5)

(3) TD

(5) GND 
Top View  

RS-485 

через порт программирования PLC (RS-485) 

DOP Series 
9 pin D-SUB штекер 

(RS-485) 

Контроллер 
9 pin D-SUB штекер 

(RS-485) 

Контроллер 
9 pin D-SUB штекер 

(RS-485) 

RXD+ (2) (3)TXD/RXD+

TXD+ (3)

RXD- (1)

TXD- (4)

GND (5) (5)SG

(8)TXD/RXD-

 Top View  
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Siemens S7 300 PLC (с PC-адаптером) DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 38400, 8, ODD, 1. (RS-232). 

Адрес контроллера: 2. 

(При связи через PC-адаптер нет адреса PLC в протоколе, следовательно, возможна связь 

только 1(HMI) с 1 (PLC)). 

Блок управления/блок состояния: DBW0 / DBW20. 

Примечание  

1) PLC DB память (DBm.DBWn, DBm.DBDn, DBm.DBXn.b) должна быть открыта для того, чтобы HMI 

могла производить запись/чтение. 

2) Основания для использования PC-адаптера: 

При коммуникации через PC-адаптер со стороны PLC используется шина PROFIBUS со скоростью 

187.5 кбит/с. Поэтому, такая структура сети обеспечивает быструю и устойчивую связь. 

S7 300 S7 300 S7 300.....

HMI HMI HMI.....

RS485

RS232

PC адаптер-

 

Когда HMI связывается с PLC без PC-адаптера, протокол будет очень сложным и скорость связи 

будет низкой (до 19200 бит/с). Поэтому, эффективность сетевой структуры связи с S7 300 будет 

хуже. 

3) Задание скорости связи 

 Требуется установка в PLC скорости связи 187.5 K или выше (не используйте 19.2K). 

 Обязательно установите скорость с двух сторон в PC-адаптере: 

"Со стороны PLC": требуется установка такой же скорости связи как в PLC - 187.5 K или выше (не 

используйте 19.2K). 

"Со стороны HMI": можно выбрать 38.4K или 19.2K , используя переключатель на кабеле. 

Скорость задаваемая в HMI: должна быть установлена такой же, как в  PC-адаптере со стороны HMI 

(38.4K или 19.2K) (Протокол: 8, ODD, 1) 

Не меняйте настройки в PLC и HMI, если не хотите иметь проблем связи. 
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PC-адаптер: 

Светодиод питания будет однократно мигать при соединении с PLC (PC-адаптера 

берет питание от  PLC) 

Если связь установлена, светодиод связи будет мигать. Иначе, свечения не будет. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

Образ входов IWn n: 0 ~ 65534 НЕТ 

Образ входов IDn n: 0 ~ 65532 НЕТ 

Образ выходов QWn n: 0 ~ 65534 НЕТ 

Образ выходов QDn n: 0 ~ 65532 НЕТ 

Внутренние биты MWn n: 0 ~ 65534 НЕТ 

Внутренние биты MDn n: 0 ~ 65532 НЕТ 

Область данных DBm.DBWn n: 0 ~ 65534 m: 1 ~ 255 

 DBm.DBDn n: 0 ~ 65532 m: 1 ~ 255 

Область данных (DB10) DBWn n: 0 ~ 65534 НЕТ 

 DBDn n: 0 ~ 65532 НЕТ 

 VWn n: 0 ~ 65534 НЕТ 

 VDn n: 0 ~ 65532 НЕТ 

Таймер Tn n: 0-65535 НЕТ 

Счетчик Cn n: 0-65535 НЕТ 

Примечание  

1) Значения в регистрах T(таймер) и C(счетчик) может быть только трехзначным. Если введенное 

значение превысит 3 разряда, только первые 3 цифры будут значащими (десятичный формат). 

Другие разряды значения регистров T(таймер) будут  0 и другие разряды значения регистров 

C(счетчик) будут отброшены. Например, допустим пользователь введет значение “12345”, при 

этом фактическое значение в регистре T(Timer) будет “12300”, а фактическое значение в регистре 

C(Counter) будет “123”. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Образ входов In.b n: 0 ~ 65535 b: 0 ~ 7 

Образ выходов Qn.b n: 0 ~ 65535 b: 0 ~ 7 

Внутренние биты Mn.b n: 0 ~ 65535 b: 0 ~ 7 

Область битовых данных DBm.DBXn.b n: 0 ~ 65535 b: 0 ~ 7 

   m = 1 ~ 255 
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Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

DBXn.b n: 0 ~ 65535 b: 0 ~ 7 Область битовых данных (10 
DB) Vn.b n: 0 ~ 65535 b: 0 ~ 7 

Примечание  

1) Для всех контактов, когда используется команда многократного дублирования “Multiple Duplicate”: 

 если номера превысят значение 65535, они будут рассматриваться как 0. 

 если значения номеров будут 0, они будут рассматриваться как 655XX. 

C. Связь (Цоколевка разъемов) 

RS-232 

Связь HMI с PC-адаптером 

DOP 
9 pin D-SUB штекер 

Контроллер 
9 pin D-SUB feштекер Контроллер 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND

(8) CTS

(7) RTS

RTS (7)

CTS (8)  

 
 
 
 

 
Вид сверху 

 

 

 

Pin1 
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Siemens S7 300 PLC (без PC-адаптера) DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 19200, 8, EVEN, 1. (RS-485). 

Адрес контроллера: 2. 

Блок управления/блок состояния: DBW0 / DBW20. 

Примечание  

1) Имейте ввиду, что может быть связь только 1(HMI) с 1 (PLC). 

2) Скорость связи в PLC должна быть установлена 19200. (8, EVEN, 1.). 

3) DB должны быть открыты, иначе соответствующие адреса (DB.DBW, DB.DBD, DBW, DBD, VW, VD, 

DB.DBX, DBX, V) не смогут читаться и записываться. 

4) Адрес станции HMI должен быть в диапазоне 0 ~ 15. Иначе, будет автоматически прсвоен адрес 

15. Адрес станции PLC так же должен быть в диапазоне 0 ~ 15. 

5) Коммуникационный кабель должен быть таким же, как для серии S7 200 (RS-485). 

6) Если связь не устанавливается в течение 5 секунд, HMI выведет на экране сообщение об ошибке. 

При подключении коммуникационного кабеля, требуется выключение/включение питания HMI, и 

связь при этом должна быть установлена. 

7) После подачи питания на HMI, HMI должна принять сообщение от PLC, и затем связь может быть 

установлена. При первом подключении потребуется больше времени для установки связи, но оно 

все равно не должно быть больше 5 сек. 

8) Этот протокол работает как пошаговый периодически чередующийся (HMI нуждается в 

многократной связи с PLC для передачи одной команды.). Скорость связи с S7 300 PLC (без PC-

адаптера) обычно ниже, чем с другими контроллерами. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

Образ входов IWn n: 0 ~ 65534 НЕТ 

Образ входов IDn n: 0 ~ 65532 НЕТ 

Образ выходов QWn n: 0 ~ 65534 НЕТ 

Образ выходов QDn n: 0 ~ 65532 НЕТ 

Внутренние биты MWn n: 0 ~ 65534 НЕТ 

Внутренние биты MDn n: 0 ~ 65532 НЕТ 

Область данных DBm.DBWn n: 0 ~ 65534 m: 1 ~ 255 (Note 1) 
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Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 

 DBm.DBDn n: 0 ~ 65532 m: 1 ~ 255 (Note 1) 

Область данных (DB10) DBWn n: 0 ~ 65534 НЕТ 

 DBDn n: 0 ~ 65532 НЕТ 

 VWn n: 0 ~ 65534 НЕТ 

 VDn n: 0 ~ 65532 НЕТ 

Таймер Tn n: 0 ~ 65535 НЕТ 

Счетчик Cn n: 0 ~ 65535 НЕТ 

Примечание  

1) Значения в регистрах T(таймер) и C(счетчик) может быть только трехзначным. Если введенное 

значение превысит 3 разряда, только первые 3 цифры будут значащими (десятичный формат). 

Другие разряды значения регистров T(таймер) будут  0 и другие разряды значения регистров 

C(счетчик) будут отброшены. Например, допустим пользователь введет значение “12345”, при 

этом фактическое значение в регистре T(Timer) будет “12300”, а фактическое значение в регистре 

C(Counter) будет “123”. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Образ входов In.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Образ выходов Qn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Внутренние биты Mn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Область битовых данных DBm.DBXn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

   m = 1 ~ 255 (Note 3) 

DBXn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) Область битовых данных (DB 
10) Vn.b n: 0 ~ 65535 b: 0 ~ 7 (Note 2) 

Примечание  

2) Для всех контактов, когда используется команда многократнокго дублирования “Multiple Duplicate”: 

 если номера превысят значение 65535, они будут рассматриваться как 0. 

 если значения номеров будут 0, они будут рассматриваться как 655XX. 

 

C. Связь (Цоколевка разъемов) 

Коммуникационный кабель должен быть таким же, как для серии S7 200 (RS-485). См. связь с S7 200 

(RS-485).  
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C. Связь (Цоколевка разъемов) 

RS-485 

через MPI-порт PLC (RS-485) 

DOP 
9 pin D-SUB штекер (RS-485) 

Контроллер 
9 pin D-SUB штекер (RS-485) 

Контроллер 
9 pin D-SUB штекер (RS-

485) 

RXD+ (2) (3)TXD/RXD+

TXD+ (3)

RXD- (1)

TXD- (4)

GND (5) (5)SG

(8)TXD/RXD-

 

 

 
Вид сверху 
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Taian TP02 PLC DELTA 

A. Заводские значения параметров связи HMI 

Протокол: 19200, 7, None, 1. 

Адрес контроллера: 1. 

Блок управления/блок состояния: V1 / V10. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер бита 
Размер данных 

WORD_DEVICE_X Xn n: 1 ~ 384 НЕТ Word 

WORD_DEVICE_Y Yn n: 1 ~ 384 НЕТ Word 

WORD_DEVICE_C Cn n: 1 ~ 2048 НЕТ Word 

WORD_DEVICE_V Vn n: 1 ~ 1024 НЕТ Word 

WORD_DEVICE_D Dn n: 1 ~ 2048 НЕТ Word 

WORD_DEVICE_WS WSn n: 1 ~ 128 НЕТ Word 

WORD_DEVICE_WC WCn n: 1 ~ 912 НЕТ Word 

 WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_C: адрес должен быть 1 или кратным 

16+1. 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

BIT_DEVICE_X Xn НЕТ n: 1 ~ 384 

BIT_DEVICE_Y Yn НЕТ n: 1 ~ 384 

BIT_DEVICE_C Cn НЕТ n: 1 ~ 2048 

BIT_DEVICE_SC SCn НЕТ n: 1 ~ 128 

 BIT_DEVICE_SC: только 1 бит может быть передан в каждой команде чтения. 
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C. Связь (Цоколевка разъемов) 

RS-422 

DOP 
9 pin D-SUB штекер (RS-422) 

Контроллер 
9 pin D-SUB штекер (RS-422) 

Контроллер 
9 pin D-SUB штекер (RS-

422) 

RXD+ (2) (3) TXD+

RXD- (1)

TXD+ (3)

(8) TXD-

(2) RXD+

(7) RXD-TXD- (4)  

 

 
Top View 

RS-485 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
RS-485 (T/R+, T/R-) 

RXD+ (2) T/R+

TXD+ (3)

RXD- (1)

TXD- (4) T/R-  
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Vigor M Series DELTA  

A. Заводские значения параметров связи HMI 

Протокол: 19200, 7, EVEN, 1. 

Адрес контроллера: 0. 

Блок управления/блок состояния: D0 / D10. 

Примечание  

1) Адрес контроллера: 0 для PROGRAMMER PORT; 1 для COM PORT 

2) VB серия так же может использовать этот адрес. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Диапазон чтения/записи 
Тип регистров Формат 

Номер слова Номер 
бита 

Размер данных 

Входные реле Xn n: 0 ~ 770 (Octal) НЕТ Word (кратно 8) 

Выходные реле Yn n: 0 ~ 770 (Octal) НЕТ Word (кратно 8) 

Вспомогательные реле Mn n: 0 ~ 5112 НЕТ Word (кратно 8) 

Специальные реле Mn n: 9000 ~ 9248 НЕТ Word (9000 + кратно 
8) 

Шаговые реле Sn n: 0 ~ 992 НЕТ Word (кратно 8) 

Текущее значение таймера Tn n: 0 ~ 255 НЕТ Word 

Текущее значение 16-
битного счетчика Cn n: 0 ~ 199 НЕТ Word 

Текущее значение 32-
битного счетчика Cn n: 200 ~ 255 НЕТ Word 

Регистры данных Dn n: 0 ~ 8191 НЕТ Word 

Специальные регистры 
данных Dn n: 9000 ~ 9248 НЕТ Word 

Контакты 

Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Входные реле Xn НЕТ n: 0 ~ 777(Octal) 

Выходные реле Yn НЕТ n: 0 ~ 777(Octal) 

Вспомогательные реле Mn НЕТ n: 0 ~ 5119 

Специальные реле Mn НЕТ n: 9000 ~ 9255 

Шаговые реле Sn НЕТ n: 0 ~ 999 

Контакт таймера Tn НЕТ n: 0 ~ 255 
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Диапазон чтения/записи 
Тип контактов Формат 

Номер слова Номер бита 

Контакт счетчика Cn НЕТ n: 0 ~ 255 

Катушка таймера TCn НЕТ n: 0 ~ 255 

Катушка счетчика CCn НЕТ n: 0 ~ 255 

C. Связь (Цоколевка разъемов) 

RS-232 

 (PROGRAMMER PORT) 

DOP 
9 pin D-SUB штекер(RS-232) 

Контроллер 
разъем USB TYPE A 

Контроллер 
разъем USB TYPE A 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(4) GND 

 
 
 
 

 
Вид сверху 

(COM PORT) 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер 
9 pin D-SUB гнездо (RS-232) 

Контроллер 
9 pin D-SUB гнездо (RS-232) 

RXD (2) (3) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND 

 
 
 
 
 

Вид сверху 

 

 

2 
3 
4 

Pin1 
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YOKOGAWA ACE PLC DELTA  

A. Заводские значения параметров связи HMI 

Протокол: 9600, 8, EVEN, 1. (ASCII code) 

Адрес контроллера: 1. 

CPU NO. : 1. 

Блок управления/блок состояния: D1 / D10. 

Примечание  

1) Проверка суммы (CheckSum) и Стоповые символы (CR, LF) не используются. Поэтому, в 

контроллере так же надо установить флаг “Not using CheckSum and End character”. 

2) Номер CPU используется во время связи, однако, Screen Editor не имеет такой установки. 

Поэтому, если пользователь желает установить номер CPU, установите адрес станции HMI в 

закладке “General”  в окне ”Configuration” меню “Options” (Options  ”Configuration”  General). 

(Адрес станции HMI рассматривается как номер CPU. По умолчанию адрес HMI установлен как 0, 

но 0 это неправильный номер, и пользователь должен задать правильное значение. 

B. Адреса чтения/записи операндов контролера 

Регистры 

Тип регистров Формат Номер слова Размер 

WORD_DEVICE_X Xn n: 201 ~ 65464 Word 

WORD_DEVICE_Y Yn n: 201 ~ 65464 Word 

WORD_DEVICE_I In n: 1 ~ 16384 Word 

WORD_DEVICE_E En n: 1 ~ 4096 Word 

WORD_DEVICE_L Ln n: 1 ~ 65488 Word 

WORD_DEVICE_M Mn n: 1 ~ 9984 Word 

WORD_DEVICE_TP TPn n: 1 ~ 3072 Word 

WORD_DEVICE_CP CPn n: 1 ~ 3072 Word 

WORD_DEVICE_D Dn n: 1 ~ 8192 Word 

WORD_DEVICE_B Bn n: 1 ~ 32768 Word 

WORD_DEVICE_W Wn n: 1 ~ 65499 Word 

WORD_DEVICE_Z Zn n: 1 ~ 512 Word 

WORD_DEVICE_V Vn n: 1 ~ 64 Word 

WORD_DEVICE_R Rn n: 1 ~ 4096 Word 

WORD_DEVICE_TS TSn n: 1 ~ 3072 Word 

WORD_DEVICE_CS CSn n: 1 ~ 3072 Word 

 WORD_DEVICE_X / WORD_DEVICE_Y: последние два разряда адреса должны быть как 1 или 

кратны 16+1 и меньше чем 65. 
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 WORD_DEVICE_I / WORD_DEVICE_E / WORD_DEVICE_L / WORD_DEVICE_M: адрес должен 

быть 1 или кратным 16+1. 

 WORD_DEVICE_X / WORD_DEVICE_Y / WORD_DEVICE_L / WORD_DEVICE_W: допустимые 

адреса непоследовательны. 

Контакты 

Тип контактов Формат Номер бита 

BIT_DEVICE_X Xn n: 201 ~ 65464 

BIT_DEVICE_Y Yn n: 201 ~ 65464 

BIT_DEVICE_I In n: 1 ~ 16384 

BIT_DEVICE_E En n: 1 ~ 4096 

BIT_DEVICE_L Ln n: 1 ~ 65488 

BIT_DEVICE_M Mn n: 1 ~ 9984 

BIT_DEVICE_TU TUn n: 1 ~ 3072 

BIT_DEVICE_CU CUn n: 1 ~ 3072 

 BIT_DEVICE_X / BIT_DEVICE_Y : последние два разряда адреса должны быть меньше 65 (1 ~ 64). 

 BIT_DEVICE_X / BIT _DEVICE_Y / BIT _DEVICE_L : допустимые адреса непоследовательны. 

 Многократное дублирование: 

Следующий битовый адрес за X264 - это X301 (несуществующие адреса X265 ~ X300) 

Следующий битовый адрес за X364 - это X401. 

Адреса Y такие же как X. 

(Словные адреса X и Y так же автоматически пропускаются) 

C. Связь (Цоколевка разъемов) 

Требуется использование специального кабеля YOKOGAWA ACE PLC. 

RS-232 

DOP 
9 pin D-SUB штекер (RS-232) 

Контроллер (6 pin) 
(RS-232 для YOKOGAWA) 

Контроллер (6 pin) (RS-232 
для YOKOGAWA) 

RXD (2) (1) TXD

TXD (3)

GND (5)

(2) RXD

(5) GND  
   Вид сверху 
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